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Voicemail Pro:  

1. Voicemail Pro
The diagram illustrates a Voicemail Pro system with some of the setup options. Full details on the installation options
available are covered in the Installing Voicemail Pro  section.

· IP Office Control Unit 
The IP Office Voicemail Pro licenses are entered into the configuration of the IP Office system. The licenses are
required to activate Voicemail Pro features. An unlicensed Voicemail Pro service will run for two hours to allow
demonstration and testing. License keys are issued against and validated against the unique serial number of the
feature key dongle used by the IP Office. For USB and parallel port feature key dongles, the dongle must be
installed on a PC running the IP Office Feature Key Server application. 

· Voicemail Pro Server 
The Voicemail Pro Service is installed on the Voicemail Pro server PC. This becomes the PC where messages and
other data are stored for the mailboxes and services provided by Voicemail Pro. 

· Voicemail Pro Client
The Voicemail Pro Client is used to manage and configure the Voicemail Pro service. It can be installed on the
Voicemail Pro server PC or on a separate PC. Only one client can connect to the server at any time. 

· Telephone Extension
For internal extensions, the voicemail server can be configure to send message waiting indication. By default this
is automatically done when the extension users own mailbox contains new messages. 

· User's PC 
The following applications can be used on a user's PC to access their messages:

· Phone Manager
IP Office Phone Manager can be used to display the number of new messages in a mailbox and to access that
mailbox. The Pro version of Phone Manager can also control the playback of the individual messages once a
mailbox has been accessed. 

· Web Browser
If the Voicemail Pro server PC is also running Microsoft's IIS web server, users can access voicemail features.

· Web Campaigns
The web campaigns option can be used to collect spoken and key press responses to question from
callers and then display those responses to internal agents. 

· Web Voicemail
For Voicemail Pro 4.2+, UMS licensed users can be configured to access their own mailbox using a web
browser. 

· Email Options
The voicemail server can interact with email systems in a number of ways: 

18
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· Voicemail Email
The Voicemail can, using either MAPI or SMTP, indicate the delivery of a new message to the voicemail
store by issuing an emailed Voicemail Alert, or attaching a copy of the Voicemail to the email. Please
note these options do not support the synchronization of messages between the users email program
and their voicemail mailbox. In addition to the Alert and Copy capability, the Voicemail also offers the
ability to forward voicemail messages to the email store. Unless the user is a UMS licensed user and the
mail store is Exchange 2007, the voicemail messagess delivered via a Forward will only be accessible
via the users email Client. 

· IMAP
For Voicemail Pro 4.2+, UMS licensed users will be able to access their voicemail messages, stored in
the Voicemail Store, via email clients such as Outlook that support an IMAP Client. This capability
includes synchronization between the voicemail messages presented via the email client and the
voicemail mailbox.

· Exchange Integration - Unified Messaging System (UMS) 
For Voicemail Pro 5.0+, UMS licensed users delivering voicemail messages into Exchange 2007, utilizing
an Outlook 2007 email client, will have their voicemail messages presented using the Microsoft media
controls, without the need to install any client side components. For UMS licensed users, using the
Voicemail to email forward capability, where Exchange 2007 is the email store, the emails delivered into
exchange will be accessible via the TUI and visual voice. Note: Voicemail messages forwarded onto an
email store will not be accessible via the Web Services or IMAP interfaces.

· ContactStore Server 
The current IP Office Voice Recording Library (VRL) application is Avaya IP Office ContactStore. The application can
be installed on the Voicemail Pro Server in a separate hard disk partition or on a separate server. The diagram
illustrates the option of installing ContactStore on a separate server.

Voicemail Pro is supplied the IP Office User and Admin Applications DVD. Voicemail Pro ScanSoft TTS is supplied as a
separate 2 DVD set. 
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Voicemail Pro:  

1.1 What is New in 5.0
The following is a summary of the new features in the IP Office Voicemail Pro 5.0 release. For details of previous releases
refer to the Appendix . 

Voicemail Pro 5.0
· ContactStore 7.8 

The ContactStore software has been updated to version 7.8. The new version uses a different database format and
supports a wider range of search options. The method of interaction with the voicemail server and IP Office has
not changed. However, ContactStore 7.8 has not been tested with pre-5.0 versions of Voicemail Pro and IP Office.
For full details refer to the IP Office ContactStore Installation manual. 

· Updated TTS (ScanSoft) Prompts and Software 
The TTS (ScanSoft) software include with Voicemail Pro 5.0 has been updated. The change allows: 

· Additional Languages 
Additional language support for Chinese (Mandarin), Danish, Finnish, French Canadian, Greek, Hungarian,
Polish, Portuguese and Swedish. The set of TTS languages now matches the recorded prompt languages
provided by Voicemail Pro with the exception of Hungarian. 

· Vista Support 
The updated TTS drivers are supported on Vista and on 64-bit versions of supported Windows operating
systems. 

IP Office Configuration Changes
The following changes to the IP Office 5.0 configuration are applicable to Voicemail Pro 5.0. 

· IP500 Support 
Voicemail Pro 5.0 no longer requires the IP Office to have an IP500 Upgrade Standard to Professional
license. 

· IP500 Voicemail Pro Ports  
For IP500 control units, the maximum number of licensable voicemail channels has increased to 40. 

· System Default Mailbox Breakout Numbers  
Breakout numbers allow callers to select to be redirected to another destination while listening to a user's mailbox
greeting. Each user mailbox can have up to 3 possible breakout numbers set, accessed by the caller dialing 0, 2 or
3. IP Office 5.0+ allows system default numbers to be set for each mailbox breakout. These system defaults are
then applicable to all user mailboxes unless overridden by a user's own breakout number settings. 

· User Rights Mailbox Breakout Numbers 
User mailbox breakout numbers can also be set through user rights. 

· Additional Breakout Number Support in IP Office Mailbox Mode 
The additional breakout numbers 2 and 3 are now supported on Voicemail Pro systems running in IP Office
mailbox mode. 

· Forward Unconditional to Voicemail  
Within the IP Office configuration for a user's forwarding settings, for Forward Unconditional the option To
Voicemail can be selected. This will override any forwarding number set and send calls immediately to voicemail
when forward unconditional is enabled. This option is supported with all IP Office voicemail types including
Voicemail Pro. 

· Small Community Network Fallback  
Within an IP Office Small Community Network, voicemail server is associated with a central IP Office via which it
provides voicemail services to all the IP Offices in the SCN. IP Office 5.0 provides a number of SCN fallback
settings, including allowing the voicemail server to work with a fallback IP Office if the central IP Office is removed
from the network for any reason. This feature is configured within the IP Office configurations and requires the
fallback IP Office to have the appropriate licenses for the voicemail features required during fallback. 

UMS Enhancements
The following additions have been made to UMS operation: 

· Hunt Group Mailbox Support  
Hunt group mailboxes are now supported. A UMS Web Service option is available on the Hunt Group | Voicemail
tab within the IP Office configuration. The use of this option allows access to the hunt group mailbox messages
using IMAP or a web browser. This consumes UMS Web Service licenses in the same way as enabling users for
UMS.

· Web Browser Playback Enhancements  
The Web Browsers message playback interface has been enhanced to allow the user to call the sender of the
message, if the CLI is know, or select ‘previous’, ‘next’, ‘first’ or ‘last’ message without leaving the interface. In
addition the message forward capability has been enhanced to ease the selection of destinations.
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· UMS Exchange 2007  
A UMS licensed user configured to use Exchange 2007 as the Voicemail store, by setting the Voicemail to email
forward option, will have their voicemail messages delivered into Exchange, and will still be able to get access to
the voicemail messages via the Telephone User Interface (TUI) and Visual Voice, as well as being provided access
by Exchange Compatible applications using interfaces such as Exchange Web Services, or the Exchange IMAP
server. Please note, the VMPro Web Services, or the VMPro IMAP server will only present messages in the
Voicemail Store, therefore in the instance where the voicemail messages have been forwarded on to another mail
store, these messages will not be presented by these interfaces. Mail stores such as Exchange 2007 provide their
own methods for IMAP and Web browsing which would then be the interfaces of choice.

Call Flow Actions
The following changes have been made to Voicemail Pro actions. 

· Whisper Action  
Two new options are now provided by the Whisper action. The action can now be used requiring a caller recording.
The transfer target is still able to accept or reject the call but will do this based on the displayed text and the
prompts pre-recorded with the action when it was setup. Whisper calls can also be used with auto accept. When
selected, after hearing the caller's recording and the action prompts the call is automatically connected to the
transfer target. 

· Alarm Set  
This action was previously restricted to setting up a single non-repeated alarm back to an internal caller's own
extension. The action has now been enhanced to allow the setup of alarms to other extension and repeating
alarms. 

· Clock Action  
The clock action can now be used to say the time just once before moving to the next call flow action or to repeat
the time until the caller presses a DTMF key or hangs up. 

· Increment and Test Counter  / Decrement and Test Counter  
These two new actions have been added to the list of Condition actions. They can be used to change the value of
one of the 15 new $COUNTER call variables and then branch the call flow if the new value matches a specified
target value. 

· Transfer  / Assisted Transfer
These actions now include an option to change the caller's priority prior to the transfer. 

· For the Transfer action, transferring to a short code is now supported. 

· Generic Action  
The Specific tab settings of this action have been changed to allow the entry of generic commands by the
selection from a list of commands and then completion of relevant parameters. The resulting text string for the
resulting generic command can still be displayed and edited if required or if a generic command not included in the
parameterized command list is being used. 

Call and User Defined Variables
The following changes have been made to the call and user defined variables provided by the voicemail server. 

· $COUNTER  
A set of $COUNTER call variables, $COUNTER1 to $COUNTER15 have been added. The value of these can be set,
incremented and decremented using Generic actions and the specific Increment and Test Counter, Decrement and
Test Counter actions. 

· User Defined Variable Display  
The current values of all the user defined variables can be displayed and edited through using the Voicemail Pro
client. This is done by selecting Server Queues and then User Variables in the left hand navigation pane. 

Voicemail Pro Client Changes
· Minimum Message Length  

Through the voicemail server's general preferences, the minimum message length saved by the voicemail server
can be seen and changed. The value can be set between 0 and 10 seconds. 

· Navigation Changes  
A number of changes have been made to the items that can be selected in the left hand navigation pane of the
Voicemail Pro client. 

· Users / Groups  
Selecting Users or Groups in the left hand navigation pane displays details for each mailbox. Voicemail Pro 5.0
provides the following additional options when using this display. 
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Voicemail Pro: What is New in 5.0

· Disable Mailbox 
By right clicking on a listed mailbox and selecting Disable Mailbox, the use of the mailbox can be
disabled. Attempts to connect to the mailbox will receive number unobtainable indication from the
voicemail server. 

· Clear Mailbox 
By right-clicking on the listed mailbox and selecting Clear Mailbox, all existing messages and prompts in
the mailbox are deleted. 

· Server Queues  
The option Server Queues in the navigation pane gives access to the following information. 

· Alarms  
When selected, outgoing alarms calls set using Alarm Set actions are listed in the Voicemail Pro client's
right hand pane. The list can also be used to add, delete alarms and to edit alarm settings.

· User Variables  
When selected, the current values of user defined variables are listed in the Voicemail Pro client's right
hand pane. The list can be used to add, delete user defined variables and to edit the current value of
those variables. 

· Outcalls  
When selected, outgoing calls being made or scheduled to be made by the voicemail server are listed in
the Voicemail Pro client's right hand pane. The list can be used to delete calls. 

· Conditions Import/Export  
Existing conditions can now be exported to a file and then imported into the configuration of another
Voicemail Pro 5.0+ system. 
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1.2 Features of Voicemail Pro
Voicemail Pro provides voicemail for every telephone on the system. Messages can be retrieved from a user's own
extension or from another telephone. Voice messages can also be forwarded to other voice mailboxes. Using Voicemail
Pro call flows can be created that can, for example, guide a caller to the correct extension.

Listed below are some of the differences between Embedded Voicemail and Voicemail Pro. For a fuller comparison, see
the product description.

Feature Embedded
Voicemail

Voicemail
Pro

Integration with Phone Manager Pro.

Create personal greetings.  1 only  9 max

Selection of voicemail transfer numbers

Play a greeting continuously.

Forward or copy a message to Email.

Listen to an Email using Text To Speech.

Send Email Notification. *

Forward a voice message to another mailbox or multiple mailboxes.

Forward a voice message to multiple mailboxes using a Personal Distribution
List.

Forward a voice message with a header

Rewind Message

Fast forward a message

Skip a message

Pause a message

Skip Message

Set message priority

Control when old messages are automatically deleted.

Alphanumeric data collection

Give callers a choice of transfer options.

Call recording

Create Campaigns

Receive message notification at destinations configured by the user (known as
Outcalling).

Transfer to Fax

Reply to a message if CLI is available

*Added in IP Office 4.2. 
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Voicemail Pro: Features of Voicemail Pro

1.3 Supported Languages
By default the prompts installed match the installer language selection plus English. If other languages are required they
need to be selected by doing a custom installation. The installable Voicemail Pro prompts are listed in the table below.
The availability of a language in voicemail does not necessarily indicate support for IP Office in a country that uses that
language. 

Language WAV
Folder

Fallback Selection TTS 5.0

Brazilian Portuguese ptb > pt > en.

Chinese (Cantonese) zzh > en > enu.

Chinese (Madarin) ch > en > enu.

Danish da > en.

Dutch nl > en.

English UK en en.

English US enu > en.

Finnish fi > en.

French fr > frc > en.

French Canadian frc > fr > enu > en.

German de > en.

Greek el > en.

Hungarian hu > en.

Italian it > en.

Korean: ko > en.

Latin Spanish eso > es > enu > en.

Norwegian no > en.

Polish pl > en.

Portuguese pt > ptb > en.

Russian ru > en.

Spanish es > eso > en.

Swedish sv > en.

When the IP Office routes a call to the voicemail server it indicates the locale for which matching prompts should be
provided if available. Within the IP Office configuration, a locale is always set for the system. However differing locales
can be set for each user, incoming call route and for short codes in addition to the default system locale. 

The locale sent to the voicemail server by the IP Office is determined as follows:

Locale Source Usage

Short Code Locale The short code locale, if set, is used if the call is routed to voicemail using
the short code. 

System Locale If no user or incoming call route locale is set system locale is used unless
overridden by a short code locale. 

Incoming Call Route Locale The incoming call route locale, if set, is used if caller is external.

User Locale The user locale, if set, is used if the caller is internal.

If the prompts matching the IP Office locale are not available, the voicemail server will provide prompts from a fallback
language if available. The table of languages above lists the order of fallback selection. 

If required, the language provided by a voicemail call flow can be changed using a  Select System Prompt
Language  action. 

TTY Teletype Prompts
TTY (Teletype (Textphone)) is included in the list of installable languages. TTY is a text-based system that is used to
provide services to users with impaired hearing. See Support for Callers with Impaired Hearing .
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1.4 Number of Simultaneous Users
All connections between the voicemail server and the IP Office are via the LAN using data channels. The maximum
number of data channels that can be used for voicemail operation at any moment are shown below. 

Specific functions can have voicemail channels reserved  for their use or may have channel restrictions. 

IP Office Maximum for
Voicemail Pro

Small Office Edition 10

IP406 V2 20

IP412 30

IP500 40[1]

1.30 ports on pre-IP Office 5.0 systems. 

· Voicemail Pro Licenses  
The actual number of ports available on Voicemail Pro is controlled by license keys entered through IP Office
Manager. 

· The Voicemail Pro license enables 4 ports.

· Additional Voicemail Pro licenses can be added to enable further ports up to the maximum shown in the
table.

· VoIP/VCM Channels 
Though linked to the IP Office via a LAN connection, voicemail does not use VoIP VCM channels. The Voicemail
Server is seen as a device on the IP Office's TDM telephony interface.

· Calls to/from voicemail involving non-IP trunks and extensions do not use VCM channels.

· Calls to/from voicemail from IP trunks and extensions do use a VCM channel.
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Installing Voicemail Pro

Chapter 2.
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2. Installing Voicemail Pro
Voicemail Pro 5.0 can be installed with the following IP Office systems: 

· IP406 V2.

· IP412.

· IP Office 500

2.1 General Installation Requirements
Here is a list of general requirements for all types of voicemail installation. 

· A PC with IP Office Manager and Microsoft .NET Framework versions 2.0 installed on it. If .NET 2.0 is not detected,
you will be prompted to install it before the Voicemail Pro installation proceeds.

· An IP Office Feature Key and if necessary (ie. for parallel and USB feature keys) a PC running the IP Office Feature
Key Server application. Refer to the IP Office Installation Manual for details. 

· Licenses based on the serial number of the IP Office Feature Key. This should include: 

· A license for Voicemail Pro and any additional voicemail ports is required. If Voicemail Pro Server is installed
without a license it will run for 2 hours and then shut down.

· Licenses for any other Voicemail Pro components being installed, see Voicemail Pro Licenses .

· IP Office Applications DVD. 

 

Tips

· Before you start to install Voicemail Pro it is advisable to check that the PC that you are using can connect to the IP
Office unit and that you can load and save a configuration file using IP Office Manager.

· Switch off any PC and hard disk sleep, power down, suspend, hibernation modes.

· The Voicemail Pro software needs to be installed using an account with full administrator rights on the PC. The service
subsequently runs under that account. We recommend that a specific account is created for this purpose and set so
that its password does not expire.

24
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Installing Voicemail Pro: General Installation Requirements

2.1.1 PC Specification
The PC specifications given below are the minimum required. To avoid having to replace the server when upgrading we
recommend that at least a Pentium 4 2.8GHz or higher is used wherever possible.

This application requires various licenses entered into the IP Office configuration to control the features it offers and the
number of simultaneous connections , up to 40 on IP Office 5.0+ IP500 control units. The operation of Voicemail Pro
can be customized to provide special services.

The Voicemail Pro software can be installed as separate Voicemail Pro client and server parts. This allows the remote
administration of the Voicemail Pro server from a PC with just the Voicemail Pro client installed. A copy of the client is
automatically installed locally with the Voicemail Pro server.

Source

DVD IP Office 5.0 Applications DVD (700472863)

Languages See Supported Languages .

IP500  IP Office Standard Edition[1],  IP Office Professional Edition.

License  See below.

1.For pre-IP Office 5.0 IP500 systems, an IP500 Upgrade Standard to Professional licenses is required to support
Voicemail Pro. 

The Voicemail Pro server part of the software consists of several components in addition to the core server software,
these are:

· Campaigns 
The Voicemail Pro can be configured to run a campaign. This consists of a series of questions for which the
Voicemail Pro records the callers answer or key presses. The resulting recordings can then be played back by
users. The web aspect of campaigns allows user to perform this playback and processing of campaign recordings
via their web browser. This requires an IIS web server to be run on the same PC as the Voicemail Pro software.

· Text to Speech (TTS) 
Through adding additional licenses, the Voicemail Pro is able to use the TTS functions of Windows to speak text
and numbers to callers in addition to recording prompts. This is intended mainly for scenarios where the Voicemail
Pro is obtaining text and number values from a customer database.

· UMS Web Voicemail
UMS allows users to access their voicemail mailbox using either an IMAP compatible email program or through
their web browser. UMS Web Voicemail requires the Voicemail Pro service to be installed on a server PC that has
IIS already present. It also installs PHP if not detected as already present. 

 

· Installation on Windows Server Operating Systems
On many Windows server PC's, while the Windows Audio components are present by default they are not always
enabled. If this is the case the playback of voice prompts may be 'choppy' and the TTS (if installed) will not work.
However, enabling Windows Audio does not require the server PC to have a sound card installed. 

1.Ensure that you have full administrator rights for the PC. This process will also require the PC to be restated. 

2.In the Windows Control Panel select Sounds and Audio Devices. 

3.If Windows Audio has not been enabled, select the Enable Windows Audio check-box. 

Notes:

1. Use of the Large Fonts setting is not supported. Use of this option may cause options on some screens to become
inaccessible.

2. A 100Mbps network card is strongly recommended.

3. Free disk space requirements  are also subject to the message storage required. 
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Basic Voicemail Pro

Minimum PC Requirements

RAM 256MB

Hard Disk Free Space 2GB*

Processor:

- Pentium P4 1.4GHz

- Celeron Any 1.7GHz

- AMD Any 1.4GHz.

*Also allow 1MB per minute for message and prompt storage.

Operating System Support

Server OS:

2000 Server

2003 Server

2008 Server

Client OS:

2000 Professional

XP Professional

Vista Business/Enterprise

Vista Ultimate

Voicemail Pro plus UMS Web Voicemail and/or Campaigns

Minimum PC Requirements

RAM 512MB

Hard Disk Free Space 2GB*

Processor:

- Pentium P4 2.8GHz

- Celeron Not tested.

- AMD Athlon XP 3000+, Athlon 64

*Also allow 1MB per minute for message and prompt storage. 

Operating System Support

Server OS:

2000 Server

2003 Server

2008 Server

Client OS:

2000 Professional

XP Professional

Vista Business/Enterprise

Vista Ultimate

· Both Web Campaigns and UMS Web Voicemail require the IIS web server on the voicemail server PC to be enabled. 

· Windows 2008 Server IIS does not support legacy IIS applications such as Campaigns by default. This is rectified
by reinstalling IIS from the Windows installation disk, and selecting Legacy IIS support. 

· UMS Web Voicemail will install PHP is not detected as already installed. 

Voicemail Pro plus IMS
Note that IMS is not supported with UMS. The installation of IMS is not covered by this documentation. For details of IMS
refer to the Voicemail Pro 4.2 Installation manual. 

Minimum PC Requirements

RAM 512MB

Hard Disk Free Space 2GB*

Processor:

- Pentium P4 2.8GHz

- Celeron Not tested.

- AMD Athlon XP 3000+, Athlon 64

*Also allow 1MB per minute for message and prompt storage.

Non OS Applications IMS

Microsoft Exchange 2000 Yes

Microsoft Exchange 2003 Yes

Microsoft Exchange 2007 No

Microsoft Outlook 2003* Yes

Microsoft Outlook 2007* Yes

*Not supported in caching mode. 

Operating System Support

Server OS:

2000 Server

2003 Server

2008 Server

Client OS:

2000 Professional

XP Professional

Vista Business/Enterprise

Vista Ultimate
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Installing Voicemail Pro: General Installation Requirements

Voicemail Pro plus IVR and or TTS

Minimum PC Requirements: Basic Voicemail Pro

RAM 512MB

Hard Disk Free Space 20GB*

Processor:

- Pentium P4 2.8GHz

- Celeron Not tested. 

- AMD Athlon XP 3000+, Athlon 64

Also allow 1MB per minute for message and prompt storage.

Operating System Support

Server OS:

2000 Server

2003 Server

2008 Server

Client OS:

2000 Professional

XP Professional

Vista Business/Enterprise

Vista Ultimate

· If the database being queried is located on the VM Pro server the query speed of the database will be affected by
the amount of memory available. Please take into account the memory requirements of the database being
queried.

Voicemail Pro and IP Office Customer Call Reporter
Voicemail Pro and IP Office Customer Call Reporter can be run on the same server up to a maximum of 17 Voicemail Pro
ports. Supported on a Dual Core CPU of 2.4Ghz and higher. The separate requirements of Voicemail Pro and Customer
Call Reporter must be meet. 

Voicemail Pro and IP Office Compact Call Center (CCC)
Voicemail Pro and CCC can be run on the same server up to a maximum of 25 CCC agents and 8 Voicemail Pro ports.
Supported on a Dual Core CPU of 2.4Ghz and higher. The separate requirements of Voicemail Pro and CCC must be
meet. 
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Ports

Component Location - %ProgramFiles%\Avaya\IP Office\ Ports

Voicemail Pro Service Voicemail Pro\VM\vmprov5svc.exe UDP 50791.

UDP 50795.

ALL 50801.

ALL 8089.

VMPro Database Voicemail Pro\VM\VMPDBSvc.exe  

VPIM Client Voicemail Pro\VPIMClient.exe  

VMPro VPIM DBSVR Voicemail Pro\VPIM\vpimdbsvr.exe  

VMPro VPIM Receiver Voicemail Pro\VPIM\VPIMReceiver.exe  

VMPro VPIM Server Voicemail Pro\VPIM\VPIMServer3.exe  

IMS Admin Voicemail Pro\IMS\IMSAdmin.exe  

IMS Service Restart Voicemail Pro\IMS\IMSServiceRestart.exe  

IMS Gateway Service Voicemail Pro\IMS\UMServer.exe TCP 445.

TCP 593.

UDP 445.

UDP 593

IMS Voice Service Voicemail Pro\IMS\VMServer.exe  

IMS Security Voicemail Pro\VM\IMSSec.exe  

IMS Client for Outlook %ProgramFiles%\Avaya\IMS Client\UMSForm.exe TCP 445.

TCP 593.

UDP 445.

UDP 593.

2.1.2 Network Requirements
The PC should be configured and tested for TCP/IP networking.

We strongly recommend that the voicemail server PC is connected to the IP Office Control Unit directly or via a LAN
switch.

If directly connected, changing the settings of the PC network card to match the IP Office control unit can resolve some
issues. This should be done according to the PC or network card manufacturer's instructions. The options for IP Office
LAN ports are:

· IP412: Use LAN1 and half duplex.

· Small Office Edition, IP406 (V2) and IP500: Full duplex.

· All IP Office LAN ports are 10Mbps/100Mbps auto sensing.

If not directly connected, using any of the above settings must be supported and matched by the intervening network
equipment.

· The PC should have a fixed IP address. Although PCs in a DHCP network may retain the same IP address between
reboots this is not guaranteed.

· If the IP Office is acting as a DHCP server, it defaults to using 192.168.42.2 to 192.168.42.201 for DHCP clients.
This leaves 192.168.42.202 to 192.168.42.254 for devices that require fixed IP addresses.
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Installing Voicemail Pro: General Installation Requirements

2.1.3 Disk Space Requirements
The following are only approximations: 

· At least 2GB of free disk space is required on the operating system drive (by default c:), regardless of to which
drive Voicemail Pro is actually installed.

· A compact Voicemail Pro installation requires 130MB. 

· A typical installation requires approximately 255MB. 

· A custom installation requires up to 2GB of disk space. However, prompts and recorded messages consume an
additional 1MB of disk space per minute.

· For a busy environment you can expect to require at least 1000 minutes of message recording space, that is 1GB.

· If you are installing the Client only, you can expect to require at least 170MB.

2.1.4 Web Server Operation
If web browser access is required, the Microsoft IIS Web Server must be installed on the server PC before Voicemail Pro
is installed:

· Microsoft web server products run as services and require Voicemail Pro to also run as a service. 

· Internet Information Server 5.0 or higher is required.

 

2.1.5 ContactStore Operation
The current IP Office Voice Recording Library (VRL) application is Avaya IP Office ContactStore. This application and its
installation are documented separately, however:

· IP Office ContactStore should be installed after Voicemail Pro has been installed and its operation verified.

· IP Office ContactStore must use a separate hard disk partition for its message archiving from that used by
Voicemail Pro for current mailbox messages. Use of a separate hard disk or installation onto a separate server PC
are alternatives.

· The use of RAID 1 or RAID 5 are recommended.

· The use of a DVD recorder for long-term archiving is recommended.

· A figure of 7.2MB per hour for archived recordings is given.

· The archived messages held by IP Office ContactStore are accessed via web browser using the port address 8888.
This port address is not configurable and so it is necessary to ensure that it does not conflict with any other web
server service running on the same server PC. 
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2.1.6 Voicemail Pro Licenses
The following License Keys can be used with Voicemail Pro. The license keys are entered into the IP Office configuration
using the IP Office Manager. If the Voicemail Pro server is installed without a license, it will run for 2 hours and then
shutdown. 

For Voicemail Pro 4.2+, the Help | About  screen in the voicemail client can be used to check which IP Office the
voicemail server is working and the licenses it has received from that IP Office. 

Required Licenses
The following are the minimum licenses required for an IP Office system to support Voicemail Pro:

· Voicemail Pro (4 ports) 
This license is required to enable support for the Voicemail Pro voicemail server. It also enables 4 voicemail
ports. 

· IP500 Upgrade Standard to Professional 
On pre-IP Office 5.0 systems using an IP500 control unit, this license is required for the system to support a
Voicemail Pro server. 

 

Additional Port Licenses
The port licenses control the number of ports (simultaneously connected calls into/from the voicemail server). Note: The 
maximum number of ports  supported for voicemail operation is set by the type of IP Office control unit. Multiple port
licenses can be used to achieve the number of ports required.

· Additional Voicemail Pro (2 ports) 
Enables 2 additional Voicemail Pro ports.

· Additional Voicemail Pro (4 ports) 
Enables 4 additional Voicemail Pro ports.

· Additional Voicemail Pro (8 ports) 
Enables 8 additional Voicemail Pro ports.

· Additional Voicemail Pro (16 ports) 
Enables 16 additional Voicemail Pro ports.

 

Voicemail Pro Feature Licenses 
These licenses enable the use of specific features within Voicemail Pro.

· VMPro VB Script 
Enables use of VB Scripting through the VB Script action

· VMPro Database Interface 
Enables database integration within call flows.

· VMPro TTS (Generic) 
Enables use of text to speech facilities using the default Windows and third party TTS engines. One license per
simultaneous instance of TTS usage.

· VMPro TTS (ScanSoft) 
Enables use of text to speech facilities using Avaya supplied TTS (ScanSoft) engines. One license per
simultaneous instance of TTS usage.

· Networked Messaging 
Enables the use of Voicemail Pro Network Messaging.

· VMPro Recording Administrators 
Allows call recordings to be transferred to a VRL (Voice Recording Library) application. The currently
supported application is ContactStore for IP Office. 

· For centralized voicemail operation, a VMPro Recording Administrators license is required in each IP Office
system for which VRL support is required. 

· UMS Web Services (IP Office 4.2+)
Allows the voicemail server to run IMAP and Web Voicemail services. The number of UMS Web Services
licenses set the number of users who can be configured to access either of those services. For Voicemail Pro
5.0+, hunt groups can also be configured for UMS Web Services and consume the same license. 
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Installing Voicemail Pro: General Installation Requirements

2.1.7 User and Group Mailboxes
The voicemail server creates mailboxes based on the user and hunt group names that are entered in the IP Office
Manager application. Whenever the Voicemail Pro is restarted or the IP Office configuration is changed, new mailboxes
are created for any new names that are found.

This method of operation has the following consequences:

· Mailboxes are based on names 
For all users and groups, if their name is changed or deleted, they are no longer associated with their former
mailbox and any associated Voicemail Pro start points.

· Voicemail is case sensitive 
If a mailbox or start point name is entered incorrectly in IP Office Manager or Voicemail Pro, the intended
operation will not occur and the call may be disconnected.

· Voicemail removes spaces at the end of mailbox names 
If spaces are left at the end of a mailbox user's name in IP Office Manager, when the mailboxes are created, the
space at the end of the name is dropped. When this occurs the mailbox cannot be found as there is a mismatch
between the user name and directory. 
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2.2 Server/Client Installation
The Voicemail Pro installation software offers a number of different types of installation. The key types are client only,
compact, typical and custom. These differ in the components installed as detailed in the table below.

Component Sub Component Installation Type Notes

Client Compa
ct

Typic
al

Custo
m

Voicemail
Pro

Voicemail Pro
Client

Voicemail Pro
Service

Languages Installs the prompts that best match the server
PC locale plus English prompts. For an installation
with additional languages use the Custom
installation option.

VPNM VPNM Database
Receiver

VPNM Server

VPNM Receiver

Voicemail Pro Campaign Web
Component

Not available for installation on an XP Pro server. 

Integrated
Messaging
Service
(IMS)

IMS Client Package Not available for installation of Vista, 2008 and
64-bit operating systems 

Not available if Web Voicemail (UMS) is selected
for installation. 

The installation of IMS is not covered by this
documentation. For details of IMS refer to the
Voicemail Pro 4.2 Installation manual. 

IMS Database
Service

IMS Gateway
Service

IMS Voice Service

IMS Administration
Tool

Web Voicemail (UMS) Only available for installation on server operating
systems. Not available if any IMS components
are selected for installation. 

Before you begin:

1.Log on to the server PC using the account under which you intend the Voicemail Pro server or service to run. This
account must have full administrator rights to the server PC.

2.Recommendation 
Create a new user account called Voicemail and give it full administrator rights on the PC. This will help to identify
the purpose of the account. Set the account password so that it does not expire. 

3.In IP Office Manager, check that the correct licenses for Voicemail Pro have been installed and show a status of
Valid. For compact and typical Voicemail Pro installations, the minimum required licenses are:

· Voicemail Pro (4 ports) 
This license is required to enable support for the Voicemail Pro voicemail server. It also enables 4 voicemail
ports. 

· IP500 Upgrade Standard to Professional 
On pre-IP Office 5.0 systems using an IP500 control unit, this license is required for the system to support a
Voicemail Pro server. 

4.For installations other than client only and compact, check that the necessary pre-installation processes have been
completed: 

· Web Campaigns Installation

· Voicemail Email Installation

· UMS Web Voicemail  

· IMAP Installation

· Web Voicemail Installation

· Exchange 2007 Installation

· Centralized Voicemail Pro

· Installing Text to Speech Features

· Voicemail Private Networked Messaging (VPNM) Installation

· Installing Voicemail Pro TTY Prompts

31

53

37

38

41

47

51

73
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Installing Voicemail Pro: Server/Client Installation

· Installation on Windows Server Operating Systems
On many Windows server PC's, while the Windows Audio components are present by default they are not always
enabled. If this is the case the playback of voice prompts may be 'choppy' and the TTS (if installed) will not work.
However, enabling Windows Audio does not require the server PC to have a sound card installed. 

1.Ensure that you have full administrator rights for the PC. This process will also require the PC to be restated. 

2.In the Windows Control Panel select Sounds and Audio Devices. 

3.If Windows Audio has not been enabled, select the Enable Windows Audio check-box. 
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To install the Voicemail Pro software components:

1.Insert the IP Office Applications DVD. Click on the link for Voicemail Pro and then double-click on setup.exe. 

2.The Choose Setup Language menu is displayed. This language is used for the installation process and does not
affect the language prompts that are installed. 

3.Select the language for the installation process. Click OK. 

4.The Preparing Installation menu is displayed. 

· Voicemail Pro requires Microsoft .NET 2.0 Framework. If this is not detected, you will be prompted to install it.
Click Yes to install Microsoft .NET 2.0 Framework.

· If the Modify, repair or remove the program window appears you need to follow the upgrade process . 

5.The Welcome window is displayed. Click Next. 

6.The Customer Information menu is displayed. 

· Use the default names or enter a user and company name. These settings do not affect the Voicemail Pro
installation.

· Select the option Anyone who uses this computer (all users).

· Click Next. 

7.The Choose Destination Location menu is displayed. Unless specifically required, for ease of maintenance use
the proposed folder location. Click Next. 

8.The Messaging Components menu is displayed.

9.Select Voicemail Pro (Full) or Voicemail Pro Client - Only. Click Next. If Voicemail Pro Client - Only was
selected, go to step 14. 

10.The Setup Type menu is displayed. Select Compact, Typical or Custom and click Next. 

· If the option selected was Custom, the Select Features menu is displayed. Select the components required
for the installation and click Next.

11.The Service Account Name menu is displayed. This window is used to select the account under which the
Voicemail Pro services will be run following installation. 

· Enter the user name and password of the account to use. Alternatively, click Browse and select a name from
the list of available PC or network accounts.

· Click Next. The account name and password are validated. If the validation fails you whether you want to
create a new account that matches the details entered. 

12.The Select Program Folder menu is displayed. By default, the program folder for the Voicemail Pro client is set
to IP Office. For ease of maintenance use this option unless there is a specific reason to use a different folder.
Click Next. 

13.The Start Copying Files menu is displayed. It shows a summary of the components that are about to be
installed. Check that this list is as expected. If for any reason the details are not what you expect, click Back and
make the necessary changes. When you are satisfied that the details are correct, click Next to start copying the
files.

14.The Setup Status menu is displayed. This shows you the progress of the file installation. For a client only
installation, the software installation process is now completed. 

15.The InstallShield Wizard Complete menu is displayed. 

16.Depending on the operating system and the components installed you may be prompted to restart the computer.
If so select Yes, I want to restart my computer now.

17.Click Finish.

18.If necessary, the computer will restart and you will need to log in to continue the installation process. If
otherwise, the installation process continues without restarting.

19.The installation process continues by requesting a number of configuration settings used by the voicemail server
services, 

1.The IP Office Voicemail Pro Email Settings window is displayed. This is used to enter the account that the
voicemail pro server should use for email functions. Enter the name of the email account to use or click 
Browse and select an account to use. Click Next. 

2.The IP Office Voicemail Pro SMTP Email Settings window opens. 

3.In the Mail Server box, type the name of the SMTP mail server or use the name that is proposed. This should
be the fully qualified domain name. 

4.In the Port Number box, type the number of the receiving port on the SMTP mail server. The default is 25.

34
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5.To enforce server authentication, check the Server Requires Authentication box. This is optional. If you
check it you also need to provide the Account Name and Password that need to be entered. You can also
choose whether or not to set the Use Challenge Response Authentication option.

6.Click Finish. An attempt is made to validate the email settings. An error message is displayed when the
attempt to connect with an SMTP server fails. Click OK to acknowledge the message. 

20.You have now finished installing the Voicemail Pro server and client software. 

21.If doing a custom installation to install a specific Voicemail Pro feature, refer to the appropriate section for details
of any actions that need to be performed after the installation of the Voicemail Pro server software. 

· Web Campaigns Installation

· Voicemail Email Installation

· UMS Web Voicemail  

· IMAP Installation

· Web Voicemail Installation

· Exchange 2007 Installation

· Centralized Voicemail Pro

· Installing Text to Speech Features

· Voicemail Private Networked Messaging (VPNM) Installation

· Installing Voicemail Pro TTY Prompts

To Initialize the Voicemail Pro Call Flow:  

1.Select Start | Programs | IP Office | Voicemail Pro. The Voicemail Pro Client starts and the main window
opens.

2.Click the  Save and Make Live icon.

3.Select Yes. The file root.vmp is created and made available to the Voicemail Pro server. This is the compiled non-
editable version of the editable call flow.

4.Voicemail operation can now be tested from an extension by dialing *17.
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2.2.1 Modifying the Installed Components

1.Start the Windows Control Panel. 

2.Select Add and Remove Programs. 

3.Select IP Office Voicemail Pro from the list of installed applications. 

4.Click on Change. 

5.Select Modify and click Next. 

6.The Select Features menu is displayed. The existing installed components are indicated by a tick mark. 

7.Select the additional components required for the installation. 

8.Not that de-selecting a component will cause it to be uninstalled. 

9.Click Next. 

10.The process continues are a normal installation . 26
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2.2.2 Web Campaigns Installation
The web campaigns component of Voicemail Pro requires IIS to be installed and running on the server PC. 

1.Check that IIS is installed and running on the server PC. 

· Windows 2008 Server IIS does not support legacy IIS applications such as Campaigns by default. This is
rectified by reinstalling IIS from the Windows installation disk and selecting Legacy IIS support during the
installation.

2.Check that the server PC can be browsed from other PC's on the customer network. 

3.If the Voicemail Pro server software has not yet been installed: 

· Run the Voicemail Pro software installation  and select Voicemail Pro (Full). 

· Select either Typical or Custom. If Custom is selected, ensure that Voicemail Pro Campaigns Web is
selected in the list of components. 

4.If the Voicemail Pro server software is already installed: 

· Modify the installed components and ensure that Voicemail Pro Campaigns Web is selected in the list of
components. 

Windows 2003 Server
The following configuration changes are required for IIS version 6 after installation of the Voicemail Pro web campaigns
component.

1.Open the Windows Control Panel.

2.Select Administrative Tools | Computer Management.

3.Go to Services and Applications | IIS Manager | Web Sites | Default Web Site.

4.Under Web Sites, right-click Default Web Site and select Properties.

· Select the Home Directory tab.

· Under Application Settings section, set the Execute Permissions to Scripts and Executables.

· Click OK twice.

5.Under Web Sites, go to Web Service Extensions.

6.Right-click and select Add a new web service extension.... 

· Set the following values:

· Extension Name: campaigns.

· Required files: Click Add. Select the file type as CGI exe files and browse to the campaign.exe file
location specified during installation. This is usually c:\InetPub\wwwroot\scripts\campaign.exe or
c:\InetPub\scripts\campaign.exe.

· Set extension status to Allowed.

· Press OK.

26
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2.2.3 The Voicemail Pro Services
If Voicemail Pro has been installed successfully, if the server PC has been rebooted then the voicemail service is started
automatically. However it is useful know how to check the services and to manually restart them if necessary.

To check/restart the Voicemail Pro Service:

1. Open the Windows Control Panel.

2. Select Administrative Tools > Services. 
 

3. The Voicemail Pro Service should be visible. Its Status should be Started and the Startup Type should be set
to Automatic. Other services may be present depending on the Voicemail Pro options installed. The possible
services are: 

· Voicemail Pro Service
This is the main Voicemail Pro service. Normally this is the only service that needs to be stopped and
restarted. It will stop and restart the other services that it uses.

· VMProDBService
This service is used for remote client connections. 

· IMS (Gateway), IMS (Voice) and IMS (Restart)
These services are used by the IMS components of Voicemail Pro if installed and licensed.

· VPNM Database Server, VPIM Receiver and VPNM Server
These services are used by the VPNM components of Voicemail Pro if installed and licensed. 

4. Close Services.

  

Setting the Voicemail Services or PC to Restart Automatically
The following action is optional. If there is some fault causing the Voicemail Pro service to halt, that fault should be
investigated and fixed, however having the service or PC automatically restarted if possible will minimize the disruption to
the Voicemail Pro users. 

1.Use the Windows control panel to select the Voicemail Pro Service. 

2.Right-click on the service and select Properties. 

3.Select the Recovery tab. 

4.Use the options presented to either restart the service and or restart the PC should the operating system detect
that the Voicemail Pro service has halted. 

Using a Batch File to Start Services 
In some instances, certain computers might not respond quickly enough in order to start all of the Avaya services in the
correct order. In this circumstance, it can be advisable to create a batch file which will delay the start of these services
until the PC is fully running.

Avaya IP Office Services can be started successfully at system start-up using a scheduled task that initiates the batch file
below. This batch file ensures that the services will start successfully and in the proper order.

1. Set all Avaya services listed below to Manual start. Do not include Key Server.

2.Create the batch file below and save it to %SYSTEMROOT%. Only include lines for the services which are installed.

@echo off
rem Wait 60 seconds before execute.
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timeout /t 60
net start VMProDBService
net start Voicemail Pro Service
net start IMS(Restart)
net start IMS(Voice)

net start IMS(Gateway)

3.Create a scheduled task to start the batch file at system start-up.
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2.3 Upgrading Voicemail Pro
This section describes how to upgrade Voicemail Pro. The options available are:

· Upgrading from Voicemail Lite

· Upgrading from below Voicemail Pro 3.2

· Upgrade from 3.2 or higher

 

2.3.1 Upgrade from below version 3.2
It is important that the settings of an existing Voicemail Pro are exported before any upgrade. Although folders that
contain prompts and messages are not affected by the upgrade process, the editable version of a customer call flow is
lost.

To upgrade from below version 3.2 to version 4.x+:

1.Export the Database 
Before removing Voicemail Pro as part of an upgrade, you must create a backup copy of the call flow database. This
will contain any customizations made to the default call flow.

1.Start the Voicemail Pro Client.

2.From the File menu, select the option Import or Export.

3.Select the option Export call flows and click Next.

4.Enter a file path and file name ending in .mdb, for example C:\temp\backup.mdb. Click Next.

5.Click Finish to start the export then click Close to complete the export procedure.

6.Close the Voicemail Pro Client.

2.Back up the Registry 
Any registry settings that are associated with Voicemail Pro need to be backed up.

1.Insert the IP Office Applications DVD. Click on the link for Voicemail Pro and then double-click on setup.exe.
The Choose Setup Language window opens.

2.Right-click the DVD drive and select Open.

3.Locate the file backupreg.bat and double-click it to run the application. 

4.Check that the registry settings have been backed up.  The batch file should have created 3 backup files in the
Windows Temp directory. Make sure that the following 3 files exist in that location:

· VMPro.arf

· NetAly.arf

· IMSGateway.arf

3.Remove Voicemail Pro 
Any previous versions of Voicemail Pro must be removed before you start to install the new version.

1.Open the Windows Control Panel.

2.Select Add/Remove Programs.

3.Select IP Office Voicemail Pro and click Add/Remove.

4.From the options offered, select Remove and click Next.

5.Follow the prompts that you see on the screen during the removal process.

6.When the process has been completed, select the option Yes, I want to restart my computer now and click
Finish.

4.Restore the Registry 
The Voicemail Pro registry settings that were backed up in step 2 needs to be restored.

1.Insert the IP Office Applications DVD. Click on the link for Voicemail Pro and then double-click on setup.exe.
The Choose Setup Language window opens.

2.Locate the file restorereg.bat and double-click it to run the application. This restores the registry settings
previously associated with Voicemail Pro.

5.Install the New Software  
See Installing Voicemail Pro  and then refer to the sections that relate to the type of Voicemail Pro that you intend
to install.
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6.Restore the Database 
The copy of the call flow database that contained any customizations made to the default call flow needs to be
restored.

1.Start Voicemail Pro.

2.From the File menu, select Import or Export. The Import or Export Call Flows window opens.

3.Select Import Call Flows.

4.Click Next.

5.Click the Browse button and locate the file that contains the backed up call flows.

6.Select the file and click Open.

7.In the Import or Export Call Flows window, click Next.

8.Click Finish to start importing the database.

9.Click Close to complete the import process.

10.Click on Save and Make Live to save the Call flows.

The new version of Voicemail Pro has been installed. Test that the system is running by dialing *17 from any extension.
You should hear the mailbox announcement.

 

2.3.2 Upgrade from Version 3.2+
You can directly upgrade versions of Voicemail Pro from Voicemail Pro 3.2 upwards. However we still recommend that
you follow the procedure for backing up the database before upgrading. 

To upgrade from version 3.2 or higher:

1.Insert the IP Office Applications DVD. Click on the link for Voicemail Pro and then double-click on setup.exe.
The Choose Setup Language window opens.

2.Select the installation language. The language selected is used for the installation.

3.Click OK. You are asked 'This setup will perform an upgrade of IP Office Voicemail Pro. Do you want to continue?' 

4.Click Yes. The Upgrading the IP Office Voicemail Pro window opens.

5.Click Next to start the upgrade. The setup status window opens. The progress of the upgrade is indicated by a
time bar. 

6.Click Finish. The Email settings window opens.

7.Enter your email account details and click Next. The SMTP Email settings window opens.

8.Enter your SMTP Email details and click Finish. The SMTP settings entered will be validated. If an error occurs, the
validating configuration window opens containing the SMTP Error .

9.Click Yes when asked if you want to start the Voicemail Pro service. 

10.The new version of Voicemail Pro has been installed. Test that the system is running by dialing *17 from any
extension. You should hear the mailbox announcement.

57
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2.3.3 Upgrade to Voicemail Pro
You can upgrade from Voicemail Lite to Voicemail Pro. The process described here assumes that Voicemail Pro is being
installed onto the same PC that previously hosted Voicemail Lite. The steps described here will remove Voicemail Lite but
will not remove the existing mailbox messages and greetings.

To upgrade from Voicemail Lite to Voicemail Pro:

1.Remove Voicemail Lite

1.Make sure that Voicemail Lite is not running. It might be necessary to close the Voicemail Lite server program.

2.Open the Windows Control Panel and select Add/Remove Programs.

3.Select IP Office Admin Suite and click Change. The Welcome to the Installshield Wizard for IP Office Admin
Suite window opens.

4.Click Next. The Program Maintenance window opens.

5.Select Modify and click Next.

6.In the list of selected Features, click the option Voicemail Lite and select This feature will not be available.

The feature Voicemail Lite will have a red cross by the name. .

· Important - Do not uncheck any other boxes as this will also remove those features.

7.Click Next. The Ready to Modify the Program window opens.

8.Click Install. The Voicemail Lite program will be removed, which may take several minutes.

9.Click Finish to exit the InstallShield Wizard.

10.Click Close to close the Add/Remove Programs window.

11.Remove any shortcuts to VMLite.exe from Start > Programs > Startup.

2.Install the New Software 
The next step is to install the Voicemail Pro software. See Installing Voicemail Pro  and then refer to the sections
that relate to the type of Voicemail Pro that you intend to install.

3.Move the Voicemail Lite Folders 
This must be done before users start to use Voicemail Pro. As part of the upgrade procedure you need to move the
Voicemail Lite folders that contain any existing voicemail messages and mailbox greetings. This stage copies the
existing Voicemail Lite messages and greetings over the newly installed Voicemail Pro set.

4.Using Windows Explorer or My Computer, locate the folder C:\Program Files\Avaya\IP Office\Voicemail Server.

5.Copy all sub-folders and files in that folder.

6.Paste the sub-folders and files in the folder C:\Program Files\Avaya\IP Office\Voicemail Pro\VM. Replace any
existing folders.

7.Select the Mailbox Mode. 
Voicemail Lite runs in IP Office mailbox mode. By default Voicemail Pro installs in Intuity mailbox mode. If required by
your users, you can set Voicemail Pro back to IP Office mailbox mode.

1.Start the Voicemail Pro Client.

2.Click the Preferences  icon and select General.

3.On the General tab, change the Default Telephony Interface from Intuity to IP Office.

4.Click OK.

5.Click  Save & Make Live.

The new version of Voicemail Pro has been installed. Test that the system is running by dialing *17 from any extension.
You should hear the mailbox announcement.
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2.4 UMS Web Services
Voicemail Pro 4.2+ adds support for user mailboxes to be accessed using the additional methods listed below. For
Voicemail Pro 5.0+ this has been expanded to include hunt group mailboxes. 

· IMAP Email Client Support
This method allows mailbox access using any email client that supports IMAP, for example Outlook and Lotus
Notes. The Voicemail Pro server PC acts as the IMAP server. 

· Web Voicemail Access
This method alls mailbox access using a web browser. Messages can be played back to a phone or through the PC
if the browser is audio enabled. Web voicemail requires the voicemail server to also run IIS and PHP. 

· UMS Exchange 2007 (Voicemail Pro 5.0+)
A user or group can be configured to have their voicemail messages forwarded to the inbox of an Exchange 2007
email account. Telephone, including Visual Voice, mailbox access is redirected to that email inbox as the store for
voicemail messages. Alternatively the user can access their voicemail messages using Outlook 2007 or any other
mechanisms supported by Exchange 2007. Voicemail messages in an Exchange 2007 inbox are not visible to UMS
IMAP and UMS Web Voicemail, however Exchange 2007 provides its own methods for IMAP and web browsing of
Exchange mailboxes. 

Use of UMS services requires UMS Web Service licenses in the IP Office configuration. The license sets the number of
users and hunt groups that can be configured for UMS in the IP Office configuration. 

Feature Web
Voicemail

IMAP Client Exchange
2007

Playback via PC.

Playback via User Extension. [1]

Save message Wav to PC.

Forward messages to other voicemail mailbox.

Forward messages to other email mailbox.

Undelete manually deleted messages.

Mark message as unread.

Change voicemail password.

Show Message Types
Web

Voicemail
IMAP Client

Exchange
2007

- New (Unread).

- Old (read).

- Saved.

- Priority.

- Private.

- Deleted.

1.Exchange 2007 Unified Messaging supports the playback of messages through a range of options controlled and
configured on the exchange server. 
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2.4.1 IMAP Installation
Voicemail Pro 4.2+ support mailbox synchronization with email clients that can support IMAP (Internet Message Access
Protocol) accounts. Examples are Outlook, Outlook Express and Lotus Notes. 

Once configured, the IMAP folder and the mailbox are synchronized whenever the IMAP folder is opened. The method of
indication of the different message types will depend on the email client being used and is not controlled by the Voicemail
Pro. 

The number of mailboxes that can be configured for IMAP and/or web access is controlled by licenses. 
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Installing the Voicemail Pro IMAP Server
The IMAP server is installed as a standard part of the Voicemail Pro service installation. It uses the IP address of the
Voicemail Pro server PC and runs on the standard IMAP port 143. 

The only special consideration is to avoid having any other IMAP server running on the same PC. 

Configuring the IP Office for Web Services
1.Start IP Office Manager. 

2.Receive the configuration from the IP Office associated with the Voicemail Pro server. 

3.In the  Licenses section, add the UMS Web Services license. 

4.Merge the configuration back to the IP Office and then receive the configuration again. 

5.In the  Licenses section check that the License Status of the UMS Web Services license is now shown as
Valid. 

6.Start the Voicemail Pro client

7.Select Help | About. 

8.The screen should list the Web Services as Started and should show the number of UMS licenses. 

Configure Users for UMS
1.Start IP Office Manager. 

2.Receive the configuration from the IP Office system hosting the user. 

3.UMS can be enabled in two ways: 

· Through Individual User Settings:

· Select  User and then select the required user. 

· Select the Voicemail tab. 

· Enable UMS Web Services. Click OK.

· Through Licenses:

· Select  Licenses. 

· In the Manager navigation pane, double click on the UMS Web Services license. 

· The Select Web Service Users menu is shown. 

· Select the users for which UMS Web Services are required. Click OK.

4.Merge the configuration back to the IP Office.

Configuring Hunt Groups for UMS
Access to hunt group mailboxes using UMS is supported for Voicemail Pro 5.0+. 

1.Start IP Office Manager. 

2.Receive the configuration from the IP Office system hosting the hunt group. 

3.Select the hunt group. 

4.Click on the Voicemail tab. 

5.Enable UMS Web Services. Click OK. 

6.Merge the configuration back to the IP Office. 
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Configuring a User Email account
The exact method of configuration of an IMAP account depends on the IMAP client being used by the user. For example it
may be necessary to enable some field with dummy data in order for the email client to accept the account even though
those settings are not used by the Voicemail Pro IMAP server. 

The general details that are required are: 

IMAP Account Setting IP Office Value

Incoming Server Voicemail Pro server IP address or domain name address. 

Account Name User name or extension number.

Password User voicemail code. 

Example: Outlook

1.Select Tools and then Options. 

2.Select Mail Setup and then click E-mail Accounts. 

3.Select Add a new e-mail account. 

4.Select IMAP as the server type. 

5.In Server Information for Incoming mail server and Outgoing mail server enter the IP address or domain
name address of the Voicemail Pro server PC. 

6.In Logon Information enter the user's extension number and voicemail code as the User Name and Password
. 

7.Click Next. 

Example: Outlook Express

1.Select Tools and then Accounts. 

2.Select Add and then Mail. 

3.Enter a descriptive name such as Voicemail and click Next. 

4.Enter an email address. This is not used but a value must be entered to move to the next screen. Click Next. 

5.Set My incoming mail server is a to IMAP. 

6.In the Incoming server field enter the IP address or domain name address of the Voicemail Pro server PC. 

7.Enter a value in the Outgoing mail server field. This is not used but a value must be entered to move to the next
screen. Click Next. 

8.For Account Name enter the user's extension number or name in the IP Office configuration. 

9.For Password enter the user's Voicemail Code. 

10.Click Next and then Finish.
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2.4.2 Web Voicemail Installation
Voicemail Pro 4.2+ support web access to user mailboxes. Users are then able to play their messages, mark them as
saved or deleted, or forward messages to another mailbox. Playback is through the user's own associated extension on
the IP Office system or through the audio facilities of the PC. 

Web Voicemail Installation Requirements
The Web Voicemail component is selectable as part of a custom Voicemail Pro installation. Note the pre-requisites below
before doing the Web Voicemail installation. 

· o IIS Web Server
Must be installed on the voicemail server PC before the Voicemail Pro Web Voicemail component is installed. 

· o PHP
Web Voicemail uses PHP. If an existing PHP is not detected, the Voicemail Pro installation will install its own
PHP. 

· o UMS Web Services License
The use of Web Voicemail and the number of users who can be configured to access it are controlled by the UMS
Web Services license entered in the IP Office configuration. 

· o Computer Name\URL
The computer name is used as part of its URL on the network. Ensure that the name is set to something that
appropriately indicates its purpose and that can be used as part of the URL for the web server within the
customer's domain. 

· o Remove IMS
Voicemail Pro UMS is not supported on systems that are using Voicemail Pro IMS. IMS must be removed before
UMS can be selected for installation. 
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User and Browser Requirements
For users to access Web Voicemail they require a web browser that meets the following requirements: 

· o Javascript Enabled Web Browser
Web Voicemail is tested against the following browsers. Other browser may work so long as they support
JavaScript and CSS. 

· Internet Explorer V6 SP1 or higher. 

· Internet Explorer V7 or higher. 

· Mozilla Firefox V2.0.0.2 or higher.

· Opera V9.10 or higher. 

· PC Playback 
Browser access allows the selection of message playback either via an IP Office extension or through the web
browser. Avaya test browser playback using the following Windows media players: 

· Windows Media Player 10. 

· Windows Media Player 11. 

· Quick Time 7.4.

· VLC 0.8. 

· o User Name and Password
Once enabled for UMS Web Services in the IP Office configuration, to log on using Web Voicemail, the user will
need to know their Name and Voicemail Code as set in the IP Office configuration. Note that this is the Name
and not the Full Name. 

Voicemail Pro Software Installation with Web Voicemail Component
The Web Voicemail component is installed as part of a Custom Voicemail Pro installation. From the list of 

1.Verify that IIS is installed and running on the voicemail server PC. Check that it can be browsed from user PC's. 

· While the server can be browsed by IP address, the URL used by users will be based on the server's computer
name within the customer domain. Check that web server can be browsed from user PC's using the server's
computer name as part of the URL. If necessary change that name to accurately indicate its function. 

2.Insert the IP Office Applications DVD. Click on the link for Voicemail Pro and then double-click on setup.exe.
The Choose Setup Language window opens.

3.When asked for the type of Voicemail Pro install to perform, select Voicemail Pro (Full). 

4.On the next screen select Custom. 

5.In the list of components scroll down and select Web Voicemail. Do not change any of the other selections unless
you understand the requirements for those components. 

· UMS Web Voicemail is not supported in conjunction with IMS. If one is selected for installation the other
cannot be selected. 

6.Follow the remainder of the installation process and allow the voicemail server to reboot when required. 

Configuring the IP Office for Web Services
1.Start IP Office Manager. 

2.Receive the configuration from the IP Office associated with the Voicemail Pro server. 

3.In the  Licenses section, add the UMS Web Services license. 

4.Merge the configuration back to the IP Office and then receive the configuration again. 

5.In the  Licenses section check that the License Status of the UMS Web Services license is now shown as
Valid. 

6.Start the Voicemail Pro client

7.Select Help | About. 

8.The screen should list the Web Services as Started and should show the number of UMS licenses. 
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Configure Users for UMS
1.Start IP Office Manager. 

2.Receive the configuration from the IP Office system hosting the user. 

3.UMS can be enabled in two ways: 

· Through Individual User Settings:

· Select  User and then select the required user. 

· Select the Voicemail tab. 

· Enable UMS Web Services. Click OK.

· Through Licenses:

· Select  Licenses. 

· In the Manager navigation pane, double click on the UMS Web Services license. 

· The Select Web Service Users menu is shown. 

· Select the users for which UMS Web Services are required. Click OK.

4.Merge the configuration back to the IP Office.

Configuring Hunt Groups for UMS
Access to hunt group mailboxes using UMS is supported for Voicemail Pro 5.0+. 

1.Start IP Office Manager. 

2.Receive the configuration from the IP Office system hosting the hunt group. 

3.Select the hunt group. 

4.Click on the Voicemail tab. 

5.Enable UMS Web Services. Click OK. 

6.Merge the configuration back to the IP Office. 

UMS Web Voicemail and ContactStore
It is possible to run ContactStore and UMS Web Voicemail on the same server PC. However some additional steps are
required following installation in order to allow browser access to both applications. 

1.Install UMS web voicemail. 

2.Install ContactStore. 

3.Reboot the server. 

4.Within services, stop the ContactStore service. 

5.Using a web browser access a voicemail mailbox using UMS web voicemail. 

6.Restart the ContactStore service. 

7.Both application should now be accessible via web browser. 
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Playback Control
UMS message playback through the web browser is tested and supported with the Windows Media Player. It may work
with other audio playback controls but will not have been tested. 

The following methods can be used to check that the audio playback is associated with the Windows Media Player. 

Firefox

1.Select Tools | Options | Applications or Tools | Options | Content | File Types | Manage. 

2.In the search box enter x-mplayer2. 

3.Check that the Action is set to Use Windows Media Player or Use Windows Media Player plug-in Dynamic
Link Library. 

Opera

1.Select Tools | Preferences. 
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2.Select Downloads and use the search box to find x-mplayer2. 

3.Check that the setting is set to Use plug-in and Windows Media Player Plug-In Dynamic Link Library. 

Internet Explorer

1.Internet Explorer uses the application associated with the wav file type for Windows. 

2.Select My Computer. 

3.Select Tools | Folder Options. 

4.Select File Types. 
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5.Locate and select the WAV extension type. 

6.Check that the details show Windows Media Player as the selected application for this file type. 
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2.4.3 Exchange 2007 Installation
A UMS user or group can be configured to have their voicemail messages forwarded to the inbox of an Exchange 2007
email account. They can then access their voicemail messages using Outlook 2007 or any other mechanisms supported
by Exchange 2007 Unified Messaging. IP Office telephone mailbox access, including Visual Voice, is redirected to the
voicemail messages stored in the email inbox.  

Voicemail messages in an Exchange 2007 inbox are not visible to UMS IMAP and UMS Web Voicemail, however Exchange
2007 provides its own methods for IMAP and web browsing of Exchange mailboxes. 

· Note 
When using an Exchange 2007 server as the message store for a user's voicemail messages, the voicemail server will
deliver messages to the Exchange server on completion of the recording. However, the presentation to Outlook and
back to the voicemail server for message waiting indication (MWI) and access via telephone is delayed by Exchange
server processing. The delay is typically 1 or 2 minutes. The same delay also applies to changes in the message status
that affect message waiting indication. 

The following are the pre-requisites for UMS Exchange 2007: 

· Exchange 2007 Server 

· The Exchange 2007 server must be configured with the Unified Messaging Server Role selected. 

· A Dial Plan must be created on the Exchange 2007 server. This can be a blank dial plan but it must exist. 

· Within the Exchange 2007 server settings for each mailbox, select Enable Unified Messaging. 

· Voicemail Pro 

· The Voicemail Pro server must be configured for MAPI based voicemail email . 

· The supported MAPI applications are Exchange 2007 and Outlook 2007. 

· IP Office 

· The user or hunt group must be licensed and enabled for UMS Web Services. 

· The user or hunt group's Voicemail Email mode must be set to Forward. 
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Exchange Server 2007 Unified Messaging Configuration
This is a simple overview of the minimum steps required. For full details refer to the Microsoft documentation. 

In order to support UMS Exchange Server 2007 operation, the Exchange Sever must be configured to include the Unified
Messaging Server Role. 

1.From the Windows Control Panel, select Program and Features. 

2.Select Microsoft Exchange Server 2007 and click Change. 

3.The wizard for changing Exchange Server setup is started. Click Next. 

4.In the Server Role Selection list check that Unified Messaging Server Role is one of the selected roles. Click
Next through the wizard and then Finish.
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Having enabled the Unified Messaging role on the Exchange Server, the role can be configured and enabled for the
mailboxes.

1.Select Start | Programs | Microsoft Exchange Server 2007 | Exchange Server Management Console. 

2.Expand the Server Configuration list. The Unified Messaging role should appear in the list. 

3.You need to create a Unified Messaging dial plan. 

a. Expand the Organization Configuration and select Unified Messaging. 

b.Select the UM Dial Plans tab and in the Actions list select New UM Dial Plan.... 

c. The New UM Dial Plan wizard will be started. 

d.Create a plan similar to the one shown above. The digits length is not important but must be matched later in
the process. The simplest option is to set it to match your IP Office extension number length. Click New and
then Finish. 

4.You now need to select which mailboxes the Unified Server role is available. 
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a. Expand the Recipient Configuration section and select Mailbox. 

b.Right click on the configuration settings used for general mailbox users and select Enable Unified
Messaging.... 

 

c. The wizard for the mailbox Unified Messaging settings is started. 

d.For the Unified Messaging Mailbox Policy click on Browse... and select the previously created dial plan. 
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e.Select Automatically generate PIN to access Outlook Voice Access. Click Next. 

f. Select Manually entered mailbox extension. Enter a number that matches the digit length that was
specified in the UM Dial Plan previously created. The actual number entered does not need to match an IP
Office extension, only the length is important. Select Next. 

g.Select Enable and then Finish. 

2.5 Centralized Voicemail Pro
A Small Community Network (SCN) consists of several IP Office telephone systems. These are connected using H323
Lines where the Supplementary Services settings of the lines has been set to SCN. For details refer to the IP Office
Manager documentation. 

Within a Small Community Network, separate voicemail servers on each or some of the IP Offices is not supported.
However a single Voicemail Pro server can be used to provide voicemail features for all the IP Offices in the SCN.

One IP Office is treated as the central system and the voicemail server is associated with the central system. Within the
other remote IP Office systems, the voicemail settings are configured to indicate that they get their voicemail services
from the central IP Office. 

Once the IP Office SCN has been setup, the following settings are used in the IP Office systems to provide voicemail
operation for all the IP Offices. 

IP Office Settings Central IP Office Remote IP Offices

Voicemail Type Voicemail Pro Centralized Voicemail

Voicemail IP Address Set to the voicemail server PC's IP address. Not used.

Voicemail Destination Not used. Set to the Outgoing Group ID of the H323
Line to the central IP Office. 
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Licenses This system needs licenses  for all the
Voicemail Pro features required. 

These systems only require a VMPro
Recording Administrators license is they want
to use ContactStore. They do not require any
other voicemail licenses. 

Names All user and group names must be unique.

Numbers All user and group extension numbers must be unique. 

Voicemail Fallback
IP Office 5.0+ supports a number of fallback features for Small Community Networks. In conjunction with Voicemail Pro
5.0+, that can includes one of the IP Offices acting as the fallback system to associate with the voicemail server should
the central IP Office be not available to the network for a period of time. 

When voicemail fallback is configured, if the central IP Office is removed from the network, within 3 minutes voicemail
operation should resume via the fallback IP Office. When the central IP Office is restored, within 3 minutes voicemail
operation via the central IP Office is resumed. During the period of handover between IP Offices, voicemail services are
not available and any current calls to/from voicemail are lost. 

To setup voicemail resilience: 

· Within the configuration of the central IP Office, on the H323 Line to the fallback IP Office, the Supplementary
Services setting is changed from IP Office - SCN to IP Office -SCN Fallback. The option Backs up my
Voicemail should then be selected from the SCN Backup Options. 

· Within the configuration of the fallback IP Office, licenses for the voicemail features required to operate during
resilience must be entered. 
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2.6 Voicemail Email
Voicemail Email allows the voicemail server to provide a number of email functions: 

· Forward a Message to Email 
If the voicemail server is set to IP Office mailbox mode, mailbox users are able to manually forward an voicemail
message to their email. 

· Automatic New Voicemail Messages 
For all mailbox modes, users can use voicemail email to automatically have a message sent to their email
whenever they receive a new voicemail message. The email can be a simple alert or it can include a copy of the
voicemail as an attachment. 

· eMail Action 
With customized call flows, an eMail  action can be used to send a caller's recorded voicemail message to a
specified email address.

· UMS Exchange 2007 
In conjunction with Exchange 2007 and Outlook 2007, users are able to use their Outlook inbox as their mailbox
for voicemail messages. 

Voicemail Email features requires the voicemail server to be configured for access to either an SMTP email server or to a
MAPI email server via a MAPI enabled email client program on the voicemail server PC.

· SMTP Installation  
This is an email standard supported by most email servers. It is the default email mode for the voicemail server. 

· MAPI Installation 
MAPI requires a MAPI compliant email client program to be installed on the Voicemail Pro server. Supported MAPI
clients are Outlook 2000, 2002, 2003, 2007. It also requires the Voicemail Pro service to be run using a user
account that is able to send emails via that MAPI client. 

· The exact method of integration between the voicemail server and the MAPI email client depends on whether
the voicemail server is part of a work group or a domain. This guide contains examples for both approaches. 

· The MAPI process described in this guide was based on Microsoft Windows 2000 Professional with Microsoft
Outlook 2000 and Microsoft Outlook Express 5.5. Steps may differ depending on the version of Windows and
email client used. 

 

2.6.1 SMTP Setup
By default the Voicemail Pro server is installed defaulted to SMTP operation and the necessary details of the SMTP server
account to use are requested as part of the Voicemail Pro server installation. 

To install Voicemail Pro for SMTP Voicemail Email

1.Obtain details of an email account that the Voicemail Pro service can use from whoever administrates the
customer's email server. The details required are:

· Email address.

· Server SMTP address.

· Email account user name and password.

· Whether the email server uses CHAP. 

2.Install the Voicemail Pro software .

3.When requested, enter the email address . 

4.When requested, enter the Voicemail Pro SMTP  email account settings.

5.Configure the IP Office user and group accounts  with the email addresses. 
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2.6.1.1 Selecting SMTP Operation

By default, the Voicemail Pro server is configured for SMTP email mode. However if required it can be switched between
SMTP and MAPI mode. Some options are not available if you are working offline. You must be working online to use this
feature. 

To select the server email mode

1.Start the Voicemail Pro Client.

2.Click  Preferences and select General.

3.Click the MAPI tab.

4.The Use Email Protocol settings allow you to switch Voicemail Pro between MAPI and SMTP.

· If MAPI is selected, a valid MAPI profile and password must be entered in the fields above. That MAPI profile
must exist within the MAPI email client on the server PC and be useable by the account under which the
Voicemail Pro service is running.

· If SMTP is selected, the SMTP email account settings  must be entered.

5.Click OK.

6.Click  Save and Make Live.

103



Voicemail Pro Page 55
15-601063 Issue 21c (16 July 2009)IP Office 5.0

Installing Voicemail Pro: Voicemail Email

2.6.1.2 Changing the Server SMTP Settings

To configure the server SMTP email settings:

1.Open the Windows Control Panel.

2.Select IP Office Voicemail Pro. The IP Office Voicemail Pro window opens.

3.Click the SMTP Email Settings tab. 

· Mail Server 
Enter the name of the SMTP mail server. This should be the fully qualified domain name.

· Port Number 
Enter the receiving port on the SMTP mail server. The default is 25.

· Mail Drop box, 
This field is only required for Voicemail Pro VPNM. Enter the name of the destination folder for outgoing emails
on the SMTP Server. Alternatively click the browse button and select the folder to use.

· Server requires authentication 
If the SMTP server requires authentication select this option to enter the Account Name and Password that
should be used by the voicemail server. You can also select Use Challenge Response Authentication if
used by the SMTP server. 

4.Click Check to validate the changes that you have made.

5.Click OK. You are prompted to restart the affected services so that your changes are enabled.

6.Choose Yes. The services that are affected by your changes are automatically stopped and restarted.
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2.6.1.3 Setting the Server Email Address

To configure email settings:

1.Open the Windows Control Panel.

2.Select IP Office Voicemail Pro. The IP Office Voicemail Pro window opens.

3.Click the Email Settings tab. 

· Account Details box, 
type the name of the MAPI email account to use for email messages. 

· For MAPI, enter the name of the MAPI email account to use for email messages. Alternatively, select 
Browse to display a list of available email accounts. 

· For SMTP, enter the email address that the voicemail server should use. This address should match the
account details set on the SMTP Email Settings tab. 

· Message Parameters 
These options are only available if you have installed and are using IMS. For IMS you can specify the way in
which the .wav files of voicemail messages are to be sent in emails. Sending .wav files across a network
creates a high loading on the network and networks servers. A one-minute message requires a 1MB .wav file.

4.Click OK.
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2.6.1.4 SMTP Errors

SMTP error logging can be enabled to generate a log of SMTP activity. For a default Voicemail Pro installation the activity
is logged in a file in C:\Program Files\Avaya\IP Office\Voicemail Pro\VM\logs. The file name includes a date
stamp for the day on which it is generated.

Enabling SMTP Error Reporting:

1. Stop the Voicemail Pro service

2. Start the Registry Editor. 

3. Locate the registry key. This differs depending on the version of Voicemail Pro. 

Voicemail Pro 3.2: Locate the key HKEY_LOCAL_MACHINE\SOFTWARE\Network
Alchemy\Voicemail\Directories.

Voicemail Pro 4.0+: Locate the key HKEY_LOCAL_MACHINE\SOFTWARE\Avaya\Media
Services\Directories.

4. From the menu bar select Edit. 

5. Select New and then String Value. 

6. Enter SMTPLogging. 

7. Right-click on the new registry key SMTPLogging and select Modify. 

8. Set the value to 1. 

9. Close the Registry Editor. 

10. Restart the Voicemail Pro service. 

SMTP Error Codes

Value Meaning

1 An exception has occurred.

3 The process has run out of memory.

4 An error has occurred due to a problem with the message body or attachments.

5 There was a problem initiating the conversation with the mail server. Ensure the setting of the Domain property
is correct.

6 There was an error terminating the conversation with the SMTP mail server.

7 The "From" address was not formatted correctly or was rejected by the SMTP mail server. Some SMTP servers
will only accept mail from particular addresses or domains. SMTP mail servers may also reject a from address if
the server can not successfully do a reverse lookup on the from address.

8 An error was reported in response to receipt address. The SMTP server may refuse to handle mail for unknown
recipients.

9 There was an error connecting to the SMTP mail server.

10 There was an error opening the file. If you have specified file attachments, ensure that they exist and that you
have access to them.

11 There was an error reading a file. If you have specified file attachments, ensure that they exist and that you
have access to them.

15 No mail server specified.

16 There was a problem with the connection and a socket error occurred.

17 Could not resolve host.

18 Connected but server sent back bad response.

19 Could not create thread.

20 Canceled as a result of calling the Cancel method.

21 The operation timed-out while the host was being resolved.

22 The operation timed-out while connecting.

24 ESMTP Authentication failed.

25 The selected ESMTP Authentication mode is not supported by the server.

26 ESMPT Authentication protocol error.

27 Socket Timeout error.

105 Invalid license key.
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2.6.2 MAPI Setup
2.6.2.1 Domain Member

Before you start to install the Voicemail Pro software, you must:

1. Create a Voicemail Domain Account .

2. Configure Outlook for Internet Mail .

 

You are then ready to install Voicemail Pro for MAPI Voicemail Email as a Domain Member. This involves the following key
stages:

1. Install the Voicemail Pro Software .

2. Switch Voicemail Pro to MAPI .

 

2.6.2.1.1  Creating a Voicemail Domain Account

To create a Voicemail Domain Account

1. Make sure that the PC that will be running the voicemail server is a member of the domain. To join the domain you
will need the use of a log account with administrative permissions on the domain as well as the server PC, consult
the domain administrator.

· Windows 2000
Right click My Computer and select Properties. Select the Network Identification tab.

2. On the Exchange server:

· Create an account called Voicemail on the domain and an associated mailbox.

· Provide a secure password.

· Check the User Cannot Change Password and Password Never Expires boxes.

3. Log on to the voicemail server PC using a domain administrator account.

4. From the Control Panel, select Administrative Tools.

5. Select Computer Management | Local Users and Groups | Groups.

6. Double-click Administrators and select Add.

7. From the Look In list select the domain name.

8. In the Name window, locate and highlight Voicemail. Click Add followed by OK and OK to close.
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2.6.2.1.2  Configuring Outlook for VoiceMail Email

To configure Outlook for Voicemail Pro email

1. On the desktop, right-click the Outlook icon and select Properties.

2. On the General tab, select Add.

3. Select Microsoft Exchange Server.

4. Click Next.

5. In the Server field, enter the name of the Exchange Server.

6. In the Mailbox field, enter Voicemail.

7. Click Next.

8. When you are asked if you travel with this computer, select No.

9. Click Next.

10. Click Finish.

11. Highlight the MS Exchange Settings and click Properties.

12. Highlight Microsoft Exchange Server and click Properties.

13. Click Check name and ensure that the name is resolved.

14. If the name is resolved, select Apply.

15. Click OK, OK and Close to shut the mail settings.

16. Do not continue until the name has been resolved correctly with the Exchange Server. If the name is not resolved,
check the account details with the Exchange Administrator.

17. Open Outlook and select Yes to register Outlook as the default email application.

18. Select Tools > Options.

19. Click the Preferences tab.

20. Click Email Options.

21. Uncheck Save copies of messages in Sent Items folder.

· You might want this option selected during initial setup to aid troubleshooting. However due to the size of wav
file message attachments you should uncheck it after installation testing is completed.

22. Log on to the Voicemail Pro Server PC using the voicemail account.

23. From Outlook, send a message direct to an extension user.

24. If this message is received correctly, you can continue installing the Voicemail Pro software. See Installing the
Voicemail Pro Software .
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2.6.2.1.3  Installing the VoiceMail Pro Software

To install the Voicemail Pro software

1. Log off and log back on using the Voicemail account and password.

2. Install the required Voicemail Pro software. 

3. When the installation process requests a User Name and Password for the Voicemail Pro service, enter the
Voicemail account details.

4. Restart the server PC when requested and log on using the Voicemail account.

5. When SMTP email details are requested, enter no values and ignore the error message following the SMTP check.

6. Start the Voicemail Pro Service .

7. Check that the basic voicemail services start and operate correctly.

8. Switch Voicemail Pro to MAPI .
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2.6.2.1.4  Switching VoiceMail Pro to MAPI

By default, the Voicemail Pro server is configured for SMTP email mode. However if required it can be switched between
SMTP and MAPI mode. Some options are not available if you are working offline. You must be working online to use this
feature. 

To select the server email mode

1.Start the Voicemail Pro Client.

2.Click  Preferences and select General.

3.Click the MAPI tab.

4.The Use Email Protocol settings allow you to switch Voicemail Pro between MAPI and SMTP.

· If MAPI is selected, a valid MAPI profile and password must be entered in the fields above. That MAPI profile
must exist within the MAPI email client on the server PC and be useable by the account under which the
Voicemail Pro service is running.

· If SMTP is selected, the SMTP email account settings  must be entered.

5.Click OK.

6.Click  Save and Make Live.
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2.6.2.2 Work Group Member

Before you start to install the Voicemail Pro software, you must:

1. Create a Voicemail User Account .

2. Configure Outlook Express for Internet Mail .

3. Configure Outlook for Voicemail Email .

4. Configure Outlook for Exchange Server .

The user name and password created are requested as part of the installation of the Voicemail Pro service. The process
described here assumes that Outlook is installed but has not been previously used or configured.

You are then ready to install the Voicemail Pro software. See Installing the Voicemail Pro Software .

By default, Voicemail Pro is set to use SMTP for emails. You need to change this to MAPI. See Switching Voicemail Pro to
MAPI .

You also need to set the SMTP Email Account settings on the Voicemail Pro so that they match those of the customer's
email server. See Changing SMTP Email Account Settings .

 

2.6.2.2.1  Installing VoiceMail Pro for MAPI VoiceMail Email as a Work Group Member

Before you start to install the Voicemail Pro software, you must:

1. Create a voicemail user account. See Creating a Voicemail User Account .

2. Configure Outlook Express for Internet Mail. See Configuring Outlook Express for Internet Mail .

3. Configure Outlook for internet mail. See Configuring Outlook for Voicemail Email .

4. Configuring Outlook for exchange server. See Configuring Outlook for Exchange Server .

The user name and password created are requested as part of the installation of the Voicemail Pro service. The process
described here assumes that Outlook is installed but has not been previously used or configured.

You are then ready to install the Voicemail Pro software. See Installing the Voicemail Pro Software .

By default, Voicemail Pro is set to use SMTP for emails. You need to change this to MAPI. See , Switching Voicemail Pro to
MAPI .

You also need to set the SMTP Email Account settings on the Voicemail Pro so that they match those of the customer's
email server. See  Changing SMTP Email Account Settings .

 

2.6.2.2.2  Creating a Voicemail User Account

To create a Voicemail User Account

1. Log on to the server PC as the local administrator and create a new user. For this example the name of the user
account created used is Voicemail.

2. Set a secure password.

3. Clear User must change password at next logon and check Password never expires.

4. Click Create and then Close.

5. Right-click the New Account, and select Properties.

6. Select the Member Of tab.

7. Click Add.

8. In the Select Groups window, highlight Administrators and click Add. Click OK.

9. Continue with one of the following as appropriate to the installed MAPI client and method for sending email.
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2.6.2.2.3  Configuring Outlook Express for Internet Mail

To configure Outlook Express for Internet Mail

1. Click the Outlook Express icon to start the Configuration wizard.

2. In the Display name box enter Voicemail.

3. Click Next.

4. Select I already have an e-mail address that I'd like to use and enter the address in E-mail address, eg.
voicemail@example.com. Click Next.

5. Enter the name or address of the Incoming mail server and the Outgoing mail server. Note, if you enter the name,
you must ensure that the voicemail PC has the correct IP address of the DNS Server configured.

6. Click Next.

7. Enter the email account name and password, for example Voicemail. Select Remember password.

8. Click Next.

9. Click Finish to complete the wizard.

10. Open Outlook Express and select Tools > Options.

11. Click the General tab.

· Uncheck Send and Receive messages at Start up.

· Uncheck Check for new messages every.

12. Select the Send tab.

· Uncheck Save copy of sent messages in the 'Sent Items' folder.

· Check Send messages immediately.

· Under Mail Sending Format select Plain Text.

13. Click OK.

14. Log on to the server PC using the account that will be used for the Voicemail Pro server.

15. From Outlook or Outlook Express, send a message direct to an extension user.

16. If this message is received correctly, continue with installing the Voicemail Pro software.
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2.6.2.2.4  Configuring Outlook for Internet Mail

For the installation of Outlook to work correctly, the following setup process must be followed. Outlook can be configured
in two ways. Using the Wizard, prior to completing the steps below will cause Outlook not to send the messages
correctly.

To configure Outlook for Internet Mail:

1. Right-click the Outlook icon on the desktop and select Properties.

2. Select Add.

3. Select Internet Email and click OK.

4. For the Mail Account, enter Voicemail.

5. For User Information enter Voicemail as the Name and for the Email address enter your address, for example.
voicemail@example.com.

6. Select the Servers tab. Enter the name or IP address of the Outgoing mail server and Incoming mail server.

7. The Incoming Mail Server details can be left blank as Outlook does not need to check for mail. Otherwise, enter
the account name and password for example, Voicemail. Select Remember password.

8. Select the Connection tab. Select Connect using my local area network (LAN). Click Next.

9. Click OK.

10. Click Next.

11. Accept the default path for file creation.

12. Select Next, then Finish and then Close.

13. Open Outlook.

14. On the Email Service Option Screen, select Internet Only.

15. Click Next.

16. Select Yes to register Outlook as the default email application.

17. Select Tools > Options.

18. Click the Preferences tab.

19. Click Email Options.

20. Uncheck Save copies of messages in Sent Items folder.

· You might want this option selected during initial setup and troubleshooting. Due to the size of wav file
message attachments it is advisable to uncheck it after installation is complete.

21. Log on to the server PC using the account that will be used for the Voicemail Pro server.

22. From Outlook or Outlook Express, send a message direct to an extension user.

23. If this message is received correctly, continue with installing the Voicemail Pro software.
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2.6.2.2.5  Configuring Outlook for Exchange Server

This option may be configured if Outlook is to be configured to connect to the Exchange Server, using a valid user name
and password, while the Voicemail PC remains a member of a work group.

To configure Outlook for Exchange Server:

1. Create a new mailbox on the Exchange Server, for example Voicemail, and assign it the same password as has
been configured on the voicemail PC.

2. Clear User must Change password at Next Logon and select Password Never Expires.

3. On the voicemail PC, logon with the Voicemail account.

4. Right-click the Outlook icon on the desktop and select Properties.

5. Select Add.

6. Highlight Microsoft Exchange Server and click OK.

7. Type in the Microsoft Exchange Server name and enter Voicemail in the Mailbox field.

8. Highlight the MS Exchange Settings, Click Properties.

9. Highlight Microsoft Exchange Server. Click Properties.

10. Click Check name and ensure the name is resolved.

11. If the name is resolved, select Apply. Click OK, OK and Close to shut the Mail settings.

12. Do not continue until the name has been resolved correctly with the Exchange Server. If the name is not resolved,
check the account details with the exchange administrator.

13. Open Outlook and select Yes to register Outlook as the default email application.

14. Select Tools > Options.

15. Choose the Preferences tab. Click Email Options.

16. Uncheck Save copies of messages in Sent Items folder.

· You may want this option selected during initial setup and troubleshooting. Due to the size of wav file
message attachments deselect it once installation is complete.

17. Log on to the server PC using the account that will be used for the Voicemail Pro server.

18. From Outlook or Outlook Express, send a message direct to an extension user.

19. If this message is received correctly, continue with installing the Voicemail Pro software.
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2.6.2.2.6  Installing the VoiceMail Pro Software

To install the Voicemail Pro software

1. Log off and log back on using the Voicemail account and password.

2. Install the required Voicemail Pro software. 

3. When the installation process requests a User Name and Password for the Voicemail Pro service, enter the
Voicemail account details.

4. Restart the server PC when requested and log on using the Voicemail account.

5. When SMTP email details are requested, enter no values and ignore the error message following the SMTP check.

6. Start the Voicemail Pro Service .

7. Check that the basic voicemail services start and operate correctly.

8. Switch Voicemail Pro to MAPI .
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2.6.2.2.7  Switching VoiceMail Pro to MAPI

By default, the Voicemail Pro server is configured for SMTP email mode. However if required it can be switched between
SMTP and MAPI mode. Some options are not available if you are working offline. You must be working online to use this
feature. 

To select the server email mode

1.Start the Voicemail Pro Client.

2.Click  Preferences and select General.

3.Click the MAPI tab.

4.The Use Email Protocol settings allow you to switch Voicemail Pro between MAPI and SMTP.

· If MAPI is selected, a valid MAPI profile and password must be entered in the fields above. That MAPI profile
must exist within the MAPI email client on the server PC and be useable by the account under which the
Voicemail Pro service is running.

· If SMTP is selected, the SMTP email account settings  must be entered.

5.Click OK.

6.Click  Save and Make Live.
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2.6.2.2.8  Changing SMTP Email Account Settings

To change SMTP Email Account Settings:

1. Open the Windows Control Panel.

2. Select  IP Office Voicemail Pro.

3. Select the SMTP Email Settings tab. 

4. Enter the settings to match the customer's email server and the email account configured on that server for the
Voicemail Pro service.

5. Click the Email Settings tab. 

6. Enter the email address for the account setup on the customer's email server for the Voicemail Pro service.

7. Click Check to test the connection to the specified email account.

8. Click OK. 
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2.6.3 Voicemail Email Operation
2.6.3.1 User and Group Configuration

The email address for each user and hunt group is set through the IP Office configuration.  

· Voicemail Email: Default = Blank (No voicemail email features) 
This field is used to set the user or group email address used by the voicemail server for voicemail email
operation. When an address is entered, the additional Voicemail Email control below are selectable to
configure the type of voicemail email service that should be provided. 

· Use of voicemail email requires the voicemail pro server to have been configured to use either a local
MAPI email client or an SMTP email server account. See Voicemail Email Installation . 

· The use of voicemail email for the sending (automatic or manual) of email messages with wav files
attached should be considered with care. A one-minute message creates a 1MB .wav file. 

· Voicemail Email Default = Off
If an email address is entered for the user or group, the following options become selectable. These control
the mode of automatic voicemail email operation provided by the voicemail server whenever the voicemail
mailbox receives a new voicemail message. 

· Users can change their voicemail email mode using visual voice . If the voicemail server is set to
IP Office mode , user can also change their voicemail email mode through the telephone prompts.
The ability to change the voicemail email mode can also be provided in a call flow using a Play
Configuration Menu  action or a Generic  action. 

· If the voicemail server is set to IP Office mode , users can manually forward a message to email. 

· Off
If off, none of the options below are used for automatic voicemail email. Users can also select this mode
by dialing *03 from their extension. 

· Copy
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, a copy
of the message is attached to an email and sent to the email address. There is no mailbox
synchronization between the email and voicemail mailboxes. For example reading and deletion of the
email message does not affect the message in the voicemail mailbox or the message waiting indication
provided for that new message. 
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· Forward
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, that
message is attached to an email and sent to the email address. No copy of the voicemail message is
retained in the voicemail mailbox and their is no message waiting indication. As with Copy, their is no
mailbox synchronization between the email and voicemail mailboxes. Users can also select this mode by
dialing *01 from their extension. 

· UMS Exchange 2007
Voicemail Pro 5.0+ supports voicemail email to an Exchange 2007 server email account. For users
and groups also enabled for UMS Web Services this significantly changes their mailbox operation. The
Exchange Server inbox is used as their voicemail message store and features such as message
waiting indication are set by new messages in that location rather than the voicemail mailbox on the
voicemail server. Telephone access to voicemail messages, including Visual Voice access, is
redirected to the Exchange 2007 mailbox. See UMS Exchange 2007 Installation  and UMS
Exchange 2007 . 

· Alert
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, a
simple email message is sent to the email address. This is an email message announcing details of the
voicemail message but with no copy of the voicemail message attached. Users can also select this mode
by dialing *02 from their extension. 
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2.6.3.2 How Voicemail Email Messages Look

Messages sent by a user or group's voicemail email settings contain the following:

· To 
The user/group email address.

· From 
The name and address setting of the email client account.

· Subject 
Voicemail Message ('calling number' > 'user name') From:'calling number'.

· Body 
If the user or group's Voicemail Email mode is set to Copy or Forward, the message body will contain "IP Office

Voicemail redirected message".

· Attachment 
When using Copy or Forward mode, the message is attached as a wav file.

 

Messages sent via a Voicemail Pro eMail action are configurable, see The Voicemail Pro eMail Action .
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2.6.3.3 The Voicemail Pro Email Action

The  eMail action in Voicemail Pro can be used to send messages via email in response to caller actions in the
voicemail call flow. The action can also attach a wav file.

In the example above, the eMail action follows a Voice Question action. The $ in the eMail action's Attach file to
email field instructs it to use the file recorded by the preceding Voice Question action.

The same method can be used with a Leave Mail action. Note however that the Leave Mail action must be set to a valid
target mailbox which will then have a copy of the message.

Alternatively, the eMail action can attach a prerecorded wav file by specifying the file name. That named file can be
created by an Edit Play List action.
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2.7 Text to Speech (TTS) Installation
The Voicemail Pro server is able to use the Text to Speech (TTS) feature to:

· Speak text in call flows using the  Speak Text action. The text can include variables passed from other actions
including database actions.

· Support Email Text to Speech. This requires MAPI based Voicemail Email to have been set up and tested.

· When installed in parallel with Voicemail Email, Voicemail Pro TTS can be used to provide email reading to selected
mailbox users. 

Licensing
Voicemail Pro TTS requires the server PC to have a Microsoft SAPI 5 compatible TTS engine installed and a valid license
entry. Two IP Office licenses exist to enable Voicemail Pro support for TTS operation. These are:

· VM Pro Generic TTS 
This license enables the Voicemail Pro server to use either Microsoft's own SAPI 5 TTS engines or third-party SAPI
5 compatible TTS engines. The Microsoft TTS engines (Microsoft Sam, Mike, Mary and Simplified Chinese) are
installed by default as part of the Microsoft Windows installation. One VM Pro Generic TTS license is required for
each simultaneous usage.

· VM Pro ScanSoft TTS 
This license enables the Voicemail Pro server to use Avaya supplied TTS engines. These engines currently provide
better voice quality than the Microsoft TTS engines and support a wider range of languages. They are supplied on
a set of 2 DVD's separate from the Voicemail Pro software. One VM Pro ScanSoft TTS license is required for each
simultaneous usage.

TTS licenses are enabled for a number of ports (simultaneous usages). If both Generic TTS and ScanSoft TTS licenses are
enabled in Manager, both of the TTS engines will be used on a first-come first-served basis. Due to this, the TTS engine
used by a particular port for a particular call cannot be guaranteed. To have one consistent engine used for all calls,
Avaya only supports one type of license is use within a system.

Languages
For Voicemail Pro 5.0, the supplied ScanSoft TTS software now supports the same set of languages as Voicemail Pro
speech prompts except for Hungarian. If more than one TTS language is installed, a Select System Prompt Language
action can then be used to switch TTS to a different language from the selected default. 

· Installation on Windows Server Operating Systems
On many Windows server PC's, while the Windows Audio components are present by default they are not always
enabled. If this is the case the playback of voice prompts may be 'choppy' and the TTS (if installed) will not work.
However, enabling Windows Audio does not require the server PC to have a sound card installed. 

1.Ensure that you have full administrator rights for the PC. This process will also require the PC to be restated. 

2.In the Windows Control Panel select Sounds and Audio Devices. 

3.If Windows Audio has not been enabled, select the Enable Windows Audio check-box. 
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2.7.1 Installing Generic Text to Speech
To install Text to Speech:

1.Install and test Voicemail Pro as normal.

2.Using IP Office Manager, add the VMPro TTS (Generic) license into the IP Office configuration. Send the new
configuration to the IP Office system.

3.Reload the IP Office configuration into IP Office Manager and check that the status of the license has changed to 
Valid.

4.The Voicemail Pro installation includes the default Microsoft TTS engines (Microsoft Sam, Mike, Mary and Simplified
Chinese) as standard. If another third-party SAPI 5 compatible TTS engine is going to be used, install that
software.

5.If the system is licensed for generic TTS, Voicemail Pro will automatically discover any SAPI 5 installed engine. If
there is no 3rd party engine installed then the Microsoft 3rd party engine is used.

 

2.7.2 Installing Avaya Text to Speech
The Avaya TTS engine for Voicemail Pro is supplied on separate DVD's (x2) from the Voicemail Pro software . 

To install Avaya Text to Speech:

1.Install and test Voicemail Pro as normal. 

2.Using IP Office Manager, add the VM Pro TTS (ScanSoft) license into the IP Office configuration. Send the new
configuration to the IP Office system. 

3.Reload the IP Office configuration into IP Office Manager and check that the status of the license has changed to 
Valid.

4.Insert the first Avaya TTS DVD. The installation should auto-start.

5.Follow the prompts and install the required languages. 

6.If the system is licensed for Avaya TTS, the ScanSoft engine is automatically used.

 

2.7.3 Using the Speak Text Action

One method of employing TTS is through adding a Speak Text action to a call flow. The text to be spoken is entered
in the action's Specific tab. 

This text can include combinations of:

· Typed text sentences.

· Voicemail Pro Call Variables . For example:

· Entering $KEY would be replaced when spoken by the last digits dialed within the call flow by the
caller.

· If using database interaction, entering $DBD[x] would be replaced by the current value of that
database field.

· Entering $CLI would speak the caller's CLI, if available, back to them.

· SAPI 5 XML  tags can be added to alter how the text is spoken. For example when 123 needs to be
spoken as one two three rather than "one hundred and twenty-three", enter <spell>123</spell>.
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2.7.4 Text to Speech SAPI Controls
Windows TTS engines use Microsoft's SAPI (Speech Application Program Interface). This includes the use of XML tags in
the text to change how the text is spoken. For example, in the text This is the <volume level="90">text</volume>
to speak the items within < > brackets are XML tags used to change how the speech is spoken.

The following are samples of the SAPI XML controls supported by Voicemail Pro TTS. Further information on SAPI 5 can
be obtained from Microsoft support websites.

· Volume  
Change the speech volume.

· Rate  
Change the speech rate.

· Pitch  
Change the speech pitch.

· Emph  
Add emphasis to words.

· Spell  
Spell out words and numbers literally.

· Silence  
Add a period of silence.

· Partofsp  
Change the usage of words.

Entering XML Tags 
XML tags can be used in two ways, either nested or empty.

· Nest Tags: Example = <volume level="90">text</volume> 
Nested tags consist of:

· An opening XML tag, in the example above <volume level="90">.

· The text to which the opening tag command should be applied.

· A closing XML tag. The closing tag use the same command as the opening tag, prefixed with / and no other
settings. In the example above this is </volume>.

· Empty Tags: Example = <volume level="90"/>All following text
An empty tag is not nested, its command and settings apply to all the following text. Empty tags are recognizable
by the / before the tags closing >.
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Example SAPI XML Tags

Volume
Controls the volume of the speech. This tag can be nested or empty.

· Attributes:

· level= 
Supports values between 0 and 100, being percentages of the system's set volume.

· Examples:

· <volume level="50"/> Speak allow following text at level 50.

· <volume level="50"> Speak this text at level 50</volume> and this as normal.

Rate
Controls the speed at which the text is spoken. This tag can be empty or nested.

· Attributes 
Only one attribute may be applied within a tag.

· absspeed= 
Sets the absolute speed for the speech in a range between -10 and 10 with 0 being normal speech.

· speed=
Sets a speed change that is added to the current speed.

· Examples:

· <rate absspeed="5"> Speak this text at rate 5</rate> and this text as normal.

· <rate absspeed="5"/> Speak all following text at rate 5.

· <rate speed="-5"/> Drop the current speech speed by 5.

Pitch 
Controls the pitch at which the text is spoken. This tag can be empty or nested.

· Attributes 
Only one attribute may be applied within a tag.

· absmiddle= 
Sets the absolute pitch for the speech in a range between -10 and 10 with 0 being normal speech.

· middle= 
Sets a pitch change that is added to the current speed.

· Examples:

· <pitch absmiddle="5"> Speak this text at pitch 5</rate> and this text as normal.

· <pitch absmiddle="5"/> Speak all following text at pitch 5.

· <pitch middle="-5"/> Drop the current speech pitch by 5.

Emph 
Applies emphasis to a word or section of text. This tag must be nested.

· Attributes: 
This tag has no attributes.

· Example:

· Say <emph>boo</emph>.
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Spell
Spell forces the engine to speak any nested text literally rather than applying any speech rules. This is useful for
numbers where rather that than saying 3001 as three thousand and one for 3001, the speech required is three zero zero
one. This tag must be nested.

· Attributes 
This tag has no attributes.

· Example:

· The telephone number is <spell>555 3468</spell>.

Silence 
Inserts a period of silence. This tag must be empty.

· Attributes

· msec= 
Sets the duration in milliseconds.

· Example:

· A short silence <silence msec="500"/> of half a second.

Partofsp
Forces the pronunciation of a word according to it usage if not correctly determined by the TTS speech engine or to
override the engine. This tag must be nested.

· Attributes:

· part= 
Takes a value from noun, verb, modifier, function or interjection.

· Example:

· To <partofsp part="verb">record</partofsp> that <partofsp part="noun">record</partofsp> press 1.
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2.7.5 Setting Up Text To Speech to Read Email

In conjunction with MAPI email clients and Exchange server, TTS can be used to read new e-mails in a user's email inbox
when they access their voicemail mailbox.

This feature is supported only for Intuity mode. Users hear their new voicemail messages and then the number of
"Messages with text". Before each email is spoken, details of who it is from, when the message was sent and the size are
given. This allows large or non-urgent e-mails to be skipped.

· Email reading cannot be used for e-mails in HTML format. If HTML messages are received, all of the code will be
read out as a message.

To set up text to speech to read email:

1. Install and test Voicemail Pro for MAPI-based Voicemail Email operation with an Exchange Server.

2. To perform email reading, the Voicemail account created on the Exchange server for Voicemail Email must able to
access the individual users email mailboxes. This can be achieved by either:

· On the Exchange Server, ensure that Voicemail user account is granted rights to access all user email boxes,
or;

· Within each user's Outlook:

· Select Tools > Options.

· Select Delegates.

· Add the voicemail account as a delegate.

3. If you have not already done so, install and test TTS operation using a Speak Text action.

4. Using IP Office Manager, load the IP Office configuration and open the settings for the user.

5. Select the Voicemail tab. 

6. In Voicemail Email, enter the user's email address. The same address is used for both Voicemail Email and Email
Reading services.

7. Select Voicemail Email Reading.

8. Click OK and merge the new configuration back to the IP Office system.

9. Send the user a test email. Then log into the user's voicemail mailbox and check whether following the voice
messages a new "message with text" is announced.
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2.8 Troubleshooting
2.8.1 About
For Voicemail Pro 4.2+, the about screen displays information about the IP Office to which the Voicemail Pro server is
connected and the licenses it has received from that IP Office. 

1.In the menu bar, select Help and then About. 

2.The menu displays information from the voicemail server. This includes the address of the IP Office with which it is
working and the licenses it has received from that IP Office. 

3.To close the information window click the top-right X button. 
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2.8.2 Checking the Voicemail Pro Service
If Voicemail Pro has been installed successfully, if the server PC has been rebooted then the voicemail service is started
automatically. However it is useful know how to check the services and to manually restart them if necessary.

To check/restart the Voicemail Pro Service:

1. Open the Windows Control Panel.

2. Select Administrative Tools > Services. 
 

3. The Voicemail Pro Service should be visible. Its Status should be Started and the Startup Type should be set
to Automatic. Other services may be present depending on the Voicemail Pro options installed. The possible
services are: 

· Voicemail Pro Service
This is the main Voicemail Pro service. Normally this is the only service that needs to be stopped and
restarted. It will stop and restart the other services that it uses.

· VMProDBService
This service is used for remote client connections. 

· IMS (Gateway), IMS (Voice) and IMS (Restart)
These services are used by the IMS components of Voicemail Pro if installed and licensed.

· VPNM Database Server, VPIM Receiver and VPNM Server
These services are used by the VPNM components of Voicemail Pro if installed and licensed. 

4. Close Services.

  

Setting the Voicemail Services or PC to Restart Automatically
The following action is optional. If there is some fault causing the Voicemail Pro service to halt, that fault should be
investigated and fixed, however having the service or PC automatically restarted if possible will minimize the disruption to
the Voicemail Pro users. 

1.Use the Windows control panel to select the Voicemail Pro Service. 

2.Right-click on the service and select Properties. 

3.Select the Recovery tab. 

4.Use the options presented to either restart the service and or restart the PC should the operating system detect
that the Voicemail Pro service has halted. 

Using a Batch File to Start Services 
In some instances, certain computers might not respond quickly enough in order to start all of the Avaya services in the
correct order. In this circumstance, it can be advisable to create a batch file which will delay the start of these services
until the PC is fully running.

Avaya IP Office Services can be started successfully at system start-up using a scheduled task that initiates the batch file
below. This batch file ensures that the services will start successfully and in the proper order.

1. Set all Avaya services listed below to Manual start. Do not include Key Server.

2.Create the batch file below and save it to %SYSTEMROOT%. Only include lines for the services which are installed.

@echo off
rem Wait 60 seconds before execute.
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timeout /t 60
net start VMProDBService
net start Voicemail Pro Service
net start IMS(Restart)
net start IMS(Voice)

net start IMS(Gateway)

3.Create a scheduled task to start the batch file at system start-up.
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2.8.3 Voicemail Pro User Log
User authentication failures are logged in the event viewer, under VMPro User Log. The following details are logged:

· UserID

· Tool name

· IP address of the Client trying to log in.

 

To view the log details:

1.From the Control Panel, select Administrative Tools > Computer Management. The Computer Management
window opens.

2.In the System Tool directory, view the Event Viewer.

3.Click VMPro User Log to view the details.

 



Voicemail Pro Page 83
15-601063 Issue 21c (16 July 2009)IP Office 5.0

Installing Voicemail Pro: Troubleshooting

2.8.4 Tracing in Debug
Many applications, including Voicemail Pro, output activity messages that are viewable in Debug View (DbgView). This
application can be downloaded from http://marketingtools.avaya.com/knowledgebase/tools/debug.

 

Installation

1.Download the zip file.

2.Unpack the files into a folder such as c:\debug on the server PC. 

3.Run DbgView.exe.

4.Events are shown in the DbgView window. These can be logged to a file if required. The level of detail shown can
be filtered to show more or less activity.

 

Logging

1.Run DbgView.exe.

2.Select File | Log Preferences. 

3.Set the logging details are required and click OK.

4.While DbgView is running the viewable trace is also copied to the specified file.

5.The debug log files can be opened in programs such as WordPad. 

 

http://marketingtools.avaya.com/knowledgebase/tools/debug
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Filtering

1.Select View | Debug Filters.

2.Select the module for which you want to increase/decrease reporting.

3.In the right hand panel adjust the level of reporting.

4.Close the Configure Debug Filters window.
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2.8.5 The Voicemail Console
The voicemail console mode (that is running as the voicemail service in Interact with desktop mode) is no longer used.
Running services in this mode is not supported by Microsoft on Vista or Server 2008. 

Instead you should use the debug viewer  to view voicemail server activity as it occurs.83
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Voicemail Pro Preferences

Chapter 3.
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3. Voicemail Pro Preferences
There are two main areas through which Voicemail Pro system preferences are set and configured. 

· Voicemail Pro Client  
These voicemail server settings are set using the Voicemail Pro client. 

· General  
General voicemail server settings. 

· Directories  
Set the folder paths for different file locations. 

· Housekeeping  
Set the times for automatic deletion of different types of messages. Also set the default playback order. 

· MAPI  
Select the email mode (MAPI or SMTP) used by the voicemail server for its email functions. 

· SNMP Alarm  
Set the criteria which will cause the voicemail server to send alarms via the IP Office. 

· Outcalling  
Set the default times for outcalling operation and the frequency of outcalling retires. 

· VPNM  
If VPNM is installed and licensed, this tab is available to set the locations of the remote VPNM servers and
the mailbox users on those servers. 

· Windows Control Panel  
These settings are set through the Windows Control Panel on the voicemail server PC. 

· System Settings  
Used by IMS to set the logging level used by the voicemail server. 

· Path Setting  
Used by IMS to set the path to the server PC running the IMS Voice Server service. 

· SMTP Email Settings  
If SMTP is the selected email mode for the voicemail server, this tab is used to set the SMTP account
details for the voicemail server. 

· Email Settings  
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Voicemail Pro Preferences:  

3.1 System Preferences
A range of voicemail server settings can be set through the Voicemail Pro client. 

To change the Voicemail Pro Preferences:

1.Click the Preferences  icon and then choose General or VPNM. Alternatively, from the Administration
menu, select Preferences and then choose General or VPNM.

2.Select the System Preferences tab required.

· General  
General voicemail server settings. 

· Directories  
Set the folder paths for different file locations. 

· Housekeeping  
Set the times for automatic deletion of different types of messages. Also set the default playback order. 

· MAPI  
Select the email mode (MAPI or SMTP) used by the voicemail server for its email functions. 

· SNMP Alarm  
Set the criteria which will cause the voicemail server to send alarms via the IP Office. 

· Outcalling  
Set the default times for outcalling operation and the frequency of outcalling retires. 

· VPNM  
If VPNM is installed and licensed, this tab is available to set the locations of the remote VPNM servers and
the mailbox users on those servers. 

3.1.1 General
Although the default IP Office configuration settings allow voicemail to start operating almost immediately, as soon as a
voicemail server is running on the LAN, there are some general system preferences that you can set or change.

To set up general system preferences:

1.Display the main Voicemail Pro window.

2.From the Administration menu, select Preferences > General. 

· Client/Server Connection Timeout (mins) 
The voicemail server only allows one Voicemail Pro client to be connected at a time. This timeout logs out an
inactive client, stopping it from preventing another client from connecting. 
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· Default Telephony Interface 
Select the mailbox operation mode for all mailboxes. The options are IP Office  mode or Intuity
emulation mode. 

· Voicemail Password 
A voicemail password is optional for the voicemail server is optional. If you set a password here, it must
match the Voicemail Password configured within the IP Office's security settings. See Identifying the Voicemail
Server PC . 

· Min. Message Length (secs) (Voicemail Pro 5.0+)
By default the minimum message length is 3 seconds in IP Office mailbox mode, 0 seconds in Intuity
emulation mode. This field allows the minimum length to be set between 0 and 10 seconds. Messages under
this length are deleted immediately.

· Max. Message Length (secs) 
This value sets the maximum length for messages. The default message length is 120 seconds. The maximum
message length is 3600 seconds (60 minutes). 1 minute equals approximately 1MB of disk space.

· Max. Call\VRL Record Length (secs), 
This value sets the maximum recording time for recorded calls. The default and maximum length is 3600
seconds (60 minutes). 

· Play Advice on Call Recording 
If selected, an advice warning is played whenever call recording is started advising the callers that their call is
being recorded. This may be a legal requirement in some countries and so should not be disabled without
checking first.

· System Fax Number 
box, type the number of the general fax machine to which all incoming faxes should be directed. If a fax
board is being used, this number must match the number of the extension that is connected to the fax board
of the fax server PC. See Setting the Voicemail Pro System Fax Number .

· Intuity mailbox owners have the additional option to define their own personal fax number instead of the
system fax number. As the system administrator, you still need to set a system fax number to enable
mailbox owners to override it with their preferred personal fax number. Incoming calls are directed to
Voicemail Pro and then Voicemail Pro redirects fax calls to the mailbox owner's personal fax number, if
one has been set. For information mailbox owners should read the Intuity Mailbox User Guide.

· If your fax system requires prefix addressing, for example the C3000 fax server, do not type a fax
number in the System Fax Number box. Instead type the number to use as a prefix so that a fax
message can be identified and forwarded to the extension number of the intended recipient. For example,
if the prefix were 55, a fax message for extension 201 would have the prefix of 55 automatically added
so that the complete number would become 55201.

· System Fax Number 
By default fax detection is not enabled when Voicemail Pro is first installed. When fax detection is enabled,
any fax calls that are left in a voicemail mailbox, are redirected to this system fax number.

· Use as a Prefix 
If your fax system does not use prefix addressing, leave this box unchecked. For this feature to work,
you also need to set up a short code. 

· Enable Fax Sub-Addressing 
Most fax servers perform fax forwarding based on DTMF signaling received with the fax call. Check the 
Enable Fax Sub-Addressing box so that the DTMF signal is passed to the fax server after the call has
been answered so that the fax can be forwarded to the email address of the intended recipient.

3.Click OK.

4.Click  Save and Make Live and select Yes.

 

299 298

107

358



Voicemail Pro Page 91
15-601063 Issue 21c (16 July 2009)IP Office 5.0

Voicemail Pro Preferences: System Preferences

3.1.2 Directories
When Voicemail Pro is installed some default folder locations are used. You can change these if required.

To set the location of Voicemail system folders:

1.Display the main Voicemail Pro window.

2.From the Administration menu, select Preferences > General.

3.Click the Directories tab. 

4.In the Voicemail Server Directory box, type the path to the folder where the voicemail server program is to be
stored. This is the folder where the file Root.vmp is saved when the Save & Make Live option is used.
Alternatively click the browse button and select a folder to use.

5.In the Voicemail Server Speech Directory box, type the path to the folder where the libraries of speech
prompts are to be stored. Alternatively click the browse button and select a folder to use.

6.In the Remote Campaign Directory box, type the path to the folder where the campaign files are to be stored.
Alternatively click the browse button and select a folder to use.

7.Click OK.

8.Click  Save and Make Live and select Yes.
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3.1.3 MAPI
By default, the Voicemail Pro server is configured for SMTP email mode. However if required it can be switched between
SMTP and MAPI mode. Some options are not available if you are working offline. You must be working online to use this
feature. 

To select the server email mode

1.Start the Voicemail Pro Client.

2.Click  Preferences and select General.

3.Click the MAPI tab.

4.The Use Email Protocol settings allow you to switch Voicemail Pro between MAPI and SMTP.

· If MAPI is selected, a valid MAPI profile and password must be entered in the fields above. That MAPI profile
must exist within the MAPI email client on the server PC and be useable by the account under which the
Voicemail Pro service is running.

· If SMTP is selected, the SMTP email account settings  must be entered.

5.Click OK.

6.Click  Save and Make Live.
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3.1.4 Housekeeping
This tab is used to set the Voicemail Pro server settings for automatically deleting messages and for the default playback
order of messages.

Messages are automatically deleted from the voicemail server after a set delay. This delay can be adjusted for different
message type including unread messages.

The process of housekeeping is performed after any two hour idle period, that is a period with no call into or from the
voicemail server. 

To set housekeeping rules:

1.From the Administration menu, select Preferences > General.

2.Click the Housekeeping tab. 

· The different message status types are: 

· New 
This status is applied to messages where neither the header or the message content has been played. 

· Old 
This status is applied to messages where the user has played the message content but has not marked
the message as saved. 

· Saved 
This status is applied to messages that have been marked as saved by the user. 

· Unopened 
This status is used for messages where, in Intuity emulation mode, the user has played the message
header but has not played the message content. 

3.Automatic message deletion 
Sets the time, in hours, after which messages of various types automatically deleted. A value of 0 disables
automatic deletion. The actual deletion is performed during the next idle period during which there are no calls to
or from the voicemail server.

4.Message playback order (System Setting) 
Sets the order of playback used for different message types. The options are first in-first out (FIFO) and last in-
first out (LIFO). FIFO is the default.

5.Click OK.

6.Click  Save and Make Live and select Yes.
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3.1.5 SNMP Alarm
The IP Office system can be configured to send alarms. These alarms can be sent from the IP Office using SNMP, SMTP
email or Syslog alarm formats. This tab is used to sets the levels at which the voicemail server will indicate to the IP
Office to send an alarm. 

 To set up disk space and recording time alarms:

1.Display the main Voicemail Pro window.

2.From the Administration menu, select Preferences > General.

3.Click the SNMP Alarm tab.

4.Choose the Alarm Threshold Unit either Disk Space Left (MB) or Recording Time left (minutes).

5.In the Alarm Threshold Level box, type the number of units (minutes or MB) left at which SNMP alarms are to
be triggered. The minimum is 11. This value also sets two further SNMP alarm levels which are:

· Space OK Alarm 
This alarm is triggered when the amount of available space returns to above a level set at Alarm Threshold
Level plus 30.

· Critical Alarm 
This alarm is set at 30 or, when the Alarm Threshold Level is less than 40, at Alarm Threshold Level minus 10.
Currently the critical alarm value will decrease in accordance with the above rule. Note however that it does
not increment upwards when the Alarm Threshold is increased again. To reset the critical alarm back to 30,
click Default Settings.

6.To return to the default alarm settings, click Default Settings. The Alarm Threshold Level is reset to 60. The
Space OK level is reset to 90. The Critical Alarm level is reset to 30.

7.Click OK.

8.Click  Save and Make Live and select Yes.
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3.1.6 Outcalling
The outcalling preferences in Voicemail Pro are defaults for global operation. Mailbox owners can configure their own
outcalling options from their telephone, for example, create their own time profile. 

Details on how users can configure outcalling are found in the Intuity Mailbox guide and Phone Manager User Guide. 

A timeout value can also be set by a user. This is how long outcalling will attempt to call a number before giving up. 

To set the global outcalling preferences:

1.Display the main Voicemail Pro window.

2.From the Administration menu, select Preferences > General.

3.Click the Outcalling tab.

4.Select the times that outcalling is active in the System Times section.

· Prime Times 
The time period that outcalling is to be active as default for the system.

· Peak Times 
The busiest working hours.

5.Set the retry settings in the System Retry Settings section.

6.The Number of Retries can be between 0 and 10. If the message is not collected after the last retry, no
notification is sent until another new message is delivered in the user's mailbox.

7.The Retry Interval for each retry attempt. The interval is the length of time between each attempt to ring to
targeted number again. The 6th to 10th retries use the default retry interval.

8.Double-click a selected retry time to edit the interval between retries. The New interval number window opens
where the length of time between each attempt to ring the target number can be changed. Click OK to save the
change and return to the Outcalling window.

9.Click OK.

10.Click  Save and Make Live and select Yes.
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3.1.7 VPNM

This set of preferences are only available if VPNM was selected during installation and is licensed within the IP Office
configuration. It is used to add a list of the remote VPNM servers and mailbox users on those servers. 

To open the VPN window:

1. Start the Voicemail Pro Client.

2. From the Administration menu, select Preferences > VPNM. The VPNM window opens. 

To add a VPNM server:

1. In the VPNM Server(s) section, click Add.

2. Enter the fully qualified domain name of the remote VPNM destination (the remote Voicemail Pro server PC or
Avaya Interchange).

3. Enter the two digit access prefix, if these are being used.

4. Click OK.

To delete a VPNM server:

1. In the VPNM Server(s) section, select the server that you need to delete.

2. Click Delete. When a server is deleted, all of the users associated with that server are also deleted.
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To add a user to VPNM server:

1. In the Users for VPNM Server(s) section, click Add. The Adding a new user window opens.

2. Enter details for the user. All of these details MUST be completed before the user can be added.

· Select the VPIM server from the listing.

· Enter the user's full name. The user's full name is used by the local Voicemail Pro's dial by name feature.

· Enter the user's extension. The local extension number is used as the local mailbox number and so should not
conflict with any existing local number.

· Enter the user's remote extension. The remote extension number should be the user's real extension number.
Typically this and the 'local extension number' are kept the same using a unique extension number dial plan
for the linked systems.

· Enter the user's full telephone number. The full telephone number should be a dialable number that is routed
to the user's extension or mailbox.

3. Click OK to save the details and return to the VPNM configuration window.
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To add a group of users:

1. (Optional) Check the option Enable WildCard. When this option is selected you can use the question mark symbol
(?) to represent any number.

2. In the Users for VPNM Server(s) section, click Add Range. The Adding a range of users window opens.

3. Enter details for the users. All of these details MUST be completed before the users can be added.

· Select the VPNM server to which you want to add the users.

· Enter the start number of the extension range.

· Enter the local prefix.

· Enter remote prefix.

4. Click OK to save the details and return to the VPNM configuration window.

To change details of a VPNM user:

1. In the Users for VPNM Server(s) section, select the name of the user whose details need to be changed.

2. Click Modify. You can change the user's full name, the local extension number and the full telephone number.
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3.2 Control Panel Options

To change the Voicemail Pro Server Preferences:

1.Open the Windows Control Panel.

2.Select  IP Office Voicemail Pro.

3.The tabs and options within the tabs will vary according to the installed Voicemail Pro components. Possible tabs
are:

· System Settings  
Used by IMS to set the logging level used by the voicemail server. 

· Path Setting  
Used by IMS to set the path to the server PC running the IMS Voice Server service. 

· SMTP Email Settings  
If SMTP is the selected email mode for the voicemail server, this tab is used to set the SMTP account
details for the voicemail server. 

· Email Settings  
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3.2.1 System Settings
If IMS is installed the Systems Settings tab is available. You can specify the level of service logging for the IMS
Gateway Server service and the IMS Voice Server service. Four levels of logging are available, with increasing level of
detail.

Typically logging is required only if IMS problems are being experienced and diagnosis is required. The information is
logged in the Event Viewer application.

To specify the level of IMS service logging:

1.Open the Windows Control Panel.

2.Select IP Office Voicemail Pro. The IP Office Voicemail Pro window opens.

3.Click the System Settings tab. 

4.In the Logging Level boxes, select the level to use for each of the IMS services.

· None 
No logging recorded.

· Some 
A low level of logging recorded where only errors are logged.

· Most 
A medium level of logging where errors and warnings are recorded.

· All 
All errors, warnings and information are logged.

5.Click Check to validate the changes that you have made.

6.Click OK. You are prompted to restart the affected services so that your changes are enabled.

7.Choose Yes. The services that are affected by your changes are automatically stopped and restarted.
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3.2.2 Path Settings
If IMS is installed, the Path Settings tab is available. You need to specify the computer name of the server PC that is
hosting the IMS Voice Service. Typically, this is installed on the same server PC as the Voicemail Pro Server.

To specify the name of the host server PC for IMS:

1.Open the Windows Control Panel.

2.Select IP Office Voicemail Pro. The IP Office Voicemail Pro window opens.

3.Click the Path Settings tab. 

4.Type the name of the computer on which the IMS Voice Service has been installed. Alternatively, click Browse and
select the name of the computer.

5.Click Check to validate the changes that you have made.

6.Click OK. You are prompted to restart the affected services so that your changes are enabled.

7.Choose Yes. The services that are affected by your changes are automatically stopped and restarted.
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3.2.3 Email Settings
You can configure certain email settings such as the account to use for email and the way in which .wav files are
transmitted.

To configure email settings:

1.Open the Windows Control Panel.

2.Select IP Office Voicemail Pro. The IP Office Voicemail Pro window opens.

3.Click the Email Settings tab. 

· Account Details box, 
type the name of the MAPI email account to use for email messages. 

· For MAPI, enter the name of the MAPI email account to use for email messages. Alternatively, select 
Browse to display a list of available email accounts. 

· For SMTP, enter the email address that the voicemail server should use. This address should match the
account details set on the SMTP Email Settings tab. 

· Message Parameters 
These options are only available if you have installed and are using IMS. For IMS you can specify the way in
which the .wav files of voicemail messages are to be sent in emails. Sending .wav files across a network
creates a high loading on the network and networks servers. A one-minute message requires a 1MB .wav file.

4.Click OK.
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3.2.4 SMTP Email Settings
For SMTP email, you need to define connections to external SMTP Email Servers. You can define your connections in the
SMTP Email settings tab. 

To configure the server SMTP email settings:

1.Open the Windows Control Panel.

2.Select IP Office Voicemail Pro. The IP Office Voicemail Pro window opens.

3.Click the SMTP Email Settings tab. 

· Mail Server 
Enter the name of the SMTP mail server. This should be the fully qualified domain name.

· Port Number 
Enter the receiving port on the SMTP mail server. The default is 25.

· Mail Drop box, 
This field is only required for Voicemail Pro VPNM. Enter the name of the destination folder for outgoing emails
on the SMTP Server. Alternatively click the browse button and select the folder to use.

· Server requires authentication 
If the SMTP server requires authentication select this option to enter the Account Name and Password that
should be used by the voicemail server. You can also select Use Challenge Response Authentication if
used by the SMTP server. 

4.Click Check to validate the changes that you have made.

5.Click OK. You are prompted to restart the affected services so that your changes are enabled.

6.Choose Yes. The services that are affected by your changes are automatically stopped and restarted.
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IP Office Configuration

Chapter 4.
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4. IP Office Configuration
The default IP Office configuration settings allow almost immediate voicemail operation as soon as a voicemail server is
running on the LAN. Those default settings are:

· Voicemail running on a PC accessible by the IP Office using a broadcast address of 255.255.255.255.

· Voicemail on for each user and hunt group on.

· No Voicemail Code set for any mailboxes. Until a code is entered for a mailbox, it can only be accessed from the
user's own extension.

· No Voicemail Email or Voicemail Help operation.

· No Voicemail Reception numbers set for user mailboxes.

· Hunt group mailboxes are created and used by default but there is no default message waiting indication or
method for collecting messages. A method for accessing each hunt group mailbox should be programmed. See 
Hunt Group Voicemail .247
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IP Office Configuration:  

4.1 System Settings
The IP Office can work with several different types of voicemail server. Therefore it is important to check that it is
configured for operation with Voicemail Pro. 

1.In IP Office Manager, select System.

2.Click the Voicemail tab. 

· Voicemail Type 
The default Voicemail Type is Voicemail Pro. Make sure that this has not been changed.

· Voicemail IP Address 
By default the IP Office connects to the Voicemail Pro server by using the address 255.255.255.255 to
broadcast for any server on the same LAN as itself. When it receives a response it will use that voicemail
server. However it may be necessary or desired to set this access to an exact address. Change the default
address (255.255.255.255) to the IP address of the PC on which the Voicemail Pro server is running. 

· For configuration of IP Office systems using centralized Voicemail Pro in an IP Office Small Community
Network (SCN) see Centralized Voicemail Pro . 

· Message Button Go To Visual Voice 
Many Avaya phones have a fixed button labeled MESSAGES which can be used by the phone user to access
their mailbox. If this option is selected, then on phones able to support  Visual Voice , visual voice is used
when the button is pressed rather than the standard voice prompt interface. 

· Voicemail Channel Reservation 
For calls going to voicemail from the IP Office, the IP Office can restrict how many sessions of various types
are active at the same time. See Voicemail Channel Reservation . 

· DTMF Breakout (IP Office 5.0)
Previous breakout numbers for a user mailbox were set through the user voicemail settings . IP Office 5.0+
allows system defaults to be set. These are then applied to all user mailboxes unless the users own settings
differ. 

· Reception / Breakout (DTMF 0) 
The number to which a caller is transferred if they press 0 while listening to the mailbox greeting rather
than leaving a message (*0 on embedded voicemail).

· For systems set to Intuity emulation mode, the mailbox user can also access this option when
collecting their messages by dialing *0. 

· If the mailbox has been reached through a call flow containing a Leave Mail  action, the option
provided when 0 is pressed are: 

· For IP Office mode, the call follows the Leave Mail action's Failure or Success results
connections depending on whether the caller pressed 0 before or after the record tone.

· For Intuity mode, pressing 0 always follows the Reception / Breakout (DTMF 0) setting. 

· Breakout (DTMF 2) 
The number to which a caller is transferred if they press 2 while listening to the mailbox greeting rather
than leaving a message (*2 on embedded voicemail). For pre-5.0 systems this option is not support for
Voicemail Pro running in IP Office mailbox mode. 
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· Breakout (DTMF 3) 
The number to which a caller is transferred if they press 3 while listening to the mailbox greeting rather
than leaving a message (*3 on embedded voicemail). For pre-5.0 systems this option is not support for
Voicemail Pro running in IP Office mailbox mode.

3.Click OK to save any changes.

4.Send the configuration back to the IP Office. 
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4.2 User Voicemail Settings
Voicemail can be configured for each individual user in IP Office Manager. 

To change voicemail configuration for an individual:

1.Open IP Office Manager.

2.In the Navigation pane, click  User and select the individual user.

3.Select the Voicemail tab. 

· Voicemail Code / Confirm Voicemail Code 
These fields are used to set or change the user's mailbox passcode. 

· If the voicemail server is set to Intuity Emulation mode, mailbox users are asked to set a voicemail
code the first time that they access the mailbox. 

· Voicemail On Default = On
When on, the mailbox is used by the IP Office to answer the user's unanswered calls or calls when the user's
extension returns busy. Note that selecting off does not disable use of the user's mailbox. Messages can still
be forward to their mailbox and recordings can be placed in it. The mailbox can also still be accessed to collect
messages. For other options Disabling a Mailbox .  

· Voicemail Help Default = Off
For voicemail systems running IP Office mailbox mode, this option controls whether users retrieving messages
are automatically given an additional prompt "For help at any time press 8." If switched off, users can still
press 8 for help. For voicemail systems running in Intuity emulation mode, this option has no effect. On those
systems the default access greeting always includes the prompt "For help at any time, press *4" (*H in the US
locale).

· Voicemail Ringback Default = Off
When on, if the user has a new message, the voicemail server can call the user's extension whenever the
extension changes from off-hook to on-hook. The voicemail server will not ring the extension more than once
every 30 seconds. 

· Voicemail Email: Default = Blank (No voicemail email features) 
This field is used to set the user or group email address used by the voicemail server for voicemail email
operation. When an address is entered, the additional Voicemail Email control below are selectable to
configure the type of voicemail email service that should be provided. 

· Use of voicemail email requires the voicemail pro server to have been configured to use either a local
MAPI email client or an SMTP email server account. See Voicemail Email Installation . 

· The use of voicemail email for the sending (automatic or manual) of email messages with wav files
attached should be considered with care. A one-minute message creates a 1MB .wav file. 

· Voicemail Email Default = Off
If an email address is entered for the user or group, the following options become selectable. These control
the mode of automatic voicemail email operation provided by the voicemail server whenever the voicemail
mailbox receives a new voicemail message. 

· Users can change their voicemail email mode using visual voice . If the voicemail server is set to
IP Office mode , user can also change their voicemail email mode through the telephone prompts.
The ability to change the voicemail email mode can also be provided in a call flow using a Play
Configuration Menu  action or a Generic  action. 
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· If the voicemail server is set to IP Office mode , users can manually forward a message to email. 

· Off
If off, none of the options below are used for automatic voicemail email. Users can also select this mode
by dialing *03 from their extension. 

· Copy
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, a copy
of the message is attached to an email and sent to the email address. There is no mailbox
synchronization between the email and voicemail mailboxes. For example reading and deletion of the
email message does not affect the message in the voicemail mailbox or the message waiting indication
provided for that new message. 

· Forward
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, that
message is attached to an email and sent to the email address. No copy of the voicemail message is
retained in the voicemail mailbox and their is no message waiting indication. As with Copy, their is no
mailbox synchronization between the email and voicemail mailboxes. Users can also select this mode by
dialing *01 from their extension. 

· UMS Exchange 2007
Voicemail Pro 5.0+ supports voicemail email to an Exchange 2007 server email account. For users
and groups also enabled for UMS Web Services this significantly changes their mailbox operation. The
Exchange Server inbox is used as their voicemail message store and features such as message
waiting indication are set by new messages in that location rather than the voicemail mailbox on the
voicemail server. Telephone access to voicemail messages, including Visual Voice access, is
redirected to the Exchange 2007 mailbox. See UMS Exchange 2007 Installation  and UMS
Exchange 2007 . 

· Alert
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, a
simple email message is sent to the email address. This is an email message announcing details of the
voicemail message but with no copy of the voicemail message attached. Users can also select this mode
by dialing *02 from their extension. 

· UMS Web Services 
If selected, the user is able to use UMS  to access their mailbox. UMS options allow messages to be
accessed via a web browser, an IMAP compatible email application or an Exchange 2007 email account. 

· DTMF Breakout
When a caller is directed to voicemail to leave a message, they can be given the option to be transferred to a
different extension. The greeting message needs to be recorded telling the caller the options available. The
extension numbers that they can be transferred to are entered in the fields below. For IP Office 5.0+, these
system default values can be set for these numbers and are used unless a different number is set within these
user settings. 

· Reception / Breakout (DTMF 0) 
The number to which a caller is transferred if they press 0 while listening to the mailbox greeting rather
than leaving a message (*0 on embedded voicemail).

· For systems set to Intuity emulation mode, the mailbox user can also access this option when
collecting their messages by dialing *0. 

· If the mailbox has been reached through a call flow containing a Leave Mail  action, the option
provided when 0 is pressed are: 

· For IP Office mode, the call follows the Leave Mail action's Failure or Success results
connections depending on whether the caller pressed 0 before or after the record tone.

· For Intuity mode, pressing 0 always follows the Reception / Breakout (DTMF 0) setting. 

· Breakout (DTMF 2) 
The number to which a caller is transferred if they press 2 while listening to the mailbox greeting rather
than leaving a message (*2 on embedded voicemail). For pre-5.0 systems this option is not support for
Voicemail Pro running in IP Office mailbox mode. 

· Breakout (DTMF 3) 
The number to which a caller is transferred if they press 3 while listening to the mailbox greeting rather
than leaving a message (*3 on embedded voicemail). For pre-5.0 systems this option is not support for
Voicemail Pro running in IP Office mailbox mode.

4.Click OK to save the voicemail changes for the user.

5.Amend any other user details, then save and merge the configuration changes.

Forward to Voicemail 
For IP Office 5.0+, the option To Voicemail is available for Forward unconditional on the User | Forwarding tab
within the IP Office configuration. When selected, the Forward Number set for Forward Unconditional is overridden and
calls are sent direct to the user's mailbox. 
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The option Forward Hunt Group calls is also overridden if To Voicemail is selected. 
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4.3 User Source Numbers
The Source numbers can be changed for individual users in IP Office Manager. The Source Numbers tab gives a list of
Dial In Source Numbers. Several of these numbers can relate to voicemail operation. The source number settings that
can be used for Voicemail Pro are:

· V<Caller's ICLID> = Voicemail Trusted Source Access. 
Strings prefixed with a v indicate numbers from which access to the user's mailbox is allowed without requiring
entry of the mailbox's voicemail code.

· When in Intuity mode users will still have to enter their voicemail code if they use the Messages button on
their telephone. However, If they have a button programmed to collect voicemail they can access their
mailbox without entering their voicemail code.

· H<Group Name> = Hunt Group Voicemail Indication. 
Allows the user to receive message waiting indication for new group messages. Enter H followed by the group
name, for example HMain for the group Main. See Hunt Group Message Waiting Indication .

· P<Telephone Number> = Voicemail Ringback Number. 
This entry sets the destination for callback (outbound alert) calls from voicemail. Enter P followed by the telephone
number including any necessary external dialing prefix, for example P917325559876. This facility is only
available when using Voicemail Pro through which a default Callback or a user specific Callback start point has
been configured. This feature is separate from voicemail ringback which alerts the user's own extension.

To add a source number:

1.Open IP Office Manager.

2.In the Navigation pane, click  User and select the individual user.

3.View the Source Numbers tab.

4.Click Add. 

5.Enter the number in the Source Number field at the bottom of the window.

6.Click OK and save the configuration file.
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IP Office Configuration: User Source Numbers

4.4 Hunt Group Settings
Voicemail can be configured for each hunt group on the IP Office system. This section looks at the basic voicemail
settings. For full details of other hunt group operation, see Hunt Group Voicemail . 

Voicemail Answer Time
For IP Office 4.0+, the condition under which calls targeted to a hunt group go to voicemail has been changed to a
timeout. For calls waiting to be answered, once this timeout expires the call is redirected to voicemail regardless of where
it is in the hunt group. 

Hunt Group Settings
1.Open IP Office Manager.

2.In the Navigation pane, click  Hunt Group and select the hunt group.

3.Select the Voicemail tab.

· Voicemail Code / Confirm Voicemail Code 
Enter a voicemail code between 1-15 digits in the Voicemail Code field. This is required when users retrieve
voicemail messages for the hunt group remotely, for example from an extension that is not a member of the
hunt group or from an external telephone.

· Voicemail Email: Default = Blank (No voicemail email features) 
This field is used to set the user or group email address used by the voicemail server for voicemail email
operation. When an address is entered, the additional Voicemail Email control below are selectable to
configure the type of voicemail email service that should be provided. 

· Use of voicemail email requires the voicemail pro server to have been configured to use either a local
MAPI email client or an SMTP email server account. See Voicemail Email Installation . 

· The use of voicemail email for the sending (automatic or manual) of email messages with wav files
attached should be considered with care. A one-minute message creates a 1MB .wav file. 
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· Voicemail Email Default = Off
If an email address is entered for the user or group, the following options become selectable. These control
the mode of automatic voicemail email operation provided by the voicemail server whenever the voicemail
mailbox receives a new voicemail message. 

· Users can change their voicemail email mode using visual voice . If the voicemail server is set to
IP Office mode , user can also change their voicemail email mode through the telephone prompts.
The ability to change the voicemail email mode can also be provided in a call flow using a Play
Configuration Menu  action or a Generic  action. 

· If the voicemail server is set to IP Office mode , users can manually forward a message to email. 

· Off
If off, none of the options below are used for automatic voicemail email. Users can also select this mode
by dialing *03 from their extension. 

· Copy
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, a copy
of the message is attached to an email and sent to the email address. There is no mailbox
synchronization between the email and voicemail mailboxes. For example reading and deletion of the
email message does not affect the message in the voicemail mailbox or the message waiting indication
provided for that new message. 

· Forward
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, that
message is attached to an email and sent to the email address. No copy of the voicemail message is
retained in the voicemail mailbox and their is no message waiting indication. As with Copy, their is no
mailbox synchronization between the email and voicemail mailboxes. Users can also select this mode by
dialing *01 from their extension. 

· UMS Exchange 2007
Voicemail Pro 5.0+ supports voicemail email to an Exchange 2007 server email account. For users
and groups also enabled for UMS Web Services this significantly changes their mailbox operation. The
Exchange Server inbox is used as their voicemail message store and features such as message
waiting indication are set by new messages in that location rather than the voicemail mailbox on the
voicemail server. Telephone access to voicemail messages, including Visual Voice access, is
redirected to the Exchange 2007 mailbox. See UMS Exchange 2007 Installation  and UMS
Exchange 2007 . 

· Alert
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, a
simple email message is sent to the email address. This is an email message announcing details of the
voicemail message but with no copy of the voicemail message attached. Users can also select this mode
by dialing *02 from their extension. 

· Voicemail On Default = On
When on, the mailbox is used by the IP Office to answer the user's unanswered calls or calls when the user's
extension returns busy. Note that selecting off does not disable use of the user's mailbox. Messages can still
be forward to their mailbox and recordings can be placed in it. The mailbox can also still be accessed to collect
messages. For other options Disabling a Mailbox .  

· Voicemail Help Default = Off
For voicemail systems running IP Office mailbox mode, this option controls whether users retrieving messages
are automatically given an additional prompt "For help at any time press 8." If switched off, users can still
press 8 for help. For voicemail systems running in Intuity emulation mode, this option has no effect. On those
systems the default access greeting always includes the prompt "For help at any time, press *4" (*H in the US
locale).

· Broadcast 
Select the option Broadcast if you want any voicemail messages left for the hunt group to be forwarded to
the mailboxes of the individual group members. The original message in the hunt group mailbox is deleted
after being broadcast. 

· UMS Web Service (IP Office 5.0+)
If selected, the hunt group mailbox can be accessing using UMS  via a web browser or an IMAP compatible
email application. 

4.Click OK and save the configuration.
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IP Office Configuration: Hunt Group Settings

4.5 Voicemail Channel Reservations
By default inbound calls routed from IP Office to voicemail are able to use any available voicemail channels, up to the
limit of the number of licensed channels , regardless of how many calls of the same type are already in progress.
However, if required, channels can be reserved for different types of inbound calls to the voicemail server. 

Voicemail channel reservations can be made for:

· Auto Attendant 

· Announcements 

· Voice recording 

· Mailbox access 

· Mandatory voice recording 

It is worth checking the voicemail channel reservations if there are problems. If insufficient voicemail channels are
available:

· Internal calls to an auto attendant are queued. The call will queue until a resource becomes available.

· Announcements are not heard by the caller, but the call is routed correctly.

· Manual voice recording is activated but no recording is made. The call will continue.

· Users are placed in a queue when trying to access their mailbox access.

· A user with mandatory recording on outgoing calls (internal and external) gets a busy tone.

· A call on a line with mandatory recording set will be barred.

To change voicemail channel reservations:

1.Open IP Office Manager and the load the configuration.

2.In the Navigation pane click  System and select the system.

3.Click the Voicemail tab. 

4.Amend the channel reservations as required. By default the values are 0. 
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To view the utilization of voicemail channels:

1.Open the System Status Application.

2.Click Resources. The System Resources summary is displayed. The following details are displayed:

· The number of voicemail channels available.

· The number of channels in use.

· Congestion information

Channel Restrictions

· The Voicemail Pro server has restrictions on the number of channels it can use for different types of outgoing calls
that it can make. These limits are separate for each of the cal types. When a limit is reached, further calls of that
type are delayed until one of the existing calls is completed. These limitations are not controlled by Voicemail
Channel Reservation  settings. 

· Outcalling can use up to 5 channels at any time. 

· Conference center invitation calls can use up to 5 channels at any time. 

· Callback calls can use up to 2 channels at any time. 

· Alarm calls can use up to 2 channels at any time. 
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5. Using the Voicemail Pro Client
5.1 Logging in to the Voicemail Pro Server
You can run the Voicemail Pro Client in offline mode and you can also use it to connect to a Voicemail Pro Server. 

To remotely connect to a Voicemail Pro Server with the Voicemail Pro Client, you will need to login using the name and
password of a Voicemail Pro administrator account already configured on the Voicemail Pro server. By default, the
Voicemail Pro Server does not have any user accounts defined. Therefore no remote Voicemail Pro Clients can connect. 

To start the Voicemail Pro Client:

1.From the Start menu, select Programs | IP Office | Voicemail Pro Client. 

2.The Voicemail Pro Client window opens. 

· Local Login 
If the Client and Server are installed on the same machine, you do not need a user name and password to log
in. The current settings and configuration of the Voicemail Pro server are automatically loaded into the
Voicemail Pro client. 

· Remote Login
If you are using the Voicemail Pro client to connect remotely to the Voicemail Pro server you need to login
using a Voicemail Pro account already configured on the server. 

· From the File menu, select Login. 

· Enter the User Name and User Password for the account. 

· In the Unit Name/IP Address field, type the name or the IP address of the server you want to connect
to. By default the IP address or name that was last used is already filled in. If the server is on the same
network you can click Browse to select from a list of available Voicemail Pro servers. 

· Click OK. 

5.2 Continue Offline Message Window
Only one Voicemail Pro client can be connected to a Voicemail Pro server at any time. To avoid access to the server being
blocked by a session of Voicemail Pro client that has been left connected, an idle timeout is used (the Client/Server
Connection Timeout (mins)  setting). By default the timeout is set to 5 minutes. 

If your Voicemail Pro client session has timed out, the Voicemail Pro client will prompt you whether it should attempt to
re-establish the session or close. You are then able to continue working in offline mode or to close the application. 
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Using the Voicemail Pro Client: Continue Offline Message Window

5.3 The Main Voicemail Pro Window
The Voicemail Pro Client is a Windows interface used to customize the Voicemail Pro Server.

The parts of the Voicemail Pro Client window are:

· Title Bar  
The title bar indicates the telephony interface that is being used, namely IP Office or Intuity. If you are working
offline, the title bar displays Offline. If you are working online, the name of the connected server is displayed. 

· Toolbar  
The toolbar across the top of the window provides access to the Voicemail Pro options via icons instead of the
menus. 

· Start Points  
The upper left Navigation pane contains an expandable/collapsible list of customizable voicemail start points.

· Modules  
The lower left Navigation pane contains a library of voicemail modules. 

· Details Pane  
The details pane shows information relating to the option selected in the left-hand panel. 
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5.4 Saving Changes and Making them Live
Voicemail Pro settings, such as call flow details, are stored in a database file (Vmdata.mdb). To be used by the
Voicemail Server they must be saved as a Root.vmp in the voicemail server folder. To find out how to set the location of
this folder, see Setting the Location of Voicemail System Files .

To save configuration changes without making them live:

1.Choose  Save as to save the database as a .vmp file with the name that you specify. You can then copy the file to
other systems.

 

To save configuration changes and make them live:

1.Choose  Save & Make Live to save the settings in a file called Root.vmp in the voicemail server folder.

If you are working remotely in Offline mode ,you are prompted to select whether to save your changes to the local
database or to the remote server.

 

5.5 Logging Out
It can be useful to connect to a system to download the current system configuration and then disconnect and make
changes offline. You can then test configuration changes offline before applying them to a live system.

To log out:

1.From the File menu, select Log Out. 

2.You are logged out of the Voicemail Pro server and placed in offline mode. You can either make configuration
changes offline and then log back in when you are ready or log on to a different server to work. See Logging in to
the Voicemail Pro Server .

Notes

· Logging out is not the same as closing down with the Exit option. See Closing Down .

· If the Client and Server are installed on the same machine, the Log Out option is not available.

 

5.6 Closing Down
When you have finished working, you can close down the Voicemail Pro Client. 

To close the Voicemail Pro Client:

1.From the File menu, select Exit.

2.If you have not made any changes, the Voicemail Pro Client closes and you are returned to the desktop. If you
have made changes, a message is displayed to ask whether you want to save them.

3.If you do not want to save your changes, click No. No changes are saved. If you want to save your changes, click
Yes. Your changes are saved but not yet made live.

4.If you are ready to make your changes live, click Save & make Live. 
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Using the Voicemail Pro Client: Closing Down

5.7 Changing Between Offline and Online Mode
It can be useful to connect to a system to get the current system configuration and then disconnect and make changes
offline. If the Voicemail Pro client and server are on the same machine, you can switch between online and offline mode
without having to log out.

To switch between online and offline mode:

1.From the File menu, select Select Mode. 

2.Select Offline to work offline or Online to connect to the server and work online. If you select Online, the normal
login process  continues. 

5.8 Administrator Accounts
When the Voicemail Pro client is used on the same PC as the voicemail pro server it connects automatically to that locale
server. No specific Voicemail Pro client user account is used. 

You can also use the Voicemail Pro Client remotely from another PC. However in order for it to connect remotely to the
Voicemail Pro server you will need to log in using the name and password of a Voicemail Pro client user account. By
default, the Voicemail Pro server does not have any user accounts defined and so cannot be accessed remotely. 

The process below is used to create a Voicemail Pro user account. There are two types of account, a standard client user
and administrator users. The key difference is that administrator users are able to setup other user accounts and change
user account details. 

To add a Voicemail Pro Client User Account

1.In the left hand navigation pane, select Voicemail Pro Administrators. The name, type and status of any
existing Voicemail Pro client administrators are displayed in the right hand pane.

2.Right-click on the right hand pane and select Add. 

3.Enter the details for the new Voicemail Pro client user: 

· User Name 
Enter a unique name for the Voicemail Pro client user account. The name must be at least 5 characters long
and must not contain spaces or any of the following characters: \ / : * ? < > | , ;.
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· New Password / Confirm Password
Enter and confirm the password for the account. The password must be at least 5 characters long and must
not contain spaces or any of the following characters: \ / : * ? < > | , ;.

· Type 
Select the type of account:

· Standard 
A standard account can perform administration of call flows using the Voicemail Pro Client. A standard
administrator can change their own password but cannot add, remove or modify other accounts. 

· Administrator  
This type of account can administer all settings including other Voicemail Pro client account settings. 

· Status 
By default new users are created as Inactive. Their status changes to Active when they connect to a
Voicemail Pro server.

4.Click OK.

5.Click  Save and Make Live to save the changes. The user created can now log into the Voicemail Pro Client
Server, for more information, see Logging in to the Voicemail Pro Server . 

If you are a standard user, you can change your own password when you are working in online mode. If you are working
offline, the Change Password option is not available. 

To change your password:

1.From the File menu, select Change Password. 

2.In the New Password box, type the new password.

3.In the Confirm Password box, retype the new password.

4.Save the changes.
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Using the Voicemail Pro Client: Administrator Accounts 

5.9 Confirm Call Flow Download Window
When you connect to a server across a LAN or WAN to view or modify the call flow on the server, a check is made to see
if the call flow that is stored locally on the Client machine is the same. The call flow on the server might be different to
the call flow on the Client because:

· The local call flow is older than the version on the server, for example if the call flow on the server has been
modified by another Client connection.

· The local call flow is newer than the version on the server, for example if the call flow on the server has been
worked on while the local Client was being used in offline mode.

· The local call flow is from a different server, for example if you are connecting to a different server to the one
from which the call flow was previously downloaded.

If the call flow is the same no data will need to be copied back from the server to the Client. If the call flow is different
you can chose to download the call flow from the server or to use the local call flow.

· Download 
Click to download the call flow from the server.

· Cancel 
Click this if you do not want to download the call flow from the server.

To upload the local call flow to the server, use the Save or Save and Make Live options from the File menu. See Saving
Changes and Making them Live .

 

5.10 Using the Details Pane
The information displayed in the main right-hand window of the Voicemail Pro client depends on what is currently
selected in the left-hand navigation windows. For instance, if Users is selected, details of all the user mailboxes and the
messages in those mailboxes is displayed. 
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5.10.1 Users / Groups
When you click on Users or Groups in the left-hand navigation pane, the right-hand pane displays information about the
user or group mailboxes. 

When you right-click on a mailbox a number of options are available: 

· Add Start Points / Edit Start Points / Delete Start Points 
If the mailbox has any customized call flow start points setup, they are listed in the Callflows Assigned column.
These options allow you to add additional start points. A list of start point types is displayed which you can then
select or deselect. Selecting an option will create a matching start point for the mailbox. Deselecting an option will
delete the matching start point and any content. 

· Clear Mailbox (Voicemail Pro 5.0+)
This option will reset the mailbox. All existing messages are deleted and any prompts such as the user name and
greetings. The mailbox password is not reset. 

· Disable Mailbox (Voicemail Pro 5.0+)
This option will stop the mailbox from being used to receive messages. This includes the forwarding of messages
to the mailbox and manual or automatic recording placing recordings into the mailbox. If selected we recommend
that the Voicemail On setting within the IP Office configuration is also disabled, that will stop the IP Office from
attempting to use the mailbox. This option does not affect any existing messages in the mailbox. Disabled
mailboxes are listed as DISABLED in the Last Accessed column. See Disabling a Mailbox . 293
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Using the Voicemail Pro Client: Using the Details Pane

5.10.2 Voicemail Pro Administrators
By clicking on Voicemail Pro Administrators in the left-hand pane, you can view all the existing accounts and their
current status. 

You can also use the Voicemail Pro Client remotely from another PC. However in order for it to connect remotely to the
Voicemail Pro server you will need to log in using the name and password of a Voicemail Pro client user account. By
default, the Voicemail Pro server does not have any user accounts defined and so cannot be accessed remotely. 

The process below is used to create a Voicemail Pro user account. There are two types of account, a standard client user
and administrator users. The key difference is that administrator users are able to setup other user accounts and change
user account details. 

To add a Voicemail Pro Client User Account

1.In the left hand navigation pane, select Voicemail Pro Administrators. The name, type and status of any
existing Voicemail Pro client administrators are displayed in the right hand pane.

2.Right-click on the right hand pane and select Add. 

3.Enter the details for the new Voicemail Pro client user: 

· User Name 
Enter a unique name for the Voicemail Pro client user account. The name must be at least 5 characters long
and must not contain spaces or any of the following characters: \ / : * ? < > | , ;.

· New Password / Confirm Password
Enter and confirm the password for the account. The password must be at least 5 characters long and must
not contain spaces or any of the following characters: \ / : * ? < > | , ;.

· Type 
Select the type of account:

· Standard 
A standard account can perform administration of call flows using the Voicemail Pro Client. A standard
administrator can change their own password but cannot add, remove or modify other accounts. 

· Administrator  
This type of account can administer all settings including other Voicemail Pro client account settings. 

· Status 
By default new users are created as Inactive. Their status changes to Active when they connect to a
Voicemail Pro server.

4.Click OK.

5.Click  Save and Make Live to save the changes. The user created can now log into the Voicemail Pro Client
Server, for more information, see Logging in to the Voicemail Pro Server . 

If an administrator tries unsuccessfully to log in to the Voicemail Pro Client 3 times consecutively, their account is locked
and cannot be used for an hour. As an administrator you can release a locked account by changing its Status back to
Inactive. 
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5.10.3 Server Queues
The following options are new in Voicemail Pro 5.0+. 

5.10.3.1 User Variables

The Voicemail Pro client allows you to define user variables for the system that are then useable within any call flows.
User variables differ from call variables in that they are system wide values that can be shared between all calls while call
variable values differ from call to call. 

Within a call flow a  Set User Variable  action can be used to set or change the value of a user variable. This
includes using the current value of a call variable  to set as the new value for the user variable. 

Call flows can also be branched using a  Test User Variable  action to check the current value of the variable
against a required value.

The existing value of a user variable can also be obtained using the variable $REG[<variable_name>] in call flows. 

By clicking on User Variable in the left-hand pane, you can view all the existing user variables and their current values. 

To add and delete user variables and to change the current value you can right-click on the variable and select the
required option. For example select Modify to change the value.
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Example of Using User Variables

1.Add a variable called Reception.

2.Two start points need to be created, one for indicating when the reception is open, the other for when the
reception is closed. When completed the call flows will look similar to the examples shown.

· Create a start point called ReceptionOpen and connect it to a Set User Variable action. The Set User
Variable action needs to have the user variable Reception assigned with the value Open.

· Create a start point called ReceptionClosed and connect it to a Set User Variable action. The Set User
Variable action needs to have the user variable Reception assigned with the value Closed.

3.Create the matching short codes on the telephone system.

4.For calls using another start point, you can now use the Test User Variable action to test whether the value of
reception is open. The action has true and false results which you can link to the appropriate following actions,
for example transferring calls to the reception desk or to a mailbox.
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5.10.3.2 Alarms

The Voicemail Pro client can display the alarm calls that have been configured for the Voicemail Pro to perform. These
can be setup through call flows using the Alarm Set  action or directly through the Voicemail Pro client. 

· The Voicemail Pro is limited to 2 outgoing alarm calls at the same time (subject to voicemail port availability). Any
additional alarm calls are delayed until the existing alarm calls have been completed. 

· To delete an existing alarm, right click on it and select Delete. 

· To add an alarm right click and select Add, then use the settings below. 

· To modify an alarm right click on it and select Modify. 

· Time (hh:mm) 
Set the alarm time in 24-hour format (hh:mm or hhmm). A time value can be entered or a call
variable  can be used. If left blank or an invalid time value, the call flow user is asked to enter a
time the same as if Ask Caller was selected. 

· Frequency 
Sets how often the alarm should occur. The options are Single, Daily or Weekly. A variable with
value 1, 2 or 3 respectively can be used. 

· Day 
Useable with Single and Weekly alarms. Set the day for the alarm. The option Today is also
available for alarms where the Frequency is set as Single. 

· File 
This field is optional. If a file is specified here it is used for the alarm call. If no file is specified the
default alarm message ("This is an alarm call, please hang up") is used. 

· Display Text 
By default the alarm will display "Alarm" on the target if it is an Avaya display phone. This field can
be used to customize the text used. 
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Using the Voicemail Pro Client: Using the Details Pane

5.10.3.3 Outcalls

When you click on Outcalls in the left hand navigation pane, details of any currently set calls are displayed in the right
hand pane. These are calls being made by the voicemail server. 

The types of calls that are displayed are listed below. The voicemail server may also be configured for alarm calls, those
are displayed on a separate alarms page  on which they can also be configured. The information displayed for the calls
are: 

· Type 
The type of outgoing call. 

· Conference
These are conference invite calls being made by the voicemail server on behalf of the IP Office Conferencing
Center application. 

· Callback 
These are new message notification calls being made for mailbox users configured for remote callback . 

· Outbound Alert 
These are new message notification calls being made for mailbox users configured for outcalling . 

· Created 
The time and data at which the outgoing call was configured on the voicemail server. 

· State 
The current state of the outgoing call. The options are: Failed, IN Progress, Conference, Queued and Suspended. 

· Attempts 
The number of times the voicemail server has attempted to place the alert call. 

· Next Attempt 
The time and data of the next outgoing call attempt. 

· Target 
The target number for the next call attempt. 

Channel Restrictions

· The Voicemail Pro server has restrictions on the number of channels it can use for different types of outgoing calls
that it can make. These limits are separate for each of the cal types. When a limit is reached, further calls of that
type are delayed until one of the existing calls is completed. These limitations are not controlled by Voicemail
Channel Reservation  settings. 

· Outcalling can use up to 5 channels at any time. 

· Conference center invitation calls can use up to 5 channels at any time. 

· Callback calls can use up to 2 channels at any time. 

· Alarm calls can use up to 2 channels at any time. 
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5.11 Toolbar Icons
The Voicemail Pro screen includes the following icons. These may be grayed out according to which area of the Voicemail
Pro screen is currently active. 

·  Save as

·  Save and Make Live

·  Cut

·  Copy

·  Paste

·  Add Start Point

·  Edit Start Point

·  Delete Start Point

·  Preferences

·  User Defined Variables

·  Conditions Editor

·  Campaigns

·  Connection

·  Basic Actions

·  Mailbox Actions

·  Configuration Actions

·  Telephony Actions

·  Miscellaneous Actions

·  Condition Actions

·  Database Actions

·  Queue Actions
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Using the Voicemail Pro Client: Toolbar Icons

5.12 Importing and Exporting
You can import or export the voicemail call flow as a .mdb database file. Exporting the configuration is a recommended
step when upgrading a voicemail system . 

You can also import and export selected modules as a .mod file. This allows you to develop and test modules on one
system before moving them to another. 

Voicemail Pro 5.0+ also allows you to import and export selected conditions as a .con file. 

Important

· Importing and exporting does not apply to prompts. Prompts must be moved as separate items or re-recorded.

· When you import a database file the contents of the existing database are replaced. 

· When you import modules or conditions, any existing module or condition with the same name is overwritten. 

 

To export a file:

1.From the File menu, select Import or Export.

2.Select Export Data and click Next.

3.Enter the name of the file that you want to export. Add the extension .mdb for the whole database, .mod for
modules or .con for conditions. Alternatively, click Browse, select the type of file to export.

4.Click Open. and click Next.

5.Module and condition files can contain several modules or conditions, select the ones required. Click Next.

6.Click Finish. The selected file is exported.

7.Click Close.

 

To import a file:

1.From the File menu, select Import or Export.

2.Select Import Data and click Next.

3.Enter the name of the file that you want to import or click Browse to select the file. 

4.Click Open and click Next.

5.Module files can contain several modules, select the module required. Click Next.

6.Click Finish. The selected file is imported.

7.Click Close.

8.Click  Save & Make Live before you close the Voicemail Pro Client to apply the imported file. The existing
database is overwritten and a backup copy is saved in the folder DB Backup.
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5.13 Including Other Files
In some special circumstances it may be necessary to include the settings of an existing .vmp file into the Voicemail Pro
settings.

To include other files:

1.From the File menu, select Includes. The Configuration Includes window opens.

2.Click , the New Include File opens.

3.Select a file to include.

4.Click Open.

5.Click Update to update the Voicemail Pro file settings.

Notes

· If you use included files, the Voicemail Pro database contains only a pointer to the name and location of the files
and not the actual files. Therefore you should not move or rename an included file. It is strongly recommended
that before you include a file, you place it in the same folder as Root.vmp.

· Click  if you need to remove an included file. The highlighted file is removed but not deleted.
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Using the Voicemail Pro Client: Including Other Files

5.14 Start Points
Voicemail Pro consists of a number of start points. When the voicemail server receives a call, it looks for a matching start
point and if it finds one it then provides a series of actions linked to that start point. If no match is found then it provides
standard voicemail functions to the call.

The Navigation pane contains an expandable and collapsible list of start points. These can be start points for individual
users, hunt groups, short codes and default start points.

·  Specific Start Points 
This folder contains the start points for users, groups and short codes.

·  Users  
This folder contains start points set up for individual users. When selected a list is shown in the details pane
containing the mailbox owners names and the names of any call flows that have been assigned to the selected
mailbox.

 This is a user who has one or more start points configured. It can be expanded to show the different start
points.

·  Collect - Used when the user rings voicemail.

·  Leave - Used for calls to the user that are redirected to voicemail.

·  Callback - Used when voicemail rings a user to inform them of messages in the user's mailbox.
See Setting up Voicemail Pro Callback .

·  Queued & Still Queued - Used when calls to the user are queued. See Personal Announcements
.

·  Groups  
This folder contains start points set up for hunt groups. When selected a list is shown in the details pane
containing the mailbox owners names and the names of any call flows that have been assigned to the selected
mailbox.

 This is a group that has one or more start points configured. It can be expanded to show the different
start points.

·  Collect - Used when someone accesses the group's mailbox.

·  Leave - Used when calls to the hunt group are redirected to voicemail.

·  Queued & Still Queued - Used when calls to the group are queued. See Customizing a Hunt
Group Call Flow .
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·  Short Codes 
This folder contains any start points set up for particular short codes. Short code start points require the
Telephone Number entry of the matching short code in the IP Office Manager to be set up in a particular way. For
example, if a Start Point for short code *88 is set up, the settings for short code *88 in the IP Office Manager
application must be as follows:

· Short Code: *88

· Telephone Number: *88

· Feature: Voicemail Node. 
The above will allow internal callers to access the start point. To allow external callers access, an
Incoming Call Route should be set up with the destination *88.

·  An individual short code on the IP Office. This requires a matching special short code to be set up
in Manager.

·  Default Start Points 
Rather than set up individual start points for every user and group, you can also program actions against the
default start points. These will then be used for all calls received by the Voicemail Server that don't match a
specific start point. See Default Start Points .

·  Voicemail Pro Administrators  
When the Voicemail Pro Administrators folder is selected a list is displayed in the details pane. The list contains the
name, type and status of the administrators. Details can be added, amended or deleted. 

·  Server Queues  
These option allow you to view listing of a range settings. 

· User Variables

· Alarms

· Outcalls

·  Modules  
Modules are reusable sets of actions. They allow you to create a sequence of actions that you can then use within
any other start point's call flow. Any changes to the module will affect all the start points using that module. This
simplifies the programming of actions if a number of start points use the same sequence of actions. Using modules
also reduces the size of the call flow.
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Using the Voicemail Pro Client: Start Points

5.14.1 Default Start Points
The default start points can be used to create a sequence of actions that will be applied to all suitable calls unless a
specific start point exists.

·  Collect 
Used when a caller attempts to access a mailbox.

·  Leave 
Used when a caller is redirected to voicemail.

·  Callback 
Used when the voicemail calls a user to inform them about messages in a mailbox. See Setting up Callback .

·  Queued 
Used for callers queuing for a hunt group or user. See Customizing Queue Announcements .

·   Still Queued 
Used for callers queuing for a hunt group or user. See Customizing Queue Announcements .

 

When a default start point is used, the following actions can attempt to recognize who the presumed user is (the internal
user calling or being called) and access the matching mailbox for that user unless the action specifies another mailbox.

· Get Mail Action. 

· Leave Mail Action. 

· Play Configuration Menu.

· Listen Action. 

· Record Name Action. 

· Edit Play List Action. 

 

The following actions will automatically recognize who the presumed user is and then use that user's voicemail reception
settings unless the action specifies another mailbox.

· Transfer Action. 

· Assisted Transfer Action. 

· Whisper Action. 
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5.14.2 Using Start Points
Start points can be for individual users, hunt groups, short codes or default start points. All start points can be added, 
edited , renamed  or deleted .

To add a start point for a User or Group:

1.Either click Users or Groups and then . The Adding a new window opens. Alternatively, right-click 

Users or Groups and select Add.

2.Select the name that matches the user or group on the telephone system. To add all users or groups check the
option Add all users.

3.Select the types of start points required. The start points Collect, Leave, Callback, Queued and Still Queued
are available for both users and groups.

4.Click OK.

 

To add a start point for a short code:

1.Click Short Codes and then . The Adding a new short code window opens. Alternatively, right-click 
Short Codes and select Add.

2.Enter the short code.

· Short code start points require the telephone number entry of the matching short code in the IP Office
Manager application to be set in a specific way. For example, if a start point for short code *88 is set up the
settings for short code *88 in the manager application must be as shown below. The short code will allow
internal callers to access the start point. To allow external callers access, an Incoming Call Route should be
setup with the extension *88.

· Short code: *88

· Telephone number: *88

· Feature: Voicemail Node.

3.Click OK.

To edit a start point:

1.In the Navigation pane of the main Voicemail Pro window, select the start point to edit and click . The Editing
start point window opens. Alternatively, right-click the start point and select Edit.

2.Make the required changes.

3.Click OK.

 

To delete a start point:

1.In the Navigation pane, select the start point to delete and click . Alternatively, right-click the start point and
then select Delete.

2.You are asked if you are sure that you want to delete the selected start point.

· Click Yes to delete the start point.

· Click No to cancel the deletion.

 

To rename a user, group or short code start point:

1.In the Navigation pane, right-click the user, group or short code and select Rename. The New start point name
window opens.

2.Type the new name.

3.Click OK. The start point is renamed.
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Using the Voicemail Pro Client: Start Points

5.14.3 Viewing Call Flows as Text
For support calls and diagnostic purposes it can be useful to view Voicemail Pro modules and start points as text files.
You can then display the contents of the text file on the screen. The file can be changed as you would change any other
text file.

To view a start point or module as text:

1.Select File menu | View as Text. A Notepad window opens. The txt file contains information of all Conditions and
Campaigns as well as all call flow details.
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5.15 User Variables
The Voicemail Pro client allows you to define user variables for the system that are then useable within any call flows.
User variables differ from call variables in that they are system wide values that can be shared between all calls while call
variable values differ from call to call. 

Within a call flow a  Set User Variable  action can be used to set or change the value of a user variable. This
includes using the current value of a call variable  to set as the new value for the user variable. 

Call flows can also be branched using a  Test User Variable  action to check the current value of the variable
against a required value.

The existing value of a user variable can also be obtained using the variable $REG[<variable_name>] in call flows. 

By clicking on User Variables  in the left hand navigation pane you can view all the user variables and their current
values. This pane can also be used to add and modify the user variables including changing their values. 

To add a user defined variable:

1.Click  or press F8. The User defined variables window opens.

2.Click . The Add user defined variable window opens.

3.Type a name for your new variable.

4.Click OK. The new variable is added to the list.
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Using the Voicemail Pro Client: User Variables

Example of Using User Variables

1.Add a variable called Reception.

2.Two start points need to be created, one for indicating when the reception is open, the other for when the
reception is closed. When completed the call flows will look similar to the examples shown.

· Create a start point called ReceptionOpen and connect it to a Set User Variable action. The Set User
Variable action needs to have the user variable Reception assigned with the value Open.

· Create a start point called ReceptionClosed and connect it to a Set User Variable action. The Set User
Variable action needs to have the user variable Reception assigned with the value Closed.

3.Create the matching short codes on the telephone system.

4.For calls using another start point, you can now use the Test User Variable action to test whether the value of
reception is open. The action has true and false results which you can link to the appropriate following actions,
for example transferring calls to the reception desk or to a mailbox.
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5.16 Call Variables
A number of call variables exist which can be used to perform tasks. For example, $NAM can be used to speak the user's
name within an action's entry prompt. Call variables can also be checked by the compare element in a condition and then
branch the call flow according to the variables value.

Unless otherwise stated, call variables are session based. This means that the variable values are specific to a particular
call within Voicemail Pro and does not persist between calls, including calls transferred from the Voicemail Pro which then
return. Also unless otherwise stated the values are 'read-only'. 

· When accessing voicemail prompts, voicemail variables  can be used in both the path and filename for
the prompt. For example, if prompts Greeting1.wav,  Greeting2.wav etc. are recorded, an action set to
play Greeting$KEY.wav would play the greeting prompt that matched the current value of $KEY. 

Speaking Variables to Callers 
Call variables can be used as prompts. The value of the call variable will then be spoken. This applies to all variables that
are numeric values. It also applies to $NAM which will play the mailbox users recorded name prompt. 

Numbers are spoken as a series of single digits. For example 123 is spoken as "one two three". To speak 123 as "one
hundred and twenty-three" requires TTS to be installed and a Speak Text  action used.

Some call variables can be played as prompts, for example:

· $NAM 
Plays the mailbox's name prompt if one has been recorded.

· $CLI 
Speaks the caller's CLI.

· $RES 
Plays the current result if it is a .wav file.

· $VAR 
Plays the variable as a list of digits.

Variable Length 
The length of the value stored within a variable is limited. For Voicemail Pro 4.2+ this limit has been increased from 64
characters to 512 characters. 
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Using the Voicemail Pro Client: Call Variables

Available Variables

Variable Write Description

$CID Contains the unique call ID that the IP Office assigns to all calls that it handles. The same
call ID is shown in IP Office SMDR records. 

$CLI Holds the CLI of the caller if available to the IP Office. 

$COUNTER Voicemail Pro 5.0+ provides counter variable $COUNTER1 to $COUNTER15. These can be
used in the same way as other variables. They can also be manipulated using  Generic
action commands for Set Counter , Clear Counter , Counter Decrement  and
Counter Increment . They can also be used with the Decrement and Test Counter

 and Increment and Test Counter  actions. By default the initial value of a
counter variable is 0.  The formats $COUNTERx or $COUNTER[x] are both supported.

$CP The 16 variables $CP0 to $CP15 are used to store values (call parameters) for the
duration of a call within the call flow. Values can be written into these variables using the 
Generic  action command CPx:<value> where x is 0 to 15 and <value> is the value
to be stored. The formats $CPx or $CP[x] are both supported.

$DBD A set of 6 variables $DBD[0] to $DBD[5] for fields extracted from a current database
record. See Database Actions .  The formats $DBDx or $DBD[x] are both supported.

$DDI Holds the DDI of the call if available. (Voicemail Pro 4.1+)

$ETA Holds the expected time to answer in seconds for a queued caller. This time is based on
the last 5 queued and answered calls for the same target in the last hour. The variable can
be used to speak the value as a prompt or to test the value in a condition. Only available
when using hunt group Queued and Still Queued start points.

$KEY Holds the last DTMF key series entered. For more information, see Example Call Flow .

$LOC Holds the locale setting for the call passed by the IP Office system. See Changing the
Language of Custom Prompts . 

$NAM Holds the name of the mailbox user (blank for short codes). If used as a prompt, the
mailbox's recorded name prompt is played. 

$POS Holds the position of a queued caller. Can be used to speak the position as a prompt or
test the value in a condition. Only available when using Queued and Still Queued start
points.

$QTIM The same as the $ETA above but returns the estimated time to answer rounded up to the
nearest minute. This variable can be used to speak the value as a prompt or to test the
value in a condition.

$REG[name] When used, this variable returns the current value of the named user variable. 

$RES Holds the value of the result of the previous action. For example when a call flow has been
branched by an action that has True and False results, on one branch the value of $RES
is "True", on the other "False".

$SAV Holds the last saved result. This can be entered using the following entry in a Generic
action, Save:<value>, for example Save:$KEY or Save:1234.

$TARGET For calls sent by the IP Office to a mailbox, this variable contains the original target of a
call, ie the original target user or hunt group. (Voicemail Pro 4.2+)

$TimeQueued Holds the length of time, in seconds, that the call has been part of a particular hunt group
queue. Only available when using Queued and Still Queued start points. (Voicemail Pro
4.1+)

$TimeSystem Holds the length of time, in seconds, since the call was presented to the IP Office system.
Only available when using Queued and Still Queued start points. (Voicemail Pro 4.1+)

$UUI Available when a recording is triggered by auto-recording. Holds the user name, hunt
group name or account code that triggered the auto-recording process. See Customizing
Auto Recording .

$VAR A general variable which can hold amongst other things DTMF key sequences.

· Write 
This column indicates those call variables where the existing value can be changed using methods such as
VBScript or generic action commands. Other call variables have a fixed value set when the call is received by the
voicemail server or, for $DBD values, the value is requested by the voicemail server. 
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5.17 Creating Modules
Modules are reusable sets of actions. They allow you to create a sequence of actions that can be reused in another call
flow.

Any changes to a module will affect all other start points that are using that module. This simplifies the programming of
actions if a number of start points use the same sequence of actions. Using modules also reduces the size of a call flow.

· To create connections from a module to other actions you must use the Module Return action within the module, see
Module Return Action .

To create a module

1.Click Modules and then . The Adding a new start point window opens. Alternatively, right-click Modules and
select Add.

2.Enter a name for the module. This should not match any user or group name on the IP Office.

3.Click OK. You can now add actions and connections to the module in the same way as for any start point.

 

To add a module to a start point

1.Select the start point to which you want to add the module action and then click the right-hand panel.

2.Click and drag the module required from the Navigation pane to the Details pane.

 

For support calls and diagnostic purposes it can be useful to view Voicemail Pro modules and start points as text files.
See Viewing Call Flows as Text .

 

5.17.1 Running a Module
Modules can be run internally using short codes or can be configured for external calls.

Run a module from a short code 
You can use modules directly in conjunction with short codes. The short code must call the name of the module. This
example short code will run the module called Special when a user dials *97. The service that the user receives will
depend on the actions in the module.

· Short code: For example *97

· Telephone Number: "Special" (include quotation marks)

· Line Group ID: 0

· Feature: Voicemail Collect

 

Run a module for an external call 
A module can be applied directly to an incoming (external) call from within the IP Office Manager application. Within the
appropriate Incoming Call Route entry, set the Destination to the module name prefixed with "VM:".

For example, enter VM:AutoAttend to route a call to a module called AutoAttend. Note that the maximum entry length
is 15 characters. This means that the module name is limited to 12 characters.

· If there is a hunt group on the system whose name matches the module name, calls will be routed to that group
when the voicemail server is not running.
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5.18 The Conditions Editor
Conditions are constructed from a set of basic elements. These elements can be combined within a single condition to
create complex rules. For example, the week planner can be used to define a company's standard working hours and
then combined with the calendar to define exception days such as public holidays.

Within the voicemail call flow, conditions can be checked by a test condition action and, according to whether the
condition is currently true or false, callers can be routed to different actions. See Test Condition Action .

Condition Elements
The following different types of elements can be added to a condition. 

·  Calendar  
Select days from the calendar (up to 255 days) which, if the current date matches a selected day, cause the
element to be 'true'. 

·  Week Planner  
Select days of week, and then a time period on each of those days, that should cause the element to be 'true'. 

·  Condition  
Select an existing condition that is then used as an element within another condition. 

·  Compare  
Compare one value to another using a selected criteria such as "Is equal to" or "Is greater than or equal to" and
return 'true' when the criteria is meet. The values compared can be the current value of call variables  and or
number values entered directly.

Logic Settings
Logic settings can be applied to both the whole condition and to the elements in a condition. These can alter when a
condition is true or false. 

·  AND 
The condition is true when all the elements within it are true, for example both A and B are true.

·  OR 
The condition is true when any element within it is true, for example if the day is Monday or Tuesday.

·  NOT 
This logic element can be used to reverse the value (e.g. return false when true) of individual elements or of the
whole condition.
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5.18.1 Using the Condition Editor
You can add elements  to existing conditions, change the logic  of a condition and delete  elements and
conditions.

 

To start the Condition Editor:

1.Click the  icon. You can also open the Condition Editor by pressing F6 or click Administration > Condition
Editor.

2.When the Condition Editor is started, any existing conditions are shown. In the example there are no conditions.

To add a new condition:

1.Click the  icon in the toolbar. The New Condition window opens.

2.Enter the name for the condition and then click OK.

3.The new condition is placed in the Condition Editor window. The condition is represented by the icon 
followed by the condition name.

When a condition has been created, elements can be added and altered. A condition can consist of multiple elements,
including several elements of the same type. In the example there are conditions added complete with elements.
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To add elements to a condition:

1.Click the  Element List icon in the toolbar.

2.Click the type of element required.

·  Calendar - See Calendar .

·  Week Planner - See Week Planner .

·  Compare - See Compare .

·  Condition - See Condition .

3.Click  Condition Name in the Condition Editor window. The element icon is added.

4.You can now edit the element's settings.

 

To edit elements:

1.Select the element, click  Edit icon in the toolbar. The element's properties window opens. Alternatively,
double click the element to open the properties window.

2.Make any changes.

3.Click OK to save the changes and close the properties window.

 

To change the logic setting of a condition:

1.Click Logic icon in the toolbar.

2.Select the required logic.

· x|| (OR)

· x+ (AND)

· x! (NOT).

3.In the Condition Editor window, click the element to apply the logic to. The logic indicator changes.

To change the name of a condition:

1.Select the condition, click  Edit icon in the toolbar. The Rename condition window opens.

2.Amend the condition's name.

3.Click OK.

 

 To delete elements and conditions:

1.Select the condition or element to be deleted.

2.Click  icon in the toolbar. The selected condition or element is deleted.
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5.18.2 Calendar

 Select days from the calendar (up to 255 days) which, if the current date matches the selected day, return 'true'. 

Double-click a day to select or deselect the day. Selected days are shown with a green background, for example .

Note that a grey background  indicates weekend days, not whether the day is selected or not. 

· Multiple Day Logic 
By default a logical OR X|| is applied to this condition element. This allows the element to be true if any of the
selected days is true. If a logical AND X= is used and more than one day is selected, the element cannot return
true. 

Note that days that are selected and are now in the past are not automatically deselected. 

To add a calendar element:

1.Click the  Element List icon in the toolbar.

2.Click  Calendar.

3.Click on the condition to which the element should be added. 

4.Double-click on the element to view its settings. 

5.Double-click on the individual dates to select or deselect them. 

6.Click OK.
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5.18.3 Week Planner

 The Week Planner element is used to set which time periods during a normal week return 'true'. It consists of an
entry for each day of the week and a start and end time for the 'true' period on each day.

· Multiple Day Logic 
By default a logical OR X|| is applied to this condition element. This allows the element to be true if any of the
selected days is true. If a logical AND X= is used and more than one day is selected, the element cannot return
true. 

 

To add a Week Planner element:

1.Click the  Element List icon in the toolbar.

2.Click  Week Planner.

3.Click on the condition to which the element should be added. 

4.Double-click on the element to view its settings. 

5.Select the days required and the time period during each day that will return 'true'. 

6.Click OK.



Voicemail Pro Page 148
15-601063 Issue 21c (16 July 2009)IP Office 5.0

5.18.4 Condition

 The Condition element is used to combine the value of an already existing condition. When selected the element
displays a list of the other conditions from which to select.

To add a condition element:

1.Click the  Element List icon in the toolbar.

2.Click  Condition.

3.Click on the condition to which the element should be added.

4.Double-click on the element to view its settings.

5.Select the existing condition that you want to use.

6.Click OK.

 

Example: 
Two conditions have been created:

· Using a Week Planner  element, a condition is created so that calls received between 09:00 and 18:00, Monday
to Friday are treated differently to calls received outside of these hours. For more information.

· Using a Calender  element, a condition is created so that calendar dates such as public holidays can be
accounted for.

· The two conditions need to be combined so that the call flow treats calls during working hours differently to calls
received outside working hours and on bank holidays.

1.Click the  Element List icon in the toolbar.

2.Click  Condition.

3.Click the Week Planner in the Condition Editor window. The  condition is placed in the Condition Editor
window.

4.Open the properties of the condition element by double-clicking .

5.Select the Calendar condition result.

6.Click logic options and select a  NOT action. Click  Condition to apply the logical option.

7.Click OK. The condition is now true when it is between 09:00 and 18:00, Monday to Friday and not a holiday.
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5.18.5 Compare

 The Compare element is used to add a variable that will be used to determine the call flow to be presented to the
caller. You can compare Voicemail Pro call variables , for example $POS or $ETA, against each other or against a value
you enter.

To add a condition element:

1.Click the  Element List icon in the toolbar.

2.Click  Compare.

3.Click on the condition to which the element should be added. 

4.Double-click on the element to view its settings.

· Value A 
Enter a value or use the drop down to select a call variable . 

· Is 
Select the criteria which should be used to determine whether the element is currently 'true' or 'false'. Options
are: 

· Equal to 
True if value A equals values B (A = B).

· Not equal to 
True if value A does not equal value B (A =! B).

· Less than 
True if value A is less than value B (A < B).

· Greater than 
True if value A is greater than value B (A > B).

· Less than or equal to 
True if value A is less or equal to value B (A <= B).

· Greater than or equal to 
True if value A is greater than or equal to value B (A >= B).

· Value B 
Enter a value or use the drop down to select a call variable . 

5.Click OK.
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Voicemail Pro Actions

Chapter 6.



Voicemail Pro Page 152
15-601063 Issue 21c (16 July 2009)IP Office 5.0

6. Voicemail Pro Actions
When a start point  has been added, it can be linked to an action. Each action can have one or several results,
depending on the type of action, and each result can be linked to a subsequent action. In this way you can build up a call
flow.

Each action can have a number of results (true, false, no answer, busy). The types of results depend of the type of
action, most actions having just a 'Next' result. Each result can be used as a connection point to another action. See 
Connections .

A set of actions and connections can be combined and reused as a module. Modules  are reusable sets of actions. They
allow you to create a sequence of actions that you can then use within any other start point's call flow. Changes to the
module will affect all start points using that module. This simplifies the programming if a number of start points need the
same sequence of actions. 

You can double-click an action to display the properties in a series of tabs. Many actions share the same standard tabs
but each usually also has a specific tab that contains options unique to that action's function.

The standard tabs of an action are:

· General
Set a name for the action in the call flow and whether a PIN code is required by callers to use the action. 

· Entry Prompts
Sets the prompts that should be played to callers that reach the action. 

· Reporting
Use to provided reporting on calls that use the action. The reporting is done through the IP Office CCC or IP Office
SBCC applications. 

· Results
Displays the results configured for the action. Each result can be connected to a further action in the call flow.  

 

To add an action:

1.Select the start point to which you want to add an action.

2.Click in the Details pane.

3.Click Actions and select the type of action that you want to add from the list, for example Basic Actions.

4.From the submenu, select the required action. For example, if you selected Basic Actions, you might choose Speak
Text. The cursor changes to show that you have selected an action to add. Alternatively on the toolbar, click the
icon for the required type of action and then select an action from the submenu.

5.Click in the details pane, where you want to place the action. The new action is added. You can now edit the action
and add connections to it.

 

You can change the properties of an action. For example, If you selected the Speak Text action you can specify the actual
text to be spoken when an action is taken.

To edit an action:

1.Double-click the action in the details pane or right-click it and select Properties. The Properties window opens.
Details of the selected action are contained in a set of tabs.

2.Select a tab and change the action properties as required.

3.Click OK when you have finished.

 

To delete an action:

1.In the Details pane where the actions are displayed, click the action to delete.

2.From the Edit menu, select Delete or right-click the action and select Delete.

3.The selected action is deleted.
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Voicemail Pro Actions:  

6.1 Connections
The actions that are added to a start point must be connected before they can be used. The sequence of the connections
determines how the call is routed through voicemail.

Each action can have a number of results (for example True, False, No Answer and Busy). The types of results depend
of the type of action. For each result, a connection can be added.

· Most actions only have a Next result, i.e. a single connection to the next action.

· Other actions may have two results, for example True or False. Each of these results represents a connection
point for different following actions.

· Some actions may have multiple results. For example, the Assisted Transfer action has results for Next, No
Answer and Busy. Each of these results represents a connection point for different following actions.

· If a result occurs, for which no connection to a following action has been set, either the call is disconnected or, if it
came from a hunt group queue, it is transferred back to the queue.

· Within modules, all connections should end in another action or in a Module Return action.

 

To add a connection:

1.Click the icon.

2.Click and drag the cursor from action's result that triggers the connection to the action that should follow the
connection.

 

To delete a connection:

1.Click the connection to delete. It is displayed in red.

2.Press Delete. The connection is removed. Alternatively, either select Edit and then Delete or right-click and then
select Delete.
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6.2 Available Actions
Once a start point has been added, it can be linked to an action. The available actions are divided into the following
groups:

·  Start Point  
This special action is present by in all call flows. It is simply the start point for the call flow to which other actions
can be linked. While this action has General, Entry Prompts, Reporting and Results tabs they should not be
used. Any settings added to those tabs will be ignored and should be applied through the tabs of the first
additional action added to the call flow and linked to the Start Point. 

 Basic Actions
These actions are chiefly used to control the routing of a call between actions.

·  Generic Action
Can be used to simply play a prompt to the caller through its Entry Prompts tab. It can also be used to enter
custom commands for the voicemail server.

·  Speak Text Action
Allows text to entered and then played to the caller. Requires TTS to be installed and licensed.

·  Menu Action
Branch the call flow according to the phone buttons presses made by the caller. 

·  Goto Action
Go to another start point.

·  Disconnect Action
Disconnect the call.

·  Home Action
Return to the start point.

·  Module Return Action
Return to the start of a module.

 Mailbox Actions
These actions relate to the leaving and collecting of messages from a mailbox.

·  Get Mail Action
Collect messages from a mailbox.

·  Leave Mail Action
Leave a message in a mailbox.

·  Listen Action
Record to a mailbox.

·  Voice Question Action
Record responses to a series of prompts.

·  Campaign Action
Access a campaign to read or leave messages.

133

165

178

180

182

183

183

183

185

186

187

188

189



Voicemail Pro Page 155
15-601063 Issue 21c (16 July 2009)IP Office 5.0

Voicemail Pro Actions: Available Actions

 Configuration Actions
These actions allow a caller to change the settings of a user or hunt group mailbox.

·  Edit Play List Action
Re-record a prompt.

·  Record Name Action
Re-record a mailbox name.

·  Play Configuration Menu Action
Change user or group settings.

·  Select System Prompt Language Action
Change the prompt language.

 Telephony Actions
These actions relate to telephony functions such as call transfers.

·  Variable Routing Action
Route on a match to a variable such as the caller's CLI.

·  Route Incoming Call Action
Route a call depending on whether the call is internal or external.

·  Route by Call Status
Calls route is determined by why the reason the call was routed to voicemail.

·  Transfer Action
A blind transfer.

·  Whisper Action
Screened transfer.

·  Call List Action
Transfer to a user selected choice.

·  Dial by Name Action
Select user/group by keypad letters.

·  Conferencing Center
Provides a route for callers to enter the conference ID and their conference PIN code. IP Office Conferencing
Center needs to be installed.

·  Assisted Transfer Action
A transfer with assistance for callers.

·  Alphanumeric Action
Allows the caller to input text and numeric values.
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 Miscellaneous Actions

·  eMail Action
Email a recording.

·  Open Door Action
Open and/or close a door relay.

·  Alarm Set Action
Set an alarm call time.

·  Clock Action
Play the time to the caller.

·  Post Dial Action
Play a recording to an extension.

·  VB Script Action
Allows Visual Basic to be used to script call flow events.

·  Remote Call Flow
Allows call flows developed elsewhere to be included in an existing call flow.

 Condition Actions
These actions are used to create branches in the call routing according to whether a value is true or false.

·  Test Condition Action
Test whether a condition is true or false.

·  Set User Variable Action
Set a variable to a particular value.

·  Test User Variable Action
Test the value of a variable.

·  Test Variable Action
Check if user dialing matches set digits.

·  Increment and Test Counter  
Increment a $COUNTER variable and then test whether is matches a specified value. 

·  Decrement and Test Counter  
Decrement a $COUNTER variable and then test whether is matches a specified value.  

 Database Actions
These actions relate to retrieving and adding data to a database. The use of database actions with Voicemail Pro requires
entry of a VMPro Database Interface license in the IP Office configuration.

·  Database Open Action
Open a database.

·  Database Execute Action
Perform an action on a database.

·  Database Get Data Action
Get information from a database.

·  Database Close Action
Close a database. 

 Queue Actions
These actions are associated with hunt group queues and are not available to user and short code start points. The IP
Office Manager option Synchronise calls to announcements should not be used when using the queue actions.  

·  Queue ETA Action
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Voicemail Pro Actions: Available Actions

Speak the caller's expected time to answer.

·  Queue Position Action
Speak the caller's queue position.
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6.3 Standard Action Tabs
The standard tabs of an action are:

· General
Set a name for the action in the call flow and whether a PIN code is required by callers to use the action. 

· Entry Prompts
Sets the prompts that should be played to callers that reach the action. 

· Reporting
Use to provided reporting on calls that use the action. The reporting is done through the IP Office CCC or IP Office
SBCC applications. 

· Results
Displays the results configured for the action. Each result can be connected to a further action in the call flow.  

6.3.1 General
The General tab contains the action name. You can also enter notes about the action and protect a call flow by adding an
access code. 

This tab is shown for the Start action in calls flows. However it should not be used as settings applied to the Start action
are ignored and should instead be applied through the first other added to the call flow. 

· Token Name 
The name of the action, for example, the token name for the action Menu is 'Menu'. The token name can be
changed so the use of the action can be indicated. It could also be confusing having two actions within a module
with the same name.

· Description 
Use this field to enter notes about why the action is being used or other information that may be needed.

· Pin 
Each action can be protected by a PIN number. The PIN number can be the voicemail code of the presumed user.
To do this enter a $ symbol. For example, entering $ would force the caller to dial their voicemail code, entering
104$ would force the caller to dial 104 followed by their voicemail code.
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Voicemail Pro Actions: Standard Action Tabs

6.3.2 Entry Prompts
The Entry Prompts tab is used to select the prompts to be played before the action performs its main role. Multiple
prompts can be added and the order in which they are played adjusted.

This tab is shown for the Start action in calls flows. However it should not be used as settings applied to the Start action
are ignored and should instead be applied through the first other added to the call flow. 

· When accessing voicemail prompts, voicemail variables  can be used in both the path and filename for
the prompt. For example, if prompts Greeting1.wav,  Greeting2.wav etc. are recorded, an action set to
play Greeting$KEY.wav would play the greeting prompt that matched the current value of $KEY. 

·  Add Prompt 
Clicking  or double-clicking an existing listed prompt starts the Wave Editor . This tool allows you to record
and play prompts through the Voicemail Pro server PC or through an extension on the IP Office system. The
dialogue that appears allows the selection of an existing prompt or the ability to specify a new file name and then
record the new prompt. 

·  Edit Prompt 
Edit the details of the currently highlighted prompt using the Wave Editor .

·  Delete Prompt 
Delete the currently highlighted prompt from the play list. Note that the actual prompt file is not deleted from the
server.

·  Move Prompt 
Move the position of the currently highlighted prompt in the play list.

· Allow prompts to be interrupted by Tones 
Allow the caller to press tone keys to make selections during the playing of the actions entry prompts.
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The Edit Play List  action can be used in call flows to record a specified prompt. This allows the creation of call flow
options where the voicemail user can record prompts themselves to reflect changes in operation. 

Speaking Variables to Callers 
Call variables can be used as prompts. The value of the call variable will then be spoken. This applies to all variables that
are numeric values. It also applies to $NAM which will play the mailbox users recorded name prompt. 

Numbers are spoken as a series of single digits. For example 123 is spoken as "one two three". To speak 123 as "one
hundred and twenty-three" requires TTS to be installed and a Speak Text  action used.

Some call variables can be played as prompts, for example:

· $NAM 
Plays the mailbox's name prompt if one has been recorded.

· $CLI 
Speaks the caller's CLI.

· $RES 
Plays the current result if it is a .wav file.

· $VAR 
Plays the variable as a list of digits.
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Voicemail Pro Actions: Standard Action Tabs

6.3.2.1 Using the Wave Editor

The Wave Editor is used by Voicemail Pro to select, record and play prompts. It can be used to select existing prompts or
to record new prompts.

The Entry Prompts tab of each call flow action allows prompts to be played before the action performs its main role.

Clicking  or double-clicking a listed prompt starts the Voicemail Pro Wave Editor. This tool allows you to record and play
prompts through the Voicemail Pro server PC or through an extension on the IP Office system.

To record a new prompt:

1.Select the media device to use, either Telephony Handset or PC Multimedia. If Telephony Handset is
selected, enter the extension of the telephone to be used.

2.Enter a file name for the recording. The file will be stored in the path shown. Alternatively use the browse icon 
to select an existing prompt file to be recorded.

· When accessing voicemail prompts, voicemail variables  can be used in both the path and filename for
the prompt. For example, if prompts Greeting1.wav,  Greeting2.wav etc. are recorded, an action set to
play Greeting$KEY.wav would play the greeting prompt that matched the current value of $KEY. 

3.Click the  record button to record the message. If the media type selected is Telephony Handset, the telephone
extension will ring. When the handset is picked up a message will be heard saying "Record at the tone".

4.Speak the message, click  stop button when finished.

5.To listen to the recording, press the  play button. If there is no media device attached, the recorded message will
be heard from the telephone extension.
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To select a prompt.

There are a large number of standard prompts that can be used. Enter the name of the prompt or use the  button to
browse to the required file. For a sample listing of these prompts see US English Intuity Prompts  and English Non-
Intuity Prompts .

Useful files are:

· en\MC_00 - Plays a bleep.

· en\MC_01 - Plays 1 second of silence.

· Entering 1234.wav will play "one two three four" (unless a file called 1234.wav has been recorded).

 

Some call variables  can be played as prompts. For example:

· $NAM - Plays the user name.

· $CLI - Speaks the caller's CLI.

· $RES - Plays the current result if it is a .wav file.

· $VAR - Plays the variable as a list of digits.

6.3.3 Specific
The contents of this tab vary according to the type of action. In some cases this tab may have a different name, for
example Touch Tones for the Menu action. Not all actions contain the Specific or Touch Tones tab. Details of the specific
tab are covered in the section that describes the available actions.

This tab is shown for the Start action in calls flows. However it should not be used as settings applied to the Start action
are ignored and should instead be applied through the first other added to the call flow. 

369

383

140



Voicemail Pro Page 163
15-601063 Issue 21c (16 July 2009)IP Office 5.0

Voicemail Pro Actions: Standard Action Tabs

6.3.4 Reporting
The Reporting tab provides information that is then used by other IP Office applications that can report of calls that use
an voicemail call flow. 

Setting CCC SBCC

Flag the current
call has been
answered by
Voice Mail

Calls are not recorded as answered until that
have reached an action where this option is
selected. 

If not selected, the number of calls and the number of
times trigger values are incremented by calls that
complete the action and are routed to a further action.
 

If selected, the number of calls and the number of
times triggered values are increments by calls that
reach the action. 

Request to call
back the current
caller

If this option is selected, the CCC will keep a
record of the caller's CLI if provided. This is
then used within the CCC product to arrange
a callback call by an agent. 

Not used by SBCC. 

Send reporting
information

If selected, information can be associated with the call. That information then allows reports to be
run. 

Group Name These fields are used by CCC to groups
details of calls that have reached the action. 

Sets the label used by SBCC in its Voicemail Report. 

Topic Not used by SBCC.

Annotation Not used by SBCC.
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6.3.5 Results
This tab shows the results available from an action. For the majority of actions the results are fixed and appear grayed
out, i.e. they cannot be changed. For some actions the results are variable.

This tab is shown for the Start action in calls flows. However it should not be used as settings applied to the Start action
are ignored and should instead be applied through the first other added to the call flow. 
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Voicemail Pro Actions: Standard Action Tabs

6.4 Basic Actions

 Basic Actions
These actions are chiefly used to control the routing of a call between actions.

·  Generic Action
Can be used to simply play a prompt to the caller through its Entry Prompts tab. It can also be used to enter
custom commands for the voicemail server.

·  Speak Text Action
Allows text to entered and then played to the caller. Requires TTS to be installed and licensed.

·  Menu Action
Branch the call flow according to the phone buttons presses made by the caller. 

·  Goto Action
Go to another start point.

·  Disconnect Action
Disconnect the call.

·  Home Action
Return to the start point.

·  Module Return Action
Return to the start of a module.

6.4.1 Generic

 The Generic action can be used to play a prompt to the caller. It can also be used to enter custom commands for the
voicemail server. The maximum length for the string is 128 characters.

Voicemail Pro 5.0+ allows generic commands to be entered either as traditional "free format" text strings such as SAVE:
$KEY or through using a series of data fields to set the parameters for the required string. 

The types of generic command are: 

· Arithmetic Evaluation  
Perform a mathematic operation on existing variables and save the result as a call variable. 

· Change Caller's Priority  
Change the priority of a call before it is presented to a hunt group. 

· Change User or Group Configuration  
Get or change the current status of a range of user and hunt group settings. 

· Clear Counter  
Return one of the $COUNTER variables to 0. 

· Counter Decrement  
Decrement one of the 15 $COUNTER variables. 

· Counter Increment  
Increment one of the 15 $COUNTER variables. 

· Generic "Free Format" Command  
Enter a command as a plain text string. 

· Set Counter  
Set one of the 15 $COUNTER variables to a specific value. 

· Set CPxx Value  
Set the value of one of the 15 $CP variables. 

· String Manipulation  
Extract or change the string stored in an existing variable and save the result as a call variable. 
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6.4.1.1 Arithmetic Evaluation

This Generic option allows an arithmetic operation to be performed on call variables. The result is then stored in a
selected call variable . For non-numeric values the string can be changed using the String Manipulation  option. 

· Select Generic command: Arithmetic Evaluation 

· Select Variable For Result 
Select the call variable into which the result of the arithmetic calculation should be stored. 

· Enter Expression to evalute 
The string entered here can include numeric values, other call variables such as $KEY and the following
arithmetic operators in addition to ( and ) brackets: 

· * = Multiply by.

· / = Divide by.

· % = Modulus (remainder after division)

· + = Add.

· – = Subtract.

· ^ = Bitwise exclusive or (XOR). Does a binary comparison of the decimal inputs, returning a 1 for
each bit if only one of the corresponding input bits is 1, otherwise returning 0 for the bit. 

· If the values being evaluated are integers (eg. 123), the result will be an absolute integer value. For
example 123/2 will result in 61. 

· If any value being evaluated is a decimal (eg. 123.0), the result will be a 6 decimal place value. For
example 123.0/2 will result in 61.500000. 

Free Format Equivalent
This action creates a free format similar to EVAL:$CP0=$CP1+$CP2+5. In this example the current values of $CP1,
$CP2 plus 5 are added and then stored as $CP0. 
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Voicemail Pro Actions: Basic Actions

6.4.1.2 Change Callers Priority

This Generic option allows the call priority of a call to be changed. The priority value is retained when the call is
transferred back to the IP Office system.

· When calls are presented to a hunt group on the IP Office, calls waiting to be answered are queue in
order of priority and then longest waiting. By default internal caller's have Low priority while the priority
of external callers is set by the IP Office Incoming Call Route used to route the call (default also Low). 

· Mixing calls of different priority is not recommended if Voicemail Pro is being used to provide queue
estimate time to answer (ETA) and queue position announcements to callers, since those values will no
longer be accurate when a higher priority call is placed into the queue. Note also that in such a situation
Voicemail Pro will not allow a value already announced to a caller to increase. 

· Select Generic command: Change Callers Priority

· Set Callers Priority to: 
The caller's priority can be set to Low, Medium or High. A call variable  set to 1, 2 or 3 can also be used
to set Low, Medium or High priority respectively.

Free Format Equivalent
This action creates a free format similar to CHANGECALLPRIORITY:M. In this example the caller's priority is set to
medium. 
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6.4.1.3 Change User or Group Configuration

This Generic action option allows you to create generic commands that either get or set the value of configuration
settings in the IP Office system. The IP Office settings are listed in the table below. 

Some of these settings as indicated below can be changed using a Play Configuration Menu  action. 

Any user or group configuration changes made using this method are written the file "AuditTrail.txt" on the voicemail
server PC (C:\\Program Files\Avaya\IP Office\Voicemail Pro\VM\Logs\AuditTrail.txt). The file includes the time, date,
details of the change and the CLI of the caller making the change. 

· Select Generic command: Change User or Group Configuration

· Operation 
Select whether the command should Get a value from the IP Office configuration or Set a value in the
configuration. When Get is selected, the Select Variable For Result option is shown as a reminder that the
value obtained is saved into the Voicemail Pro $SAV variable. 

· From User\Group Mailbox 
Select the IP Office user or mailbox whose configuration settings the command accesses. 
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Voicemail Pro Actions: Basic Actions

· Parameter
Select the IP Office configuration setting that is being got or set. For full details of the operation of these
settings refer to the IP Office Manager Application documentation. 

Parameter User Hunt
Group

Parameter Values Free Format
Parameter Name

Play
Configurati
on Action

Absent Message 0 ("None"), 1 ("On vacation until"), 2 (
"Will be back"), 3 ("At lunch until"), 4 (
"Meeting until"), 5 ("Please call"), 6 (
"Don't disturb until"), 7 ("With visitors
until"), 8 ("With cust. til."), 9 ("Back
soon"), 10 ("Back tomorrow"), 11
(Custom).

absent_msg

Absent State 0 (Off) or 1 (On). absent_set

Absent Text Text added to the end of the Absent
Message when the Absent State is
on. 

absent_text

Announcements 0 (Off) or 1 (On). enable_comfort_annou
ncements

Do Not Disturb 0 (Off) or 1 (On). do_not_disturb

Ex Directory 0 (Off) or 1 (On). exdirectory

Forward Unconditional 0 (Off) or 1 (On). forward_unconditional

Forward Number The destination number for the users 
Forward Unconditional when that
option is on. 

forward_number

Forward on Busy 0 (Off) or 1 (On). forward_busy

Forward on No Answer 0 (Off) or 1 (On). forward_na

Forward Hunt Group
Calls

0 (Off) or 1 (On). Used with Forward
Unconditional. 

forward_hg

Forward on Busy
Number

The destination number for the user's 
Forward on Busy and Forward on
No Answer if either option is on. 

forward_busy_number

Mobile Twinning Number The destination number being used for
the user's mobile twinning.

mobile_twinning_num
ber

Twinning Type Mobile indicates or sets twinning on,
any other value indicates or sets
mobile twinning off. 

twinning_type

Voicemail On 0 (Off) or 1 (On). voicemail_on

Voicemail Reception 0 (Off) or 1 (On). voicemail_reception

Voicemail Email Mode 0 (Off), 1 (Copy), 2 (Forward), 3
(Alert). 

voicemail_emailmode

Voicemail Callback
Number

The destination number for voicemail
callback .

voicemail_dialback

· Select Variable For Result 
If the Operation is a Get, a call variable must be selected to store the value returned. 

Free Format Equivalent
This action creates a free format command of the form CFG:GET "<extension number>" <parameter name> <parameter
value> or CFG:SET "<extension number>" <parameter name> <parameter value>. The free format parameter names
and values are listed in the table above. 

For example, to set announcements on for extension 201, the free format command is CFG:SET "201"
enable_comfort_announcements 1. 

The following additional options exist only as free-format command strings: 

Option User Hunt
Group

Value Free Format
Parameter Name

Play
Configurati
on Action

Follow Me Number Number follow_me_number

Voicemail Code Number voicemail_code

Off Hook Station 0 (Off) or 1 (On) off_hook_station
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Dial In 0 (Off) or 1 (On) dial_in_on

Monitor Group Number monitor_group

System Phone 0 (Off) or 1 (On) systemphone
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Voicemail Pro Actions: Basic Actions

6.4.1.4 Clear Counter

This Generic action option allows one of the 15 $COUNTER call variables to be reset to 0. 

Voicemail Pro 5.0+ provides counter variable $COUNTER1 to $COUNTER15. These can be used in the same way as other
variables. They can also be manipulated using  Generic  action commands for Set Counter , Clear Counter ,
Counter Decrement  and Counter Increment . They can also be used with the Decrement and Test Counter
and Increment and Test Counter  actions. By default the initial value of a counter variable is 0.  The
formats $COUNTERx or $COUNTER[x] are both supported.

· Select Generic command: Clear Counter

· Select Counter 
Enter 1 to 15 to select $COUNTER1 to $COUNTER15 respectively. 

Free Format Equivalent
This action creates a command similar to CLEARCOUNTER1. 
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6.4.1.5 Counter Decrement

This Generic action option allows one of the 15 $COUNTER call variables to decreased by 1. 

Voicemail Pro 5.0+ provides counter variable $COUNTER1 to $COUNTER15. These can be used in the same way as other
variables. They can also be manipulated using  Generic  action commands for Set Counter , Clear Counter ,
Counter Decrement  and Counter Increment . They can also be used with the Decrement and Test Counter
and Increment and Test Counter  actions. By default the initial value of a counter variable is 0.  The
formats $COUNTERx or $COUNTER[x] are both supported.

· Select Generic command: Counter Decrement

· Select Counter 
Enter 1 to 15 to select $COUNTER1 to $COUNTER15 respectively. 

Free Format Equivalent
This action creates a command similar to DECCOUNTER:$COUNTER1. In this example decrementing the value of
$COUNTER1. 
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6.4.1.6 Counter Increment

This Generic action option allows one of the 15 $COUNTER call variables to be increased by 1. 

Voicemail Pro 5.0+ provides counter variable $COUNTER1 to $COUNTER15. These can be used in the same way as other
variables. They can also be manipulated using  Generic  action commands for Set Counter , Clear Counter ,
Counter Decrement  and Counter Increment . They can also be used with the Decrement and Test Counter
and Increment and Test Counter  actions. By default the initial value of a counter variable is 0.  The
formats $COUNTERx or $COUNTER[x] are both supported.

· Select Generic command: Counter Increment

· Select Counter 
Enter 1 to 15 to select $COUNTER1 to $COUNTER15 respectively. 

Free Format Equivalent
This action creates a command similar to INCCOUNTER:$COUNTER1. In this example incrementing the value of
$COUNTER1. 
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6.4.1.7 Generic Free Format Command

This Generic action option allows the direct entry of generic commands. If the action has been previously used to setup
using a specific type of generic command, the resulting free format text string for that command is shown and can be
edited if required. 

Details for many free format commands are included in the sections on other Generic action commands. In addition the
following commands can be used:

· Save a Value: Save:<value>
This generic command can be used to replace the value of the call variable $SAV with a specified value. For
example Save:$KEY or Save:1234. 

· Forward a Message: FWD:<ext1>#<ext2>## 
This option can be used with a generic action that is proceeded by an action that records a message such as a 
Voice Question or Edit Play List action. It then forwards the message to another mailbox or mailboxes. Each
extension number should be followed by a # plus an additional # at the end of the string.
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6.4.1.8 Set Counter

This Generic action option allows one of the 15 $COUNTER call variables to be set to a specific value. 

Voicemail Pro 5.0+ provides counter variable $COUNTER1 to $COUNTER15. These can be used in the same way as other
variables. They can also be manipulated using  Generic  action commands for Set Counter , Clear Counter ,
Counter Decrement  and Counter Increment . They can also be used with the Decrement and Test Counter
and Increment and Test Counter  actions. By default the initial value of a counter variable is 0.  The
formats $COUNTERx or $COUNTER[x] are both supported.

· Select Generic command: Set Counter

· Select Counter 
Enter 1 to 15 to select $COUNTER1 to $COUNTER15 respectively. 

· Value 
Enter the numeric value for the counter. A call variable such as $KEY can be entered to set the counter to
match the current value of that variable. 

Free Format Equivalent
This action creates a command similar to COUNTER1:34 or COUNTER2:$KEY. These examples set the value of
$COUNTER1 to 34 and $COUNTER2 to $KEY respectively. 
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6.4.1.9 Set CPxx Value

This Generic action option allows a value to be stored as one of the 15 $CPxx call variables . The value to store can be
the value of another variable or a value entered in the action. 

· Select Generic command: Set CPxx Value

· Select Data Variable 
Enter 1 to 15 for call variable CP1 to CP15 respectively. 

· With Value 
Enter the value to store. Another call variable such as $KEY can be specified in order to have that variables
current value stored. 

Free Format Equivalent
This action results in a free format command like CP4:$KEY. In that example the current value of $KEY is stored as
variable $CP4. 
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6.4.1.10 String Manipulation

This Generic action option allows a call variable to be edited in various ways. For example take the full CLI of a call (for
example 01555364200) and save just the area code part (in the example 555) as a new value. The action treats variable
values as text strings, it does not differ whether the value is numeric or alphabetic. For numeric variables value, the
value can also be manipulated using the Arithmetic Evaluation  option.

· Select Generic command: String Manipulation

· Select Variable 
Enter the call variable on which the action should perform an operation. 

· Select Variable For Result 
Enter the call variable which should be used to store the result of the operation. 

· Select Operation 
Select the operation to be performed on the selected input. Depending on the selected operation the
additional fields Number of Characters and From Position Index may be displayed. 

Operation Description Example

Free Format Command $CP0 $CP1

From Position Return the selected number of characters
starting from the position index and going right. 

STRING:$CP1=mid
($CP0,3,3)

01555364200 555

From the Left Return the selected number of characters
starting from the left end. 

STRING:$CP1=left
($CP0,5)

01555364200 01555

From the Right Return the selected number of characters
starting from the right end. 

STRING:$CP1=right
($CP0,5)

01555364200 64200

Lowercase Change any uppercase characters in the input
into lowercase.

STRING:$CP1=lower
($CP0)

ABCdef123 abcdef123

Reverse Reverse the order of characters in the input. STRING:$CP1=reverse
($CP0)

ABCdef123 321fedCBA

Uppercase Change any lowercase characters in the input
into uppercase.

STRING:
$CP1=upper($CP0)

ABCdef123 ABCDEF123

· Number of Characters 
This option is displayed for the operation From Position, From the Left and From the Right. It sets the number
of characters to be returned. 

· From Position Index 
This option is displayed for the operation From Position. It sets the start character for set of characters to be
returned.
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6.4.2 Speak Text

 The Speak Text action allows any text to be spoken to the caller. To be able to use the Speak Text action you
require TTS (Text to Speech) to be installed and licensed .

For examples of the action in a call flow, see:

· Entering Details in to the Database .

· Returning Data from the Database .

Settings

1.Click the  Basic Actions icon and select  Speak Text. 

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions. 

3.Select the Specific tab.

· Text to speak 
Enter the text to be spoken in the Text to speak field. this can include: 

· Typed text sentences.

· Voicemail Pro Call Variables . For example:

· Entering $KEY would be replaced when spoken by the last digits dialed within the call flow by the
caller.

· If using database interaction, entering $DBD[x] would be replaced by the current value of that
database field.

· Entering $CLI would speak the caller's CLI, if available, back to them.

· SAPI 5 XML  tags can be added to alter how the text is spoken. For example when 123 needs to be
spoken as one two three rather than "one hundred and twenty-three", enter <spell>123</spell>.

Results
This action has the following result which can be connected to a further action: 

· Next 
Connect the result to a following action in the call flow. 

Speaking Variables to Callers 
Call variables can be used as prompts. The value of the call variable will then be spoken. This applies to all variables that
are numeric values. It also applies to $NAM which will play the mailbox users recorded name prompt. 

Numbers are spoken as a series of single digits. For example 123 is spoken as "one two three". To speak 123 as "one
hundred and twenty-three" requires TTS to be installed and a Speak Text  action used.

Some call variables can be played as prompts, for example:

· $NAM 
Plays the mailbox's name prompt if one has been recorded.
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· $CLI 
Speaks the caller's CLI.

· $RES 
Plays the current result if it is a .wav file.

· $VAR 
Plays the variable as a list of digits.
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6.4.3 Menu

 The Menu action allows you to specify DTMF tones for which you want to create connections to following actions. For
example, a menu can be created that gives callers a choice of transfer locations. 

Each Menu action supports a maximum of 15 active touch tone entries.

For examples of the action being used in a call flow, see:

· Using a Play Configuration Menu Action .

· Example Call Flow for Mobile Twinning .

· Routing Calls to Voicemail, Example Call Flow .

· Changing the Language of System Prompts .

· Changing the Language Setting for a TTY Device .

Settings

1.Click the  Basic Actions icon and select  Menu.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions. 

3.For Menu actions, the Specific tab is replaced with the Touch Tones tab.

· 0-9, *, #
Use the dialing digits check boxes to indicate the DTMF tones for which connections are required. 

·  Add
The  icon allows you to add custom sequences of dialing digits. In addition to the standard dialing digits (0
to 9, *, #) the following special digits can be used. If a sequence is added, ensure that the associated box is
checked before you select OK. The sequence must be unique. For example, if 5 is selected, no other sequence
that begins with 5 can be used. 

· ? = Any Digit 
The ? character can be used to represent any digit (except * and #). For example, 123??? can be used
for any six digit string starting with 123. See Example Call Flow: SelfSelect Module .

· $ = Any Sequence of Digits 
The $ character can be used to match any sequence of digits for which there is no other match. Key press
entry is ended either by the caller pressing # or 5 seconds after the last digit dialed.
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· F = For Fax Calls 
The F letter can be used to automatically detect any incoming fax calls. Once detected, the calls can be
routed to another number. See Routing Fax Calls Using a Menu Action .

·  Delete
Use this icon to delete the currently selected custom dialing sequence. 

· Invalid Input Handling 
The following options can be used if the caller does not dial or dials an invalid digit. 

· No of Retries (Voicemail Pro 4.2+)
This option allows you to specify the number of retries a caller is allowed if they make an invalid entry or the
timeout occurs. 

· Timeout
If selected, the Voicemail Pro will wait for the specified number of seconds for a valid digit . If the timeout
expires the Voicemail Pro will either allow a retry or if the No of Retries has been reach, it will follow the
Timeout result connection within the call flow.

· Invalid Entry (Voicemail Pro 4.2+)
If selected, if the caller enters an invalid digit, the Voicemail Pro will either allow a retry or if the No of Retries
has been reach, it will follow the Timeout result connection within the call flow. 

· Prompt (Voicemail Pro 4.2+)
You can associate a prompt with the Timeout and or Invalid Entry options. If a prompt is specified, before

allowing a retry the Voicemail Pro will play that prompt. Use the  to access the Wave Editor . 

Results
The action can have the following results which can then be connected to further actions: 

· Timeout
This result is used to connect to a following call flow action if the caller does not make an entry
within the specified number of seconds on their last retry. 

· Invalid
This result is used to connect to a following call flow action if the caller makes an invalid entry on
their last retry. 

· Others
A result for connection to a following call flow action is shown for each select dialing digit
sequence. 
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6.4.4 Goto

 The GoTo action will transfer the caller to another call flow start point.

Settings

1.Click the  Basic Actions icon and select  GoTo.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions. 

3.Select the Specific tab.

· Please select a node to go to 

Click  to browse to select a start point, module or system defined variable. For short codes, the browse
method does not work. Instead enter "Short Codes.xxx" where xxx is the short code key sequence.

· Select the option Start point or module. Select from the available options.

· Users - all the users with specific start points are listed.

· Groups - all the Groups with specific start points are listed.

· Any default start point.

· Any available modules.

· Select the option System defined variables to browse the available call variables. You can also type the
name of the start point directly.

Results
This action does not have any results. 
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6.4.5 Disconnect

 The Disconnect action disconnects the caller.

Settings

1.Click the  Basic Actions icon and select  Disconnect. 

Results
This action does not have any results that can be connected to a following action. The caller is disconnected. 

 

 

6.4.6 Home

 The Home action returns the caller to the start point of the calls entry into voicemail. The PIN option in the General
tab is not used for this action.

Settings

1.Click the  Basic Actions icon and select  Home.

Results
This action does not have any results that can be connected to a following action. Instead the caller is
returned to the start point of the call entry into the voicemail. 

For an example of the action being used in a call flow, see Using a Play Configuration Menu Action .

 

6.4.7 Module Return
 The Module Return action is used within modules only. It creates a connection point from the module to subsequent

actions within any call flow that uses the module. A module can use several Module Return actions if necessary. 

Settings

1.Click the  Basic Actions icon and select  Module Return. 

2.The action has no properties.

Results
This action does not have any results that can be connected to a following action. Instead it
appears as a result in the module icon when the module is inserted into another call flow. 

For examples see Changing the Language of System Prompts  and User Defined Variables .
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6.5 Mailbox Actions

 Mailbox Actions
These actions relate to the leaving and collecting of messages from a mailbox.

·  Get Mail Action
Collect messages from a mailbox.

·  Leave Mail Action
Leave a message in a mailbox.

·  Listen Action
Record to a mailbox.

·  Voice Question Action
Record responses to a series of prompts.

·  Campaign Action
Access a campaign to read or leave messages.
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6.5.1 Get Mail

 The Get Mail action allows access to the messages in the caller's mailbox or a specified mailbox. The caller then has
access to the standard mailbox features setup for that mailbox. If the extension is a trusted extension, the user does not
have to enter their mailbox number and code. 

See Creating a Trusted Location .

For examples of the action being used in a call flow, see:

· Using a Play Configuration Menu Action .

· Setting Up Callback .

· Changing the Language of Custom Prompts .

· Changing the Language of System Prompts .

· Enabling Access to Hunt Group Voicemail .

· Changing the Language Setting for a TTY Device .

Settings

1.Click the  Mailbox Actions icon and select  Get Mail.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.The Specific tab is used to select either the caller's mailbox or mailbox option.

· Caller's mailbox
The mailbox matching the start point of the call.

· Mailbox 
Select or enter the name of the target mailbox. If ? is entered, Voicemail will prompt caller's to enter the
mailbox number required.

Results
The action can have the following results which can then be connected to further actions: 

· Next
This conditions when this option is used depend on the mailbox mode in which the Voicemail Pro is
running: 

· IP Office mode 
Users who press 0 while they are logged into their mailbox will be routed to the Next result.

· Intuity mode 
Users who press *0 whilst in their mailbox will be routed to their Voicemail Reception number
if set. The Next result is not used.
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6.5.2 Leave Mail

 The Leave Mail action allows the caller to leave a message in the start point's mailbox or in a specified mailbox. For
examples of the action in a call flow, see:

· Routing Calls to Voicemail, Example Call Flow .

· Hunt Group Queuing, Example Call Flow using $POS.

· Changing the Language Setting for a TTY Device .

· Example Call Flow: Dial by Name .

Settings

1.Click the  Mailbox Actions icon and select  Leave Mail.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.The Specific tab is used to indicate the target mailbox for the message. 

· Caller's Mailbox 
The mailbox matching the start point of the call.

· Mailbox 
Select or enter the name of the target mailbox.

· VRL
If selected, specifies that the message should be transferred to a third-party Voice Recording Library (VRL)
application. See Voice Recording Library . 

Results
The Leave Mail action has Success and Failure results. The use of these depends on which mailbox mode the Voicemail
Pro server is using.

· IP Office mode: 
Callers in the mailbox follow the Failure or Success results depending on whether they press 0
before or after the leave a message tone respectively. This overrides the mailbox user's 
Voicemail Reception setting set in the IP Office configuration.

· Intuity mode: 
The results cannot be accessed. Callers pressing 0 will always follow the mailbox user's 
Voicemail Reception setting set in the IP Office configuration.
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6.5.3 Listen

 The Listen action allows the caller to leave a message in the start point's mailbox or in a specified mailbox. The caller
can only leave a message and cannot access any other mailbox features. 

For examples of the action in a call flow, see Customizing Manual Recording  and Customizing Auto Recording .

Settings

1.Click the  Mailbox Actions icon and select  Listen.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.In the Specific tab, select either the Caller's mailbox or Mailbox option.

· Caller's Mailbox: The mailbox matching the start point of the call.

· Mailbox: Select or enter the name of the target mailbox.

Results
This action has the following result which can be connected to a further action: 

· Next 
Connect the result to a following action in the call flow. 
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6.5.4 Voice Question

 The Voice Question action allows you to create a play list where the caller hears a sequence of prompts and their
responses are recorded.

If the play list is completed, a single file containing the recorded responses is created. That file can then be placed into a
specified mailbox or passed to an eMail action.

Settings

1.Click the  Mailbox Actions icon and select  Voice Question.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.In the Specific tab questions need to be added to the play list.

4.Click  Add a Prompt. The Wave Editor  window opens. Specify a new file name and then record the new
prompt or select an existing prompt.

5.Click  Record a Response. Specify a name and a length in seconds for the recorded response. Click OK. 

6.Repeat the above steps to create a series of questions and responses. Use the following controls to adjust the list. 

·  Edit: - Edit the settings of the currently highlighted item.

·  Delete: - Deletes the currently highlighted item from the play list. This does not delete the actual prompt
file.

·  Shuffle: - Move the currently highlighted item within the play list.

7.Specify a mailbox into which the recorded file of the responses should be stored. If no mailbox is specified the file
can be passed to an eMail action . 

Results
This action has the following result which can be connected to a further action: 

· Next 
Connect the action to a following action within the call flow. The Next result can be
connected to an eMail action if no mailbox is selected in the Specific tab.
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6.5.5 Campaign

 A campaign is used to ask callers a series of questions and record their spoken or key press responses. Agents can
then access the campaign recordings and process the response using their telephone key pad or a web interface. 

Campaigns are setup using the Campaign Wizard . The Campaign action can be used to either route a caller into a
campaign or to allow an agent to access any messages left for a campaign. 

Settings

1.Click the  Mailbox Actions icon and select  Campaign.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.You need to enter the campaign and select whether to leave or collect campaign information in the Specific tab.

· Please select a campaign 
Enter the campaign that you want to use. Then select on of the following:

· Leave campaign information (e.g. customers) 
Select if the action should start the campaign to collect the caller's responses.

· Pick up campaign information (e.g. agent) 
Select if the action should start playing back the response left by callers to the campaign.

When accessing the caller recordings from using a Campaign action or park slot number, the following controls are
provided through the telephone keypad. 

1 Go to the start of the call. 7 Previous response.

2 Rewind. 8 Start of response.

3 Stop processing the message. 9 Next response.

4 Mark call as processed and delete. 0 Pause.

5 Mark call as processed and save. # Fast forward.

Results
This action has the following result which can be connected to a further action: 

· Next 
Connect the action to a following action within the call flow. 
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6.6 Configuration Actions

 Configuration Actions
These actions allow a caller to change the settings of a user or hunt group mailbox.

·  Edit Play List Action
Re-record a prompt.

·  Record Name Action
Re-record a mailbox name.

·  Play Configuration Menu Action
Change user or group settings.

·  Select System Prompt Language Action
Change the prompt language.

6.6.1 Edit Play List

 The Edit Play List action can be used to record a specified prompt file held on the voicemail server PC. This allows
call flows to be created to change the prompts being used by other call flows. 

Settings

1.Click the  Configuration Actions icon and select  Edit Play List.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.In the Specific tab, select the prompt file held on the voicemail server.

· File Path
This path is relative to the WAVS folder defined  for the voicemail server. 

· To browse to a file location click . The Wave editor  window opens. Select an existing prompt or
define and record a new one. 

· When accessing voicemail prompts, voicemail variables  can be used in both the path and filename for
the prompt. For example, if prompts Greeting1.wav,  Greeting2.wav etc. are recorded, an action set to
play Greeting$KEY.wav would play the greeting prompt that matched the current value of $KEY. 

· For announcements, the formats [GREETING]\<name>_Queued and [GREETING]
\<name>_StillQueued can be used, where <name> is replaced by the hunt group or user name. 

Results
This action has the following result which can be connected to a further action: 

· Next 
Connect the action to a following action within the call flow. 
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6.6.2 Record Name

 The Record Name action is used to allow callers to record a name prompt for their mailbox or a specified mailbox.
For an example of the action in a call flow, see Adding a Record Name Module .

The mailbox name prompt is used for the Dial By Name  feature and is played to callers who are directed to the
mailbox to leave a message. If the voicemail server mailbox mode  is set to Intuity mode, users can record the name
prompt through the telephone prompt interface.

· If it is necessary to have a service for the bulk recording of mailbox name prompts an command called 
NameWavsTable  can be used. 

Settings

1.Click the  Configuration Actions icon and select  Record Name. 

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.In the Specific tab the mailbox to record that the name is to be recorded for is selected.

· Caller's mailbox 
The mailbox matching the start point of the call.

· Mailbox 
Select or enter the name of the target mailbox.

Results
This action has the following result which can be connected to a further action: 

· Next 
Connect the action to a following action within the call flow. 
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6.6.3 Play Configuration Menu

 The Play Configuration action allows various users or hunt group settings to be altered. Because of the nature of
this action it should always be protected by a PIN code in its General tab. For an example of the action being used in a
call flow, see Using a Play Configuration Menu Action .

The options given when a caller accesses this action are:

User Hunt Group

1.Edit forwarding number[1]. 

2.Edit follow me number[1]. 

3.Set call forwarding[1]. 

4.Set voicemail on/off[1]. 

5.Set do not disturb[1]. 

6.Edit voicemail code[1]. 

7.Edit voicemail reception[1]. 

8.Set voicemail email mode[1]. 

9.Edit voicemail callback number[1]. 

1.Set voicemail on/off[1]. 

2.Edit voicemail code. 

3.Set voicemail email mode[1]. 

4.Set service mode. 

1.For Voicemail Pro 5.0+, those option marked as [1] can also be set using Generic  action commands. 

Any user or group configuration changes made using this method are written the file "AuditTrail.txt" on the voicemail
server PC (C:\\Program Files\Avaya\IP Office\Voicemail Pro\VM\Logs\AuditTrail.txt). The file includes the time, date,
details of the change and the CLI of the caller making the change. 

Settings

1.Click the  Configuration Actions icon and select  Play Configuration Menu.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions. In the General tab, enter a PIN code in the PIN field. 

3.In the Specific tab, select the mailbox to play the configuration menu for:

· Caller's mailbox 
The mailbox matching the start point of the call.

· Mailbox 
Select or enter the name of the target mailbox.

Results
This action has the following result which can be connected to a further action: 

· Next 
Connect the action to a following action within the call flow. 
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6.6.4 Select System Prompt Language

 The Select System Prompt Language action is supported on Voicemail Pro 1.2.6 or higher. It allows the system to
alter the language spoken during a call flow. For examples of the action being used in a call flow, see Changing the
Language of System Prompts  and Changing the Language Setting for a TTY Device .

For details of supported languages see Supported Languages . Not all languages are installed by default. If the
selected language is not available the voicemail server will use the next nearest language. 

Settings

1.Click the  Configuration Actions icon and select  Select System Prompt Language.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.In the Specific tab select the language that the system prompts are to be played in. If a language is selected
which is not loaded on the Server, the system will automatically select the most appropriate language.

· Possible system prompts 
List of all prompt languages that could be installed on the system.

· Installed on the Server 
Displays if the prompts for a particular language are installed on the server.

Results
This action has the following result which can be connected to a further action: 

· Next 
Connect the action to a following action within the call flow. 
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6.7 Telephony Actions

 Telephony Actions
These actions relate to telephony functions such as call transfers.

·  Variable Routing Action
Route on a match to a variable such as the caller's CLI.

·  Route Incoming Call Action
Route a call depending on whether the call is internal or external.

·  Route by Call Status
Calls route is determined by why the reason the call was routed to voicemail.

·  Transfer Action
A blind transfer.

·  Whisper Action
Screened transfer.

·  Call List Action
Transfer to a user selected choice.

·  Dial by Name Action
Select user/group by keypad letters.

·  Conferencing Center
Provides a route for callers to enter the conference ID and their conference PIN code. IP Office Conferencing
Center needs to be installed.

·  Assisted Transfer Action
A transfer with assistance for callers.

·  Alphanumeric Action
Allows the caller to input text and numeric values.
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Voicemail Pro Actions: Telephony Actions

6.7.1 Variable Routing

 This action routes calls based on whether a selected call variable  matches any of the numbers specified by the
action's settings. This action replaces the previous CLI Routing action but can perform the same function using the $CLI
variable.

The selected variable is checked for a match against all strings. Where multiple matches occur, the one with the most
matching digits (excluding wildcards) is used. If several equal length matches are found, the first one in the list is used. 

Settings

1.Click the  Telephony Actions icon and select  Variable Routing.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.Select the Specific tab.

· Select a Variable 
This drop down is used to select the call variable  against which the values are checked for a match.

· Does the Variable match any of the following numbers 
The area below lists the numbers against which the selected variable will be selected for a possible match. If
the variable matched multiple numbers in the list, the routing for the match nearest the top of the list is used.

·  Add a new number to the list of numbers. Some examples are listed in the results section below.

· Numbers can include a ? wildcard to represent any single digit, with multiple ?'s to represent a
matching number of digits. 

· Numbers can include a * wildcard to match any digits including multiple digits.  

·  Edit an existing selected number.

·  Delete an existing selected number.

·  Move the position of the currently highlighted string.
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Results
This action has a separate result for each number string entered on the action's Specific tab plus a No Match result.
Examples are:

· 01707364725 will only match that number exactly.

· 01707* will match any number beginning with 01707.

· *4625 will match any number ending in 4625. 

· *4329* any number containing 4329.

· 01707?????? will match any 11 digit number beginning with 01707. 

· ???????4625 will match any 11 digit number ending in 4625. 

· ??7* will match any number with 7 as the third digit.
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Voicemail Pro Actions: Telephony Actions

6.7.2 Route Incoming Call

 The Route Incoming Call action allows a call flow to be branched based on whether the call is internal or external. 

Settings

1.Click the  Telephony Actions icon and select  Route Incoming Call. 

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions. 

3.There is no Specific tab for this action.

Results
This action has the following results which can be connected to further actions: 

· Internal 
This result is used for internal calls. 

· External 
This result is used for external calls. 
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6.7.3 Route by Call Status

 The Route by Call Status action allows a call flow to be branched based on the reason the original IP Office target
for the call did not answer it. .

Settings

1.Click the  Telephony Actions icon and select  Route by Call Status.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.There is no Specific tab for this action.

Results
This action has the following results which can be connected to further actions: 

· No Answer 
This result is used for calls routed to the voicemail server because the original target
user or hunt group was rung but did not answer. 

· Busy 
This result is used when the call has been routed to the voicemail server because the
original target user is busy. 

· Out of Hours 
This result is used for hunt group calls when the original target hunt group is in night
service mode. 

· Default 
Where the cause for the call being routed to voicemail cannot be determined or does
not fit the criteria above, the Default route is used.
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Voicemail Pro Actions: Telephony Actions

6.7.4 Transfer

 The Transfer action transfers the caller to the extension that matches the mailbox selected. This is a blind transfer;
if the call returns to the voicemail server again, for example if unanswered, it will be treated as a new call. More
advanced transfers are done using either a Call List Action  or Assisted Transfer Action .

 

Settings

1.Click the  Telephony Actions icon and select  Transfer.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions. 

3.Select the Specific tab. 

· Destination 
Enter the number of the destination for the transfer. This can include IP Office short codes or numbers
specified by the current value of a Voicemail Pro call variable  such as $KEY. Type the required text

directly or use the  browse button to select the text that should be used including using a the value of a
call variable . 

· For IP Office 5.0+ operation, a short code can be set as the transfer destination. 

· Source of transfer (displayed on phone) 

The number to display on the destination phone if internal. Type the required text directly or use the 
browse button to select the text that should be used including using a the value of a call variable . 

· Description (displayed on phone) 
The text description to display on the destination phone if internal. Type the required text directly or use the 

 browse button to select the text that should be used including using a the value of a call variable . 

· Set Call Priority (Voicemail Pro 5.0+) 
If selected, the caller's priority can then be set to Low, Medium or High. A call variable  set to 1, 2 or 3
can also be used to set Low, Medium or High priority respectively. 

· When calls are presented to a hunt group on the IP Office, calls waiting to be answered are queue in
order of priority and then longest waiting. By default internal caller's have Low priority while the priority
of external callers is set by the IP Office Incoming Call Route used to route the call (default also Low). 

· Mixing calls of different priority is not recommended if Voicemail Pro is being used to provide queue
estimate time to answer (ETA) and queue position announcements to callers, since those values will no
longer be accurate when a higher priority call is placed into the queue. Note also that in such a situation
Voicemail Pro will not allow a value already announced to a caller to increase. 

· Notify caller of transfer to target (Voicemail Pro 4.1+) 
If enabled, the caller hears "Transferring to" followed by the associated mailbox name of the destination if
available or otherwise the destination number if it matches an internal extension number. This follows any
prompts selected in the Entry Prompts list above.
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Results
A Transfer action has no results.

MS-CRM Call Data Tagging
Call Data Tags enable advanced scenarios to be built around your Microsoft CRM 3.0 and Avaya Microsoft CRM
Integration Solution. In situations where CLI/ANI matching is not sufficient, you can add screening and specific data
collection interactions with your customers using the Voicemail Pro. The Voicemail Pro Assisted Transfer and Transfer
actions can be used to pass data to users and pop matching records based on that data.  

Based on your solutions requirements, you could obtain and verify the data collected, and then transfer the call with a
data tag, that will utilize your specific criteria to lookup the required, account, contact or case, once the call is offered.

The tags are conformant xml fragments, they are comprised of an element AV_M and two attributes the Microsoft CRM
entity (account, contact or incident) and the schema name of the field to match on, in this example ‘contactid’  and the
data is the record key.

For example:

· <AV_M O="contact" S="contactid" >{e44e6dbf-bd2a-da11-badb-505054503030}</AV_M>

where

· <AV_M = element name.

· O="contact" = crm entity.

· S="contactid" = attribute to search on.

· > = end of element attributes

· {e44e6dbf-bd2a-da11-badb-505054503030} = the data to match on, this should be unique.

· </AV_M> - Closing tag.

 

The xml element name, attributes names and Microsoft CRM entity and schema names are case sensitive.

 

Additional Examples

· Account – Account Number: <AV_M O="account" S="accountnumber" >TL00001</AV_M>

· Case – Ticket Number: <AV_M O="incident" S="ticketnumber" >CAS-01001</AV_M>
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Voicemail Pro Actions: Telephony Actions

6.7.5 Whisper
 The Whisper action allows a recording made by the caller to be played to a transfer target while the caller is held.

While listening to the recording and prompts the transfer target can either accept the call by pressing 1 or reject the call
by pressing any other key or hanging up. 

The caller recording is obtained by a Voice Question or Listen action preceding the Whisper action. The Whisper
action also allows several text items to be set for display on the transfer target extension and for prompts to be played
before and after the caller's recording. 

Voicemail Pro 5.0+ allows the action to be used without requiring a recording. The transfer target decides whether to
accept or reject the call based on the displayed information and the prompts if they have been setup. Voicemail Pro 5.0+
also allows the whisper call transfer to be automatically accepted after the recording (if any) and prompts have been
played to the transfer target. 

Settings

1.Click the  Telephony Actions icon and select  Whisper.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.Select the Specific tab. Complete the fields with relevant details.

· Play Recording (Voicemail Pro 5.0+) 
If not selected, the call is presented to the target without playing the caller's recording. This allows the action
to be used without requiring a recording from the caller. The prompts before and prompts after recording are
still played if they have been setup. 

· Auto Accept (Voicemail Pro 5.0+)
If selected, after the recording has been played the caller is automatically connected without the target
extension having to accept the call. If this option is used, the Reject result connection is not useable. If the
user extension is set to auto-answer, the whisper call is answered, the recording and prompts played and the
call connected without any action by the target. 

· Play recording to 
Enter the extension that is rung with the caller's recording.

· Source of transfer 
Displayed in the caller's number field on Avaya phones.

· Description 
Displayed in the caller's name field on Avaya phones.
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· No answer timeout 
Select how long the voice mail server should wait for an answer before following the No Answer connection.
The whisper action will not go to the target extension voicemail.

· Prompts played before the recording and Prompts played after the recording 
Click . The Wave Editor window opens. Select the prompts that are to be played to the target extension
when they answer the call. The prompts played after the caller's recording should include the instruction 
"Press 1 to accept or hang up to reject".

Results
This action has the following results which can be connected to further actions: 

· Next 
This result connection is not used. 

· No Answer 
This result connection is used if the transfer target does not answer the whisper call. The time
out for no answer is set by the actions No answer timeout setting. 

· Busy 
This result connection is used if the transfer target returns busy to the whisper call. 

· Reject 
This result connection is used if the transfer target rejects the call by pressing any key other
than 1 or by hanging up.



Voicemail Pro Page 203
15-601063 Issue 21c (16 July 2009)IP Office 5.0

Voicemail Pro Actions: Telephony Actions

6.7.6 Call List

 Using a Call List action, a caller can indicate the extension to which they want to be transferred. If selected the
caller can be restricted to selecting an extension within a particular group. The transfer in this case is not blind, if
unanswered the action can link to actions for no answer or busy .

Settings

1.Click the  Telephony Actions icon and select  Call List.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.Select the Specific tab. Complete the fields with relevant details.

· Transfer to group 
Enter a group name if you want to restrict the caller to a particular group.

· Prompt user with a list of group members 
If this option is selected, the voicemail server will list the group members for the caller.

· Source of transfer (displayed on phone) 

The number to display on the destination phone if internal. Type the required text directly or use the 
browse button to select the text that should be used including using a the value of a call variable . 

· Description (displayed on phone) 
The text description to display on the destination phone if internal. Type the required text directly or use the 

 browse button to select the text that should be used including using a the value of a call variable . 

· No answer timeout
The value selected is how long the voicemail server waits for an answer before following the No Answer
connection.

Results
This action has the following results which can be connected to further actions: 

· Next 
This connection result is not used.

· No Answer 
This connection result is used if the transfer target does not answer the call. 

· Busy 
This connection result is used if the transfer target returns busy. 
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6.7.7 Dial by Name

 The Dial by Name action enables callers to enter the name of the person or group they want to contact by dialing on
a keypad. The caller is then played a list of matching names from which they make a selection. The list uses the name
prompts recorded by the mailbox users. For an example of the action in a call flow, see Example Call Flow: Dial by Name

.

The action assumes that the telephone uses the ITU standard alphabet markings as shown below. 

· The action prompts the caller to dial the name they require and then press #. Callers can also press *# to exit
without making a selection. For example, dialing 527 matches names starting with JAS (for example "Jason") and
KAR (for example "Karl"). 

· If no matches are found, the caller is given the option to retry.

· If 10 or less matches are found, the matching mailbox name greetings are played as part of a selection list, i.e. 
"Press 1 for …, press 2 for …, …".

· If more then 10 matches are found, the caller is prompted to either press # to hear the first 10 or to dial more
characters to reduce the number of matches. If they select to play the list, after each set of 10 matches they can
either make a selection or follow the prompts for other options.

For a user to be included in the dial by name list, they must:

· Have recorded a mailbox name. 

· Not be marked as ex-directory in the IP Office configuration.

343
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Voicemail Pro Actions: Telephony Actions

Settings

1.Click the  Telephony Actions icon and select  Dial by Name.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.In the Specific tab you can select from three types of names that will be included in the list. Users set to ex-
directory through the Manager application are not included. You can also select how the names will be sorted.

Results
This action has the following results which can be connected to further actions: 

· True 
If the caller makes a selection, the matching extension number is stored as in the $KEY
variable that can then be used by any following action linked to the True result . 

· False 
This result is used if the caller does not make a selection. 
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6.7.8 Conferencing Center

 The Conferencing Center action is used in conjunction with the Avaya IP Office Conferencing Center application. It
provides a route for callers to enter the conference ID and their conference PIN code.

Results

1.Click the  Telephony Actions icon and select  Conferencing Center.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.Select the Specific tab.

· Gather conference and pin information before validation 
If selected, the caller is prompted to enter both the conference ID and then their PIN before the values are
checked. If either entry is invalid the caller is notified but not told which entry is incorrect. If this option is not
selected, the caller is prompted to enter the conference ID first and told if the ID is not valid. If valid they are
then prompts to enter their PIN and then told if the PIN is not valid. 

· Allow the delegate to try and enter the conference ID a total of 
Up to 10 re-tries can be allowed. If the ID is entered incorrectly the result failure is returned.

Results
This action has the following results which can be connected to further actions: 

· Invalid Conference or Password 

· Conference Not Started 

· Conference Finished 

· Conference Full 

· Failure 
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Voicemail Pro Actions: Telephony Actions

6.7.9 Assisted Transfer

 The Assisted Transfer action transfers the caller to the specified number which can include IP Office short codes.
The caller hears either music on hold if installed. The transfer is not blind, if the call receives busy or no answer then it
returns to follow the appropriate connection.

· Note: On systems with IP trunks and extensions and especially within an IP Office Small Community Network there
may be a short delay to connect the speech path when an assisted transfer is answered. 

Settings

1.Click the  Telephony Actions icon and select  Assisted Transfer.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions. 

3.Select the Specific tab. 

· Mailbox 
Enter the number of the destination for the transfer. This can include IP Office short codes or numbers
specified by the current value of a Voicemail Pro call variable  such as $KEY.

· Source of transfer (displayed on phone) 

The number to display on the destination phone if internal. Type the required text directly or use the 
browse button to select the text that should be used including using a the value of a call variable . 

· Description (displayed on phone) 
The text description to display on the destination phone if internal. Type the required text directly or use the 

 browse button to select the text that should be used including using a the value of a call variable . 

· No answer timeout 
Sets how long in seconds the voicemail server should wait for the transferred call to be answered before
following the No Answer results connection.

· Set Call Priority: Voicemail Pro 5.0+. 
If selected, the caller's priority can then be set to Low, Medium or High. A call variable  set to 1, 2 or 3
can also be used to set Low, Medium or High priority respectively.

· When calls are presented to a hunt group on the IP Office, calls waiting to be answered are queue in
order of priority and then longest waiting. By default internal caller's have Low priority while the priority
of external callers is set by the IP Office Incoming Call Route used to route the call (default also Low). 

· Mixing calls of different priority is not recommended if Voicemail Pro is being used to provide queue
estimate time to answer (ETA) and queue position announcements to callers, since those values will no
longer be accurate when a higher priority call is placed into the queue. Note also that in such a situation
Voicemail Pro will not allow a value already announced to a caller to increase. 
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· Notify caller of transfer to target: Voicemail Pro 4.1+. 
If enabled, the caller hears "Transferring to" followed by the associated mailbox name of the destination if
available or otherwise the destination number if it matches an internal extension number. This follows any
prompts selected in the Entry Prompts list above.

 

Results
This action has the following results which can be connected to further actions: 

· Next 
This connection result is not used.

· No Answer 
This connection result is used if the transfer target does not answer the call. 

· Busy 
This connection result is used if the transfer target returns busy. 

· Invalid Number 
This connection result is used if the transfer target is not a valid. 

MS-CRM Call Data Tagging
Call Data Tags enable advanced scenarios to be built around your Microsoft CRM 3.0 and Avaya Microsoft CRM
Integration Solution. In situations where CLI/ANI matching is not sufficient, you can add screening and specific data
collection interactions with your customers using the Voicemail Pro. The Voicemail Pro Assisted Transfer and Transfer
actions can be used to pass data to users and pop matching records based on that data.  

Based on your solutions requirements, you could obtain and verify the data collected, and then transfer the call with a
data tag, that will utilize your specific criteria to lookup the required, account, contact or case, once the call is offered.

The tags are conformant xml fragments, they are comprised of an element AV_M and two attributes the Microsoft CRM
entity (account, contact or incident) and the schema name of the field to match on, in this example ‘contactid’  and the
data is the record key.

For example:

· <AV_M O="contact" S="contactid" >{e44e6dbf-bd2a-da11-badb-505054503030}</AV_M>

where

· <AV_M = element name.

· O="contact" = crm entity.

· S="contactid" = attribute to search on.

· > = end of element attributes

· {e44e6dbf-bd2a-da11-badb-505054503030} = the data to match on, this should be unique.

· </AV_M> - Closing tag.

 

The xml element name, attributes names and Microsoft CRM entity and schema names are case sensitive.

 

Additional Examples

· Account – Account Number: <AV_M O="account" S="accountnumber" >TL00001</AV_M>

· Case – Ticket Number: <AV_M O="incident" S="ticketnumber" >CAS-01001</AV_M>
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Voicemail Pro Actions: Telephony Actions

6.7.10 Alphanumeric

 The Alphanumeric action allows callers to input text and numeric values directly from the telephone keypad. When
completed the entry is stored in the call variable $KEY which can be used by following actions. For an example of the
action being used in a call flow, see Example Call Flow for Mobile Twinning .

The action assumes that the telephone uses the ITU standard alphabet markings as shown below. 

· Users enter data by pressing the key marked with the character required. For keys with multiple marking several
key presses are required. For example, to enter C the user must press the 2 key three times. After each key
press, the associated letter or number is spoken.

· To move on to entering the next character, the user should press whichever other key is marked with the required
character or first press # if the required character is on the key just used.

· Controls available are:

· # - Accept last character and begin entry of next character if the required character is on the key just used.

· *1 - Hear the characters entered so far.

· *2 - Delete all characters entered so far.

· *3 - Delete the last character entered.

· *# - Accept the set of characters entered and go to next call flow action.

 

Settings

1.Click the  Telephony Actions icon and select  Alphanumeric.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.Select the Specific tab.

· Check the option Play Help if you want instruction to be given to the caller explaining how to enter
information.

· If you want to use a timeout result from the action, check the option Wait for a key press for up to and set
the number of seconds for the timeout period.
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Results
This action has the following results which can be connected to further actions: 

· Timeout 
This result connection only available if the option Wait for a key press for up to is
selected on the Specific tab. 

· DTMF Data 
This result connection is used if the caller enters some data and then presses *#.

· No DTMF Data 
This result connection is used if the caller presses *# without entering any data.
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Voicemail Pro Actions: Telephony Actions

6.8 Miscellaneous Actions

 Miscellaneous Actions

·  eMail Action
Email a recording.

·  Open Door Action
Open and/or close a door relay.

·  Alarm Set Action
Set an alarm call time.

·  Clock Action
Play the time to the caller.

·  Post Dial Action
Play a recording to an extension.

·  VB Script Action
Allows Visual Basic to be used to script call flow events.

·  Remote Call Flow
Allows call flows developed elsewhere to be included in an existing call flow.
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6.8.1 eMail

 The eMail action is used to send a recording to a specific email address.

Settings

1.Click the  Miscellaneous Actions icon and select  eMail.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.Select the Specific tab. Complete the fields with relevant details.

· Send e-mail to 
Enter the email address of the recipient.

· Subject 
In the Subject field, type the subject line for the email.

· Content 
In the Content field, type the text to be placed in the email.

· Attach file to e-mail 
In the Attach file to email field the recorded file to be attached to the email needs to be selected. 

· If just $ is entered then the action will use the recording collected by a preceding Leave Mail  action
or Voice Question  action. 

Results
This action has the following result which can be connected to a further action: 

· Next 
Connect the result to the required action.
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Voicemail Pro Actions: Miscellaneous Actions

6.8.2 Open Door

 The Open Door action activates either of the door entry switches provided on IP Office telephone system control
units. These can be used to activate door entry relays. 

Settings

1.Click the  Miscellaneous Actions icon and select  Open Door.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.In the Specific tab, check either of the two door relay options. 

Results
This action has the following result which can be connected to a further action: 

· Next 
Connect the result to the required action.
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6.8.3 Alarm Set

 The Alarm Set action allows an alarm call to be setup to be played to a specified extension at a specified time. By
default the alarm call displays ALARM and plays the prompt "This is an alarm call please hang up". 

On pre-5.0 Voicemail Pro systems this action only allowed internal callers to setup an alarm calls for themselves.
Voicemail Pro 5.0+ allows the action to be used by to setup alarms for other extensions. It also allows preset alarms to
be configured including regular repeating alarms. 

· Alarm calls that have been setup can be viewed in the Voicemail Pro client . They can then be edited or
deleted. 

· The Voicemail Pro is limited to 2 outgoing alarm calls at the same time (subject to voicemail port availability). Any
additional alarm calls are delayed until the existing alarm calls have been completed. 

Settings

1.Click the  Miscellaneous Actions icon and select  Alarm Set.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.In the Specific tab, complete the fields with relevant details.

· Ring alarm on: Default = Caller's Extension. 
These options set the target for the alarm when set. 

· Caller's Extension 
This option sets the alarm target as the caller's own extension number.

· Other Extension 
This option allows a specific number to be used for the alarm target or a call variable  that contains the
number to use. 

· Ring alarm at: Default = Ask Caller.
These options set the time and frequency of the alarm being set. 

· Ask Caller 
The call flow user is asked to dial the required time in 24-hour clock format. This will set a single use
alarm for that time. 

· Specific 
Allow a specific alarm time to be defined. This also allows a single use or a repeated alarm to be
specified. 
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Voicemail Pro Actions: Miscellaneous Actions

· Time (hh:mm) 
Set the alarm time in 24-hour format (hh:mm or hhmm). A time value can be entered or a call
variable  can be used. If left blank or an invalid time value, the call flow user is asked to enter a
time the same as if Ask Caller was selected. 

· Frequency 
Sets how often the alarm should occur. The options are Single, Daily or Weekly. A variable with
value 1, 2 or 3 respectively can be used. 

· Day 
Useable with Single and Weekly alarms. Set the day for the alarm. The option Today is also
available for alarms where the Frequency is set as Single. 

· File 
This field is optional. If a file is specified here it is used for the alarm call. If no file is specified the
default alarm message ("This is an alarm call, please hang up") is used. 

· Display Text 
By default the alarm will display "Alarm" on the target if it is an Avaya display phone. This field can
be used to customize the text used. 

Results
This action has the following result which can be connected to a further action: 

· Next 
This result connection can be used to connect a subsequent action after the alarm is set. 
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6.8.4 Clock

 The Clock action plays the current time on the voicemail server PC. 

Settings

1.Click the  Miscellaneous Actions icon and select  Clock.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.In the Specific tab, complete the fields with relevant details.

· Play Time Until DTMF Input: Software level = 5.0+. 
If not selected the time is played to the caller once. If selected the time is repeated until the caller presses a
DTMF key or hangs up. 

Result
This action has the following result which can be connected to a further action: 

· Next 
If Play Time until DTMF Input is selected then the connection is used after the caller has pressed a
DTMF key. Otherwise it is used after the time has been play once to the caller. 
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6.8.5 Post Dial

 The Post Dial action can be used to connect another extension to a specified call flow start point or to play a
recording to that extension. 

Settings

1.Click the  Miscellaneous Actions icon and select  Post Dial.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.In the Specific tab, complete the fields with relevant details.

· Post action 
Select this option if you want the connect a target extension to a selected call flow. 

· Post wave file 
Select this option if you want the target extension to be played a selected wav file. When Post wave file is
selected there are two options which can be selected.

· Play out a looped wave file 
The wav file will be played in a continuous loop.

· Delete the wave file after completion 
The wav file will be deleted after it has been played.

· Post the following action or wave file 
Enter the name of the required start point or use the browse button to select the start point. To play a
recording, enter c:\mywavs\hello.wav (substitute the appropriate file path and file name for the .wav file
you want played).

· To extension 
Enter or select the extension to which the call should be made. The voicemail server will attempt to make the
call every 5 minutes for the next hour until successful. The Post Dial action can be used to page a .wav file to
an extension number, including group extension numbers. This is done by entering PAGE: followed by the
target extension number. In this case the wav file will not loop if selected.

Results
This action has the following result which can be connected to a further action: 

· Next 
Connect the result to the required action.
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6.8.6 VB Script

 The VB Script action allows an administrator to construct additional call flow logic using VBScript commands and
various properties  and methods. Use of VBScript requires entry of a valid VM Pro VBScript license in the IP Office
configuration. 

When a VBScript action is executed, the voicemail server allows the script up to 1 minute to complete execution. If
execution of the script takes longer then it is terminated by the voicemail server and the action's Failure result path is
used. 

Settings

1.Click the  Miscellaneous Actions icon and select VB Script. 

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.Select the Specific tab.

· Enter VBScript 
In the script area enter the VBScript as required. Strings for the variables and methods provided for VBScript
by Voicemail Pro can be selected and inserted by right clicking on the script area. This script can contain a
maximum of 10000 characters. 

· Expand 
Check Expand to view a larger script area.

· Syntax Check 
Click the Syntax Check button to check your input for any errors.

 

Results
This action has the following results which can be connected to further actions: 

This action has two results, Success or Failure.
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6.8.7 Remote Call Flow

 The Remote Call Flow action allows a call flow, in the form of a .vmp file, developed elsewhere to be included in an
existing call flow. The aim of this action is to allow call flows developed by other applications to be placed on the
Voicemail Pro server and included in its customized call flows.

Settings

1.Click the  Miscellaneous Actions icon and select  Remote Call Flow.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.In the Specific tab, the field Remote Call Flow will show a list of remote call flow files downloaded to the
Voicemail Pro server.

Results
The Remote Call Flow action has no results. Any follow on call handling is determined by the
actions in the remote call flow.
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6.9 Condition Actions

 Condition Actions
These actions are used to create branches in the call routing according to whether a value is true or false.

·  Test Condition Action
Test whether a condition is true or false.

·  Set User Variable Action
Set a variable to a particular value.

·  Test User Variable Action
Test the value of a variable.

·  Test Variable Action
Check if user dialing matches set digits.

·  Increment and Test Counter  
Increment a $COUNTER variable and then test whether is matches a specified value. 

·  Decrement and Test Counter  
Decrement a $COUNTER variable and then test whether is matches a specified value.  

6.9.1 Test Condition

 The Test Condition action allows the current state (True or False) of a condition setup through the Conditions
Editor  to be checked. 

Settings

1.Click the  Conditions Actions icon and select  Test Condition.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.In the Specific tab, complete the fields with relevant details.

· Return the results of the following condition 
Allows a selection to be made from the conditions currently setup.

Results
This action has the following results which can be connected to further actions: 

· True 
This result connection is used by the call if the tested condition is currently true. 

· False 
This result connection is used by the call if the tested condition is currently false. 

For examples of the Test Condition action in a call flow, see:

· Customizing a Hunt Group Call Flow .

· User Defined Variables .
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6.9.2 Set User Variable

 The Set User Variable action sets a user variable to a particular value. Other call flows can then use Test User
Variable  actions to check whether the variable has a particular value. 

The variable must first be created using the User Defined Variable  menu or User Variables  panel. For an
example of the action in a call flow, see User Defined Variables .

Settings

1.Click the  Conditions Actions icon and select  Set User Variable.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.Select the Specific tab. Complete the fields with relevant details.

· Assign the following user variable
The name for the existing user variable. The variable must first be created using the User Defined Variable

 menu or User Variables  panel.

· With the following value

The value of the variable. Type the required value directly or use the  browse button to select the text that
should be used including using a the value of a call variable . 

Results
This action has the following result which can be to a further action: 

· Next 
We strongly recommend that this action is connected to another action (if necessary just
a Disconnect action), whose entry prompt confirms to the caller that the value has been
set. In some situations, such as where the Set User Variable action is accessed by the
user dialing a short code, if the user hangs-up too quickly the variable may not actually be
set. Having a following action with a confirmation message encourages users not to hang
up too quickly.
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6.9.3 Test User Variable

 The Test User Variable action has true and false connections that are followed according to whether the selected
user variables  current value matches a particular value. The Set User Variable action can be used in other calls to
set the value of the variable. For an example of the action in a call flow, see User Defined Variables . 

Settings

1.Click the  Conditions Actions icon and select  Test User Variable.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.In the Specific tab, complete the fields with relevant details.

· This action will return "TRUE" if the following variable
The name of the existing user variable to be checked. 

· Matches the value below

The value of the variable that will return a true result. Type the required value directly or use the  browse
button to select the text that should be used including using a the value of a call variable . 

Results
This action has the following results which can be connected to further actions: 

The action can have the following results which can then be connected to further actions: 

· True 
This result connection is used by the call if the tested condition is currently true.

· False 
This result connection is used by the call if the tested condition is currently true.
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6.9.4 Test Variable

 For Voicemail Pro 4.2+, the Test Variable action has been added and replaces the previous Check Digits action. It
allows calls to be routed based on matching the value of a call variable to a specified value. 

Settings

1.Click the  Conditions Actions icon and select  Test Variable.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.The following controls are available on the Specific tab: 

· Select the variable to Match
This drop-down list is used to select which Voicemail Pro call variable  should be checked for a match. Note
that with $KEY the timeout is used and additional dialing is accepted if no immediate match occurs.

· Select the parameter(s) to test the variable against
Select the types of values that should be checked for a match and if necessary entry the value. If several
options are selected, the Voicemail Pro checks for a match starting from the top and working down until a
match occurs. 

· Variable 
Check for a match against the value of another selected call variable . Type the required value directly

or use the  browse button to select the text that should be used including using a the value of a call
variable . 

· Specific
Check for a match against the value entered in the adjacent field. 

· Extn
Check for a match against valid extensions on the IP Office.

· Hunt Group
Check for a match against hunt group extension numbers. 

· Mailbox
Check for a match against mailboxes. 

· Timeout after
The timeout value is used only if $KEY is selected as the variable to match. In that case, if no immediate
match occurs on the existing value of $KEY, the Voicemail Pro will wait for the specified timeout period for the
caller to dial a new value of $KEY. 
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Results
This action will have results for connection to following actions in the call flow based on the selected options on its 
Specific tab plus a No Match and Timeout result: 

· No Match
This result is used if no match is found. 

· Timeout
This result is used when $KEY is specified as the variable to match and no match occurs within
the specified timeout period. 
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6.9.5 Decrement and Test Counter

 Decrease the values of a $COUNTER variable by 1 and then test whether its new value matches a target value. 

Voicemail Pro 5.0+ provides counter variable $COUNTER1 to $COUNTER15. These can be used in the same way as other
variables. They can also be manipulated using  Generic  action commands for Set Counter , Clear Counter ,
Counter Decrement  and Counter Increment . They can also be used with the Decrement and Test Counter
and Increment and Test Counter  actions. By default the initial value of a counter variable is 0.  The
formats $COUNTERx or $COUNTER[x] are both supported.

Settings

1.Click the  Conditions Actions icon and select  Decrement and Test Counter.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.The following controls are available on the Specific tab: 

· Select Counter 
Select the $COUNTER variable to decrement and then test. $COUNTER1 to $COUNTER15 can be selected by
entering 1 to 15 respectively. 

· Value to test counter against 
This can be a number or another call variable. When the counter matches the value the True result
connection is used, otherwise the False result connection is used. 

Results
This action has the following results which can be connected to further actions: 

· True 
This result connection is used if the counter value matches the test value. 

· False 
This result connection is used if the counter value does not match the test value. 
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6.9.6 Increment and Test Counter

 Increase the values of a $COUNTER variable by 1 and then test whether its new value matches a target value. 

Voicemail Pro 5.0+ provides counter variable $COUNTER1 to $COUNTER15. These can be used in the same way as other
variables. They can also be manipulated using  Generic  action commands for Set Counter , Clear Counter ,
Counter Decrement  and Counter Increment . They can also be used with the Decrement and Test Counter
and Increment and Test Counter  actions. By default the initial value of a counter variable is 0.  The
formats $COUNTERx or $COUNTER[x] are both supported.

Settings

1.Click the  Conditions Actions icon and select  Increment and Test Counter.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.The following controls are available on the Specific tab:

· Select Counter 
Select the $COUNTER variable to increment and then test. $COUNTER1 to $COUNTER15 can be selected by
entering 1 to 15 respectively. 

· Value to test counter against 
This can be a number or another call variable. When the counter matches the value the True result
connection is used, otherwise the False result connection is used. 

Results
This action has the following results which can be connected to further actions: 

· True 
This result connection is used if the counter value matches the test value. 

· False 
This result connection is used if the counter value does not match the test value. 
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6.10 Database Actions

 Database Actions
These actions relate to retrieving and adding data to a database. The use of database actions with Voicemail Pro requires
entry of a VMPro Database Interface license in the IP Office configuration.

·  Database Open Action
Open a database.

·  Database Execute Action
Perform an action on a database.

·  Database Get Data Action
Get information from a database.

·  Database Close Action
Close a database. 

6.10.1 Database Open

 The Database Open action opens a link to a database. If there is a connection to the database already then the
current connection is closed and the new one requested will be opened. For an example of the action in a call flow, see 
IVR Database Connection Example, Retrieving Data From the Database .

Settings

1.Click the  Database Actions icon and select  Database Open.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.Select the Specific tab. The connection string to open the database can be entered directly into the field. For help

on constructing the connection string, click . The Data Link Properties window opens.

· Provider Tab 
Select the OLE DB Provider of the data that is to be connected to. Click Next to move to the Connection
Tab.

· Connection Tab
Specific information relating the Database provider needs to be completed. Help of the information required
for each of the fields can be obtained by clicking the Help button. Fields available will be dependant on the
type of provider. Test that the information entered will allow entry into the database, click the Test Connection
button. A message Test Connection Succeeded will show if successfully connected to the database.

· Advanced Tab 
Network and other settings, for example access permissions. Fields showing will be dependant on the type of
provider selected. Click help for specific information about any of the fields.

· All 
The properties that have been selected on the previous tabs are shown in the All Tab. Amendments can be
made as required by selecting the Name and click Edit Value.

Results
This action has the following results which can be connected to further actions: 

· Success 
This result connection is used once the database is opened.

· Failure 
This result connection is used if the database cannot be opened. 
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6.10.2 Database Execute

 The Database Execute action performs an SQL query on a database opened on a preceding Database Open
action. An SQL query that is generated by the Database Execute Action does not support spaces in field or table names.
To avoid problems in a Microsoft Access database, it is advisable to avoid using a field name that has the same name as
its field type. For example, you should avoid using the name Number for a number field.

Settings

1.Click the  Database Actions icon and select  Database Execute.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.Select the Specific tab. The SQL Wizard window opens. Use the wizard to construct the SQL query. 

· You must ensure that any data included in the query matches the data type (number, integer or text) of the
field it is being used to query. Values being used to query a text field should be enclosed by quotation marks.
This applies whether using query values entered directly or using Voicemail Pro variables. For example, if
using $KEY as a query value, for a text field query ensure that you enter "$KEY". 

Results
This action has the following results which can be connected to further actions: 

· Success 
The action has been successful and has returned a set of records from the database. 

· Failure 
The action has not returned any data. 

The Database Execute action results can only be Success or Failure. Add connections to relevant actions. For an
example of the action in a call flow, see IVR Database Connection Example, Retrieving Data From the Database  and
Entering Details in to the Database .
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6.10.3 Database Get Data

 Once a Database Execute  action has been used, it may return a set of records from the database. A Database
Get Data action or actions are then used to select which record is the currently selected record whose values are placed
into the call flow's $DBD variables. 

Settings

1.Click the  Database Actions icon and select  Database Get Data.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.Select the Specific tab. Chose which record should be selected by selecting one of the following options:

· Retrieve the next item in the list 
Select the next record returned by the Database Execute action as the currently selected record. 

· Retrieve the previous item in the list 
Select the previous record returned by the Database Execute action as the currently selected record. 

· Retrieve the first item in the list 
Select the first record returned by the Database Execute action as the currently selected record. 

· Retrieve the last item in the list 
Select the last record returned by the Database Execute action as the currently selected record.  

Results
This action has the following results which can be connected to further actions: 

 The Database Get Data action has four possible results.

· Success
The selected records values have successfully been assigned to the $DBD variables.

· At End
There are no further records in the set of data.

· Empty
The execute method returned no data, the $DBD variable contains no information.

· Failure
There was a problem trying to retrieve the next data record, the $DBD variable contains no
information.

Examples of using the database actions are given in the IVR database Connection section. For an example of the action in
a call flow, see IVR Database Connection Example, Retrieving Data From the Database .
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6.10.4 Database Close

 The Database Close action will close the current database connection. If the database is open when a call
terminates, then a Database Close action is run automatically.

Settings

1.Click the  Database Actions icon and select  Database Close. 

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.There is no Specific tab for this action.

Results
This action has the following results which can be connected to further actions: 

· Success 
The database connection has been closed.

· Failure 
The database connection has not been closed. This action is useful during testing and
development of the database call flow to validate correct operation. 
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6.11 Queue Actions

 Queue Actions
These actions are associated with hunt group queues and are not available to user and short code start points. The IP
Office Manager option Synchronise calls to announcements should not be used when using the queue actions.  

·  Queue ETA Action
Speak the caller's expected time to answer.

·  Queue Position Action
Speak the caller's queue position.
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6.11.1 Queue ETA

 The Queue ETA action plays the estimated time to answer (ETA) in minutes to a caller in the queue of calls for a
hunt group. It is not used for calls queued for a user. 

The ETA is supplied by the IP Office when it requests a queue or still queued announcement message to be played to a
caller. It is calculated based on the queued time in the previous hour of the last 5 queued and answered calls. It is always
rounded up to the nearest minute. For an example, see Customizing Queuing .

Normally a simply announcement is used that does not include queue position and estimated time to answer. However if
required the Queued and Still Queued call flow start points can be added and customized using actions including this
one. 

· When calls are presented to a hunt group on the IP Office, calls waiting to be answered are queue in
order of priority and then longest waiting. By default internal caller's have Low priority while the priority
of external callers is set by the IP Office Incoming Call Route used to route the call (default also Low). 

· Mixing calls of different priority is not recommended if Voicemail Pro is being used to provide queue
estimate time to answer (ETA) and queue position announcements to callers, since those values will no
longer be accurate when a higher priority call is placed into the queue. Note also that in such a situation
Voicemail Pro will not allow a value already announced to a caller to increase. 

· The IP Office Manager option Synchronize calls to announcements should not be used with call flows that
include this action. 

 

Settings

1.Click the  Queue Actions icon and select  Queue ETA. 

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all actions.

3.Select the Specific tab. This tab may include any further prompts to be played to the caller after they hear their ETA.

Results
This action has the following result which can be connected to a further action:

· Next 
Connect the result Next to a relevant action.
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6.11.2 Queue Position

The Queue Position action plays the caller their position within the queue of calls for a hunt group. It is not used for
calls queued for a user. The queue position is supplied by the IP Office when it requests a queue or still queued
announcement message to be played to a caller. 

Normally a simply announcement is used that does not include queue position and estimated time to answer. However if
required the Queued and Still Queued call flow start points can be added and customized using actions including this
one. 

· When calls are presented to a hunt group on the IP Office, calls waiting to be answered are queue in
order of priority and then longest waiting. By default internal caller's have Low priority while the priority
of external callers is set by the IP Office Incoming Call Route used to route the call (default also Low). 

· Mixing calls of different priority is not recommended if Voicemail Pro is being used to provide queue
estimate time to answer (ETA) and queue position announcements to callers, since those values will no
longer be accurate when a higher priority call is placed into the queue. Note also that in such a situation
Voicemail Pro will not allow a value already announced to a caller to increase. 

· The IP Office Manager option Synchronize calls to announcements should not be used with call flows that
include this action. 

 

Settings

1.Click the  Queue Actions icon and select  Queue Position.

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions. The Entry Prompts tab should include any prompts to play to the caller before they hear their position.
See Entry Prompts Tab .

3.Select the Specific tab. This tab may include any further prompts to be played to the caller after they hear their
position.

Results
This action has the following result which can be connected to a further action:

· Next 
For an example of the Queue Position action in a call flow, see Customizing a Hunt Group
Callflow .
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Administration

Chapter 7.
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7. Administration
7.1 Routing Calls to Voicemail
There are different methods by which callers can be transferred to voicemail. The transfer can be used to route the caller
to a specific mailbox to leave or collect messages or to a particular Voicemail Pro start point.

The sections that follow describe the use of Voicemail Collect short codes and VM: paths as telephone numbers. These
can then be applied to dialing, DSS keys SoftConsole and Phone Manager buttons.

An example Voicemail Pro module is included which allows the transferred caller to select the extension to which they
want to talk or leave a message.

· VM: versus Short Codes? 
The VM: method is easier to deploy. For IP Office applications such as SoftConsole and Phone Manager, it can be
used without the need to access and change the  IP Office configuration using IP Office Manager. However, the
disadvantage is that VM: cannot be dialed from a physical phone. Short codes have the advantage that they can
be dialed at an extension once set up through IP Office Manager.
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7.1.1 Routing Calls to Voicemail
If a user has voicemail switched on, calls will be automatically routed to voicemail if either:

1.The extension is busy and call waiting has not been enabled.

2.The user has do not disturb set or the extension is not answered within the No Answer Time as set in IP Office
Manager program (default 15 seconds).

The caller hears the standard greeting message 'Your call is being answered by IP Office. <Name> is not available. To
leave a message, wait for the tone,'. A user can record their own greeting messages if required.

When new messages are received, the user's telephone call display or IP Office Phone Manager application is updated to
show the number of new messages waiting.

If Voicemail Ringback is enabled, the Voicemail Server calls the user's extension to attempt to deliver new messages
when the user next uses the telephone.

All messages are stored until they have been listened to and are then automatically deleted after a set time period. The
default time period for IP Office mode is 36 hours. In IP Office mode users can designate a message as saved so that it is
not automatic deleted.

A mailbox owner can turn voicemail and voicemail ringback on or off using Phone Manager. The default short codes can
also be used. The default short codes are:

· *18 - To turn voicemail on.

· *19 - To turn voicemail off.

· *48 - To turn voicemail ring back on.

· *49 - To turn voicemail ring back off.

 

7.1.2 Forward Unconditional to Voicemail
For IP Office 5.0+, the option To Voicemail is available for Forward unconditional on the User | Forwarding tab
within the IP Office configuration. When selected, the Forward Number set for Forward Unconditional is overridden and
calls are sent direct to the user's mailbox. 

The option Forward Hunt Group calls is also overridden if To Voicemail is selected. 

7.1.3 Transferring Calls to Voicemail
The facility to transfer a call directly to a user's voicemail is available using the SoftConsole or Phone Manager
applications. For users who are not using these applications, you can create a short code for them.

For example:

Field Setting

Code *201

Feature Voicemail Collect

Telephone Number "#Extn201"

Line Group Id 0

 

When creating short codes for use with voicemail, the ? indicates "collect voicemail" and the # indicates "deposit
voicemail". The telephone number entry must also be enclosed by quotation marks as shown in the example.
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7.1.4 Using Short Codes to Access Voicemail
The short code Voicemail Collect feature can be used to route callers to voicemail. The voicemail service they receive is
set by the telephone number field which should be enclosed in quote marks. See Voicemail Telephone Numbers .

· The examples use *80 but any available short code could be used.

Example 1: Access to the Mailbox Main 
The following short code will access the mailbox for Main. The ? indicates that it is to collect messages. A # is used to
indicate leave a message in the mailbox.

Field Setting

Code *80

Feature Voicemail Collect

Telephone Number "?Main"

Line Group Id 0

 

Example 2: Access a Voicemail Pro Module 
If a Voicemail Pro module has been created and called TimeCheck, the following short code could be used to access it.

Field Setting

Code *80

Feature Voicemail Collect

Telephone Number "TimeCheck"

Line Group Id 0

The Voicemail Node short code feature can also be used to access short code start points. It uses the short code start
point name as the telephone number without surrounding brackets.
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7.1.5 Using VM: to Access Voicemail
Another method for accessing voicemail is the VM: option, where VM: is followed by the name of the mailbox or
Voicemail Pro start point required.

This can be used in the telephone number field of IP Office applications such as SoftConsole, Phone Manager and
Manager.

· Example 1: SoftConsole access to the mailbox Main 
The user wants single click access to check for messages in the hunt group mail box Main (extension ID 200).

1.Start SoftConsole.

2.Click one of the BLF panel tabs.

3.Right-click and select New > BLF Group Member.

4.Type a Name, for example Messages.

5.Type a Number, in this case enter VM:?Main or VM:?200.

6.Click OK. The operator can now check for messages in that group mailbox with a single click.

 

· Example 2: Accessing a Module from Phone Manager 
The user wants to access a particular Voicemail Pro module, for this example one called TimeCheck.

1.Start Phone Manager.

2.Click the Speed Dials tab.

3.Right-click and select New.

4.Type a Name, for example Time Check.

5.Type a Number, in this case enter VM:TimeCheck.

6.Click OK.

 

· Example 3: Incoming Call Routing 
The VM notation can be used in the Destination field of a Manager Incoming Call Route. This enables you to route
calls that match the Incoming Call Route's criteria to a particular mailbox or Voicemail Pro module.
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7.1.6 Voicemail Telephone Numbers
This section describes the options that can be used with VoicemailCollect short codes and with VM: to access a mailbox
or Voicemail Pro start point. 

 Short Code Application Number Field

Collect Messages ?200 VM:?200

"?Main" VM:?Main

Leave Messages #200 VM:#200

"#Main" VM:#Main

A user attempting to collect mail from user mailboxes will be prompted for the voicemail PIN code if not accessing from a
trusted source. See Creating a Trusted Location .

 

Voicemail Pro Start Points 
The following only apply when a matching start point has been set up. If a short burst of ringing is required then #
should be inserted before the start point name. This is useful if transferring callers as it allows the transfer to be
completed before the Voicemail Prompts begin.

 Short Code Application Number Field

User Start Points for examples a user called Extn205.

Collect "Extn205.Collect" VM:Extn205.Collect

Leave "Extn205.Leave" VM:Extn205.Leave

Callback "Extn205.Callback" VM:Extn205.Callback

Queued - -

Still Queued - -

Group Start Points for example a group called Main.

Collect "Main.Collect" VM:Main.Collect

Leave "Main.Leave" VM:Main.Leave

Queued - -

Still Queued - -

Default Start Points  

Collect "Default.Collect" VM:Default.Collect

Leave "Default.Leave" VM:Default.Leave

Queued - VM:Default.Queued"

Still Queued - VM:Default.Still Queued"

Short Code Start Points 
(see also Voicemail Node)

for example a shortcode start point called DVM.

"Short Codes.DVM" VM:Short Codes.DVM

Module Start Points for these examples a module called Attend…

"Attend" VM:Attend

Campaigns for example a campaign called Catalogue.

Leave - VM:Catalogue

Collect - VM:Catalogue.Collect

The Voicemail Node short code feature can also be used to access short code start points. It uses the short code start
point name as the telephone number without surrounding brackets.
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7.1.7 Example Call Flow
This example creates a Voicemail Pro module that allows callers to select the extension to which they want to be
connected. If that extension is busy or does not answer they can then leave a message in the target mailbox.

The Voicemail Pro Module

1.In Voicemail Pro, a module was added named SelfSelect.

2.A Menu action was added. The properties were set as:

· On the Touch Tones tab the Wait for a key press for option was set to 5 seconds. This gives the action a
Timeout result which can be used if the caller does nothing or does not have DTMF dialing.

· Our IP Office has extensions and groups numbered in the 200 to 299 range. The touch tone sequence 2??
was added to match any dialing in that range.

· In Entry Prompts a prompt was recorded along the line of "Dial the number you want or wait for reception".

3.A Transfer action was added. In its properties, on the Specific tab the Destination was set to Main, the hunt
group containing our receptionists.

4.A connection was added from the Menu action's Timeout result to the Transfer action.

5.An Assisted Transfer action was added. In its properties, on the Specific tab $KEY was added in the Mailbox
field.

6.A connection from the Menu action's 2?? result to the Assisted Transfer action was added.

7.A Leave Mail action was then added. In its properties, on the Specific tab $KEY was again added in the Mailbox
field.

8.The Assisted Transfer action's No Answer and Busy result was connected to the leave Mail action.

9.Connections were then added from the Assisted Transfer action's Next result and the Leave Mail action's
Success and Failure results back to the Menu action.

· The Success and Failure results in a Leave Mail action are only used if the caller presses 0 when in the
mailbox.

10.The call flow was then saved and made live.

 



Voicemail Pro Page 242
15-601063 Issue 21c (16 July 2009)IP Office 5.0

Creating a Matching Short Code 
A short code was needed that could be used to route callers to the SelfSelect module.

1.Start IP Office Manager and receive the configuration.

2.A new system short code was added so that it would be available to all callers. The short code *80 was set up as
shown in the table.

Field Contains...

Code *80

Feature Voicemail Collect

Telephone Number "#SelfSelect"

Line Group Id 0

3.The entry “#SelfSelect” indicates the name of the Voicemail start point for the call, in this case the
VoicemailProSelfSelect module

4.For a module start point the # is optional. Using it provides a short period of ringing before the module actions
start. This is useful if manually transferring a caller as otherwise they may miss the start of the module's entry
prompts.

5.The new configuration was merged.

6.At any extension the routing can be tested by dialing *80. We can then wait to be transferred to reception or dial
the extension or group that we want.

 

Using the Module 
The short code *80 can now be assigned or the path VM:SelfSelect to whichever method the user wants to transfer
callers to the voicemail service.

A further suggestion is to provide a system short code to deal with callers who dial an invalid extension number. For our
example, a short code 2??/./"SelfSelect"/VoicemailCollect would reroute such callers back to the SelfSelect
module.
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7.2 User Voicemail Access
By default, a user can dial *17 to access their voicemail from their own extension.

A user mailbox cannot be accessed from any other location (internal or external) until a voicemail code has been set for
the mailbox. This access code is set in the IP Office Manager. Voicemail can be configured for each individual user in IP
Office Manager. See Configuring Voicemail for Individual Users .

If IP Office Manager has been configured, users can also collect their voice messages by using one the following
methods.

· Using the Messages button on their telephone 
If their extension is a trusted extension they can access their messages without entering a voicemail code by
pressing the Messages button. See Creating a Trusted Location .

· Using a Voicemail Collect button. 
A button can be programmed to allow a user to collect voice messages from their telephone. If their extension is a
trusted extension they can access their messages without entering a voicemail code See Giving Users Button
Access to Voicemail .

· Using Visual Voice 
A user can be given a display menu to user for access to their mailbox. The menu provides the user with options
to listen to messages, send messages, change their greetings and password. See Giving Users Button Access to
Voicemail .

· Using a short code. 
Short codes can be created so a user can be given access to their mailbox from locations other than their office
desk. When they call the mailbox, they will be prompted to enter the access code. See Giving Users Access from
Any Extension  and Voicemail Telephone Numbers .

If direct access is required a specified location can be set up as a trusted location. The caller then does not need to enter
an access code. Access can be from the users own extension or another location. See Creating a Trusted Location .

If users need to access their voicemail messages when they are away from the office, you can set up an Incoming Call
Route in IP Office Manager with the destination as Voicemail. Giving Users Access from an External Location .

Users can also receive notification of new voicemail messages at either their own extension or at another location. To
receive notification of new messages a user needs to configure their outcalling. See Outcalling .
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7.2.1 Giving Users Button Access
A user's telephone can have buttons programmed to allow access to voicemail. Not all telephones support this feature,
refer to the relevant guide for more information.

Buttons can be programmed for:

· Visual Voice

· Voicemail Collect .

 

Voicemail Collect Button 
Users can collect their voice messages from their own extension using a button programmed for voicemail collect. If their
extension is a trusted extension they will not need to enter their voicemail code. See Creating a Trusted Location .

A button on the user's telephone will display the label VMCol. The extension number or voicemail code do not need to be
entered if the extension is a trusted extension.

To add a voicemail collect button:

1.Start IP Office Manager and receive the IP Office configuration.

2.Click  User to display the list of existing users.

3.Click the required user.

4.Click the Button Programming tab.

5.Click the button line that you want to change.

6.Right-click in the Action field.

7.Select Advanced > Voicemail > Voicemail Collect.

8.Click OK to save the button details for the selected user.

9.Repeat for any other users.

10.Click  to merge the changes back to the IP Office system.

 

Visual Voice Button 
A Voicemail Pro user can be given a display menu for access to their mailbox. The menu provides the user with options to
listen to messages, send messages, change their greetings and password.

· The Visual Voice feature is not available on all telephones. Please refer to the user's telephone guide for more
information.

· Visual voice is only available when in Intuity mode. 

· For IP Office 4.2+, the MESSAGES button on phones can be set to access visual voice. This is done using the 
Messages Button Goes to Visual Voice (System | Voicemail) option in IP Office Manager. 

To give a user access to Visual Voice:

1.Start IP Office Manager and receive the IP Office configuration.

2.Click  User to display the list of existing users.

3.Click the required user.

4.Click the Button Programming tab.

5.Click the button line that you want to change.

6.Right-click in the Action field.

7.Select Emulation > Visual Voice.

8.Click OK to save the button details for the selected user.

9.Repeat for any other users.

10.Click  to save the changes back to the IP Office system. 
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7.2.2 Giving Users Access from Any Extension
Access to voicemail from any extension can be given to either:

· An individual user 
So that a specified user can log in to their voicemail from any extension, you need to set up a short code and associate
it with the user's extension number. For example, a short code *90 could be associated with extension number 201.
The user with extension 201 can then dial *90 from any extension and enter their voicemail code to collect their
voicemail messages.

To give a specific user access from any extension:

1.Open IP Office Manager.

2.Set up a short code, for example *90. 

Field Contains...

Code *90

Feature Voicemail Collect

Telephone Number "?Extn201"

Line Group ID 0

 

· All users 
To give all users access to voicemail from any extension you need to set up a short code. When a user dials the short
code from any extension they will be prompted for their mailbox number (extension number) and voicemail code.

To give all users access from any extension:

1.Open IP Office Manager.

2.Set up a short code, for example *98:

Field Contains...

Code *98

Feature Voicemail Collect

Telephone Number ?Anonymous

Line Group ID 0
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7.2.3 Giving Users Access from an External Location
If users need to access their voicemail messages when they are away from the office, you can set up an Incoming Call
Route in IP Office Manager with the destination as Voicemail. See the IP Office Manager help or guide.

To give users access from an external location:

1.Open IP Office Manager.

2.In the Navigation pane, click Incoming Call Route and add a new call route.

3.In the destination field, select the option Voicemail. When an incoming call is matched the call is passed to
voicemail to enable remote mailbox access. Callers are asked to enter the extension ID of the mailbox required
and then the mailbox access code.

4.Click OK to save the changes.

5.Click  to merge the configuration back to the IP Office.

 

7.2.4 Creating a Trusted Location
If a user regularly accesses their voicemail messages from another extension or a number that presents a CLI, such as
their mobile or home number, this extension or number can be set up as a trusted location.

To configure a trusted location:

1.Open IP Office Manager.

2.In the Navigation pane, click  User and select the individual user.

3.View the Source Numbers tab.

4.Add a V source number.

· Enter the users extension number. 
For example, a user whose extension number is 214 wants to be able to collect their voicemail without entering their
voicemail code. A source number V214 would be entered.

· Enter a different extension number. 
For example, a user whose extension is 214 wants to be able to collect their voicemail from extension 204. A source
number V204 would be entered. From now on when the user of extension 214, dials a short code from extension
204 they will not be prompted for their voicemail code. Not supported for Intuity mailbox users.

· Add a V source number containing the external telephone number. 
For example, V01923 38383 would be entered if the external number was 01923 38383.When the user dials the
number set up as the Incoming Call Route to Voicemail from the "trusted location", they will not be prompted for
their mailbox number or Voicemail Code. See Giving Users Voicemail Access from an External Location . Not
supported for Intuity mailbox users.

5.Click OK to save the changes.

6.Click  to merge the configuration back to the IP Office.
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7.3 Hunt Group Voicemail
Hunt groups must first be set up in IP office. You can then use Voicemail Pro to configure the way in which voicemail
works for a hunt group.

Voicemail Provides a number of services for hunt groups.

· Announcements 
If a caller is waiting to be answered, queuing or the hunt group is in out-of-hours mode, the voicemail server can
provide appropriate greetings to callers. These greetings can be changed through the normal mailbox controls.
Mailbox users can find out more in the IP Office or Intuity Mailbox user guides. See Out of Hours Operation .
See Configuring Announcements .

· Voicemail Pro allows the actions available to a queued caller to be customized as well as the greeting
messages.

· Voicemail Pro does not control the queuing of calls. Queuing is controlled by the IP Office switch that presents
queued and still queued calls at the appropriate times and provides the queue position and ETA data.

· Messaging 
If voicemail for a hunt group is on (the IP Office default), calls to the hunt group are automatically routed to
voicemail if all available extensions have been called for the number of seconds defined in the IP Office No Answer
Time parameter. The default time setting is 15 seconds.

· Message Waiting Indication 
By default there is no indication on the handset when a hunt group mailbox contains messages and no direct
access method to a hunt group mailbox.

· For hunt group members to receive message indication, an appropriate H source number entry needs to be
added. See Configuring Hunt Group Message Waiting Indication .

· For access by other users an access short code can be used. See Enabling Access to Hunt Group Voicemail
with a Short Code .
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7.3.1 Configuring Message Waiting Indication
By default no message waiting indication (MWI) is provided for hunt groups. If required indication can be enabled for
specific users including users who do not belong to the hunt group. If the user is not a member of the hunt group, a
voicemail code is also required. This is entered in the Voicemail Code field on the Hunt Group > Voicemail tab in the
IP Office's configuration. Alternatively the user can be made a member or the group but have their membership set to
disabled. This allows them to access the group mailbox without receiving group calls.

Depending on the type of telephone phone or IP Office application they are using, users who receive hunt group message
waiting indication can choose any of the following methods to collect messages.

· Phone Manager 
If Phone Manager is used, the group name and number of new messages is displayed in the Messages tab. Users
click the Messages tab to access the group mailbox.

· 4400 Series Phones 

On phones with a Menu  button, press Menu  | Menu  | Msgs | Voice. The group name is shown
along with the number of new messages. Press the display button to access the group mailbox.

· Voicemail Ringback 
If a user has voicemail ringback enabled, ringback will occur for new group messages as well as new personal
messages. Ringback for personal messages takes place before any ringback for new group messages.

 

This method of configuring hunt group message waiting indication allows individuals, including users who are not
members of the group, to receive hunt group message waiting indication.

To configure message waiting indication:

1.Open IP Office Manager.

2.In the Navigation pane, click  User and select the individual user.

3.View the Source Numbers tab.

4.Click Add.

5.In the Source Number field, enter H followed by the hunt group name. For example, to receive message waiting
indication from a hunt group called Main, enter HMain.

6.Click OK.

7.Click  to merge the configuration change back to the IP Office.
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7.3.2 Configuring Group Broadcast
If the Broadcast option is enabled, a message for a hunt group is copied to the individual user mailboxes of each hunt
group member. A call flow can be created that includes the Generic Action. See Generic Action . If messages need to
be forwarded to the same group a Personal Distribution List could be created. See Personal Distribution Lists .

To configure Group Broadcast:

1.Open IP Office Manager.

2.In the Navigation pane, click  HuntGroup and select the required group.

3.Click the Voicemail tab.

4.Check Broadcast.

5.Click OK.

6.Click  to merge the configuration change back to the IP Office.
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7.3.3 Using a Short Code to Collect Voicemail
To access messages for a hunt group, a short code can be created. For example, for a group called Main a short code
can be added with the following properties.

Field Contains...

Code *99

Feature Voicemail Collect

Telephone Number "?Main"

Line Group Id 0

 

For systems running in Intuity mode, the above will work only if the user is a member of the group and a custom call
flow has also been set up for the collect start point to that hunt group.

 

Members of the hunt group Main can now dial *99 from their own extensions to access hunt group messages. In IP
Office mode, to use this short code for access from an extension that is not a member of the hunt group, a voicemail
code should be configured for the group.
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7.3.4 Out of Hours Operation
Voicemail Provides a number of greetings for groups. One of these is an Out of Hours Greeting.

Through IP Office Manager or using a short code a hunt group can be taken in or out of service. When the group is Out of
Service, callers are played the group's "Out of Hours" greeting and can then leave a message. Alternatively, if an Out of
Service Fallback Group has been configured, callers are passed to that group.

Similarly, a group can be taken in or out of Night Service by using Manager, short codes or an associated time profile.
When the group is in Night Service, callers are played the group's "Out of Hours" greeting and can then leave a message.
Alternatively, if an Out of Hours Fallback Group has been configured, callers are passed to that group.
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7.3.5 Configuring Announcements
When a caller is waiting to be answered or queuing, announcements can be played to the caller. The announcements are
activated in IP Office Manager.

The standard announcement used is "I am afraid all the operators are busy at the moment but please hold and you will
be transferred when somebody becomes available." This can be replaced by separate recordings for the 1st and 2nd
announcements if required (see Recording the Announcements  below) or by custom call flows (see Customizing
Announcements ). 

Enabling Announcements
1.Open IP Office Manager and receive the configuration from the IP Office system.

2.In the Navigation pane, click  HuntGroup and select the hunt group.

3.View the Announcements tab.

4.Check Announcements On. Announcements will be played to a caller who is in a queued or waiting for the hunt
group.

5.Select the amount of time for the caller to be queued or waiting before they hear the first announcement. The 
Wait before 1st announcement (seconds) default is 10.

6.Select the Post announcement tone. The options are Ringing, Music on Hold or Silence. The default selection
is Music on hold.

7.(Optional) Check 2nd announcement to play another message to the caller.

8.(Optional) Select the amount of time between the first and second announcements. The default time is 20
seconds.

9.(Optional) If the second announcement is to be repeatedly played to the caller until their call is answered, check 
Repeat last announcement.

10.Click OK to save the changes.

11.Click  to merge the configuration back to the IP Office.
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Recording the Announcements
The standard announcement used is "I am afraid all the operators are busy at the moment but please hold and you will
be transferred when somebody becomes available." This can be replaced in a number of ways, depending on the 

The maximum length for announcements is 10 minutes. New announcements can be recorded using the following
methods:

· Voicemail Pro - IP Office Mode
Access the hunt group mailbox and press 3. Then press either 3 to record the 1st announcement for the hunt
group or 4 to record the 2nd announcement for the hunt group. 

· Voicemail Pro - Intuity Emulation Mode
There is no default mechanism within the Intuity telephony user interface to record hunt group announcements. To
provide one a custom call flow containing an Edit Play List  action should be used. In the file path enter
[GREETING]\<hunt_group_name>_Queued or [GREETING]\<hunt_group_name>_StillQueued. where
<hunt_group_name> is replaced by the hunt group name. 

· [GREETING] is a variable that points to the current location of the voicemail servers greeting folder (by
default c:\Program Files\Avaya\IP Office\Voicemail Pro\VM\Greetings. 
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7.3.6 Customizing Announcements
The announcements and actions provided to a caller can be customized using the Queued and Still Queued start points.

· The Queued start point replaces the default Announcement 1.

· The Still Queued start point replaces the default Announcement 2.

It is important to note that unconnected results in Queued and Still Queued call flows will return the caller to the queue
rather than disconnect them. An attempt to return the caller using a Transfer or similar action places the caller at the
back of the queue as a new call.

· Use of customized start point call flows for Queued and Still Queued is not recommended if the Synchronize
Calls option is enabled for the hunt group in the IP Office configuration. If this is the case, the only options
supported by Voicemail Pro is the playing of prompts.

 

To customize announcement 1 for a specific group:

1.In the Start Points Navigation pane, select Groups. If necessary add a Queued start point  for the required
group. 

2.Select the group's Queued start point.

3.Add the required actions to the call flow and link them. To just play a message use a Generic action. 

· Use of customized start point call flows for Queued and Still Queued is not recommended if the
Synchronize Calls option is enabled for the hunt group in the IP Office configuration. If this is the case, the
only options supported by Voicemail Pro is the playing of prompts.

4.Double on the actions added and on the Entry Prompts tab add the prompts required using the Wave Editor .

5.Click OK to save the changes.

6.Click  Save and make live. 

7.Any caller queuing for the selected group will hear the new announcement when they first join the queue.

 

To customize announcement 2 for a specific group:

1.As above but use the Still Queued start point. 
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7.3.7 Hunt Group Queuing
If hunt group queuing options are enabled, a call will be held in a queue when all available extensions in the hunt group
are busy. Using Voicemail Pro you can define custom actions and prompts for the queuing sequence.

· The Still Queued message is not played if the hunt group name exceeds 13 characters.

To configure queuing for a hunt group:

1.Open IP Office Manager.

2.In the Navigation pane, click  HuntGroup and select the hunt group.

3.View the Queuing tab.

· Queuing On : Default = On 
If selected, queuing will be available for the hunt group.

· Queue Length: Default = No Limit 
This feature sets the number of calls that will be held in the queue at any one time. If this number is exceeded
the caller will receive the busy tone or be passed to voicemail.

· Normalize Queue Length: Default = Blank 
This facility selects whether to include calls that are ringing but not answered in the queue length.

 

When queuing is selected, announcements can be played to the queued caller. See Configuring Queue Announcements
.
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7.3.8 Customizing a Hunt Group Call Flow
Voicemail Pro allows for customization of queuing operation through the use of Queued and Still Queued start points,
either specific to a particular hunt group or default for all groups.

The  Queue ETA and Queue Position actions can be used to provide callers with queue information and then
place them back in the queue. Within a Queue or Still Queued start points call flow, the default action for any unlinked
results is to place the caller back in to the queue rather than disconnect the caller.

· Incoming Call Route 'Priority' 
The IP Office supports a configurable Priority setting (1, 2 or 3) on Incoming Call Routes. Calls assigned a high
priority are moved up any call queue ahead of those with a lower priority. The use of this feature is not compatible
with Queue ETA and Queue Position messages as the spoken queue positions and ETA for some callers may be
overridden by calls with a higher priority. For example, a caller might hear that their queue position is 5. If a call is
received on an Incoming Call Route with a higher priority, the next time the queue position is heard their queue
position could be 6, further back in the queue.

· Synchronized Announcements 
If the option Synchronize Calls is enabled for the hunt group announcements within the IP Office configuration,
actions other than speaking recorded prompts are not supported in custom Queued and Still Queued start points.

 

Further customization can be applied using actions such as a  Menu action to let the caller select, for example, to
leave a message, be transferred to another number or return to the queue.

The Voicemail Pro variables, $QTIM, and $POS , can be used to further customize the Queued and Still Queued
call flows.

· $QTIM: Queued Callers Estimated Time to Answer 
If used in a prompt list, will speak the callers' estimated time to answer (ETA). For example, "Your estimated time
to answer is 5 minutes." If used elsewhere, such as in a condition, returns the ETA in minutes as a simple numeric
value.

· $POS: Queued Callers Queue Position 
If used in a prompt list, will speak the caller's queue position, for example, "You are in queue position 2." If used
elsewhere, such as in a condition, returns the caller's queue position as a numeric value.

· $TimeQueued 
IP Office 4.1+ and Voicemail Pro 4.1+. Holds the length of time, in seconds, that the call has been part of a
particular hunt group queue. Only available when using Queued and Still Queued start points. 

· $TimeSystem 
IP Office 4.1+ and Voicemail Pro 4.1+. Holds the length of time, in seconds, since the call was presented to the IP
Office system. Only available when using Queued and Still Queued start points.
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The importance of these variables is that, instead of or in addition to customizing the queue call flow for all queued
callers, you can customize the actions for callers whose ETA or position match selected criteria.

The screen below shows an example of a queued call flow that uses a condition to test the value of $POS for the queued
caller.

· When the caller is in queue positions 1 to 4, they are passed to a Queue Position action and hear their queue
position before returning to the queue.

· When the caller is in queue position 5, they are asked to leave a message.

· Instead of using a Leave Mail action, the caller could be taken through a Voice Question or Campaign action to
collect required information and the caller's responses could be saved as a message.
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7.4 Recording Calls
As well as providing messaging services, Voicemail Pro can provide a call recording service. Call recording can be turned
on manually. See  Starting Manual Call Recording . Alternatively, call recording can be configured to take place
automatically for specified users, hunt groups, incoming call routes or out going calls with account codes. See Automatic
Call Recording .

 

· If a conference call is being recorded, recording continues when a new party joins the conference.

· If a call that is being recorded is put on hold or parked, the recording will pause. When the call is reconnected the
recording resumes.

· By default, a recording is placed in a user's own mailbox but this location can be changed.

· A recording by an agent that is intruding on to a call will keep recording after the intruded call has ended. This is
to allow the recording to be annotated.

 

· Conference Capacity
Call recording uses conferencing capacity and so is subject to the available conferencing capacity of the IP Office
system.

· IP Trunks and Extensions
When the direct media path option is used with IP trunks and or an extension, it is not possible to guarantee call
recording.

· Call Recording Warning
In many locations, it is a local or national requirement to warn those involved in a call that they are being
recorded. The Voicemail Pro does this by playing an Advice of Call Recording prompt which can be switched off.
On automatically recorded call, some telephones may also display a recording symbol. See Call Recording Warning

.

· Recording Duration
Call recording is limited to the maximum length of 1 hour. See Changing the Recording Time .

· Voice Recording Library (VRL)
Recordings are normally placed into standard mailboxes. VRL operation allows recordings to be transferred to a
specialist archiving application. This allows both longer recording and the sorting and searching of recordings. See
Voice Recording Library (VRL) .
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7.4.1 Call Recording Warning
In many locations, it is a local or national requirement to warn those involved in a call that they are being recorded. One
method for doing this is to enable the Advice of Call Recording (AOCR) message provided by the Voicemail Pro server.

· The 'advice of recording' will always be played if the Advice of Call Recording message is enabled.

· It can not be guaranteed that a caller will hear an 'advice of recording' announcement when the call is using
analogue trunks. Analogue trunks do not support call status signalling so the 'advice of recording' announcement is
played as soon as the trunk is seized even if the call is ringing and has not been answered.

· The Play Advice on Call Recording option is on by default.

 

The Advice of Call Recording Message 
This message is provided in the file aor_00.wav. For each language installed on the Voicemail Pro server, a copy is
located in the sub-folders of c:\Program Files\Avaya\IP Office\Voicemail Server\WAVS.

To switch the recording warning on or off:

1.From the Voicemail Pro Client, click  or select Administration > Preferences > General.

2.Click Play Advice on Call Recording to switch this option on (checked) or off (unchecked).

3.Click OK.

4.Click Save & Make Live.

 

To hide the auto record indication 
In addition to the audible advice of call recording prompt , some Avaya terminals display REC to show that the call is
being recorded. The display can be suppressed.

1.Open IP Office Manager and load the configuration from IP Office.

2.In the Navigation pane, click  System.

3.In the System Configuration window, click the System tab.

4.Check Hide auto recording. The terminal display REC will be suppressed.

5.Save the configuration back to the IP Office system.
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7.4.2 Changing the Recording Time
For recordings being placed into a Voicemail Pro mailbox, the maximum recording time is 1 hour.

To change the recording length:

1.Start the Voicemail Pro Client.

2.Click  or select Administration > Preferences > General.

3.The Max. VRL Record Length (secs) setting is used only for calls being recorded to VRL. The maximum record
length is 3600 seconds (60 minutes).

4.Click OK.

5.Click Save & Make Live.

 

7.4.3 Voice Recording Library (VRL)
Voice Recording Library (VRL) operation allows the Voicemail Pro to transfer specific users who are automatically or
manually recording calls to a third-party application. It can also be selected as the destination for calls recorded via a 
Leave Mail action in a call flow.

Currently this mode of operation is only supported with Avaya IP Office ContactStore. This application provides tools to
sort, search and playback recordings. It also supports the archiving of recordings to DVD.

· Installation and configuration of VRL with IP Office ContactStore is documented separately.

· VRL is a licensed feature. It requires entry of a valid Voice Recording Administrators license into the IP Office
configuration.

· The VRL application must be configured to store recording on a separate partition, drive or PC from the Voicemail
Pro. This is necessary to ensure that the long term storage or recording archives and space available for mailbox
messages do not conflict.
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7.4.4 Manual Call Recording
There are several ways to start manually recording a telephone call.

Phone Manager Pro 
Users can initiate call recording using Phone Manager Pro when they are working in Agent Mode. The recording feature is
active during a telephone call and when call recording is available.

· Press  on the toolbar to start recording. Press  on the toolbar to stop the recording.

· Select Actions > Start Recording. The call will be recorded. Press Actions > Stop Recording to finish
recording the call.

 

SoftConsole 
The SoftConsole operator can manually record all or part of a current telephone call. 

· Press the  button on the toolbar. The button acts as a toggle. Press the button again to stop recording.

· Select Actions > Record Call. This action toggles and so is also used to stop recording.

· Press F5 to start recording. Press F5 again to stop the recording.

 

4400 Series 
Telephones in the 4400 Series with a Menu key can manually trigger call recording by:

· Press Menu  | Menu  | Func| Recor.

 

Using DSS Keys 
The call record function can be programmed against a DSS key. When a DSS key has been programmed it can be
pressed during a call to record the conversation.

To set a DSS key for manual recording:

1.Open IP Office Manager and load the configuration from IP Office.

2.In the Navigation pane, click  User and select the individual user.

3.Select the Button Programming tab.

4.Select the required DSS key and click Edit.

5.Click  browse for the Action. The Button Programming window opens.

6.Select Advanced | Call | Call Record. Click OK.

7.In the Action Data field, enter a description that will appear on the telephone display.

8.Click OK.

9.Click  to save the configuration file.

A call is recorded if the user presses the programmed DSS key during any call. The caller will hear an announcement that
the call is being recorded if the mandatory call recording warning is active. See Call Recording Warning .

 

Using Short Codes 
The short code feature "Call Record" can be used to trigger recording of calls into the user's designated mailbox. The
example short code (*95) can be set up as a user short code or a system short code. In either case it will trigger
recording

Field Contains...

Code *95

Feature Call Record

Telephone Number [Leave blank]

Line Group Id 0

 

To use the short code
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1.During a call, put the caller on hold.

2.Dial the short code. The call is automatically reconnected and recording begins.
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7.4.4.1 Setting Manual Recording Options

The IP Office Manager can be used to specify where recordings triggered by a user are placed:

To configure a user's recording options:

1.Open IP Office Manager and load the configuration from IP Office.

2.In the Navigation pane, click  User and select the individual user.

3.Select the Voice Recording tab.

4.In Manual Recording Mailbox, select from the list the mailbox that is to be used to contain recordings triggered
by the user.

· The Voice Recording Library options can be used only if a VRL application has been installed and licensed.
See Voice Recording Library .

· Click OK.

· Click  to merge the configuration change back to the IP Office.
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7.4.4.2 Customizing Manual Recording

Normally recording is performed by the Voicemail Pro server as a default task. However, a module named Record can be
used to customize the operation of auto-recording.

Notes

· If a Record module is created, it overrides the default record operation. Therefore it must at minimum emulate
the default manual recording process of placing recordings into the mailbox of the user who triggered recording.
For example, in the module call flow shown below, the Listen action is set to $UUI.

· Whenever recording is triggered, $UUI contains the user name of the user who that triggered the recording
process.
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7.4.5 Automatic Call Recording
The IP Office system can be configured to automatically record calls based on the user, hunt group, incoming call route
or account code.

Trigger Incoming Outgoing Default Recording
Destination

Duration

Incoming Call Route None For the call duration or up
to 1 hour.

Hunt Group Hunt group mailbox Until ended or transferred
to a user outside the hunt
group or its overflow
group.

User User mailbox Until the user ends or
transfers call.

Account Code User mailbox Until the user ends or
transfers calls.

· Individual calls may match several recording criteria. Where that is the case the following applies:

· If the destinations for the recordings are different, separate recordings occur with the durations are indicated
above.

· If the destinations for the recordings are the same, a single recording is made using either the incoming call
route, hunt group or user duration in that order or priority.

· Multiple recordings of the same call use multiple voicemail channels.

· Time profiles can be used to control when automatic call recording is used.

· For inbound calls recording will not take place if the call goes to normal voicemail.

· Different frequency settings, set in percentage terms, can be applied to the automatic recording of inbound and
outbound calls.

· A mandatory setting can be used to return a busy tone when call recording is triggered but no voicemail ports are
available.

· Where calls have been answered using a Line appearance button, the call recording goes to the mailbox setting of
the original call route destination.
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7.4.5.1 Setting Automatic Recording Options

Automatic recording can be configured for:

· Calls received and/or made by a user .

· Calls on a specific incoming call route .

· Calls to a specific hunt group .

· Outgoing calls associated with a specific account code .

The calls that are to be auto-recorded are selected through IP Office Manager.

 

To set automatic call recording for a user:

1.Open IP Office Manager and load the configuration from IP Office.

2.In the Navigation pane, click  User.

3.Select the required user.

4.Select the Voice Recording tab.

5.From the Record Inbound and Record Outbound drop-down lists select the recording frequency required.

· None: Do not record.

· On: Record all calls if possible.

· Mandatory: Record all calls. If recording is not possible, return busy tone to the caller.

· xx%: Record calls at intervals matching the set percentage, eg. for every other call for 50%.

· For inbound calls, recording will not take place if the call also goes to normal voicemail.

6.Specify the destination for the recordings. By default, this is a user's own mailbox.

7.The Voice Recording Library options can be used only if a VRL application has been installed and licensed. For
more information, see Voice Recording Library .

8.Click OK.

9.Click  to send the configuration back to the IP Office.
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To set automatic call recording for a hunt group:

1.Open IP Office Manager and load the configuration from IP Office.

2.In the Navigation pane, click  HuntGroup.

3.Select the required hunt group.

4.Select the Voice Recording tab.

5.From the Record Inbound drop-down lists select the recording frequency required.

· None: Do not record.

· On: Record all calls if possible.

· Mandatory: Record all calls. If recording is not possible, return busy tone to the caller.

· xx%: Record calls at intervals matching the set percentage, eg. for every other call for 50%.

6.For inbound calls, recording will not take place if the call also goes to normal voicemail.

7.Select the Recording Time Profile is required. If not set, recording is applied at all times.

8.The Recording Mailbox option is available for IP Office 4.1+. For previous releases the destination is always the
mailbox of the user making the call.

9.Click OK.

10.Click  to send the configuration back to the IP Office.
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To set automatic call recording for an incoming call route:

1.Open IP Office Manager and load the configuration from IP Office.

2.In the Navigation pane, click  Incoming Call Route.

3.Select the required incoming call route.

4.Select the Voice Recording tab.

 

5.From the Record Inbound drop-down lists select the recording frequency required.

· None: Do not record.

· On: Record all calls if possible.

· Mandatory: Record all calls. If recording is not possible, return busy tone to the caller.

· xx%: Record calls at intervals matching the set percentage, eg. for every other call for 50%.

6.For inbound calls, recording will not take place if the call also goes to normal voicemail.

7.Select the Recording Time Profile is required. If not set, recording is applied at all times.

8.Specify the destination for the recordings or select the option to place the recordings in the voice recording library.

9.The Voice Recording Library options can be used only if a VRL application has been installed and licensed. For
more information, see Voice Recording Library .

10.Click OK.

11.Click  to send the configuration back to the IP Office.
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To set automatic call recording for an outgoing account call:

1.Open IP Office Manager and load the configuration from IP Office.

2.In the Navigation pane, click  Account Code.

3.Select the required account code.

4.Select the Voice Recording tab.

 

5.From the Record Outbound drop-down lists select the recording frequency required.

· None: Do not record.

· On: Record all calls if possible.

· Mandatory: Record all calls. If recording is not possible, return busy tone to the caller.

· xx%: Record calls at intervals matching the set percentage, eg. for every other call for 50%.

6.For inbound calls, recording will not take place if the call also goes to normal voicemail.

7.Select the Recording Time Profile is required. If not set, recording is applied at all times.

8.The Recording Mailbox option is available for IP Office 4.1+. For previous releases the destination is always the
mailbox of the user making the call.

9.Select the option to place the recordings in the voice recording library.

· The Voice Recording Library options can be used only if a VRL application has been installed and licensed.
For more information, see Voice Recording Library .

10.Click OK.
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7.4.5.2 Customizing Auto Recording

Normally auto-recording is performed by the Voicemail Pro server as a default task. However, a module named 
AutoRecord can be used to customize the operation of auto-recording. If an AutoRecord module is created, it overrides
the default auto-record operation.

Whenever auto recording is triggered, $UUI contains either the account code, user name or hunt group name that
triggered the auto recording.

The value of condition Account1 is checked using a  Test Condition action.

If found True, the call is recorded using a Listen action, which specifies the mailbox for the recording.

If found False, the next condition test is tried.

The conditions, created within the  Condition Editor, compare the variable $UUI against possible account code
values.

The final  Listen action, used if none of the condition tests are True, has its Mailbox set to $UUI. If $UUI hasn't
matched any account code being used for auto recording, then its value will be either the user name or hunt group name
that triggered the auto recording.
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7.5 Announcements
Announcements can be played when:

· Callers are waiting to be answered or queued against a hunt group 
With Voicemail Pro, the announcements and actions provided to a caller held in a group's queue can be customized
using the Queued and Still Queued start points for that group. The call can be answered at any stage of the
announcement. See Configuring Announcements .

· Calls are going to be recorded 
In many locations, it is a local or national requirement to warn those involved in a call that they are being
recorded. See Call Recording Warning .

· Calls are received 
A call flow containing an announcement can be created so that all callers hear a mandatory announcement. The
announcement is played before the call is answered. See Mandatory Announcement Example .

· Calls are queuing against an user's extension 
User's can configure their personal announcements. When the user's extension is busy any new calls are held in a
queue against the busy extension until the No Answer Time is reached. The caller will hear the user's personal
announcement before being transferred to voicemail, if available. See Personal Announcements .

 

7.5.1 Mandatory Announcement Example
The screen below shows an example of a call flow that plays an announcement to any caller to the sales hunt group.
Callers entering at this start point can not bypass the announcement.

The Entry Prompt of the transfer action contains the announcement. After the announcement is played the caller is
transferred to the sales hunt group as specified in the Specific tab. See Transfer Action .

Once the call flow has been created, IP Office needs to be configured so that callers are transferred to the call flow.

In IP Office Manager the destination for the incoming call route is entered as VM:Sales. The incoming call route targets
the voicemail module 'Sales'. As the call flow module name is the same as the hunt group name, if voicemail is
unavailable the call will automatically be routed to the hunt group. The calls will not be lost but the callers will not have
heard the announcement.

If calls are required to only be answered after they have heard the announcement, make sure that the call flow module
name is different from the hunt group name. If voicemail is unavailable the call will not be transferred to the target hunt
group.
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7.5.2 Personal Announcements
Voicemail Pro 4.0+ supports personal announcements that are played when a caller is queuing against a user's extension
number. A call will be held in a queue when the user's extension is busy before passing to voicemail, if voicemail is
available. Personal announcements are enabled in the same way as hunt group announcements , but using the User |
Announcements tab in IP Office Manager.

· If the user requires announcements only, voicemail should be turned off for the user.

· Start points can be amended to include other actions. Voicemail Pro 4.0+ allows personal announcements to
be customized using user Queued and Still Queued start points in the same ways as customizing hunt group
announcements . For example, a menu action could be added to the Still Queued start point giving users
the option to continue to hold for the caller or to transfer to reception.

· If voicemail is on the announcements are played until the No Answer Time is reached. The caller is then
transferred to the user's voicemail. The system default setting for No Answer Time is 15 seconds, however it can
be set for individual users.
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7.6 Support for Callers with Impaired Hearing
TTY is a method of sending and receiving text messages within the speech path of telephone calls. The text is entered
and displayed through a TTY device, such as a text phone, connected in parallel with the user's normal telephone. Due to
its widespread usage and support it has become the standard used by devices for the users with impaired hearing or
vision.

Voicemail Pro 1.4 and higher supports the addition of TTY prompts for leaving messages in and collecting messages from
Intuity mode mailboxes. Callers with a TTY device can see the TTY prompts and leave TTY format messages. The mailbox
user, also with a TTY device, can collect and display those messages by following the prompts that are displayed on the
TTY device.

The TTY device and associated analog telephone (linked either by a pass-through port on the TTY device or a telephone
splitter) are connected to an analog extension port (POT) on the IP Office system. During calls the TTY can be used to
display and send TTY messages. The analog telephone can be used to send dialing digits and provide a speech path
during calls.
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7.6.1 Installing Voicemail Pro TTY Prompts
You can select TTY prompts from the list of language options when you install Voicemail Pro. See Installation Overview

. When the prompts have been installed, the user settings must be configured so that the IP Office recognizes the TTY
device.

There are two ways to configure a user so that they can use a TTY device with Voicemail Pro.

1.The simplest method is to change the user locale in IP Office Manager. This method requires no customization of a
user's mailbox. See Changing User Locale  or refer to the IP Office Manager help or User Guide.

2.An alternative to changing the user locale to TTY is to change the language setting in the Voicemail Pro call flows
for the user who needs TTY prompts. See Changing the Language Setting for a Text Phone .

7.6.2 Changing User Locale
The locale setting tty is not actually recognized by IP Office Manager. Therefore all aspects of a user's telephony
operation on the IP Office will default to the system's locale setting (System > System > Locale). However, the user
locale setting is transferred to the Voicemail Pro server during mailbox access and so will affect the prompts that are
provided.

To change the user locale:

1.Open IP Office Manager.

2.In the Navigation pane, click  User and select the individual user.

3.Select the User tab.

4.Select the option Teletype (Textphone) in the Locale field.

5.Click OK.

6.Click  to merge the configuration change back to the IP Office.

 

7.6.3 Advice for Mailbox Owners Using a TTY Device
To log into their mailbox with a TTY device, such as a text phone, mailbox owners must dial *17 and then take the analog
telephone handset off hook.

When they are connected, users see prompts on the display of the text phone.

For requests such as "Press 1 for …" users should dial from the keypad of the telephone. For messages followed by GA
(go ahead) users are required to type text using their text device.

For more information, refer to the document "User Guide for Audix TTY Interface" (555-300-710).
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7.6.4 Changing the Language Setting for a TTY Device
An alternative to setting the user locale as TTY is to change the user's language setting in the Voicemail Pro call flows for
that user. Here are two examples.

 

An Example of Customizing a Simple Mailbox Call Flow 

The  Select System Prompt Language action can be used to change the prompt language used by subsequent
actions in a call flow. Once the TTY Maintenance Patch has been installed, TTY is one of the selectable languages provided
by the action.

In the simplest form, a  Select System Prompt Language action set to TTY (Teletype (Textphone)) would be
added to the user's Collect start point and followed by a Get Mail action.

 

Similarly, a  Select System Prompt Language action set to TTY (Teletype (Textphone)), would be added to the
user's Leave start point and followed by a Leave Mail action.
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An Example of Customizing a Complex Mailbox Call Flow 
If required, more complex call flows can be configured. For example, the call flow below allows callers to press * to
receive spoken language prompts or to wait a few seconds for the timeout and then receive TTY prompts.

In this case, messages are left in the same mailbox, but callers can select to have spoken prompts or default to TTY
prompts.

For hearing impaired users who cannot handle spoken messages, the call flow for callers who select spoken prompts
could have place those messages into an alternate mailbox of a hearing user. These could then be collected and
transcribed for the user.

 



Voicemail Pro Page 277
15-601063 Issue 21c (16 July 2009)IP Office 5.0

Administration: Support for Callers with Impaired Hearing

7.7 Changing Language
Voicemail Pro can be used in a wide range of languages. For external callers, the Voicemail Pro tries to match the Locale
setting of the IP Office system. For internal callers, if they have a different user locale in their user setting, 
VoicemailProtries to match that language.

With centralized Voicemail Pro, the default locale is that of the central IP Office. If users on the remote IP Office want
different language prompts, each of their user locales must be changed separately.

If prompts for a required language are not installed, Voicemail Pro has a set of rules that it follows to find the best
alternate language. For example if prompts are not available for users with their locale set to French Canadian, Voicemail
Pro looks for French prompts instead. If French prompts are not installed, it looks for English US and finally English UK.
See Supported Languages .

The language played to a caller can be changed during a call. This is achieved using a Select System Prompt action.
See Changing the Language of System Prompts .
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7.7.1 Supported Languages
By default the prompts installed match the installer language selection plus English. If other languages are required they
need to be selected by doing a custom installation. The installable Voicemail Pro prompts are listed in the table below.
The availability of a language in voicemail does not necessarily indicate support for IP Office in a country that uses that
language. 

Language WAV
Folder

Fallback Selection TTS 5.0

Brazilian Portuguese ptb > pt > en.

Chinese (Cantonese) zzh > en > enu.

Chinese (Madarin) ch > en > enu.

Danish da > en.

Dutch nl > en.

English UK en en.

English US enu > en.

Finnish fi > en.

French fr > frc > en.

French Canadian frc > fr > enu > en.

German de > en.

Greek el > en.

Hungarian hu > en.

Italian it > en.

Korean: ko > en.

Latin Spanish eso > es > enu > en.

Norwegian no > en.

Polish pl > en.

Portuguese pt > ptb > en.

Russian ru > en.

Spanish es > eso > en.

Swedish sv > en.

When the IP Office routes a call to the voicemail server it indicates the locale for which matching prompts should be
provided if available. Within the IP Office configuration, a locale is always set for the system. However differing locales
can be set for each user, incoming call route and for short codes in addition to the default system locale. 

The locale sent to the voicemail server by the IP Office is determined as follows:

Locale Source Usage

Short Code Locale The short code locale, if set, is used if the call is routed to voicemail using
the short code. 

System Locale If no user or incoming call route locale is set system locale is used unless
overridden by a short code locale. 

Incoming Call Route Locale The incoming call route locale, if set, is used if caller is external.

User Locale The user locale, if set, is used if the caller is internal.

If the prompts matching the IP Office locale are not available, the voicemail server will provide prompts from a fallback
language if available. The table of languages above lists the order of fallback selection. 

If required, the language provided by a voicemail call flow can be changed using a  Select System Prompt
Language  action. 

TTY Teletype Prompts
TTY (Teletype (Textphone)) is included in the list of installable languages. TTY is a text-based system that is used to
provide services to users with impaired hearing. See Support for Callers with Impaired Hearing .
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7.7.2 Changing the Language of System Prompts

With the  Select System Prompt action you can change the language that is used in a call flow from that of the IP
Office system or the mailbox user's locale.

A step by step example that illustrates how to use the Select System Prompt action is provided here.

· The Select System Prompt action changes the default language prompts but not any custom prompts. To change the
custom prompts you need to use the $LOC variable in the path to the custom prompt files. See Changing the Language
of Custom Prompts .

 

Example 
In a small hotel, Voicemail Pro is providing mailboxes for rooms. To assist the room users, we want to start message
collection by letting them indicate their preferred language for Voicemail Prompts.

1. First a module for language selection was created.

The module contains a Menu action with a Select System Prompt action set to the required language for each
key press.

· For the Menu action an Entry Prompt was recorded asking the user to indicate their language choice; "Press
1 for English, 2 por Español, 3 pour Français".

· The Select System Prompt actions were all connected Module Return actions.

2. Next the default start point for message collection was altered. The Language Select module and a Get Mail
action were inserted.

3. The actions for language selection could have been inserted directly into the call flow. However, by doing it as a
module the language selection process can be reused in other start points.
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7.7.3 Changing the Language of Custom Prompts
Instead of using multiple return points from a Language Select module (one for each language) and linking to separate
Get Mail actions (each with an Entry Prompt in the required) language, you can use a single Get Mail action.

To change the language of custom prompts:

1.Through the Get Mail action's properties, record an Entry Prompt for US English users and save it as
enu\custom\getmail.wav.

2.Record a similar prompt for French Canadian users and Latin Spanish users. You need to use the same file name each
time and save each file in a different language folder.

3.Delete all except one of the entry prompt entries. That this does not delete any of the recorded prompts.

4.For the remaining entries, change the file path by inserting $LOC in place of the language folder name, for example
$LOC\custom\getmail.wav.
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7.8 Mobile Twinning

Mobile Twinning is a licensed feature. If Mobile Twinning is enabled in IP Office, a user can send internal and external
calls to an external number, for example, their mobile telephone.

· Both the internal and external telephones ring when a call is received. The call can be answered from either telephone.

· If the feature Do Not Disturb (DND) is active for the user, any callers to the internal extension number will hear the
busy tone and the external telephone will not ring. If a caller is entered in to the DND exception list, for example using
the application Phone Manager, only the internal telephone will ring.

· If any of the forward options are active, both the external and the telephone where the calls are forwarded to will ring.

· If the Follow Me option is active, only the telephone that the calls are forwarded to will ring. The external telephone
number will not ring.

 

Within Voicemail Pro you can administer the mobile twinning features using call flows. Mobile twinning can be turned on
or of and the external twinning number entered.

In a call flow the Generic action is used to control Mobile twinning. Within the Generic action details are entered in the
specific tab. In the generic 'free format' field, the following syntax can be added.

· CFG:Set MattR twinning_type Mobile 
Used to turn the Mobile twinning on for the named extension MattR. The extension number can be entered instead of
the named extension. If mobile twinning has been previously used and then turned off, the previous mobile twinning
number will become active.

· CFG:Set MattR twinning_type Internal 
Used to turn the Mobile twinning off for MattR.

· CFG:Set MattR mobile_twinning_number $KEY 
Used to set the mobile twinning number.
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7.8.1 Example Call Flow
This example creates a Voicemail Pro module that allows a user to turn Mobile Twinning on or off. They can also set their
mobile number. The example sets the mobile twinning for extension 203.

To create the example call flow:

1.Create a new module called Mobile Twinning.

2.Add a menu action with the menu options 1,2 and 3. Add a prompt to tell the caller the options available.

3.The option to turn mobile twinning on needs to be added.

· Click the  Basic Actions icon and select  Generic.

· Change the token name to Enable Mobile Twinning.

· Click the Specific tab.

· Enter the command CFG:Set 203 twinning_type Mobile.

· Click OK.

4.The option to turn mobile twinning off needs to be added.

· Click the  Basic Actions icon and select  Generic.

· Change the token name to Disable Mobile Twinning.

· Click the Specific tab.

· Enter the command CFG:Set 203 twinning_type Internal.

· Click OK.

5.The ability to enter the mobile number needs to be added.

· Click the  Telephony Actions icon and select  Alphanumeric Collection.

· Change the token name to Collect New Mobile Twinning No.

· Record an Entry Prompt to tell the user to enter their mobile twinning number.

· Click OK.

6.An action needs to be added to set the mobile number.

· Click the  Basic Actions icon and select  Generic.

· Change the token name to Set Mobile No.

· Click the specific tab.

· Enter the command CFG:Set 203 mobile_twinning_number_$KEY.

· Click OK.

7.The actions need to be connected and then the changes need to be made permanent.
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Create a short code to test the call flow.

1.In IP Office Manager, add the following short code. This example uses *90 but any short code can be used.

Field Contains...

Code *90

Feature Voicemail Collect

Telephone Number "Mobile Twinning"

Line Group ID 0

Locale [leave blank]

Force Account Code [leave blank]

2.Save and merge the configuration to the IP Office unit.

3.Test the short code by dialing *90 from extension 203.

· Press 1 to turn mobile twinning on for extension 203.

· Press 2 to enter a new mobile twinning number for extension 203.

· Press 3 to turn mobile twining off for extension 203.
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7.9 Remote Voicemail Notification
A user can be set up to receive notification of new voicemail messages when they are away from their main extension.
There are two ways that notification can be implemented.

· Voicemail Callback  
A service whereby the Voicemail Pro calls a specified number whenever the user receives a new voicemail
message. Callback requires a callback start point to be created in Voicemail Pro and a callback number entered in
IP Office Manager. 

· Voicemail Outcalling  
A service where voicemail notification can be configured to specific external numbers and the notification escalated
if the message is not listened to. Outcalling can be configured by any user of voicemail in Intuity mode.

Note

· Both the Callback and Outcalling features are separate from voicemail ringback. Ringback alerts the user's own
extension whilst Callback and Outcalling will provide voicemail notification to an external location, for example a
mobile telephone or pager. 

Channel Restrictions

· The Voicemail Pro server has restrictions on the number of channels it can use for different types of outgoing calls
that it can make. These limits are separate for each of the cal types. When a limit is reached, further calls of that
type are delayed until one of the existing calls is completed. These limitations are not controlled by Voicemail
Channel Reservation  settings. 

· Outcalling can use up to 5 channels at any time. 

· Conference center invitation calls can use up to 5 channels at any time. 

· Callback calls can use up to 2 channels at any time. 

· Alarm calls can use up to 2 channels at any time. 
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7.9.1 Callback
Voicemail callback is a service whereby the Voicemail Pro calls a specified number whenever the user receives a new
voicemail message. When the callback is answered, the system announces the outbound alert and waits for a key press
for confirmation before continuing with the associated call flow. 

This service requires configuration of a callback start point in Voicemail Pro and entry of a callback number through IP
Office Manager. See Using a Play Configuration Menu Action .

The call flow created below is a very simple example. In practice you could include a menu that allows the user access to
other features. For example access to a Play Configuration Menu action would allow the user to remotely change various
mailbox settings including their callback number. 

Channel Restrictions

· The Voicemail Pro server has restrictions on the number of channels it can use for different types of outgoing calls
that it can make. These limits are separate for each of the cal types. When a limit is reached, further calls of that
type are delayed until one of the existing calls is completed. These limitations are not controlled by Voicemail
Channel Reservation  settings. 

· Outcalling can use up to 5 channels at any time. 

· Conference center invitation calls can use up to 5 channels at any time. 

· Callback calls can use up to 2 channels at any time. 

· Alarm calls can use up to 2 channels at any time. 

To set up the callback:

1.Under  Specific Start Points, right-click  Users and select Add.

2.In the Name field, enter the user's mailbox name. Select the Callback entry point and select OK.

3.Within  select  Callback.

4.Add a  Get Mail action and under the Specific tab, in Mailbox enter the user's name again or extension number.

· Important

Record an entry prompt for the first action in the callback call flow. Experience with connection to some cell
phone systems has revealed that this entry prompt may need to be up to 20 seconds in length.

5.Connect the  Start Point and the  Get Mail action.

6.Click  Save and Make Live and select Yes.
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The Default Callback Start Point 
In the example above a callback call flow was created for an individual users. The Default Callback start point can be
used to create a default callback call flow for all users.

If the Default Callback start point is used, it must be designed so that users have to indicate which mailbox they are
accessing. In the simple call flow used above, this can be done by entering ? in the Mailbox field of the Get Mail action.

The callback number is initially set through IP Office Manager.

To set the user's callback number:

1.In IP Office Manager, open the system's configuration.

2.Click User to display a list of existing users.

3.Double-click the user for whom callback is being set up.

4.Select the Voicemail tab.

· In Voicemail Code, enter a pin code and confirm this in Confirm Voicemail Code.

5.Select the Source Numbers tab. Right-click and select add to add a new number.

· Callback Number 
Enter P followed by the destination telephone number. If you system requires an external dialing then that prefix
must be included, for example P901923555456. If connecting to a cell phone or pager system that expects digits
in separate sets, use , (comma) characters to add pauses to the telephone number dialing.

· Trusted Source 
If calls from the callback number include ICLID, you can set that number as a trusted source. In that case no request
for the user's voicemail code is made following the callback. Enter V followed by the CLI displayed on calls from the
callback number, for example V01923555456.

6.Click OK.

7.Click  to send the configuration back to the IP Office. If the only changes made were to user settings, select Merge
Config.

 

7.9.1.1 Using a Play Configuration Menu Action

The callback call flow below is more advanced than the previous example. It allows the user to check messages, transfer
themselves to another extension and to alter several aspects of their mailbox configuration.

Of main interest to a callback user is the  Play Configuration Menu action. This action allows the remote user to alter
their extensions forwarding and voicemail operation. Option 9 in the menu played to the caller allows them to change the
callback number.

To exit a Get Mail or Play Configuration Menu action and follow the call flow to the next action, the user should press
0 (not supported for Get Mail in Intuity mode).
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7.9.2 Outcalling
The Outcalling feature is only available when using Voicemail Pro 4.0+ in Intuity mode.

Voicemail Pro can be configured to send notification that a new message has been received in a user's mailbox. It will call
a specified number and when answered, will prompt the user "This is IP Office. <your name>, you have new messages.
To access your messages, please enter your extension number and press hash. To avoid further notification of these
messages, press * #". If any other action is taken then the outcalling notification attempt is treated as unanswered. 

Channel Restrictions

· The Voicemail Pro server has restrictions on the number of channels it can use for different types of outgoing calls
that it can make. These limits are separate for each of the cal types. When a limit is reached, further calls of that
type are delayed until one of the existing calls is completed. These limitations are not controlled by Voicemail
Channel Reservation  settings. 

· Outcalling can use up to 5 channels at any time. 

· Conference center invitation calls can use up to 5 channels at any time. 

· Callback calls can use up to 2 channels at any time. 

· Alarm calls can use up to 2 channels at any time. 

· For IP Office 4.2+, users with Phone Manager Pro 4.2+ can configure their outcalling through Phone Manager's
graphical interface rather than having to use the mailbox voice prompts. 

Retries 
If an outcalling notification attempt is not answered, the voicemail server can make another attempt. The number of
retries, up to 10, and the delay after a failed notification attempt can use either system default or the users own defined
settings. 

Destinations 
The mailbox user can define up to 5 destination numbers to be used with outcalling. The destinations must include any
external dialing prefixes required for the IP Office system. For each destination a ring time can also be defined (default
15 seconds) after which the voicemail server disconnects the call. 

· Desk.

· Home.

· Mobile.

· Delegate (called Secretary in some locales.

· Other.

Escalation List 
The user can choose to use an escalation list, which combines several of their destinations into a sequence that will be
tried as part of a single outcalling notification attempt. Up to 9 destinations can be included in the list and the same
destination can be used more than once. Use of the escalation list counts as a single outcalling notification attempt. 

· For Voicemail Pro 4.2+, users using Phone Manager 4.2+ can specify a delay to be used between the call to each
destination in their escalation list. 

Configuration Methods

· System Settings  
The Voicemail Pro can be configured with a set of default times for when outcalling is used, the number of retries
for outcalling notification and the interval after a failed notification attempt before the next retry. 

· User Mailbox Settings 
Mailbox owners can configure their outcalling options using their telephone, for example, entering the destination
telephone numbers. Details on how to configure outcalling for individuals can be found in the Intuity Mailbox
guide. 

· Phone Manager Control 
For Voicemail Pro 4.2+, users with Phone Manager 4.2+ can configure their own outcalling settings using Phone
Manager. This includes setting their own number of retries and the interval before any subsequent retry. When
using an escalation list, this interface also allows the user to set a delay to be used between each number in the
escalation list. 
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7.9.2.1 Setting the Outcalling Preferences

The outcalling preferences in Voicemail Pro are defaults for global operation. Mailbox owners can configure their own
outcalling options from their telephone, for example, create their own time profile. 

Details on how users can configure outcalling are found in the Intuity Mailbox guide and Phone Manager User Guide. 

A timeout value can also be set by a user. This is how long outcalling will attempt to call a number before giving up. 

To set the global outcalling preferences:

1.Display the main Voicemail Pro window.

2.From the Administration menu, select Preferences > General.

3.Click the Outcalling tab.

4.Select the times that outcalling is active in the System Times section.

· Prime Times 
The time period that outcalling is to be active as default for the system.

· Peak Times 
The busiest working hours.

5.Set the retry settings in the System Retry Settings section.

6.The Number of Retries can be between 0 and 10. If the message is not collected after the last retry, no
notification is sent until another new message is delivered in the user's mailbox.

7.The Retry Interval for each retry attempt. The interval is the length of time between each attempt to ring to
targeted number again. The 6th to 10th retries use the default retry interval.

8.Double-click a selected retry time to edit the interval between retries. The New interval number window opens
where the length of time between each attempt to ring the target number can be changed. Click OK to save the
change and return to the Outcalling window.

9.Click OK.

10.Click  Save and Make Live and select Yes.
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7.9.2.2 Phone Manager Outcalling

Users with Phone Manager Pro can access their outcalling settings using this application. For full details refer to the Phone
Manager User Guide. 
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7.10 Personal Distribution Lists
Personal distribution lists (also known as mailing lists) are available to mailbox users when the system is in Intuity mode.

Each mailbox can accommodate up to 20 lists. Each list can contain up to 360 mailbox numbers. Lists can then be used
or forwarding or sending messages from the mailbox.

Each list can be marked as private or public. Public lists can be used by other mailbox users when forwarding or sending
messages. A user can also import the contents of a public list into one of their own lists.

If Voicemail Pro Networked Messaging (VPNM) is installed, lists can include mailboxes on remote systems. The only
difference in presentation is that, where the mailbox user name is used to identify local mailboxes in a list, remote
mailboxes are listed by number only.

Lists are maintained either through the mailbox or through Phone Manager Pro version 3.0 or higher. Lists cannot be
viewed or controlled from the Voicemail Pro Client. For more information about mailing lists, mailbox owners can refer to
the Intuity Mailbox User Guide.
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7.11 Automatic Message Deletion
Messages are automatically deleted from the voicemail server after a set delay. This delay can be adjusted for different
message type including unread messages.

The process of housekeeping is performed after any two hour idle period, that is a period with no call into or from the
voicemail server. 

To set housekeeping rules:

1.From the Administration menu, select Preferences > General.

2.Click the Housekeeping tab. 

· The different message status types are: 

· New 
This status is applied to messages where neither the header or the message content has been played. 

· Old 
This status is applied to messages where the user has played the message content but has not marked
the message as saved. 

· Saved 
This status is applied to messages that have been marked as saved by the user. 

· Unopened 
This status is used for messages where, in Intuity emulation mode, the user has played the message
header but has not played the message content. 

3.Automatic message deletion 
Sets the time, in hours, after which messages of various types automatically deleted. A value of 0 disables
automatic deletion. The actual deletion is performed during the next idle period during which there are no calls to
or from the voicemail server.

4.Message playback order (System Setting) 
Sets the order of playback used for different message types. The options are first in-first out (FIFO) and last in-
first out (LIFO). FIFO is the default.

5.Click OK.

6.Click  Save and Make Live and select Yes.
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7.12 Using Voicemail to Give Error Messages
Voicemail can be used to give out messages when certain numbers are dialed. For example, if users are barred from
making international calls, rather than giving users the busy tone a recording similar to "International calls are not
permitted" could be played instead.

To create an International Calls are not Permitted error message:

1.In IP Office Manager create a virtual user. Complete the User tab with the following details:

· Name: Barred.

· Full Name: Internal Calls Error Message.

· Extension: 403.

2.You need access to the virtual user's extension from any telephone extension attached to the system. A voicemail code
needs to be added.

· Select the user Barred.

· Click the Voicemail tab.

· Add a Voicemail Code.

· Click OK.

3.Add a short code to access the virtual user's voicemail.

· Code: *95

· Feature: Voicemail Collect

· Telephone Number: "?Barred" (include quote marks)

· Line Group ID: 0

4.Save the configuration file.

5.You can now use the virtual user's voicemail to record a greeting message stating that international calls are not
permitted.

· Dial *95 from any telephone connected to the system.

· Enter the extension number 403.

· Enter the voicemail access code. The first time you enter the mailbox for extension 403 you will be asked to change
the password and record a user name.

· Press 3 to record a greeting.

· Press 1 to change the message.

· Press 1 to record greeting 1.

· Speak the new message. In this case it would be similar to "International calls are not permitted"

· Press # to end the recording.

· Press 1 to save for all calls.

· Replace the telephone handset.

6.A short code needs to be created in IP Office Manager so that when a user dials an international call they will be played
the error message.

· Code: 00N

· Feature: Voicemail Collect

· Telephone Number: "#Barred" (include quote marks)

· Line Group ID: 0

7.Save the configuration file.

8.Test the error message by trying to dial an international number from any telephone. You should be played the
message that you have just recorded.
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7.13 Disabling a Mailbox
By default, Voicemail Pro automatically creates a voicemail mailbox for each user and hunt group in the IP Office
configuration. It is also defaulted to use use voicemail to record a message if a user or hunt group call is not answered. 

There are a number of ways that use of voicemail to record messages can be disabled if it is not required for a particular
user or hunt group. These are:

· Disabling IP Office Using a Mailbox for Unanswered Calls 
Within the IP Office configuration, each user and hunt group has a Voicemail On setting. When enabled, IP Office
will use voicemail to record a message if a call is not answered. Disabling this option stops the IP Office from using
the mailbox to record messages for unanswered calls, instead calls continue ringing. Other voicemail users can still
manually forward callers and messages to the mailbox. 

· IP Office users can change their Voicemail On settings themselves by dialing short codes (*18 for on, *19 for
off) or through IP Office Phone Manager. 

· Intuity Accept Call Answer 
If the voicemail server is set to Intuity mode, users can set their mailbox to no longer accept calls using the
Accept call answer setting (select 5, 7 , 1 after logging into the mailbox). Callers directed to the mailbox by IP
Office here "Sorry, the mailbox you have reached is no accepting messages at this time. Please disconnect". 

· Customized Leave Mail 
A customized call flow can be setup for a user or group's Leave start point (or all users and groups using the
Default Start Points). That call flow can direct redirect messages to another mailbox or a range of other actions.
The Collect start point can also be customized. 

· Voicemail Server Disable Mailbox (Voicemail Pro 5.0+) 
All operation and usage of a mailbox can be disabled on the voicemail server. This is done through the details pane
view of user or group mailboxes . Right-click on the user or hunt group and select Disable. 124
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Chapter 8.
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8. Mailbox Access Controls
With IP Office mailbox owners can control their mailbox and messages in a number of ways after they have logged in to
the mailbox.

· Standard IP Office Mailbox Mode  
This is the only mode for Voicemail Lite. Voicemail Pro can also be set to run  in this mode rather than Intuity
emulation mode. 

· Intuity Mailbox Mode  
This is the default mode for Voicemail Pro. It provides through a series of spoken prompt menus an IP Office
emulation of many of the Avaya Intuity features. 

· Phone Manager  
The Phone Manager application enables a user to switch voicemail and voicemail ringback on/off. Phone Manager
Pro also provides full visual access to a user's voicemail and allows messages to be played back and controlled
through their PC. 

· Visual Voice  
This is a system of display menus rather than spoken prompts that can be used to access a mailboxes.

· UMS Web Voicemail  
This method of access allows users to access mailboxes using a web browser. The user must be configured for
UMS. The feature is licensed. 

· UMS IMAP Email Access  
This method allows users to access mailbox messages through a IMAP compatible email program. The user must
be configured for UMS. The feature is licensed. 

· UMS Exchange 2007  
Allows playback via a user's PC using Outlook 2007. 

If a mailbox does not have a recorded name greeting, when that mailbox is accessed to collect messages, the caller is
asked to record their name before proceeding to collect messages. The name greeting is used for functions such as Dial
by Name actions and Intuity mode name lookup (**6).

· Tip
As Voicemail Pro system administrator, you should ensure that mailbox owners have the help and user guide for
their type of mailbox available to them. There is an IP Office User Guide and an Intuity Mailbox User Guide. Both
are available in PDF and online help formats. 
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Mailbox Access Controls:  

8.1 General Controls
The following default IP Office short codes can be dialed by any user from their own extension. 

· *17 - Collect Messages
Access their mailbox from their own extension.

· *18 - Voicemail on / *19 - Voicemail off 
When on, the IP Office telephone system will use voicemail as the destination for unanswered calls. 

· *48 - Turn voicemail ringback on / *49 - Turn voicemail ringback off 
When on, if the user has a new message, the voicemail server will call the user's extension whenever the
extension changes from off-hook to on-hook. The voicemail server will not ring the extension more than once
every 30 seconds. 

· *01 - Sets the Voicemail Email mode to Forward

· *02 - Sets the Voicemail Email mode to Alert

· *03 - Sets the Voicemail Email mode to Off
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8.2 Intuity Mode
The following is a summary of the controls available when the voicemail server is set to run  in Intuity emulation
mode. The options that are shown in gray are not supported by IP Office Intuity emulation. For full details refer to the IP
Office Intuity Mailbox User Guide. 

74



Voicemail Pro Page 299
15-601063 Issue 21c (16 July 2009)IP Office 5.0

Mailbox Access Controls: Intuity Mode

8.3 IP Office Mode
The following is a summary of the controls available when the voicemail server is set to run  in Intuity emulation
mode. For full details refer to the IP Office Mailbox User Guide. 
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8.4 Phone Manager
The IP Office Phone Manager application provides a number of features relevant for Voicemail Pro. For full details refer to
the Phone Manager User Guide. 

· Messages Tab 
This tab is available for all Phone Manager users and will show them the number of messages in their mailbox. The
user can also be configured to see the number of messages in selected hunt group mailboxes. Clicking on any of
the rows will initiate a call to the mailbox to play the messages. 

· Voicemail Tab
This tab is available for Phone Manager Pro users. It provides a number of controls for message playback that the
user can use after having accessed a mailbox. 
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· Configuration Preferences 
Through the Phone Manager many user settings for voicemail can be accessed and changed. 
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8.5 Visual Voice
Visual Voice provides the user with a display menu for access to their mailbox rather than having to follow spoken
prompts. It can be used with Voicemail Pro (Intuity and IP Office modes) and Embedded Voicemail. The menu provide
the user with options to listening to messages, leaving messages and managing the mailbox.

It is supported on most Avaya phones with multi-line displays (more than 2 lines) and programmable buttons.

Access to visual voice can be provided in a number of ways: 

· Assign a programmable button to the function Visual Voice. For full details on button programming refer to the IP
Office Manager documentation. 

· For IP Office 4.2+, access to visual voice can be triggered by the phone's MESSAGES button rather than requiring
a separate Visual Voice programmable button. This is done using the System | Voicemail  option Messages
button goes to Visual Voice. 

· T3 phones can access visual voice via the menu selection Menu | Settings | Voicemail Settings. If a Visual
Voice programmable button is used on these phones it will only access the Listen functions. 

On phones that have a display but do not support full visual voice operation, use of the buttons above will trigger normal
spoken prompt voicemail access.  

· Direct Voicemail Transfer 
On phones with a button set to provide visual voice access, if pressed when a call is connected, the button allows
entry of an extension number for direct to voicemail transfer of the connected call.
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Visual Voice Controls
The arrangement of options on the screen will vary depending on the phone type and display size. Controls that cannot
be fitted on the current display are accessed by using the phones < and > buttons to move between screen pages.

· Listen 
Used to access the user's own mailbox. When pressed the screen will show the number of New, Old and Saved
messages. Select one of those options to start playback of messages in that category. Once message playback is
selected the available controls change:

· Previous: Play the previous message.

· Next: Play the next message.

· Rewind: Rewind approximately 5 seconds.

· FFwd: Step forwards approximately 5 seconds.

· Delete: Delete the current message.

· Save: Mark the messaged as a saved message.

· Copy: Copy the message to another mailbox. When pressed as number of additional options are displayed.

· Pre-Rec: Record a message that will be attached to the start of the message being copied.

· Targets: Enter the destination for the message copy.

· Done: Copy the message using the targets entered.

· Pause: Pause the current message. Press the button again to unpause.

· Main(0) 
Hunt group names may be displayed if the user is configured for hunt group mailbox access. The number of new
messages in the mailbox is shown after the name. Press the button to access the mailbox in the same way as the
Listen option above.

· Message 
Record and send a voicemail message to another mailbox or mailboxes.

· Greeting 
Change the main greeting used for callers to the mailbox. If no greeting has been recorded then the default
system mailbox greeting is used.

· Note: Depending on the voicemail server type and mailbox mode, it may be possible to record and use
additional greetings via the mailboxes voice prompt menus.

· Record: Record a new greeting.

· Listen: Listen to the current greeting or the new greeting just recorded.

· Submit: Submit the new greeting just recorded.

· Delete: Delete the current greeting. The mailbox will revert to using the default system greeting unless
Record and Submit are used to record a new greeting.

· Email 
This option is only shown if the user has been configured with an email address for voicemail email usage in the IP
Office configuration. This control allows you to see and if required change the current voicemail email mode being
used for new messages received in your voicemail mailbox. Use Change to change the selected mode. Press
Done when the required mode is displayed. Possible modes are:

· Email Mode Off 
Voicemail email is not used.

· Email Mode Copy 
New voicemail messages are copied to the user's email address. The original message is left in the voicemail
mailbox.

· Email Mode Fwd 
New voicemail messages are forwarded to the user's email address. The original message is deleted from
their voicemail mailbox.

· Email Mode Alert 
A alert email message is sent to the user's email address. The original message is not attached to the email
and is left in the voicemail mailbox.

· Password 
Change the voicemail mailbox password. To do this requires entry of the existing password.
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8.6 UMS Web Voicemail
The URL will be that of the voicemail server PC plus /voicemail. This will display the web voicemail login page. 

1.Logon using your user name and voicemail code as set on the IP Office system. The System Administrator can
change these if necessary. 

· Note: This is the user name set in the IP Office and used by Voicemail Pro. It is not the full name that is
shown on phones and used by IP Office Phone Manager and SoftConsole if set. 

2.Note that multiple failures to login correctly can cause your access to Web Voicemail to be locked for 1 hour. If

necessary Web Voicemail access can be unlocked using the Voicemail Pro administration client (select  Users,
right click on the user marked as Account Locked in the Web Voicemail column, enter a new password for the
user and click OK).

The interface shows the messages in your mailbox. Note that it is not updated in realtime. To check if new messages
have arrived in your mailbox since starting Web Voicemail, refresh the browser view using the browser controls. Similarly
changes to the IP Office configuration such as new or deleted users and groups are not shown until you refresh the
browser view. 

The columns can be sorted by clicking on the column title. The currently selected sort column is shown by a V symbol
next to it. 
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Mailbox Access Controls: UMS Web Voicemail

Message Types
The following icons are used for different types of messages:

·  Unread message

·  Read message
Note that by default a read message is permanently deleted from the mailbox after 30 days unless changed to a
saved message. 

·  Deleted message
Manually deleted messages are automatically moved to the Trash folder. Deleted messages remain visible for at
least 24 hours after they were marked as deleted.

· Deleted messages are not accessible through the voicemail spoken prompts interface or Visual Voice. 

· Deleted messages can be undeleted by marking them as saved, read or unread. They can then be moved
back out of the Trash folder. Moving a deleted message out of the Trash folder automatically changes it to
read. 

·  Saved message
Setting a message as saved stops it being automatically deleted after a period of time. 

·  Priority message
This icon is added the message icon to indicate that the caller has set the message as a priority message. 

Controls

·  Select
Before performing many actions such as saving, deleting or forwarding, you can select the messages to which the
action should be applied. 

· The select box at the top of the list of messages can be used to select/deselect all messages on the currently
displayed page. 

·  Save
Change the status of the selected messages to saved. 

·  Mark as read
Change the status of the selected messages to read. Changing the status of a message will override its previous
status including those marked as saved. 

·  Mark as unread
Change the status of the selected messages to unread. Changing the status of a message will override its previous
status including those marked as saved. 

·  Forward
Forward a copy of the selected message to another mailbox. When clicked, the type of mailbox (user or hunt
group) can be selected. The list of mailboxes is then shown and allows selection of multiple target mailboxes. 

·  Delete
Delete the selected messages. Manually deleted messages remain visible until the voicemail server next performs
its mailbox housekeeping. See the deleted message description above. 

· Change password
This option allows you to change your voicemail mailbox code. 
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Playing Messages

To play a message just click on it. The message menu is displayed. The appearance of this will vary depending on
whether you select playback via the default media player on your computer or through an extension on the telephone
system. 
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Mailbox Access Controls: UMS Web Voicemail

8.7 UMS IMAP
Most email clients that support IMAP display IMAP messages in a separate folder. The contents of that folder are
synchronized when the folder is viewed. 

Note that the types of icons used and whether different icons are supported for different message statuses depends on
the email client used. 

The following should be noted about the IMAP folder view: 

· New messages are presented as a closed envelope. 

· Read messages are presented as an open envelope. 

· Priority messages are indicated as such. 

· Private messages are not indicated as such. 

· Saved messages are not indicated as such. 

· Deleted messages are indicated as deleted but remain visible. 

· The voicemail server does not actually delete messages until at least 24 hours after it was marked as deleted.

· Deleted messages are no longer accessible through the voicemail telephone prompts interface or Visual
Voice. 

· Deleted messages can be undeleted. Those messages are then available through all the mailbox interfaces. 

· Moving a message in the IMAP folder to another folder in the Email client will cause the email to be copied to the
new folder and the original message is shown as deleted in the IMAP folder. 

· The Voicemail Pro housekeeping settings for automatic deletion of different message types (New, Read and Saved)
are still applied. 

· IMAP cannot be used to send or forward messages to other voicemail mailboxes. 
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8.8 UMS Exchange 2007
UMS can be configured to use a users Exchange 2007 email account as the user's voicemail message store rather than
the voicemail server. The user can then see and playback messages through their email inbox. 

This option requires the Exchange 2007 server to include the Unified Messaging component. 

· Mailbox access using the telephone, visual voice or Phone Manager is done against voicemail messages in the
email account. 

· Access using UMS IMAP and UMS web voicemail is not supported. 

· Messages are not subject to Voicemail Pro housekeeping. 

· Only voicemail messages in the inbox are recognized. If a message is moved to another mailbox folder it is no
longer visible to the voicemail system. 

· Message waiting indication (MWI) is supported. 

· Note 
When using an Exchange 2007 server as the message store for a user's voicemail messages, the voicemail server will
deliver messages to the Exchange server on completion of the recording. However, the presentation to Outlook and
back to the voicemail server for message waiting indication (MWI) and access via telephone is delayed by Exchange
server processing. The delay is typically 1 or 2 minutes. The same delay also applies to changes in the message status
that affect message waiting indication. 



Voicemail Pro Page 309
15-601063 Issue 21c (16 July 2009)IP Office 5.0

Voicemail Pro Examples

Chapter 9.
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9. Voicemail Pro Examples
This section contains a number of example for specific areas of Voicemail Pro operation. 

For simple examples refer to the separate document "Voicemail Pro Example Exercises". That document contains a series
for setting up a basic auto attendant and then adding additional features. Working through that document should leave
you familiar with the process of setting up and testing call flows. 

9.1 Using VB Script

 The VB Script action allows an administrator to construct additional call flow logic using VBScript commands and
various properties  and methods. Use of VBScript requires entry of a valid VM Pro VBScript license in the IP Office
configuration. 

When a VBScript action is executed, the voicemail server allows the script up to 1 minute to complete execution. If
execution of the script takes longer then it is terminated by the voicemail server and the action's Failure result path is
used. 

Settings

1.Click the  Miscellaneous Actions icon and select VB Script. 

2.The General , Entry Prompts , Reporting  and Results  tabs are standard tabs available to all
actions.

3.Select the Specific tab.

· Enter VBScript 
In the script area enter the VBScript as required. Strings for the variables and methods provided for VBScript
by Voicemail Pro can be selected and inserted by right clicking on the script area. This script can contain a
maximum of 10000 characters. 

· Expand 
Check Expand to view a larger script area.

· Syntax Check 
Click the Syntax Check button to check your input for any errors.
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Results
This action has the following results which can be connected to further actions: 

This action has two results, Success or Failure.
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9.1.1 VBScript Properties
The following properties can be accessed within VBScripts. Note that unless otherwise stated they are session based. The
data is specific to a particular Voicemail Pro call and does not persist between calls.

Voicemail contains various state variables that are associated with a specific interaction with voicemail. The call variables
listed map to properties associated with the object:

· $NAM  – (read-only). See Name Property .

· $CLI  – (read-only). See CallingParty Property .

· $RES  – (read-write). See Result Property .

· $VAR  – (read-write). See Variable Property .

· $SAV  – (read-write). See SavedResult Property .

· $LOC  – (read-write).See Locale Property .

 

The following properties are specific to queued and still queued call flows only.

· $QPOS  – (read-only). See PositionInQueue Property .

· $QTIM  – (read-only) See EstimatedAnswer Property .

 

The following properties are related to the messages within the mailbox.

· NewMsgs Property  
Returns the count of new messages within the session’s mailbox. 

· OldMsgs Property  
Returns the count of old messages within the session’s mailbox. 

· SavedMsgs Property  
Returns the count of saved messages within the session’s mailbox. 

· LastAccessedMsg Property  
Returns the name of the last recorded or accessed message.

Note: VB Scripting will only support variant types.

 

Internal Variables 
Some of the variables that exist within Voicemail Pro can be split into smaller sections using a delimiter.

· Example: 
A CLI contains the number 01707364143. If the call flow references the variable as CLI@0,4 then the value
01707 will be returned as they are the first five numbers.
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9.1.1.1 CallingParty Property

The CallingParty property returns the caller id associated with the voicemail session used for VBS interaction with
Voicemail (equivalent to $CLI call variable).

· Owning object: vmprov5.voicescript

· String:

· Set: This property is read-only.

· Get: A String object containing the name of the calling party (or $CLI). For example: String = Voice.
CallingParty

· Remarks: The CallingParty property is only valid for the current session to Voicemail.

· Example

Sub Main (dlgid)
dim registration
Set Voice = CreateObject("vmprov5.voicescript")
registration = Voice.Register(dlgid)
if registration Then
      dim callerid
      callerid = Voice.CallingParty
end if
End Sub

 

9.1.1.2 EstimatedAnswer Property

The EstimatedAnswer property returns the $QTIM voicemail call variable. This is the user’s estimated time to answer
within the queue in minutes and is only available for queued and still queued call flows.

· Owning object: vmprov5.voicescript

· String:

· Set: This property is read-only.

· Get: A long containing the current value for $QTIM. For example: Long = Voice.EstimatedAnswer
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9.1.1.3 LastAccessedMsg Property

The LastAccessedMsg property returns the name of the last recorded message. If the IP Office TUI is used then this will
also contain the name of the last played message.

· Owning object: vmprov5.voicescript

· String:

· Set: This property is read-only.

· Get: A string object containing the fully qualified name of the last played or recorded message. For example: String
= Voice.LastAccessedMsg

 

9.1.1.4 Locale Property

The Locale property gets and sets the $LOC voicemail call variable.

· Owning object: vmprov5.voicescript

· String:

· Set: A string object that contains the new value for the $LOC variable. For example: Voice.Locale = String

· Get: A string object containing the current value for $ LOC. For example: String = Voice.Locale

· Example

Sub Main (dlgid)
dim registration
Set Voice = CreateObject("vmprov5.voicescript")
registration = Voice.Register(dlgid)
if registration Then
      dim locale   
      DO SOME PROCESSING.
      locale = Voice.Locale
      Rem NOW SET LOCALE TO FRENCH
      Voice.Locale = “fr”
      DO SOME PROCESSING.
      Rem NOW SET LOCALE BACK TO WHAT IT WAS
      Voice.Locale = locale
end if
End Sub
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9.1.1.5 Name Property

The Name property returns the name of the mailbox associated with the voicemail session used for VBScript interaction
with Voicemail (equivalent to $NAM call variable).

· Owning object: vmprov5.voicescript

· String:

· Set: This property is read-only.

· Get: A String object containing the name of the associated voice mailbox. for example:

· String = Voice.Name

 

9.1.1.6 NewMsgs Property

The NewMsgs property returns the number of new messages contained within the session mailbox.

· Owning object: vmprov5.voicescript

· String:

· Set: This property is read-only.

· Get: The number of new messages within the mailbox. For example: Number = Voice.NewMsgs

 

9.1.1.7 OldMsgs Property

The OldMsgs property returns the number of old messages contained within the session mailbox.

· Owning object: vmprov5.voicescript

· String:

· Set: This property is read-only.

· Get: The number of old messages within the mailbox. For example: Number = Voice.OldMsgs
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9.1.1.8 PositionInQueue Property

The PositionInQueue property returns the $QPOS voicemail call variable. This is the user’s current position in the queue
and is only available for queued and still queued call flows.

· Owning object: vmprov5.voicescript

· String:

· Set: This property is read-only.

· Get: A string object containing the current value for $QPOS. For example: String = Voice.PositionInQueue

 

9.1.1.9 Result Property

The Result property gets and sets the $RES voicemail call variable. The $RES variable contains the result property of a
call flow action. The result is action-specific, for example OK, FAILED, BUSY and so on. The call flow action is able to use
the variable to determine logic to be based upon the Result of a preceding Action, or as a temporary variable in the VB-
Script. However the variable will be overwritten after the VB Action is completed. If the values from the VB action icon
need to be passed to subsequent actions, it is advisable to use user variables.

· Owning object: vmprov5.voicescript

· String:

· Set: A string object that contains the new value for the $RES variable. For example: Voice.Result = String

· Get: A string object containing the current value for $RES. For example: String = Voice.Result

· Example

Sub Main (dlgid)
dim registration
Set Voice = CreateObject("vmprov5.voicescript")
registration = Voice.Register(dlgid)
if registration Then
      dim result
      dim success
      DO SOME PROCESSING.
      if success Then
            Voice.Result = TRUE
      else
            Voice.Result = FALSE
end if
End Sub
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9.1.1.10 SavedMsgs Property

The SavedMsgs property returns the number of saved messages contained within the session mailbox.

· Owning object: vmprov5.voicescript

· String:

· Set: This property is read-only.

· Get: The number of saved messages within the mailbox. For example: Number = Voice.SavedMsgs

 

9.1.1.11 SavedResult Property

The SavedResult property gets and sets the $SAV voicemail call variable.

· Owning object: vmprov5.voicescript

· String:

· Set: A string object that contains the new value for the $SAV variable. For example: Voice.SavedResult = String

· Get: A string object containing the current value for $SAV. For example: String = Voice.SavedResult

 

9.1.1.12 Variable Property

The Variable property gets and sets the $VAR voicemail call variable.

· Owning object: vmprov5.voicescript

· String:

· Set: A string object that contains the new value for the $VAR variable. For example: Voice.Variable = String

· Get: A string object containing the current value for $VAR. For example: String = Voice.Variable
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9.1.2 VBScript Methods
9.1.2.1 ForwardMsg Method

This method can be used to forward a file or message to other mailboxes. 

Method Voice.ForwardMsg(file, mailboxes, ident)

Parameters · file (String)
This contains the name of the file to be translated. If the fully qualified path is specified
(drive:\path\file) then the full specified path name is used otherwise the file is relative to
the specified locale within the WAVS directory.

· [GREETING]\greeting 
Plays out the greeting stored within the greetings directory. The .WAV extension is
automatically appended.

· [ACCOUNTS]\mailbox\message 
Plays out the message stored within the specified mailbox. The .WAV extension is
automatically appended.

· [CAMPAIGN]\campaign\message 
Plays out a campaign message stored within the specified campaign. The .WAV
extension is automatically appended.

· mailboxes (String)
The list of mailboxes to forward the message to, separated by non digits other than
commas, for example 202 203 204.

· ident (String)
The CLI to be associated with the message.

Return Value This method does not return a value.

9.1.2.2 ForwardMsgToMailbox Method

This method is used to forward a file or message to another mailbox.

Method Voice.ForwardMsgToMailbox(file, mailbox, ident)

Parameters · file (String)
This contains the name of the file to be translated. If the fully qualified path is specified
(drive:\path\file) then the full specified path name is used otherwise the file is relative to
the specified locale within the WAVS directory.

· [GREETING]\greeting 
Plays out the greeting stored within the greetings directory. The .WAV extension is
automatically appended.

· [ACCOUNTS]\mailbox\message 
Plays out the message stored within the specified mailbox. The .WAV extension is
automatically appended.

· [CAMPAIGN]\campaign\message 
Plays out a campaign message stored within the specified campaign. The .WAV
extension is automatically appended.

· mailbox (String)
The mailbox to forward the message to.

· ident (String)
The CLI to be associated with the message.

Return Value The name of the new message. (String)
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9.1.2.3 FullFilename Method

This method is used to translate the shortcut filename to the equivalent fully qualified pathname for the file. 

Method Voice.FullFilename(file)

Parameters · file (String)
This contains the name of the file to be translated. If the fully qualified path is specified
(drive:\path\file) then the full specified path name is used otherwise the file is relative to
the specified locale within the WAVS directory.

· [GREETING]\greeting 
Plays out the greeting stored within the greetings directory. The .WAV extension is
automatically appended.

· [ACCOUNTS]\mailbox\message 
Plays out the message stored within the specified mailbox. The .WAV extension is
automatically appended.

· [CAMPAIGN]\campaign\message 
Plays out a campaign message stored within the specified campaign. The .WAV
extension is automatically appended.

Return Value The equivalent fully qualified path name for the specified file. (String)

9.1.2.4 GetCallingParty Method

This method can be used to obtain the CLI from the current call. 

Method Voice.GetCallingParty([dlgid])

Parameters · dlgid (Long. Default = 0)
The connection for the voicemail session.

Return Value The CLI value associated with the specified voicemail session. (String)

9.1.2.5 GetDTMF Method

This method is used to return user’s DTMF input. 

Method Voice.GetDTMF([digits], [timeout], [dlgid])

Parameters · digits (Long, Default = 1)
The maximum number of DTMF digits to capture.

· timeout (Long, Default = 30)
The maximum time to wait for DTMF input.

· dlgid (Long. Default = 0)
The connection for the voicemail session.

Return Value The DTMF keys that were pressed. (String)

9.1.2.6 GetEstimatedAnswer Method

This method is used to obtain the $QTIM session variable.

Method Voice.GetEstimatedAnswer([dlgid])

Parameters · dlgid (Long. Default = 0)
The connection for the voicemail session.

Return Value The value of the $QTIM session variable associated with the specified voicemail session. (String)
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9.1.2.7 GetExtension Method

This method is used to obtain an extension.

Method Voice.GetExtension(index)

Parameters · index (Long)
The extension to return. Note that the actual extension number should not be entered as
index refers to the offset number of the extension in the listing.

Return Value The extension at that position within the list, an empty string if end of list. (String)

Example

Sub Main (dlgid)
dim registration
Set Voice = CreateObject("vmprov5.voicescript")
registration = Voice.Register(dlgid)
if registration Then
     dim index
     dim ext
     index = 0
     Do
           ext = Voice.GetExtension(index)
           index = index + 1
     Loop Until Len(ext) = 0
end if
End Sub

 

9.1.2.8 GetLastAccessed Msg Method

This method returns the name of the last recorded or played message. It is the same as using $ for the filename with an 
eMail  action. 

Method voice.GetLastAccessedMsg(dlgid)

Parameters · dlgid (Long. Default = 0)
The connection for the voicemail session.

Return Value The message name. (String)

9.1.2.9 GetLocale Method

This method can be used to obtain the $LOC session variable.

Method Voice.GetLocale([dlgid])

Parameters · dlgid (Long. Default = 0)
The connection for the voicemail session.

Return Value The value of the $LOC session variable associated with the specified voicemail session.

9.1.2.10 GetMailbox Method

This method can be used to obtain a mailbox.

Method Voice.GetMailbox(index)

Parameters · index (Long)
The extension to return. Note that the actual extension number should not be entered as
index refers to the offset number of the extension in the listing.

Return Value The mailbox at that position within the list, an empty string if end of list.

212
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9.1.2.11 GetMailboxMessage Method

This method can be used to obtain a message within a mailbox.

Method Voice.GetMailboxMessage(mailbox, msgtype, index)

Parameters · mailbox (String)
The mailbox to which the message belongs. 

· msgtype (String)
The type for the message(s). N for new, O for old and S for saved.

· index 
The message to return.

Return Value The message at that position within the list, an empty string if end of list. (String)

9.1.2.12 GetMailboxMessages Method

This method can be used to obtain the count of specific messages within a mailbox. 

Method Voice.GetMailboxMessages(mailbox, msgtype)

Parameters · mailbox (String)
The mailbox to which the message belongs. 

· msgtype (String)
The type for the message(s). N for new, O for old and S for saved.

Return Value The number of messages of a particular type within the mailbox. (String)

9.1.2.13 GetMessagePriority Method

This method is used to determine whether the message was left with priority.

Method Voice.GetMessagePriority(mailbox, message)

Parameters · mailbox (String)
The mailbox to which the message belongs. 

· message 
The message to query.

Return Value True if the message was left with priority, otherwise false. (Boolean)

9.1.2.14 GetMessagePrivate Method

This method can be used to determine whether the message was left with privacy.

Method Voice.GetMessagePrivate(mailbox, message)

Parameters · mailbox (String)
The mailbox to which the message belongs. 

· message 
The message to query.

Return Value True if the message was left with privacy, otherwise false. (Boolean)
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9.1.2.15 GetMessageStatus Method

This method can be used to obtain the state of the message within a mailbox.

Method Voice.GetMessageStatus(mailbox, message)

Parameters · mailbox (String)
The mailbox to which the message belongs. 

· message 
The message to query. The message name format should be [Accounts]\mailbox\message.
For example [Accounts]\Extn247\MSG00004.

Return Value The state of the message within the mailbox - N for new, O for old, S for saved. (String)

9.1.2.16 GetName Method

This method is used to obtain the $NAM session variable.

Method Voice.GetName([dlgid])

Parameters · dlgid (Long. Default = 0)
The connection for the voicemail session.

Return Value The value of the $NAM session variable associated with the specified voicemail session. (String)

9.1.2.17 GetNewMsgs Method

This method is used to obtain the number of new messages contained within the session’s mailbox.

Method Voice.GetNewMsgs([dlgid])

Parameters · dlgid (Long. Default = 0)
The connection for the voicemail session.

Return Value The number of new messages contained within the session’s mailbox. (Long)

9.1.2.18 GetOldMsgs Method

This method is used to obtain the number of old messages contained within the session’s mailbox.

Method Voice.GetOldMsgs([dlgid])

Parameters · dlgid (Long. Default = 0)
The connection for the voicemail session.

Return Value The number of old messages contained within the session’s mailbox. (Long)

9.1.2.19 GetPositionInQueue Method

This method is used to obtain the $QPOS session variable.

Method Voice.GetPositionInQueue([dlgid])

Parameters · dlgid (Long. Default = 0)
The connection for the voicemail session.

Return Value The value of the $QPOS session variable associated with the specified voicemail session. (String)



Voicemail Pro Page 323
15-601063 Issue 21c (16 July 2009)IP Office 5.0

Voicemail Pro Examples: Using VB Script

9.1.2.20 GetRegister Method

This method is used to retrieve a string stored in one of the session sixteen data variables $CP0 to $CP15.

Method Voice.GetRegister(regnum, [dlgid])

Parameters · regnum (Long)
Data register to use for storage (0-15).

· dlgid (Long. Default = 0)
The connection for the voicemail session.

Return Value The data stored within the specified register. (String)

9.1.2.21 GetResult Method

This method is used to obtain the $RES session variable.

Method Voice.GetResult([dlgid])

Parameters · dlgid (Long. Default = 0)
The connection for the voicemail session.

Return Value The value of the $RES session variable associated with the specified voicemail session. (String)

9.1.2.22 GetSavedMsgs Method

This method is used to obtain the number of saved messages contained within the session’s mailbox.

Method Voice.GetSavedMsgs ([dlgid])

Parameters · dlgid (Long. Default = 0)
The connection for the voicemail session.

Return Value The number of saved messages contained within the session’s mailbox. (Long)

9.1.2.23 GetSavedResult Method

This method is used to obtain the $SAV session variable.

Method Voice.GetSavedResult([dlgid])

Parameters · dlgid (Long. Default = 0)
The connection for the voicemail session.

Return Value The value of the $SAV session variable associated with the specified voicemail session. (String)

9.1.2.24 GetUserExtension Method

This method returns the extension number associated with the specified mailbox. 

Method voice.GetUserExtension(mailbox)

Parameters · mailbox (String)
The mailbox to which the message belongs. 

Return Value The extension number. (String)
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9.1.2.25 GetUserMailboxFromExtn Method

This method returns the mailbox associated with a specified extension number. 

Method voice.GetUserMailboxFromExtn(extension)

Parameters · extension (String)
The extension number. A variable such as $CLI can be used with internal callers to identify
the user's own mailbox. 

Return Value The mailbox name. (String)

9.1.2.26 GetUserVariable Method

This method returns the current value of a specified user variable. 

Method voice.GetUserVariable(variable)

Parameters · variable (String)
The user variable name. 

Return Value The current value of the user variable. (String)

9.1.2.27 GetVariable Method

This method is used to obtain the $VAR session variable.

Method Voice.GetVariable([dlgid])

Parameters · dlgid (Long. Default = 0)
The connection for the voicemail session.

Return Value The value of the $VAR variable associated with the specified voicemail session. (String)

9.1.2.28 MessageCLI Method

This method is used to obtain the CLI of the caller that left a message within a mailbox.

Method Voice.MessageCLI(mailbox, message)

Parameters · mailbox (String)
The mailbox to which the message belongs. 

· message 
The message to query.

Return Value The CLI of the caller that left the message. (String)

9.1.2.29 MessageDisplay Method

This method is used to obtain the display field associated with the message within a mailbox.

Method Voice.MessageDisplay(mailbox, message)

Parameters · mailbox (String)
The mailbox to which the message belongs. 

· message 
The message to query.

Return Value The display string associated with the message. (String)
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9.1.2.30 MessageLength Method

This method is used to obtain the length of a message within a mailbox.

Method Voice.MessageLength(mailbox, message)

Parameters · mailbox (String)
The mailbox to which the message belongs. 

· message 
The message to query.

Return Value The length of the message in milliseconds. (Long)

9.1.2.31 MessageTime Method

This method is used to obtain the date and time the message was left within a mailbox.

Method Voice.MessageTime(mailbox, message)

Parameters · mailbox (String)
The mailbox to which the message belongs. 

· message 
The message to query.

Return Value The time the message was left in the format: YEAR/MONTH/DAY HOUR:MINUTE. For example
2003/09/23 13:26. (String)

9.1.2.32 PlayDigits Method

This method is used to play the digits specified through voicemail to the active connection.

Method Voice.PlayDigits(digits, [wait], [interruptables], [dlgid])

Parameters · digits (String)
This contains the digits to be played. For example "12345" plays "one two three four five".

· wait (Boolean)
This optional parameter specifes whether voicemail should return immediately (0) or wait
until the wave file has been played first (1).

· interruptables (String, Default = "Any")
This is for future development.

· dlgid (Long. Default = 0)
The connection for the voicemail session.

Return Value The key press that was used to terminate the playback. (String)

Example

Sub Main (dlgid)
dim registration
Set Voice = CreateObject("vmprov5.voicescript")
registration = Voice.Register(dlgid)
if registration Then
      dim key
      key = Voice.PlayDigits("12345");
end if
End Sub
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9.1.2.33 PlayLocaleWav Method

This method is used to play a wave file through voicemail to the active connection taking into account the system locale.

Method Voice.PlayLocaleWav(wav, [wait], [interruptables], [dlgid])

Parameters · wav (String)
This contains the name of the wave file to be played. If the fully qualified path is specified
(drive:\path\file) then the full specified path name is used otherwise the file is relative to
the specified locale within the WAVS directory.

· [GREETING]\greeting 
Plays out the greeting stored within the greetings directory. The .WAV extension is
automatically appended.

· [ACCOUNTS]\mailbox\message 
Plays out the message stored within the specified mailbox. The .WAV extension is
automatically appended.

· [CAMPAIGN]\campaign\message 
Plays out a campaign message stored within the specified campaign. The .WAV
extension is automatically appended.

· wait (Boolean)
This optional parameter specifes whether voicemail should return immediately (0) or wait
until the wave file has been played first (1).

· interruptables (String, Default = "Any")
This is for future development.

· dlgid (Long. Default = 0)
The connection for the voicemail session.

Return Value · The key press that was used to terminate the playback. (String)
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9.1.2.34 PlayWav Method

This method is used to play a wave file through voicemail to the active connection.

Method Voice.PlayWav(wav, [wait], [interruptables], dlgid)

Parameters · wav (String)
This contains the name of the wave file to be played or the name of a system parameter to be
spoken. The following formats are allowable. If the string just contains numbers, then the digits
are played, for example 12345 plays "one two three four five". If the fully qualified path is
specified (drive:\path\file) then the full specified pathname is used otherwise the file is relative to
the WAVS directory.

· $NAM 
Plays the recorded name for the mailbox if one has been recorded. If a name has not been
recorded then optional TTS can be used (providing it has been licensed).

· $TIME:hh[:mm[:ss] [ Y][ dd[/mm[/yy]]]] = Plays out the specified time and date. The
hours to speak must always be specified and optional the number of minutes, seconds, day,
month and year. Note that the actual prompts spoken and order of playing of the elements
varies according to locale. Further examples are given in the table below: 

· English UK: "At eleven hour fifty five, date twenty first September two oh oh three". 

· English US: "Sunday September twenty first, eleven fifty five AM". 

· $QPOS [:position]  = This plays out "You are at queue position 'position' in the queue".

· $QTIM [:eta] = This plays out “Estimated time to answer is 'eta' minutes".

· $MSGN:msgs = Plays out the specified number of new messages. For example $MSGN:10
plays "You have ten new messages".

· $MSGO:msgs = Plays out the specified number of old messages. For example $MSGN:0
plays "You have no old messages".

· $MSGS:msgs = Plays out the specified number of saved messages. For example $MSGS:5
plays "You have five saved messages".

· $CID, $CLI, $DATE, $ETA, $KEY, $POS, $SAV, $TIME 
Play out the contents of the call variable.

· [GREETING]\greeting 
Plays out the greeting stored within the greetings directory. The .WAV extension is
automatically appended.

· [ACCOUNTS]\mailbox\message 
Plays out the message stored within the specified mailbox. The .WAV extension is
automatically appended.

· [CAMPAIGN]\campaign\message 
Plays out a campaign message stored within the specified campaign. The .WAV extension is
automatically appended.

· wait (Boolean)
This optional parameter specifes whether voicemail should return immediately (0) or wait until the
wave file has been played first (1).

· interruptables (String, Default = "Any")
This is for future development.

· dlgid (Long. Default = 0)
The connection for the voicemail session.

Return Value The key press that was used to terminate the playback. (String)

Example

Sub Main (dlgid)
dim registration
Set Voice = CreateObject("vmprov5.voicescript")
registration = Voice.Register(dlgid)
if registration Then
     dim key
     key = Voice.PlayWav(“test”, True, “Any”, dlgid);
end if
End Sub
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Examples of Time Playback

voice.PlayWav(...) UK English US English

"$TIME:0", True, "Any", dlgid "At Midnight Oh Zero" "Twelve Midnight"

"$TIME:11", True, "Any", dlgid "At Eleven Hour O’Clock" "Eleven AM"

"$TIME:12", True, "Any", dlgid "At Twelve Hour O’Clock" "Twelve Noon"

"$TIME:13", True, "Any", dlgid "At Thirteen Hour Hundred" "One PM"

"$TIME:23", True, "Any", dlgid "At Twenty Three Hour
Hundred""

"Eleven PM"

"$TIME:24", True, "Any", dlgid "At Midnight Oh Zero" "Twelve Midnight"

"$TIME:0:00:00 Y", True, "Any", dlgid "Yesterday At Midnight Oh
Zero"

"Thursday May Seventh
Twelve Midnight"

"$TIME:11:00:00 Y", True, "Any", dlgid "Yesterday At Eleven Hour O’
Clock"

"Thursday May Seventh
Eleven AM"

"$TIME:12:00:00 Y", True, "Any", dlgid "Yesterday At Twelve Hour O
’Clock"

"Thursday May Seventh
Twelve Noon"

"$TIME:13:00:00 Y", True, "Any", dlgid "Yesterday At Thirteen Hour
Hundred"

"Thursday May Seventh One
PM"

"$TIME:23:00:00 Y", True, "Any", dlgid "Yesterday At Twenty Three
Hour Hundred"

"Thursday May Seventh
Eleven PM"

"$TIME:24:00:00 Y", True, "Any", dlgid "At Midnight Oh Zero" "Twelve Midnight"

"$TIME:0:00:00 13/10/2008", True, "Any", dlgid "At Midnight Oh Zero date
Thirteenth October Two Oh
Oh Eight"

"Monday October Thirteenth
Twelve Midnight"

"$TIME:11:00:00 13/10/2008", True, "Any", dlgid "At Eleven Hour O’Clock Date
Thirteenth October Two Oh
Oh Eight"

"Monday October Thirteenth
Eleven AM"

"$TIME:12:00:00 13/10/2008", True, "Any", dlgid "At Twelve Hour O’Clock
Date Thirteenth October Two
Oh Oh Eight"

"Monday October Thirteenth
Twelve Noon"

"$TIME:13:00:00 13/10/2008", True, "Any", dlgid "At Thirteen Hour Hundred
Date Thirteenth October Two
Oh Oh Eight"

"Monday October Thirteenth
One PM"

"$TIME:23:00:00 13/10/2008", True, "Any", dlgid "At Twenty Three Hour
Hundred Date Thirteenth
October Two Oh Oh Eight"

"Monday October Thirteenth
Eleven PM"

"$TIME:24:00:00 13/10/2008", True, "Any", dlgid "At Midnight Oh Zero Date
Thirteenth October Two Oh
Oh Eight"

"Monday October Thirteenth
Twelve Midnight"
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9.1.2.35 RecordMsg Method

This method is used to record a user’s speech input to the specified file.

Method Voice.RecordMsg(recording, maxtime, [interruptables], [appendtofile], [dlgid], [playbeep])

Parameters · recording (String)
This contains the name of the file for the recording to be stored to and can be in the following
formats. If the fully qualified path is specified (drive:\path\file) then the full specified pathname is
used otherwise the file is relative to the specified locale within the WAVS directory.

· [GREETING]\greeting 
Plays out the greeting stored within the greetings directory. The .WAV extension is
automatically appended.

· [ACCOUNTS]\mailbox\message 
Plays out the message stored within the specified mailbox. The .WAV extension is
automatically appended.

· [CAMPAIGN]\campaign\message 
Plays out a campaign message stored within the specified campaign. The .WAV extension is
automatically appended.

· maxtime (Long)
The maximum recording length specified in seconds.

· interruptables (String, Default = "Any")
This is for future development.

· appendtofile (Boolean. Default = False)
Set to true if the recording should be appended to the file, false to clear the file first.

· dlgid (Long. Default = 0)
The connection for the voicemail session.

· playbeep (Boolean. Default = False)
This flag sets whether a beep is played before the start of recording.

Return
Value

The key press that was used to terminate the recording. (String)

9.1.2.36 RecordRegister Method

This method is used to record a user’s speech input to the specified file stored in the specified register.

Method Voice.RecordRegister(regnum, [maxtime], [interruptables], [dlgid], [playbeep])

Parameters · regnum (Long)
Data register containing file to store recording to.

· maxtime (Long. Default = 60)
The maximum recording length specified in seconds.

· interruptables (String, Default = "Any")
This is for future development.

· dlgid (Long. Default = 0)
The connection for the voicemail session.

· playbeep (Boolean. Default = False)
This flag sets whether a beep is played before the start of recording.

Return Value The key press that was used to terminate the recording. (String)
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9.1.2.37 Register Method

This method is used to determine whether the voicemail session that was used to launch the VB script is still active.

Method Voice.Register(dlgid)

Parameters · dlgid (Long. Default = 0)
The connection for the voicemail session.

Return Value A Boolean variable indicating whether the specified voicemail session is still active. (Boolean)

Example

Sub Main (dlgid)
dim registration
Set Voice = CreateObject("vmprov5.voicescript")
registration = Voice.Register(dlgid)
if registration Then
      do something.
end if
End Sub

9.1.2.38 SetLocale Method

This method is used to set the $LOC session variable.

Method Voice.SetLocale(locale, [dlgid])

Parameters · locale (String)
The new value for the $LOC variable.

· dlgid (Long. Default = 0)
The connection for the voicemail session.

Return Value This method does not return a value.

9.1.2.39 SetMailboxMessage Method

This method is used to change the status of a message within a mailbox.

Method Voice.SetMailboxMessage(mailbox, message, msgtype)

Parameters · mailbox (String)
The mailbox to which the message belongs. 

· message (String)
The message to modify. The message name format should be [Accounts]\
mailbox\message. For example [Accounts]\Extn247\MSG00004.

· msgtype (String)
The type for the message(s). N for new, O for old and S for saved.

Return Value This method does not return a value.

9.1.2.40 SetRegister Method

This method is used to store a string in one of the sixteen session data variables $CP0 to $CP15.

Method Voice.SetRegister(regnum, data, [dlgid])

Parameters · regnum (Long)
Data register to use for storage (0-15).

· data (String)
The data to store within this register.

· dlgid (Long. Default = 0)
The connection for the voicemail session.

Return Value This method does not return a value.
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9.1.2.41 SetResult Method

This method is used to set the $RES session variable.

Method Voice.SetResult(result, [dlgid])

Parameters · result (String)
The new value for the $RES variable.

· dlgid (Long. Default = 0)
The connection for the voicemail session.

Return Value This method does not return a value.

9.1.2.42 SetSavedResult Method

This method can be used to set the value of the $SAV variable.

Method Voice.SetSavedResult(result, dlgid)

Parameters · result (String)
The new value for the $SAV variable.

· dlgid (Long. Default = 0)
The connection for the voicemail session.

Return Value This method does not return a value.

9.1.2.43 SetUserVariable Method

This method can be used to set the value of a user variable. 

Method voice.SetUserVariable(variable, value)

Parameters · variable (String)
The variable name. 

· value (String)
The value to assign to the variable. 

Return Value This method does not return a value.

9.1.2.44 SetVariable Method

This method is used to set the $VAR session variable.

Method Voice.SetVariable(value, dlgid)

Parameters · value (String)
The new value for the $VAR variable.

· dlgid (Long. Default = 0)
The connection for the voicemail session.

Return Value This method does not return a value.
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9.1.2.45 Speak Method

This method is used to speak out the specified speech provided TTS has been licensed.

Method Voice.Speak(text, [wait], [interruptables], [dlgid])

Parameters · text (String)
This contains the text to be spoken.

· wait (Boolean)
This optional parameter specifes whether voicemail should return immediately (0) or wait
until the wave file has been played first (1).

· interruptables (String, Default = "Any")
This is for future development.

· dlgid (Long. Default = 0)
The connection for the voicemail session.

Return Value The key press that was used to terminate the playback. (String)

9.1.2.46 Stop Method

This method can be used to stop any current play back. 

Method voice.Stop(dlgid)

Parameters · dlgid (Long. Default = 0)
The connection for the voicemail session.

Return Value This method does not return a value.
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9.2 Database Connection
Voicemail Pro call flows can interact, read and write data, with almost any Windows database that supports ODBC (Open
Database Connectivity) and SQL (Structured Query Language) format.

· Requirements for Voicemail Pro Database Operation 
To use the Database actions within Voicemail Pro, a VM Pro Database Interface must be added to the IP Office
configuration.

The  Database Actions that can be used in a call flow are:

·  Database Open 
Opens the required database, including any necessary permissions and security options.

·  Database Execute 
Defines a SQL query to either read matching records from the database or to write data to the database. Up to 6
fields can be defined to be returned in matching database records.

·  Database Get Data 
Selects the current record from the matches returned by the preceding Database Execute action. The record fields
are then placed into Voicemail Pro variables DBD[0] to DBD[5]. The Database Get Data allows selection of the
first, next, previous or last record.

·  Database Close 
Closes the database connection. This also occurs automatically if the caller disconnects.
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9.2.1 Example Database Scenario
In this call flow example, an auto-attendant has been created to allow callers to order books. The book details are held
within a Microsoft Access database. Callers will be able to enter either the ISBN or Author's name. The title and cost of
the item will be looked up allowing the caller to purchase the item if they wish to. If the caller purchases the book they
will be able to enter their credit card details and a contact number.

Example of the database used in the call flow.

9.2.1.1 Retrieving Data from the Database

The Bookshop_Welcome module allows callers to choose to search the database by either the books ISBN number or
the author's name. The screen below shows the call flow module used when a search by ISBN is selected. The database
actions that have been used are shown below the call flow diagram, with details on the following pages.

 



Voicemail Pro Page 335
15-601063 Issue 21c (16 July 2009)IP Office 5.0

Voicemail Pro Examples: Database Connection

Database Open Action

The Database Open Action is used to link to the bookshop database.

The specific tab of the action contains the location of the database. Click the browse button to view the Data Link
Properties dialog. The details entered into these screens will depend upon the type of database used. This example uses
a Microsoft Access Database. The example shown below shows the connection to the database. If the database is
available the callers move through the call flow to a menu action that will capture the ISBN number entered.
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Database Execute Action

The Database Execute Action contains a query against the open database, in this example it concerns the ISBN captured
in the previous menu action.

If the sequence of numbers entered by the caller matches an ISBN entry in the database, then the Author's name, cost,
ISBN and book title details are captured. This query is entered into the Database Execute Action via the specific tab.

When entering information into the specific tab for the first time you are taken through a series of steps.

1.Select the Database Open Icon required. In this example the 'Make sure Database still active' icon was selected.

2.At the SQL Function window the option to 'Select …From' was chosen as information from the database is required.

3.Details are then entered into the SQL Wizard, as shown below.
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4.When the query has been entered the SQL wizard is closed. The specific tab of the action will contain the entered
query, see example shown below.

 

Database Get Data Action

The Database Get Data Action is used to return details of any matching entries following a search against a database.

To retrieve the results an option is selected on the specific tab to select how the data is retrieved from the database. In
this example the option 'retrieve the next item in the list' was selected to allow the caller to step through the results, if
more that one match ISBN occurred.

If a matching ISBN has been found the call flow is routed to another module called
'Bookshop_CurrentBookSpeakDetails'. 
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9.2.1.2 Returning Data from the Database

The Bookshop_CurrentBookSpeakDetails module tells the caller the book title, the author's name and the cost of the
book matching the ISBN that they entered.

 

The information from the database is conveyed to the caller using the 'Speak Text Action'. 

· To use the Speak Action, the IP Office must be licensed for and have installed Text to Speech.
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Speak Book Title

The Speak Book Title action is used to tell the caller the book title associated with the ISBN that was entered.

The fields selected in the 'Request ISBN from DB' action contain the information retrieved from the bookshop database.
The fields selected were Author, Cost, ISBN and Title. 

Any fields selected in a query will appear in alphabetical order.

· $DBD[0] would return details from the field Author

· $DBD[1] would return details from the field Cost

· $DBD[2] would return details from the field ISBN

· $DBD[3] would return details from the field Title. 

 

Each Speak Text action in the call flow returns the values from a different field selected within the database query. The
'Speak Book Cost' action has additional text added so that the currency can be spoken. In this example pounds are used.
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9.2.1.3 Entering Details into the Database

The caller is given an option to buy the book. If they select to buy the book, the call flow module 
Bookshop_CurrentBookBuy operates. The call flow immediately checks that access to the bookshop database is still
available via a Database Open action.

 

Confirm Book Details

Generic actions are used to store the ISBN number and cost. The example below shows how the ISBN number is stored
in the call variable CP0.

When the details have been stored the book title and cost are spoken to the caller using a Speak Text action. See the
example below.
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Collect Callers Details

Details can be entered into a database by a caller. In this example we collect the caller's credit card number, expiry date
and telephone number. All these details are collected and then the database is updated. The example below shows the
Specific tab entry used to collect the caller's telephone number and assign it to the call variable CP4.

When all the details have been collected, the database needs to be updated. The database Execute Action is used. When
entering information into the specific tab for the first time you are taken through a series of steps.

1.Select the Database Execute icon.

2.At the SQL Function window the option to 'Insert …values' was chosen as information needs to be added to the
database.

3.Details are then entered into the SQL Wizard, as shown below. When the Database table is selected, the list of fields
contained within the table is inserted. 

4.When the details have been entered the SQL wizard is closed. The specific tab of the action will contain the command
to execute, see example shown below. 
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9.3 Dial by Name
The Dial by Name action allows callers to indicate the user or group that they require by dialing the name on their
telephone keypad and then making a selection from the matches found.

To use this feature the caller must use a telephone with DTMF dialing and with ITU alphabet letter keys as shown here.

 

The main pre-requisites before a Dial by Name action can be used are:

1.User Names
The user names are set through the IP Office Manager. Either the user's Name or Full Name field can be used for Dial
by Name. If the Full Name field is set then it takes precedence over the Name field.

· Changing Names 
Voicemail Pro mailboxes are created to match existing user Name's. If a user Name is changed, Voicemail Pro will
create a new mailbox to match the new Name. Therefore care must be taken to ensure that Name field entries are as
accurate as possible when first setting up users. Using the Full Name field for Dial by Name is recommended as the
Full Name entry can be changed without affecting the existing mailbox entries.

2.User Name Recordings
Each mailbox to be included by the Dial by Name action needs to have had a user name recorded. This can be done in
two ways:

· Intuity Mailbox Mode 
By default when the user first enters their mailbox, they will be asked to set their voicemail code password and then
to record their name.

· IP Office Mailbox Mode 
In this mode you need to set up a call flow that allows users to record their name. In this document we have
included an example module that can be used for that purpose. The same module can also be used by Intuity mode
mailbox systems to let users re-record their names. See Adding a Record Name Module .

 

344
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9.3.1 Example Call Flow
In this example, after selecting a name using the Dial by Name service, the caller is transferred to the matching
extension. If that extension doesn't answer or is busy the caller is transferred to leave a message.

 

1.In Voicemail Pro a new module was added called Dial by Name.

2.From  Telephony Actions the  Dial by name action was added.

3.From  Telephony Actions an Assisted Transfer action was also added. In its properties Specific tab the Mailbox
was set as $KEY.

4.The  Dial by name action's True result was connected to the Assisted Transfer action.

5.From  Mailbox Actions a  Leave Mail action was added.
Again in its Specific tab the Mailbox was set as $KEY. Links were added from the Assisted Transfer action's No
Answer and Busy results to this action.

 

To add a short code:

1. In IP Office Manager, a new system short code was added. For this example we chose *75 and then entered the
details as shown below.

Field Contains...

Code *75

Feature Voicemail Collect

Telephone Number "Dial by Name"

Line Group Id 0

Locale [Leave blank]

Force Account Code [Leave blank]

2. After merging this back into the IP Office, users can dial *75 to access dial by name. They can also transfer callers
to this call flow.

3. The short code can be added a SoftConsole or DSS button. In addition, an Incoming Call Route could be used to
direct specific external calls direct to the function, for example if you had a specific external number used by
employees to ring in when off site.

 



Voicemail Pro Page 344
15-601063 Issue 21c (16 July 2009)IP Office 5.0

9.3.2 Adding a Record Name Module
This module allows users to record/re-record their mailbox name. This, or a similar module, is necessary if Voicemail Pro
is using IP Office mailbox mode. However it is still useful if the Voicemail Pro is using Intuity mailbox mode as it gives
users quick access to re-record their name.

 

1.In Voicemail Pro, a new module called Record Name was added.

2.A Record Name action was added.

3.In the General tab of the Record Name action's properties we set the Pin as $. The $ means that caller's must enter
their voicemail code in order to use the action.

4.The Specific tab was left set to the Caller's Mailbox.

5.The module was saved and made live.

 

To add a Shortcode:

1.In IP Office Manager, a new system short code was added. In this example, we chose *74 and then entered the details
as shown in the table.

Field Contains...

Code *74

Feature Voicemail Collect

Telephone Number "Record Name"

Line Group Id 0

Locale [Leave blank]

Force Account Code [Leave blank]

2.After merging this back into the IP Office, users can dial *74 at their extension to record their mailbox name.
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9.3.3 Using the Name Table
It is possible to create a service that will allow access to re-record the name of any mailbox. The NameWavsTable does
this by requesting an extension number and then allowing you to play, re-record and submit a name recording for that
extension. It then allows another extension number to be entered and so on.

Naturally if this option is used it should be behind suitable PIN code and other security protection as it allows the
recording of names for any mailbox.

To use the Name table:

1.In Voicemail Pro, create a new module.

2.Add a Goto action and open its properties.

3.In the General tab, enter a unique number in the Pin.

4.In the Specific tab, in Please select a node to go to enter NameWavsTable.

5.Click OK.

6.Using a short code or other method, create a route to the new module.

 

9.3.4 Changing Full Names
Users with DS port display phones can set and change the way in which their full name is displayed through their
telephone. This name will then be used for the text matching part of Dial by Name.

To changing your name using a telephone with a menu  Key:

1.Press Menu  twice.

2.Press  and select ProgA.

3.Press  and select Name.

4.Enter the new name. Use the dialing keys and Rotat to enter characters. For example, to enter an L, press the 5 key
and then press Rotat until an L is displayed. You can use the top-left display key to backspace.

5.When the text is as you require, press Done.

6.Press Exit .
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9.4 Campaigns
A campaign is a series of questions and answers. Callers to a campaign hear the recorded questions and give their
responses, either by speaking or using the telephone keypad. The results are then saved for processing later. 

Call processing agents can access a campaign  to hear the caller answers, which they can then transcribe into a
database or other records. 

A Web Campaign Component is installed as part of a typical Voicemail Pro installation . If the Web Campaign was not
installed it can be added by doing a custom installation and selecting the Web Campaigns component.
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9.4.1 Managing Campaigns
Within the Voicemail Pro client, the Campaign Wizard is used to create and modify campaigns. 

To start the campaign Wizard:

1.Press F7 or click  Campaign Editor. 

2.The Campaign Wizard Introduction window opens. Select the required activity.

· Create a new Campaign  
This option takes you through a series of campaign wizard menus to set the campaigns settings. 

· Modify an existing Campaign  
This option displays a list of existing campaigns from which you can select the one you wish to modify. You
will then be taken through the campaign wizard menus for the campaign settings. 

· Delete an Existing Campaign  
This option displays a list of existing campaign from which you can then select the campaign to delete. 

To create a new campaign:

1.Press F7 or click  Campaign Editor. 

2.Select Create a new Campaign and click Next. 

3.The Customer Prompts  window is displayed. 

· Click  . The Please Edit the Campaign action window opens. 

· Click OK when you have entered the customer prompts. 

· Adjust the prompts as required.

·  Edit action: - Edit the currently highlighted campaign action.

·  Delete action: - Delete the currently highlighted campaign action.

·  Move action: - Move the position of an action in the sequence of campaign actions.

· Click Next. 

4.The Customer Menu  window is displayed.

· Select which options are available after the prompt is played. 

· Click Next. 

5.The Campaign Identification  window is displayed.

· Enter the details on identifying the campaign. 

· Click Next.

6.Click Finish to create the campaign.
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To modify a campaign:

1.Press F7 or click  Campaign Editor. 

2.Select Modify an existing Campaign and click Next. 

3.Select the required campaign and click Next. 

4.The Customer Prompts  window is displayed. 

· Click  . The Please Edit the Campaign action window opens. 

· Click OK when you have entered the customer prompts. 

· Adjust the prompts as required.

·  Edit action: - Edit the currently highlighted campaign action.

·  Delete action: - Delete the currently highlighted campaign action.

·  Move action: - Move the position of an action in the sequence of campaign actions.

· Click Next. 

5.The Customer Menu  window is displayed.

· Select which options are available after the prompt is played. 

· Click Next. 

6.The Campaign Identification  window is displayed.

· Enter the details on identifying the campaign. 

· Click Next.

7.Click Finish to update the campaign.

 

To delete a campaign:

1.Press F7 or click  Campaign Editor. 

2.Select Delete an existing Campaign and click Next. 

3.Select the required campaign and click Next. 

4.Click Finish to delete the selected campaign.
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9.4.1.1 Customer Prompts

The Customer Prompt window of the Campaign Wizard is used to set the sequence of questions that are played to callers
and to record their responses.

·  Add action 
To add a new campaign action, click Add action. The Please edit the Campaign action window opens.

·  Edit action 

Select the prompt or recording to edit then click Edit action. The Please edit the Campaign action window
opens.

· Play a prompt to the customer 

Select this option to play a prompt to the caller. Click  to specify which prompt to play or create a new
prompt in the Wave Editor window. See Using the Wave Editor .

· Allow the customer to input information 
Select this option to if you want the action to record the caller's response.

· What type of input do you want 
This option sets whether the voicemail server should Record voice or Record key presses.

· Please enter the maximum recording length or Please enter the maximum number of key
presses. 
The field name depends on the type of input chosen. The time specified in seconds sets the maximum
length of recording or the maximum number of key presses to record before the next action.

· Please enter a unique name that will describe the input 
A name to associate with the action. The name should be a single word with no spaces.

· The following prompt will be played to an agent when the above data is reviewed 
This option allows you to select or create a prompt that is played to agents before hearing the caller's

response. Click  to specify which prompt to play or create a new prompt in the Wave Editor window.
See Using the Wave Editor .
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9.4.1.2 Customer Menu

After completing the sequence of questions and responses, the caller can be offered a menu of options. The Customer
Menu window of the Campaign Wizard is used to select the options available.

· Please select the prompt to be played after the customer has made their recordings 
You can select or create a prompt that is then played to callers after completing the sequence of questions and

answers. The prompt should inform the customer of which actions selected from the list they can use. Click  to
specify which prompt to play or create a new prompt in the Wave Editor window. See Using the Wave Editor .

· Please select which options will be available to the customer after the above prompt has played 
Check the boxes to select the options that will be available to the customer. The customer then needs to press the
corresponding key.

· Save the Campaign (and then quit) 
Saves caller responses and then disconnects the caller.

· Play back response to the Campaign 
Plays back the customers responses to them and then repeats this customer menu.

· Restart the whole Campaign 
Delete the customers responses and restarts the sequence of questions and answers.

· Quit the Campaign (without saving) 
Disconnects the customer without saving their responses.

·  Move options 
You can move the currently highlighted option so that the key presses associated with the options differ.

· Timeout 
Sets how long the voicemail server should wait for an answer before following the No Answer connection.
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9.4.1.3 Campaign Identification

The Campaign Identification window of the Campaign Wizard is used to set a park location for the campaign and to name
the campaign.

· Where should this Campaign be parked 
Enter a park slot number for the campaign. This number can be programmed under a DSS key. That key can then
be used by agents to access the campaign. If the DSS key also incorporates a BLF lamp, that lamp is lit when new
campaign messages are left.

· The name of the Campaign is 
Enter a name for the campaign.

 

9.4.2 Accessing Campaign Results
The results of a campaign can be accessed in several ways:

· Using the Campaign Action  
The Campaign action is used to route calls into a campaign after those calls have been routed to an appropriate
start point on the voicemail server. The action's properties set whether the call is treated as a caller to the
campaign or an agent processing the campaign messages. See Campaign Action .

· Using a Campaign Park Slot Number

· Through a Web Browser

When accessing the caller recordings from using a Campaign action or park slot number, the following controls are
provided through the telephone keypad. 

1 Go to the start of the call. 7 Previous response.

2 Rewind. 8 Start of response.

3 Stop processing the message. 9 Next response.

4 Mark call as processed and delete. 0 Pause.

5 Mark call as processed and save. # Fast forward.
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9.4.2.1 Campaign Park Slots

The Park Slot number assigned to the Campaign can be used with programmable buttons to access that campaign. If the
telephone has a message waiting lamp, the lamp will be lit when there are campaign messages waiting to be processed.

· Phone Manager park slot keys cannot be used for this function.

When accessing the caller recordings from using a Campaign action or park slot number, the following controls are
provided through the telephone keypad. 

1 Go to the start of the call. 7 Previous response.

2 Rewind. 8 Start of response.

3 Stop processing the message. 9 Next response.

4 Mark call as processed and delete. 0 Pause.

5 Mark call as processed and save. # Fast forward.

To assign a campaign to a programmable button:

1.In IP Office Manager, receive the IP Office configuration.

2.Open the required  User form.

3.Select the Button Programming tab.

4.Select a free button

5.Right-click in the Action field.

6.Select Emulation > Call Park.

7.Right-click in the Action Data field. Enter the campaign's park slot number.

8.Save the configuration back to the IP Office and reboot.

9.The programmable button on the user's telephone will flashing red when there are new messages in the campaigns
park slot.

10.Press the button to display the campaign name and number of messages.

11.Press the button again to start processing those messages.

 

The UnPark Call function can also be used to collect the calls, but this method does not provide any visual feedback when
messages are present.

To use the UnPark Call function:

1.Select a free programmable button

2.Right-click in the Action field.

3.Select Advanced > Call > UnPark Call.
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9.4.2.2 Using the Web Campaign

The Web Campaign Component allows access to play and change the status of campaign messages through a Web
browser.

· Anyone who wants to use the web campaigns must have Microsoft Internet Explorer 5.0 or higher (not Netscape).
Their PC must also have multimedia sound capabilities. The Web campaign user must also have a voicemail mailbox.
The name of their mailbox is requested when the user browses the campaign messages.

· During installation of the Campaign Web Component, the root address of the web server is requested. A folder called 
campaign is then added to that root. The web address for browsing will normally be set up as a link from a page within
a company intranet rather than typed directly by users.

· Access must be via http: and not network file routing.

 

To view open the Campaign Web Campaign:

1.Open your internet browser.

2.Type the address http://<server address>/campaign/campcgi.html. The log in window opens.

3.(Optional) To change the language click the language Continue button. A menu containing the countries flag is shown.
If you place your mouse cursor over a flag, the language that it represents in indicated.

· Click the required flag to change the language.

4.(Optional) To change the sound preferences click the Sound Prefs Continue button.

· Select the playback type of either the browser default or as background. The option background is the default
selection.

· Click Back to continue.

5.Enter your mailbox box name in the User Name field.
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6.Click Continue. The Campaign Web interface opens.

7.Select the campaign results that you want to view.

8.Select the type of results that you want to view.
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9.Click Submit to view the results. The details are listed in the main part of the window.
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9.5 Fax Server Configuration
With an IP Office system, fax machines and servers can process fax messages in a number of ways.

· Fax calls can be handled without the use of Voicemail Pro 
In IP Office a fax machine can be set up to direct faxes to individual extensions or hunt groups. Faxes can be directed
to the fax machines or servers based on the DDI or DID numbers of the incoming calls. See the IP Office Manager help
and guide.

· Fax calls detected by Voicemail Pro 
When a fax message is left in a voicemail mailbox, Voicemail Pro can detect that the call is a fax call, and redirect the
call to a fax machine or fax server to receive the fax. The incoming call can be routed to a system fax number or, in
Intuity Mode, a fax number that the mailbox owner has specified.

· Fax calls can be sent to a system-wide fax number 
If Voicemail Pro detects a fax tone, it passes the call to the number that is set as the system fax number. This number
can be an analog extension that is connected to a fax board in the fax server. For information about configuring an
analog extension, see Configuring an Analog Extension Number for Fax Use .

· Fax calls can be sent to a user defined mailbox number 
If Voicemail Pro detects that the incoming call is a fax and if a system fax number has been specified, Voicemail Pro
checks to determine whether the target destination is a user defined fax number. If it is, the system fax number is
overridden and the incoming call is redirected to the user defined fax number.

If no user defined fax number has been set, the fax is sent to the system fax number. When a system fax number is
set, any fax calls that are received in user or hunt group mailboxes are directed to this number. This applies to both
IP Office and Intuity Mailboxes. See Setting the Voicemail Pro System Fax Number .

Intuity mailbox owners have options available through their telephone handset so that they can forward a fax to a
preferred fax machine or send a fax to a printer. Intuity mailbox owners can find out how to set a mailbox fax
number in the IP Office Intuity Mailbox User Guide.

If a fax system, such as a C3000, requires prefix addressing the system fax number is not used. Instead a prefix is
specified so that a fax message can be identified and forwarded to the extension number of the intended recipient.
For example if a prefix of 54 is being used, a fax message for extension 201 would have the prefix of 54
automatically added so that the complete number would become 54201. The fax server then removes the system
prefix and uses the extension number to determine the target destination for the fax. See Setting the Voicemail Pro
System Fax Number .

· Fax calls can be redirected using a call flow Menu action instead of a system fax number 
If a system fax number is not set up, a menu action can be used instead. The F character can be used as one of the
touch tone choices of a Menu action to specify the actions that should be applied to fax calls. See Routing Fax Calls
Using a Menu Action .

· Important 
By default, Voicemail Pro fax detection is disabled. To enable fax detection, you must define a system fax number.
See Setting the Voicemail Pro System Fax Number .
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9.5.1 Fax Server Configuration
Here is an illustration to show how a fax server can be configured to work with an IP Office system. The illustration
applies to the following popular fax server applications:

· Gfi FAXMaker

· Fenestrae Faxination

· Equisys Zetafax

· Captaris RightFax

 

The fax server is configured to distribute faxes to exchange server mailboxes based on the original (DTMF) fax sub
address that is passed by Voicemail Pro. For the fax server and Voicemail Pro to interact, specific user rights are needed.

If the PC that is being used as the fax server uses an analog fax board, the fax board must be connected to an IP Office
analog extension (POT) port.

The sections that follow explain how to configure a fax server to work with Voicemail Pro. The information provided
assumes that:

· The fax server software is installed.

· The hardware is installed and connected to an IP Office.

· The Exchange Connector is installed and configured.

For details of system requirements and information about installing a fax server, refer to the manufacturer
documentation or visit the manufacturer web site.

The process for configuring a fax server to work with Voicemail Pro involves the following key steps:

1.Set the system fax number. See Setting the Voicemail Pro System Fax Number .

2.If prefixed numbers are being used you can set up a short code so that fax calls are routed to prefixed numbers. 

3.If the chosen mailbox mode is Intuity, inform all mailbox owners that they can set up their own preferred fax
destinations if they like. See Setting Up a User Defined Fax Number .

4.If a system fax number is not being used, you can set up a menu action to route fax calls. See Routing Fax Calls Using
a Menu Action .

5.If the fax server PC uses an analog fax card, configure the extension number to use for faxes. See Configuring an
Analog Extension Number for Fax Use .
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9.5.2 Setting the VoiceMail Pro System Fax Number
The System Fax Number is used to:

· Enable fax detection.

By default fax detection is not enabled when Voicemail Pro is first installed. When fax detection is enabled, any fax calls
that are left in a voicemail mailbox, are redirected to the defined system fax number.

· Define the default destination for fax calls that arrive in a voicemail mailbox and which are to be redirected to a fax
machine.

Intuity mailbox owners have the additional option to define their own personal fax number instead of the system fax
number. Incoming calls are directed to Voicemail Pro and then Voicemail Pro redirects fax calls to a mailbox owner's
personal fax number, if one has been set. For information mailbox owners should read the Intuity Mailbox User Guide.

To set the Voicemail Pro system fax number:

1.From the Administration menu, select Preferences. The System Preferences window opens.

2.Click the General tab. 

3.In the System Fax Number box, type the number of the general fax machine to which all incoming faxes are to be
directed. This number must match the number of the analog extension that is connected to the fax board of the fax
server PC.

· Intuity mailbox owners can receive fax messages into their mailboxes and set a preferred fax number to use instead
of the system fax number. As the administrator you still need to set up a system fax number to enable mailbox
owners to set their own numbers. A personal mailbox fax number overrides the system fax number. Mailbox owners
can find out more in the Intuity Mailbox User Guide.

· If your fax system requires prefix addressing, for example the C3000 fax server, do not type a fax number In the 
System Fax Number box. Instead type the number to use as a prefix so that a fax message can be identified and
forwarded to the extension number of the intended recipient. For example if the prefix were 54, a fax message for
extension 201 would have the prefix of 54 automatically added so that the complete number would become 54201.

4.To use the specified prefix, check the Use as a Prefix box so that the number that you typed in to the System Fax
Number box is used. If your fax system does not use prefix addressing, leave this box unchecked.

· Important 
For this feature to work, you also need to set up a short code. 

5.Most fax servers perform fax forwarding based on DTMF signalling received with the fax call. Check the Enable Fax
Sub-Addressing box so that the DTMF signal is passed to the fax server after the call has been answered. This is so
that the fax can be forwarded to the email address of the intended recipient.

6.Click OK.

7.Click Save & Make Live.
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If prefixed numbers are being used, the next step is to up a short code so that fax calls are routed to prefixed numbers. 

If the chosen mailbox mode is Intuity, you should then inform all mailbox owners that they can set up their own
preferred fax destinations if they like. See Setting Up a User Defined Fax Number .

If a system fax number is not being used, you can set up a menu action to route fax calls. See Routing Fax Calls Using a
Menu Action .

If the fax server PC uses an analog fax card, you need to configure the extension number to use for faxes. See 
Configuring an Analog Extension Number for Fax Use .
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9.5.3 Setting up Fax Forwarding
Voicemail Pro is set up to forward faxes when users dial *1. Faxes are forwarded as follows:

· Gfi FAXMaker faxes are sent to <faxnumber>@faxmaker.com

· Fenestrae Faxination faxes are sent to <faxnumber>@faxination.com

· Equisys Zetafax faxes are sent to <faxnumber>@zfconnector.com

· Captaris RightFax faxes are sent to <faxnumber>@rightfax.com

 

Example 
For example, if a GFi FAXMaker user dials *1 and enters the fax number to use followed by # to end the fax number and
# to confirm, the fax is forwarded to <faxnumber>@faxmaker.com. Therefore if the user dials *1 followed by 201# and
# to confirm, the fax is forwarded to 201@faxmaker.com.

· It is the responsibility of the fax server administrator to ensure that exchange connectors are configured to receive
such messages.

 

9.5.4 Setting Up a User Defined Fax Number
If you enable the feature for them, Intuity mailbox owners can set up a preferred personal fax number that is more
convenient to their location, for example if they are out of the office. 

To set up a user defined fax number:

1.Complete the steps for setting up the system fax number. See Setting the Voicemail Pro System Fax Number .

2.Inform the mailbox owner that they can go ahead and set their preferred fax number. Refer the mailbox owner to the
IP Office Intuity Mailbox User Guide.

3.If it has not already been done and the fax server PC is using an analog fax card, the next step is to configure the
analog fax number to use. See Configuring an Analog Extension Number for Fax Use .
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9.5.5 Routing Fax Calls Using a Menu Action
When an incoming call is routed to the auto attendant, the Menu action has the facility to detect and redirect fax calls.
This capability is enabled by including a number in the system fax number field via the Voicemail Pro Client, and adding
'F' as the tone to detect in the Menu action. From the Menu action, incoming calls presenting a fax tone will then follow
the 'F' call flow route, which could be a transfer call to a fax server extension or hunt group.

You can add the F character to the touch tone options of a  Menu action to specify the actions that should be applied
to fax calls. The corresponding result can then be routed as required for fax calls received by the associated call flow. The
following example module call flow is using F to redirect incoming fax calls to a specific transfer number.

The F result was added to the  Menu action Touch Tones tab using the  icon.
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9.5.6 Configuring an Analog Extension Number for Fax Use
If the PC that is being used as the fax server uses an analog fax card, it must be connected to an IP Office analog
extension (POT) port. You are then ready to configure the analog extension for fax use.

To configure an analog extension number for fax use:

1.In IP Office Manager, display the extension details for the extension that you are using for the fax.

2.View the Extn tab.

3.In the Caller Display Type field, select DTMFF. 

3.View the Analogue tab.

4.Set up the incoming DDI routing of calls to specific users as required. 

· Tip 
If the fax board can support multiple lines, you can configure them as a group. The group number can then be used as
the fax destination instead of an individual extension number.

The next step is to set the Voicemail Pro system fax number. See Setting the Voicemail Pro System Fax Number .
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9.5.7 Castelle Fax Server
Voicemail Pro 4.1 added support for Castelle FaxPress products. This uses SMTP rather than MAPI to exchange fax emails
with the Voicemail Pro server.

In order for the Voicemail Pro to recognize emails received from the fax server, the From name used must start with
FaxPress. This is configured through the FaxPress client software as follows:

1.Login to the FaxPress client software as a supervisor.

2.Expand the Administration section on the left.

3.Select Embedded Services.

4.Select Email Gateway. Right-click on this and select Configuration.

5.Select the Email to Fax tab.

6.In the Return address used in emails sent from the SMTP gateway section, in the Name field enter a name in
beginning with FaxPress.
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10. Appendix
10.1 What Was New in 4.2
In conjunction with IP Office 4.2, Voicemail Pro 4.2 supports the following new features:

· IP Office Unified Messaging Service (UMS)
Two new methods for users to access their mailbox are now supported. The methods are mailbox access using
email applications that support IMAP (Internet Message Access Protocol) and mailbox access via web browsers.
The use of these requires the IP Office configuration to contain UMS Web Services licenses for the number of
required users. 

· IMAP Service
The Voicemail Pro now includes an IMAP server. Users can then access their voicemail messages using email
clients such as Outlook and Lotus notes that support an IMAP Client. When connected, the IMAP client and
Voicemail Pro will synchronize messages in the mailbox with message files in the IMAP client. Playback is
through the sound facilities of the user PC. 

· Web Voicemail Service
The Voicemail Pro web service allows users to access their mailbox using a web browser. This has been tested
with the Internet Explorer 7, Firefox 2 and Opera 9.10 PC browsers. This method of access requires Voicemail
Pro to be installed on a PC already running Microsoft's IIS web server. Users can select to have message
playback via an IP Office extension or through their PC's sound facilities. 

· Test Variable Action
The existing Check Digits action has been replaced by a Test Variable action. This, in addition to offering the
capabilities of the Check Digits action, provides significant enhancements. In addition to being able to match the
user's DTMF input against a specified string offered by the Check Digits action, the Test Variable action allows
the testing of the contents of any call variable against known user extensions, hunt-groups, mailboxes and the
contents of another variable. This allows a number entered by a caller to be verified as matching an existing
extension or hunt group prior to attempting a transfer to that number.

· Menu Action Invalid Input Handling  
The Menu action has been enhanced. It now includes a control for the number of retries for the caller to make a
valid entry and an Invalid Input result for connection to following call flow actions. Also prompts can be selected
for playback whenever an invalid entry or entry timeout occurs. 

· License and Service Status Display  
When the Voicemail Pro client is connected to a Voicemail Pro server, the Help | About screen displays a list of
the licenses being used by the Voicemail Pro server. This license details include the validation status and capacity
of those licenses. The status of related services, for example the UMS IMAP server, are also listed. 

· Call Variable Length Increase
Previously the length of values stored by call variables has been limited to 64 characters. That maximum length
has been increased to 512 characters. 

· Outcalling Configuration  
In conjunction with Phone Manager 4.2, Voicemail Pro 4.2 allows users to adjust their outcalling settings through
using a visual menu within Phone Manager. 

· Using the Phone Manager interface, users can now apply a delay between each notification call in an
escalation list. 
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Appendix: What Was New in 4.2

10.2 What Was New in 4.1
In conjunction with IP Office 4.1, Voicemail Pro 4.1 supports the following new features:

· Windows Vista Support  
Those components of Voicemail Pro previously supported on Windows XP Pro are now also supported on Windows
Vista (excluding Vista Home Basic and Vista Home Premium). The Voicemail Pro client is supported on Vista. The
Voicemail Pro server is supported on Vista but not with IMS or Web Campaigns.

· Automatic Recording Mailbox for Hunt Groups  
By default automatic recordings for hunt groups are routed to the hunt group mailbox. Previously this could not be
changed except through customized call flows on the Voicemail Pro. An alternate mailbox destination can now be
specified through the Hunt Group | Voice Recording  tab.

· Automatic Recording Mailbox for Account Codes  
By default automatic recordings for account codes are routed to the mailbox of the user making the call. Previously
this could not be changed except through customized call flows on the Voicemail Pro. An alternate mailbox
destination can now be specified through the Account | Voice Recording  tab.

· Call Data Tagging on Transfer Actions  
The Transfer action now supports fields for setting the transfer source and description to display on phones
receiving the transfer. The ability to associate call data for MS-CRM via Assisted Transfer actions is now also
supported on Transfer actions.

· Call Transfer Announcements  
The Transfer  and Assisted Transfer  actions can be configured to announce the transfer to the caller. The
announcement uses the recorded name of the mailbox associated with the transfer if available or the number if
otherwise.

· LIFO/FIFO Mailbox Operation  
The default message playback order of First In-First Out (FIFO) can now be changed to Last In-First Out (LIFO).
This is separately adjustable for new, old and saved messages. These are set through the System Preferences |
Housekeeping  tab (Administration | Preferences | General ).

· Time in Queue and Time on Call Variables  
Two new variables can be used in Queued and Still Queued call flows. They are $TimeQueued for the time in the
queue and $TimeSystem for the time the call has been on the IP Office system.

· Castelle Fax Server Support  
The Voicemail Pro can be configured to recognize faxes of this type left in user's email mailboxes and include
announcement of there presence in the user's mailbox prompts.

· Hunt Group/Account Code Call Recording Destination  
Previously the destinations for automatic call recording triggered by hunt groups or account codes could not be
changed except through a custom Voicemail Pro call flow. The IP Office 4.1 configuration now allows the required
destination for the call recording to be specified.

· $DDI Call variable for DDI Numbers  
This variable is available on DDI calls passed from the IP Office to the Voicemail Pro.

· Variable Routing (replaces the CLI Routing Action)  
The existing CLI Routing action has been replaced by the Variable Routing  action. This action allows the call
routing to be based on matching specified values to call variables such as $CLI and $DDI. The numbers to which
matching is performed can include wildcards such as ? for a single digits and * for any digits. 
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10.3 What Was New in 4.0
In conjunction with IP Office 4.0, Voicemail Pro 4.0 supports the following new features:

· Upgrade  
You can now upgrade without having to remove previous 3.2+ versions of the software.

· Outcalling  
When a new voice message is left in a user's mailbox, notification can be automatically sent to a selected external
number. Notification can be sent for all new messages or only messages marked as priority. If there is no response
to the first notification there is an escalation capability. A user can configure their outcalling settings using their
telephone handset. Details on how to configure outcalling for individuals can be found in the Intuity Mailbox guide.

· Personal & Hunt Group Announcements  
Personal announcements can be recorded. A caller will hear the user's personal announcement before being
transferred to voicemail, if available.

· Channel Reservations  
Specific functions can have voicemail channels reserved for their use. The channels are reserved in IP Office
Manager. By default there are no reserved channels.

· Automatic Recording  
Incoming call routes can be configured to be automatically recorded.
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10.4 Prompts
10.4.1 US English Intuity Prompts
The following a list of the numbered .wav files used by Voicemail Pro for US English. These are predominately, though not
exclusively, used for Intuity mailbox features.

All files are Microsoft WAVE file format (.wav) 8kHz, 16 bit mono.

Important

· It is important to note that the corresponding .wav file in other languages is not the same prompt.

WAV File Intuity Prompt

2 "at".

4 "Not private".

8 "To record a new message press 4".

13 "To record press 1 after recording press 1 again".

14 "To make private press 1, to make public press 2".

15 "And is".

18 "To forward with comment press 2".

19 "To review from beginning press *1, if finished press *#".

21 "To listen press 0".

24 "To delete press *D".

27 "To attach original, press y for yes or n for no.".

30 "To change press 1".

35 "Login incorrect".

41 "To forward message with comment at beginning, press 2".

43 "Your call is being answered by IP Office".

44 "Is not available to leave a message wait for the tone".

45 "Is busy, to leave a message wait for the tone".

46 "To access your mailbox press *R".

49 "No operator defined".

56 "Thank you for leaving you message".

58 "For name addressing press *A".

60 "Changed".

61 "To modify status, press 9 for yes, or 6 for no".

63 "New".

65 "Contains".

67 "To create another list".

70 "Unopened".

71 "To leave a message wait for the tone".

73 "You have".

74 "Deleted".

75 "To skip press # to delete press *D".

77 "Deleted".

80 "To have system wait press *W if finished please hang up or to disconnected IP Office press **X".

84 "Entry".

85 "Erased".

86 "Extension".

87 "This call is experiencing difficulties".

88 "Cannot use the guest password".

89 "First message".

91 "At end".

94 "Goodbye".

95 "Please disconnect".

96 "For help press *H".

97 "For help at anytime press *H".

100 "Invalid entry".
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WAV File Intuity Prompt

105 "To restart at the activity menu press *R".

108 "You are recording a message".

109 "Later".

110 "List".

111 "Please enter list ID".

112 "Otherwise for assistance press Zero now".

113 "You already have a list".

114 "To replace list renter ID and # sign, to create a new list enter new list ID".

115 "To transfer using names instead press *2".

117 "To reach the covering extension press *Zero".

118 "Enter last name".

119 "You wish to call".

120 "Too large to include".

124 "No more list space".

125 "Must be six or fewer numerals".

126 "To forward message with comment at end press 3".

127 "Return to previous activity".

130 "Because there were no entries".

134 "You can store your list or delete members but you cannot add members".

141 "No more lists".

142 "To list to the header press 3".

143 "To set back again press 2".

145 "List has no entries".

146 "To continue press #".

147 "Review completed".

148 "For extension addressing press *2".

150 "Members".

156 "Maximum length recorded".

159 "Member".

160 "Message".

161 "Midnight".

163 "To call sender press zero".

164 "Category".

165 "Returned to getting messages".

166 "At end to play back press 23".

167 "To approve press #, to record from here press 1, to play back press 23".

168 "Messages".

170 "Delivery scheduled".

173 "Please enter new password".

175 "Please note only IP Office subscribers can be specified by name".

178 "No addresses identified".

180 "Nothing to approve".

182 "Nothing to delete".

185 "Not found".

188 "Passwords do not match, please re-enter new password".

191 "No more messages".

192 "No messages".

193 "No name recorded".

194 "No new messages".

197 "Cannot step back".

198 "Partial name deleted".

201 "Noon".

202 "Not valid".

208 "Is not a public list".
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WAV File Intuity Prompt

209 "Cannot modify another subscriber's list".

210 "Please enter a new password".

211 "To 15 digits".

212 "Please enter password again for confirmation, to delete the password you just entered press *D".

213 "Re-enter password".

214 "Approved".

219 "Owned by".

220 "Enter password".

223 "Please enter extension".

224 "And # sign".

226 "Private".

227 "Public".

228 "Record at the tone".

232 "Recording stopped".

233 "Previous login incorrect please re-enter extension".

234 "To respond or forward press 1".

235 "To restart at the activity menu press *R, to transfer to another extension press *T".

236 "Try again".

238 "To review another list".

240 "To skip press # to listen press zero".

242 "Returned to the".

243 "Rewound".

244 "Rewound to previous message".

252 "To respond to this message press 1".

253 "Please enter month, day".

255 "To delete this message press *D".

256 "At beginning to re-record press 1 to playback press 23".

262 "Received".

272 "Contact administrator for help".

274 "Please make entry soon or be disconnected".

275 "Cannot get your messages now due to multiple logins to your mailbox".

277 "To exit directory press #".

282 "To have system wait press *W, to access the names or numbers directory press **N. If finished
please hang up or to disconnect IP Office press **X".

285 "To add a member enter extension".

286 "To add a member enter last name".

287 "Welcome to IP Office".

288 "You are in the main directory. To find a subscribers extension, enter the last name followed by the #
sign. To enter the letter Q press 7, for z press 9. To lookup by extension instead press *2".

290 "If you wish to specify a non IP Office subscriber, first change to extension addressing by pressing *A".

291 "To transfer to another extension press *T".

292 "Louder press 4, softer press 7, faster press 9, slower press 8".

294 "To add entries press 1".

295 "To renter list press *5".

298 "To specify owner by name press *2".

300 "AM".

301 "PM".

305 "You are at the activity menu".

306 "You are changing your password".

310 "January".

311 "February".

312 "March".

313 "April".

314 "May".
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315 "June".

316 "July".

317 "August".

318 "September".

319 "October".

320 "November".

321 "December".

322 "You are in the numbers directory. To find a subscribers name, enter the extension followed by the #
sign. To lookup by name instead press *2".

323 "You are responding to a piece of incoming mail".

325 "You are administering your lists. To create a mailing list press 1, to play a summary of all your lists
press 2, to review a particular list press 3".

327 "You are creating a mailing list".

328 "To delete the previous entry, press *3. To add a mailing list you have already created or a public list
owned by others, press *5. To review or modify the list you are creating, press *1. To approve the list
you are creating and move on to the next step, press #".

329 "You have not yet entered enough characters to identify a specific subscriber. To enter the letter Q
press 7, for Z press 9".

330 "Or enter just the # sign if it is your phone".

332 "System greeting used".

333 "To add entries to the list or to change status of the list press 1".

334 "When finished addressing press #".

335 "When finished press #".

339 "To replay the last few seconds press 5, to advance a few seconds press 6.".

347 "You are adding a list".

348 "You are specifying a mailing list to review".

350 "Sunday".

351 "Monday".

352 "Tuesday".

353 "Wednesday".

354 "Thursday".

355 "Friday".

356 "Saturday".

357 "You are choosing between subscribers whose names match your entry. To indicate no subscribers
match, delete entry by pressing *3. To change to extension addressing and delete your entry press
*2".

358 "You are identifying a list as private or public".

360 "You are scanning mailing lists, to review list members press 0, to rewind to previous list press 2, to
continue scanning lists press 3".

361 "To skip to next list press #, to delete list press *3".

362 "If you own the list press #, if some else owns the list".

363 "To approve the list you are creating press #".

364 "Enter owner's extension".

367 "To specify a different owner by name press *3".

368 "You are entering the number for a new list. Please enter a number up to 6 digits long".

369 "To replace an existing list, enter that list's number".

370 "These are entries in your list".

371 "To rewind to current entry press 2, to rewind to previous entry press 2 as many times as necessary,
to continue playback of list press 3".

372 "To skip to next entry press #, to delete current entry press *D".

373 "You are choosing whether to attach a copy of original message to your reply. To include the original
press y for yes, to send only your reply press n for no".

376 "To skip the next header press the # sign to listen to the header rewind by pressing 2 then play by
pressing 3 to skip to the next category press *#".

377 "To delete message press *D".

380 "Please wait".

381 "To listen to the message press 0, to re record message before delivery press 1".
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WAV File Intuity Prompt

388 "To skip press the # key".

390 "O" (Oh)

391 - 450 "One" to "sixty". For zero see 585.wav

451 "Seventy".

452 "Eighty".

453 "Ninety".

454 "Hundred".

455 "Thousand".

456 "Million".

464 "Enter extensions".

468 "To continue playing press 3".

471 "If it's your list press #".

472 "To approve press #, to record from here press 1".

477 "Press 1 to select".

478 "2 to select".

479 "3 to select".

484 "Enter more characters followed by the # sign. If you just completed entering the last name enter the
first name".

485 "Has".

486 "To reply to sender by voicemail press 1".

493 "You are requesting a transfer".

499 "When finished recording press # to approve or 1 to edit your message".

556 "To exit press *# now".

561 "You addressing your message".

562 "Enter the".

563 "Digit extension".

569 "To modify press 1, if finished press *#".

577 "To hold the message in its current category press **H".

578 "To skip to the next category press *#".

579 "Password must be".

585 "Zero".

587 "You are reviewing a list".

601 "Priority".

604 "As you use IP Office, your name will be included in system announcements that you and other people
will hear. Press 1 and at the tone please speak your name. After speaking your name press 1 again".

606 "To re-record you name press 1, to approve press #".

608 "At the tone please speak your name. After speaking your name press 1".

610 "You are recording your name. After you record your name, you can access other IP Office features. As
you use IP office your name will be included in system announcements that you and other people will
hear. Press 1 and at the tone please speak your first and last name as you would like others to hear it.
After speaking your name press 1 again".

611 "You are recording your name. To record your name, press 1. After recording press 1 again. To play
back name press 23, to approve press #".

612 "To make private press 1".

613 "To make priority press 2".

617 "To remove private status press 1".

618 "To remove priority status press 2".

622 "Not priority".

643 "You are choosing options for this message there are no options currently set".

644 "You are choosing options for this message with the current settings".

645 "Private messages cannot be forwarded by the recipients".

646 "A priority message will be delivered before other messages and will be flagged for special attention in
the recipients mailbox".

647 "The message will be private".

648 "The message will be priority".
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651 "The message will be private and priority".

681 "Sorry cannot leave a message now because this users mailbox is full".

700 "To administer mailing lists press 1".

701 "To change your password press 4".

702 "To record your name press 5".

703 "You are at subscriber administration".

704 "To create lists press 1, to scan lists press 2, to review and modify lists press 3".

707 "If finished press *#".

708 "If finished adding entries press #".

736 "You are recording your name. As you use IP office your name will be included in system
announcements that you and other people will hear".

744 "For all calls".

745 "Active".

747 "For internal calls".

748 "For external calls".

749 "For busy calls".

750 "For no answer".

751 "For out of hours calls".

752 "To listen to a greeting press 0, to create change or delete a greeting press 1, to scan all your
greetings press 2, to activate a greeting press 3, to administer call types press 4, if finished press #".

753 "Enter greeting number".

754 "Greeting".

755 "Not recorded".

756 "To listen to greeting".

757 "To re-record, press 1".

759 "To review status, press 2".

760 "Press 0".

764 "To use this greeting for all calls press 0, for internal calls press 1, for external calls press 2".

765 "Recorded but not active".

766 "To use this greeting for all calls press 1".

767 "To use this greeting for all calls press 0, for busy calls press 1, for no answer calls press 2".

770 "Recorded and active".

771 "Approved and active".

772 "Again".

773 "To activate for out of hours call press 3".

775 "To record messages press 1 to get messages press 2 to administer personal greetings press 3".

776 "The system greeting".

777 "Cannot listen to system greeting".

778 "Cannot modify system greeting".

779 "No greetings recorded".

780 "Personal greetings review completed".

781 "To skip to the next greeting press the # sign".

782 "To activate a greeting enter greeting number, to de-activate a greeting activate a different greeting in
its place".

783 "To activate another greeting enter greeting number to de-activate a greeting activate a different
greeting in its place".

784 "To activate system greeting enter 0".

785 "Same greeting used for all calls".

786 "To identify calls as internal and external press 1".

787 "To identify calls as busy and no answer press 2".

788 "To identify calls as out of hours press 3".

790 "Calls identified as internal and external".

791 "Calls identified as busy and no answer".

792 "Calls identified as out of hours".

793 "Calls not identified as out of hours".
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WAV File Intuity Prompt

797 "To use the same greeting for all calls press 5".

810 "External".

812 "No answer".

814 "Calls".

815 "You are administering your personal greetings".

816 "You are listening to a personal greeting".

817 "You are recording a personal greeting".

818 "You have just recorded".

819 "You are scanning your personal greetings".

820 "You are selecting which greeting to activate".

821 "You administering call types".

822 "As you use IP Office, your name will be included in system announcements that you and other people
will hear. At the tone please speak your name, after speaking your name press 1".

823 "For all calls".

825 "For internal".

826 "For external".

827 "For busy".

828 "For no answer".

829 "For out of hours".

830 "You must approve your recording".

832 "Please enter extension and # sign".

839 "To rewind to the previous greeting press 2".

843 "To scan headers and messages press 1, to scan headers only press 2, to scan messages only press
3".

844 "End of message".

845 "Next message".

846 "You are selecting an option for automatic message scan".

847 "You are automatically scanning your incoming messages. To listen to the message press 0, to respond
to or forward the message press 1".

848 "You are automatically scanning your incoming messages. To listen to the message press 0 to respond
to the message press 1".

849 "To skip the next message press the # sign, to the listen to the header rewind by pressing 2, then play
by pressing 3, to skip to the next category press *#".

850 "Broadcast and login message services are not available".

852 "To rewind to the current entry press 2, to rewind to previous entry press 2 as many times as
necessary".

868 "Mailbox id must be less than or equal to less than 16 digits".

869 "If the extension entered belongs to a casual subscriber you will be prompted for a mailbox id".

905 Short silence.

907 2 seconds of silence.

913 "If finished press #".

915 "No options menu available".

916 "To send message press # or enter an option to hear a list of options press 0".

924 "Seconds".

925 "Minutes".

926 Beep

928 "New messages".

929 "Old messages".

935 "Unopened messages".

936 "Partial entry deleted".

937 "Sorry you are having difficulty please get help and try again later".

938 - 968 Ordinal numbers "1st" to "31st".

971 "To send press #".

972 "To reach the covering extension press Zero".

973 "If you are finished please hang up or press **X".
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977 "Name not found".

987 "Enter last name of the person".

990 "To record and send voicemail messages press 1".

992 "To get messages press 2".

1001 "To scan incoming messages automatically press 7, to relogon press **R".

1006 "To record or change the greeting heard by callers press 3".

1010 "With priority".

1011 "With fax".

1020 "No message to send".

1028 "Page".

1029 "Pages".

1041 "There are no new faxes".

1048 "Nothing to print".

1052 "To specify your fax preferences press 3".

1061 "Your default print destination is...".

1071 "Fax message from..".

1073 "To print press *1".

1075 "To change the default print destination press 1".

1087 "To print to destination".

1088 "Press #".

1089 "To specify destination, enter digits followed by the # key".

1091 "You are specifying where your documents will be printed".

1092 "A default print destination has not been assigned".

1093 "To assign a default print destination press *7 then 53".

1098 "To approve press #".

1118 "You are specifying the default print destination for fax items".

1141 "When finished recording press # for more options".

1144 "To specify whether a message can be addressed before it is recorded press 6".

1145 "To administer call answer options press 7".

1152 "Address before record turned on".

1153 "To turn off press 1".

1154 "Address before record turned off".

1155 "To turn on press 1".

1157 "You are administering addressing options".

1158 "To prevent callers from leaving messages press 1".

1159 "Call answer messages will not be accepted".

1160 "To allow callers to leave messages press 1".

1161 "You are administering call answer options".

1162 "Sorry the mailbox you have reached is not accepting messages at this time".

1163 "Is not available".

1164 "Call answer messages will be accepted".

1219 "To review or change your reach options press 7".

1305 "Please enter an outcalling option to hear a list of options press 0".

1430 "To following message was restored".

1431 "No message to restore".

1432 "To undelete last deleted message press **U".

1434 "To return to getting messages press #".

1440 Beep

1443 "Voice file system is out of space".

1444 "Please contact the administrator".

1457 "Old and new passwords cannot be the same".

1461 "You are getting your incoming messages".

1462 "To listen to the message press Zero".

1463 "To reply to sender by voicemail press 17".
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1464 "To forward with comments press 12".

1465 "To record a new message press 14".

1466 "To respond to or forward the message press 1".

1467 "The return address for this message is not a mailbox on this system".

1469 "To reply to sender by voicemail press 7".

1964 "The ability for callers to leave messages in your mailbox is turned off".

1965 "To allow callers to leave messages press 571".

1970 "Invalid password please enter new password and # sign".

2007 "With text".

2008 "With other media".

2010 "Zero".

2011 "bytes".

2012 "Byte".

2013 "Kilobyte".

2014 "Kilobytes".

2015 "Megabyte".

2016 "Megabytes".

2018 "And".

2019 "Message from".

2021 "Private".

2022 "Private priority".

2023 "Priority".

2025 "Call from".

2026 "Call received".

2029 "This is a ".

2030 "Voice".

2031 "Fax".

2032 "Text".

2033 "Attached file".

2035 "To advance to the end of the message press *6".

2038 "Rewound".

2039 "Component".

2040 "To listen press 3".

2041 "To customize your mailbox, for example to create or edit your mailing lists or change your password,
press 5".

2042 "To administer your media preference for sorting messages, press 8".

2043 "You are administering your preferred media type for sorting incoming messages. Messages with a
primary media type matching your preference will be presented before other messages, regardless of
the order in which they have been received".

2044 "No media preference for sorting incoming messages has been specified".

2045 "For voice press 1, for fax press 2, for text press 3, for binary files press 4".

2046 "To retain your current preference press the # key".

2047 "You media preference for sorting incoming messages is".

2048 "For no preference press zero".

2049 "Will be your preferred media type".

2051 "Your password cannot be the same as your extension number consecutive digits or a single repeated
digit. Please enter new password and the # key".

2052 "At beginning of message to step back to previous message press *2 to listen press Zero".

2053 "Approximately".

2057 "At beginning of message".

2061 "To enter the telephone number of a fax machine press **5".

2063 "Enter the telephone number of a fax machine followed by the # sign".

2065 "The telephone number of a fax machine should be entered as it would be dialed from the location of
your messaging system. It can contain a maximum of 23 digits including trunk access, long distance or
international access codes if necessary and is subject to administrator restrictions".
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2071 "You are specifying the telephone number of a fax machine".

4409 -4434 Alphabetic characters "A" to "Z".

G0000 - G0009 "Press zero" through to "Press 9"

G0010 - G0019 "Press *zero" through to "Press *9".

G0020 "Press ** zero".

G0029 "Press **9".

G0031 "Press the # key".

G0032 "Press *#".

G0040 "You are changing your Outcalling options".

G0041 "System not administered for Outcalling".

G0042 "You are not authorised for Outcalling".

G0043 "When finished please hang up or ".

G0044 "You are selecting which messages will receive out calls".

G0045 "For instructions on entering your outcalling number".

G0046 "For instruction on configuring outcalling".

G0047 "You are not authorised to input a number".

G0051 "To return to the activity menu".

G0052 "Subject to administrator restrictions".

G0053 "To change times".

G0054 "To turn off"

G0055 "To turn on"

G0061 "To de-activate".

G0062 "To activate".

G0063 "To activate for all calls".

G0064 "To activate for external calls only".

G0065 "To activate for internal calls only".

G0071 "For all calls".

G0072 "For internal calls".

G0073 "For internal calls only".

G0074 "For external calls".

G0075 "For external calls only".

G0076 "For other calls".

G0080 "To use this greeting".

G0081 "For the temporary greeting"

G0082 "For number engaged calls"

G0083 "For no reply calls".

G0084 "For the default greeting".

G0085 "When finished".

G0086 "Please enter a number between".

G0087 "Where zero will set the temporary greeting to not expire".

G0088 "Please enter the number of days you wish this greeting to be active for".

G0089 "Your temporary greeting".

G0090 "For the next".

G0091 "Days".

G0092 "For today".

G0099 "Not configured".

G0100 "Turned off".

G0101 "Inactive".

G0102 "Desk".

G0103 "Home".

G0104 "Mobile".

G0105 "Temporary".

G0106 "Delegate".

G0107 "Secretary".
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G0108 "Other".

G0109 "SMS".

G0110 "Voicemail".

G0111 "Escalation".

G0112 "An escalation list".

G0113 "Extension".

G0120 "For none".

G0121 "For internal".

G0122 "For desk".

G0123 "For home".

G0124 "For mobile".

G0125 "For temporary".

G0126 "For delegate".

G0127 "For secretary".

G0128 "For other".

G0129 "For SMS".

G0130 "For voicemail".

G0131 "For escalation".

G0140 "Currently".

G0141 "For help".

G0142 "For help at any time".

G0143 "To leave".

G0144 "To change".

G0145 "To reject".

G0147 "Time".

G0148 "The time out is".

G0149 "To change the time out".

G0150 "To configure outcalling".

G0151 "Your escalations have not been configured".

G0152 "Your escalations are configured to call the following locations in the listed order".

G0153 "To repeat list".

G0154 "To repeat list with numbers".

G0155 "To review the list".

G0156 "You are selecting locations for the escalation list".

G0157 "To input the list again".

G0158 "You have completed inputting the escalation list".

G0159 "To select a destination".

G0160 "Where the following destinations will be called in order".

G0161 "To configure escalations".

G0162 "Please input your".

G0163 "Location".

G0185 "To".

G0186 "Where".

G0187 "Between".

G0188 "Invalid time".

G0191 "Is active".

G0192 "Is inactive".

G0193 "Is set to".

G0194 "Is not set".

G0195 "To repeat".

G0200 "And".

G0201 "Your outcalling is".

G0202 "Your outcalling is set".

G0203 "Your outcalling destination is set to".
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G0204 "The number is".

G0205 "Number is".

G0206 "Number".

G0207 "To change numbers".

G0208 "To input a number".

G0209 "For instructions on entering your outcalling number".

G0210 "For instructions on configuring outcalling".

G0211 "To change the number".

G0212 "There is no number defined for the selected destination".

G0213 "You are configuring outcalling destination".

G0214 "To configure outcalling".

G0215 "To re-configure outcalling".

G0216 "To change outcalling".

G0217 "To change outcalling destination".

G0218 "To change destination".

G0219 "To change".

G0220 "Destination".

G0221 "You have selected".

G0222 "There is no number defined".

G0223 "To select an alternate destination".

G0224 "To select another location".

G0225 "You have selected the option to configure your telephone numbers".

G0226 "To exit".

G0227 "To accept".

G0228 "To disable".

G0229 "To enable".

G0230 "To turn outcalling off".

G0231 "To turn outcalling on".

G0232 "To turn outcalling on for all new messages".

G0233 "To turn outcalling on for new priority messages only".

G0234 "To turn outcalling on for new private messages only".

G0235 "To turn outcalling on for new priority private messages only".

G0236 "The destination is set to".

G0237 "To change the destination".

G0238 "To set a number".

G0240 "Outcalling is turned off".

G0241 "Outcalling is turned on".

G0242 "Outcalling is turned on for all new messages".

G0243 "Outcalling is turned on only for new priority messages".

G0244 "Outcalling is turned on only for new private messages".

G0245 "Outcalling is turned on only for new priority private messages".

G0251 "Outcalling is turned on between".

G0252 "Outcalling is turned on for all new messages between".

G0253 "Outcalling is turned on only for new priority messages between".

G0254 "Outcalling is turned on only for new private messages between".

G0255 "Outcalling is turned on only for new priority private messages between".

G0260 "Outcalling is turned off".

G0261 "Outcalling is turned on".

G0262 "Outcalling is turned on for all new messages"

G0263 "Outcalling is turned on only for new priority messages".

G0264 "Outcalling is turned on only for new private messages".

G0265 "Outcalling is turned on only for new priority private messages".

G0272 "For all new messages".

G0273 "For all new priority messages".
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G0274 "For all new private messages".

G0275 "For all new priority private messages".

G0278 "Enter the time in second and #".

G0279 "Enter the new number and #".

G0280 "To input a new number".

G0281 "To input an outcalling number".

G0282 "Enter the number followed by #".

G0283 "Anything entered will be interpreted as part of the called number".

G0284 "No global commands, such as *4 will be accepted at this time".

G0285 "A * or # entered as the first character will result in the * or # being output".

G0286 "A * entered as part of the digit string will be interpreted as a pause of one and a half seconds.

G0287 "If a longer pause is required, use multiple stars in a row".

G0288 "To return to outcalling administration".

G0289 "Enter outcalling number and #".

G0290 "To exit press *# now".

G0301 "Your destination is currently configured to".

G0306 "For system outcalling schedules".

G0307 "You are specifying your outcalling time period".

G0308 "For outcalling during peak time".

G0309 "If not press *3 and re-enter time".

G0310 "To specify your times".

G0311 "To delete own time".

G0312 "Peak time is".

G0313 "For outcalling ant time press 1".

G0314 "The time you specify will be restricted by the times allowed by the system administrator".

G0315 "Outcalling specified to any time subject to administrator restrictions".

G0316 "For outcalling during prime time press 2".

G0317 "The system allows outcalls from".

G0318 "To change outcalling information press 6.

G0319 "Outcalling specified for".

G0320 "If correct press #".

G0321 "From time".

G0322 "To time".

G0350 "There is a message for".

G0351 "Based on an outcalling time profile which is currently configured as follows".

G0352 "Your outcalling time profile is currently configured as follows".

G0353 "Your outcalling time profile is not configured".

G0360 "You are specifying the time for outcalling time profile".

G0361 "To leave the current time profile".

G0362 "To change the time profile".

G0363 "Is set to".

G0364 "Please enter the time".

G0365 "The time should be entered as follows: hour, hour, minute, minute, where the hours are given in 24
hour format. For example, 5 past 1 in the afternoon would be entered as 1305".

G0366 "You are configuring outcalling time profile".

G0367 "The end time should be greater than the start time".

G0400 "You are modifying your personal settings".

G0401 "You are modifying your callback options".

G0402 "You are modifying your do not disturb options".

G0403 "You are modifying your email mode options".

G0404 "You are modifying your follow me forward options".

G0405 "You are modifying your mobile twinning options".

G0406 "You are modifying your voicemail transfer options".

G0410 "To modify your personal settings".
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G0411 "To modify your callback options".

G0412 "To modify your DND options".

G0413 "To modify your email mode options".

G0414 "To modify your follow me forward options".

G0415 "To modify your mobile twinning options".

G0416 "To modify your reception transfer options".

G0417 "To modify your follow me feature setting".

G0418 "To modify your forward unconditional setting".

G0419 "To modify your forward on busy and on no answer setting".

G0421 "Your follow me feature".

G0422 "Your forward unconditional feature".

G0423 "Your forward on busy and on no answer is set to".

G0424 "Your forward on busy is set to".

G0425 "Your forward no answer is set to".

G0426 "Your forward on busy and on no answer are inactive".

G0427 "Your do not disturb feature".

G0428 "Your email mode feature".

G0429 "Your mobile twinning feature".

G0430 "Your callback option".

G0450 "To modify your voicemail transfer on zero".

G0451 "To modify your voicemail transfer on 1".

G0452 "To modify your voicemail transfer on 2".

G0453 "To modify your voicemail transfer on 3".

G0460 "Your voicemail transfer on zero".

G0461 "Your voicemail transfer on 1".

G0462 "Your voicemail transfer on 2".

G0463 "Your voicemail transfer on 3".

G0501 "A".

G0502 "B".

G0503 "C".

G0504 "D".

G0505 "E".

G0551 "The first".

G0552 "The second".

G0553 "The third".

G0554 "The fourth".

G0555 "The fifth".

G0680 "Second".

G0681 "Seconds".

G0682 "Star".

G0683 "Hash".
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10.4.2 English Non-Intuity Prompts
Here is a list of the named .wav files used by Voicemail Pro for US and UK English. These are predominately, though not
exclusively, used for IP Office mode mailbox features and Voicemail Pro custom call flow actions.

All files are Microsoft WAVE file format (.wav) 8kHz, 16 bit mono.

WAV File Non-Intuity Prompt

a60 "Please enter extension and # sign".

aa_01 "Good morning and thank you for calling. Please key in the required extension number or hold the
line for other options".

aa_02 "Good afternoon and thank you for calling. Please key in the required extension number or hold the
line for other options".

aa_03 "Good evening and thank you for calling. Please key in the required extension number or hold the
line for other options".

aa_04 "Please hold while we try to connect you".

aa_05 "An operator is currently unavailable".

aa_06 "Please key in the extension number you would like to leave a message for".

aa_07 "Good bye and thank you for calling".

alpha_01 "Press # to accepted data, *1 to hear the data, *2 to delete the data, *3 to delete the last
character, *# to accept the data and continue".

alpha_02 "Data has been deleted".

alrm_1 "You have an alarm call set for".

alrm_2 "Alarm has been deleted press 1 to continue or * to quit".

alrm_3 "Please enter the time for the alarm call in 24 hour clock notation".

alrm_4 "You have set an alarm call for".

alrm_5 "Press 1 to validate press 2 to add a message to the end press # to cancel".

alrm_6 "Your alarm has now been set".

alrm_7 "Press 1 to verify this alarm or press 2 to delete it".

alrm_8 "This time is invalid please try again".

alrm_9 "This is an alarm call please hang up".

AM "AM".

aor_00 "Warning: your call is being recorded".

cmp_01 "The current campaign message has been marked as deleted".

cmp_02 "The current campaign message has been marked as completed".

cmp_03 "The current campaign message has been abandoned".

cmp_04 "Press 1 to start again, press 2 to rewind, press 3 to abandon, press 4 to delete, press 5 to
complete, press 7 for previous field, press 8 for start of current field, press 9 for next field, press #
to forward, press 0 to pause, press * to rewind".

conf_01 "A conference is not currently scheduled".

conf_02 "There was a problem transferring you into the conference".

conf_03 "Please enter your conference id and press # to finish".

conf_04 "Please enter your PIN and press # to finish".

conf_05 "Your conference ID or PIN is not valid".

conf_06 "Your conference ID is not valid".

conf_07 "Your PIN is not valid".

conf_08 "Please try again".

conf_09 "To be announced into the conference please speak your name and press # when you have
finished".

conf_10 "Your name is too short please try again".

conf_11 "Has invited".

conf_12 "To join them in an immediate conference press 1 to accept, 2 to decline and 3 if the delegate is not
available".

conf_13 "Has requested".

conf_14 "To join in an ad-hoc conference press 1 to accept, 2 to decline and 3 if the delegate is not
available".

conf_15 "Has declined the offer to attend the conference".

conf_16 "Is not available".

conf_17 "Has just entered the conference".

conf_18 "Has just left the conference".
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conf_19 "An unknown caller".

conf_20 "Has been invited".

conf_21 "No conference selected, thank you and good bye".

conf_22 "Transferring you to the conference now".

conf_23 "Conference not accessible".

conf_24 "You have been invited to a conference".

dbn_01 "There are".

dbn_02 "Press # to play list".

dbn_03 "To select".

dbn_04 "# for next".

dbn_05 "*# for previous".

dbn_06 "And #".

dbn_07 "Press **2".

dbn_10 "For selection by group".

dbn_11 "For selection by first name".

dbn_12 "For selection by last name".

dbn_13 "For selection by extension".

dbn_14 "Entries that match your selection".

dbn_15 "*3 to clear the list and restart".

dbn_16 "Or enter more characters followed by a # to reduce the size of the list".

dbn_17 "To change name format entry to".

dbn_18 "First name last name".

dbn_19 "Last name first name".

dbn_20 "Enter group name".

dbn_21 "Enter first name".

dbn_22 "Enter last name".

dbn_23 "Enter extension".

dom_01.wav...
dom_31.wav

Day of month ordinal numbers "1st" to "31st".

dow_01 "Sunday".

dow_02 "Monday".

dow_03 "Tuesday".

dow_04 "Wednesday".

dow_05 "Thursday".

dow_06 "Friday".

dow_07 "Saturday".

EOC_1 "Warning, your conference will end in".

EOC_2 "Your conference will end in".

int_na "Service not supported".

ivr_01 "The time according to the IVR server is".

ivr_02 "Directory wave table. Enter the number of the caller you want to edit".

ivr_03 "Name wave table. Enter the number of the extension you want to edit".

ivr_04 "Enter form entries with the # sign to terminate each line. Press # at the end to complete the
form".

ivr_05 "Form verified".

ivr_06 "Form entry is complete".

ivr_07 "Press * to abort # to accept or 0 to listen again".

ivr_08 "Do not disturb".

ivr_09 "Voicemail mode".

ivr_10 "Call forwarding".

ivr_11 "Forward number is set to".

ivr_12 "Follow me number is set to".

ivr_13 "Voicemail reception number is set to".

ivr_15 "Parameter is set to".
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ivr_16 "Parameter is enabled".

ivr_17 "Parameter is disabled press 1 to enable".

ivr_18 "Parameter is disabled".

ivr_19 "Parameter is enabled press 2 to disable".

ivr_20 "Press 1 to change press # to cancel".

ivr_21 "Enter new number after the tone".

ivr_22 "Repeat new number after the tone".

ivr_23 "Sorry the numbers you have entered are different".

ivr_24 "Email options".

ivr_25 "Alert email on incoming message".

ivr_26 "Copy messages to email".

ivr_27 "Forward messages to email".

ivr_28 "Email turned off".

ivr_29 "Service mode".

ivr_30 "In service".

ivr_31 "Out of service".

ivr_32 "Night service".

mc_00 Beep.

mc_01 Short silence.

mc_02 One seconds silence.

misc_24 "Is on holiday until".

misc_25 "Is unavailable until".

misc_26 "Is at lunch until".

misc_27 "Is away on business until".

misc_28 "And will be picking up messages regularly".

misc_29 "And will not be contactable until their return".

misc_30 "List length exceeded".

misc_31 "*, cannot access private list".

misc_32 "*, list length exceeded".

mnu_1 "You have four greeting options. For standard greeting press 1, for after hours greeting press 2, for
you are in a queue greeting press 3, for you are still in a queue greeting press 4".

mnu_2 "To hear your greeting message press 1, to change your greeting message press 2, to save your
greeting message press 3, to save your message for playing as a continuous loop press 4".

mnu_2a "To hear your greeting message press 1, to change your greeting message press 2, to save your
greeting message press 3, to save your message for playing as a continuous loop press 4, to return
to the previous menu press 8".

mnu_3 "When playing a message to delete the message press 4, to save the message press 5, to forward
the message to email press 6, to repeat the message press 7, to skip the message press 9, at the
end of your messages to play old messages press 1, to play saved messages press 2, to edit your
greeting press 3, to direct all messages to email press *01, to turn off email redirection press *02".

mnu_4 "When playing a message to delete the message press 4, to save the message press 5, for
forwarding options press 6, to repeat the message press 7, to skip the message press 9, to call
back the sender press ** at the end of your messages, to play old messages press 1, to play saved
messages press 2, to edit your greeting press 3, to direct all messages to email press *01, to send
email notifications press *02, to turn off email functions press *03, to change your access code
press *04".

mnu_5 "To forward message to email press 1, to forward message to other extensions press 2, to add a
header message press 3, to send message into your saved messages list press 4, to skip this
forwarding press #".

mnu_6 "User configure options. To edit forwarding number press 1, to edit follow me number press 2, to
set call forwarding press 3, to set voicemail press 4, to set do not disturb press 5, to edit voice mail
access code press 6, to edit voicemail reception press 7, to set voicemail email mode press 8, to
edit voicemail call back number press 9".

mnu_7. "Hunt group configure options. To set voicemail press 1, to edit voicemail access code press 2, to
set voicemail email mode press 3, to set service mode press 4".

mnu_8 "Invalid entry please try again".

mnu_9 "That destination is unavailable".



Voicemail Pro Page 386
15-601063 Issue 21c (16 July 2009)IP Office 5.0

WAV File Non-Intuity Prompt

MNU_10. "To play your old messages, press1. To play your saved messages, press 2. To edit your greeting,
press 3. To delete the current message, press 4. To save the current message, press 5. To change
your access code, press *04. For help at any time, press *4".

mo_01 "January"

mo_02 "February"

mo_03 "March"

mo_04 "April"

mo_05 "May"

mo_06 "June"

mo_07 "July"

mo_08 "August"

mo_09 "September"

mo_10 "October"

mo_11 "November"

mo_12 "December"

no_ "Number".

no_00.wav ...
no_59.wav

"Zero" to "Fifty-nine".

no_24p "More than 24".

noon "Noon".

out_01 "To administer Outlook based greetings, press 5".

out_02 "You are administering Outlook based greetings".

out_03. "Outlook based greetings are active for all calls".

out_04 "Outlook based greetings are used for the following call types".

out_05 "Outlook based greetings are currently inactive".

out_06 "To deactivate Outlook based greetings".

out_07 "To activate Outlook based greetings".

out_08 "They will be out of the office until".

out_09 "They will be busy until".

out_10 "Due to".

outb_01 "This is an IP Office outbound alert".

outb_04 "Press any key to accept".

pg_0001 "To use this greeting for all calls press 1".

pg_0002 "To use this greeting for all calls press 0".

pg_0003 "For internal calls press 1".

pg_0004 "For external calls press 2".

pg_0005 "To activate for out of hours call press 3".

pg_0006 "If the number is busy press 4".

pg_0007 "For no reply calls press 5".

pin_01 "Enter your current access code after the tone".

pin_02 "Now enter your new access code after the tone".

pin_03 "Now repeat your new access code after the tone".

pin_04 "Your access code has now been changed".

pin_05 "It has been possible to change your access code at this time".

pin_06 "Press # when you have finished".

pin_07 "Access code must contain 4 or more digits".

PM "PM".

que_01 "You are at queue position".

que_02 "In the queue".

que_03 "Call per".

que_04 "Estimated time to answer is".

que_05 "Your call will be answered in".

rec_01 "Warning: this call is being recorded".

RECNAM_01 "As you use IP Office, your name will be included in system announcements that you and other
people will hear. At the tone please say your name. After saying your name, press 1".
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RECNAM_02 "To re-record your name press 1, to confirm press #".

RECNAM_03 "Record at the tone".

PressHash "To continue, press #".

sac_01 "Cannot retrieve your messages now due to multiple logins to your mailbox".

sac_02 "Please disconnect".

seconds "Seconds".

ssb_00 "O" (Oh).

ssb_01 "O'Clock".

ssb_02 "No".

ssb_03 "None".

ssb_04 "Midnight".

ssb_05 "And".

ssb_06 "Date".

ssb_07 "Deleted".

ssb_08 "T number".

ssb_09 "For".

ssb_10 "Forwarded".

ssb_11 "Item".

ssb_12 "Press".

ssb_13 "Quantity".

ssb_14 "Saved".

ssb_15 "Yesterday".

ssb_16 "Hundred".

ssb_17 "Hour".

ssb_18 "O" (oh).

ssb_19 "At".

ssb_20 "1" (Down tone).

ssb_21 "1" (Up Tone).

ssb_22 "1" (Level Tone).

ssb_23 "Function failed to complete".

ssb_29 "Minutes".

svm_02 "Calls have been forwarded to email. New calls will also be forwarded to email until turned off".

svm_03 "Caller was".

svm_04 "Thank you for leaving a message. Mailbox has now stopped recording".

svm_05 "Please enter your mailbox number".

svm_06 "Please enter your access code".

svm_07 "There is no one available to take your call at the moment so please leave a message after the
tone".

svm_08 "For help at anytime press 8".

svm_09 "That was the last message".

svm_10 "New message".

svm_11 "New messages".

svm_12 "Old message".

svm_13 "Old messages".

svm_14 "Saved message".

svm_15 "Saved messages".

svm_16 "Remote access is not configured on this mailbox".

svm_17 "Email is not enabled on this mailbox".

svm_18 "I am afraid all the operators are busy at the moment but please hold and you will be transferred
when somebody becomes available".

svm_19 "Message was recorded".

svm_20 "You're being transferred".

svm_21 "You have".

svm_22 "Unknown caller".
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svm_23 "Forwarding to email is now turned off".

svm_24 "Start speaking after the tone and your message will be inserted before the message prior to
forwarding".

svm_25 "To hear the recording press 1, to change the recording press 2, to save the recording press 3".

svm_26 "Enter the extension to which you wish this message to be forwarded, separating each extension
using the # sign. Press # at the end to complete the list".

svm_27 "Message has not yet been recorded".

svm_28 "Start speaking after the tone and press 2 when you have finished recording".

svm_29 "There are no messages".

tim_m00 "Minute".

tim_m01 "One minute".

tim_m02 "Minutes".
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10.5 Installing VoiceMail Pro as an ACM Gateway
Complete the steps in this section to install Voicemail Pro as an ACM Gateway. There is only one type of installation for
the Voicemail Pro ACM Gateway. Therefore you are not offered the choice of custom, compact or typical during the
installation process.

To install the ACM Gateway:

1. Insert the IP Office Applications DVD. Click on the link for Voicemail Pro and then double-click on setup.exe.
The Choose Setup Language window opens.

2. Select the installation language. This language is used for the installation and for the default language prompts.

3. Click OK. Installation preparation begins.

4. Voicemail Pro requires Microsoft .NET 2.0 Framework. If this version is not detected, you are prompted to install it.
Click Yes to install Microsoft .NET 2.0 Framework and follow the instructions on the screen. 

5. If the Modify, repair or remove the program window appears you need to follow the upgrade process . 

6. In the Welcome window, click Next. The Customer Information window opens.

7. In the Customer Information window, type a user name and the company name or use the default names that are
proposed. These settings do not affect Voicemail Pro when it is installed.

8. In the same window choose the option that determines who should be able to use Voicemail Pro when it has been
installed. The recommended option is Anyone who uses this computer (all users).

9. In the Customer Information window, click Next. The Choose Destination Location window opens.

10. In the Choose Destination Location window, click Browse and locate the folder where the Voicemail Pro files are to
be installed. Otherwise, click Next to use the proposed folder. The Messaging Components window opens so that
you can choose the components that you want to install.

11. In the Messaging Components window, highlight ACM Gateway.

12. Click Next. The Service Account Name window opens. Details of the default administrator account may already be
filled in.

13. In the Service Account Name window, type the User Name and Password for the user account under which the
Voicemail Pro service should log on and run. This should be the Voicemail account created previously on the
domain and Exchange server. Alternatively, click Browse and select from the list of available PC or network
accounts or click Next to use the proposed account details. The Select Program Folder window opens.

14. By default, the program folders are created in a folder called IP Office. You can specify a different folder or select
one from the list of existing folders. To specify a different folder, type the folder name in the Program Folders box.
Alternatively, to use an existing folder, highlight a name in the list of existing folders.

15. Click Next. The account details that you have entered are verified. If you entered a new user name, a message is
displayed to ask if you want to create a new PC user account with the specified name and password. Click Yes.
The Select Program Folder window opens.

16. Select the program folder where you would like the icons for the Voicemail Pro components to be added. By
default, the program icons are added to IP Office.

17. Click Next. The Start Copying Files window opens. Before any copying starts, you are presented with a summary
of the settings that you have chosen so far.

18. Review the settings to make sure that they are what you expect. Scroll down if necessary.

19. If for any reason the details are not what you expect, click Back and make the necessary changes. When you are
satisfied that the details are correct, click Next to start copying the files. The Setup Status window opens to keep
you informed while the installation takes place.

20. When the installation is complete you are prompted to restart the computer. Choose Yes I want to restart my
computer now.

21. Click Finish to restart now.

22. When the computer restarts, log back in. The IP Office Voicemail Pro - ACM Gateway Settings window opens.

23. In the Mail Server box, type the name of the mail server to use.

24. Choose Message Networking/Interchange to use Interchange or Modular Messaging to use Modular Messaging.1.

25. Click Next. The IP Office Voicemail Pro SMTP Email Settings window opens.

· In the Mail Server box, type the name of the SMTP mail server. This should be the fully qualified domain
name.

· In the Port Number box, type the number of the receiving port on the SMTP mail server. The default is 25.

· In the Mail Drop box, type the name of the destination folder for outgoing emails on the SMTP Server.
Alternatively, click the Browse button and select the folder to use.

· To enforce server authentication, check the Server Requires Authentication box. This is optional. If you
check this option you also need to provide the Account Name and Password that need to be entered. You can
also choose whether or not to set the Use Challenge Response Authentication option.

26. Click Finish. An attempt is made to validate the email settings. If everything has been installed correctly and the
license requirements are met, you are prompted to start the Voicemail service. If the attempt to connect with the
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SMTP server fails, an error message is displayed. You might need to start the Voicemail service manually. See 
Starting the Voicemail Pro Service .

27. Click OK to acknowledge the message. You have now finished installing the Voicemail Pro ACM Gateway software.
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10.6 Installing Networked Messaging (VPNM)
Voicemail Pro Networked Messaging (VPNM) allows users to forward voicemail to mailboxes on remote voicemail systems.
This is done by adding a VPNM component to the Voicemail Pro installation.

The messages are transferred between systems using an SMTP/MIME mail format to encode both the voice part of the
message and additional message details.

Here is a diagram to illustrate VPNM between two IP Office systems.

 

Here is a diagram of a sample VPNM configuration between an IP Office and Avaya Interchange. Depending on how your
IP Network is set up, the configuration will differ slightly.

 

Up to 2000 mailboxes are supported per VPNM server and there is no constraint on the number of VPNM servers.
However, to distinguish between dial plans you might need to allocate a dial pre-fix to each server. A maximum of 99
pre-fixes are available.

This section summarizes the steps required for installing VPNM between two IP Office systems and between an IP Office
system and an Intuity Audix system through Avaya Interchange.

The instructions provided here should be read in conjunction with the other Avaya guides, for example "Avaya
Interchange Release 5.4, Adding a VPIM System to Your Network". This is because the setup for Interchange VPIM is the
same as for VPNM.
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10.6.1 Requirements for VPNM

Check that the following requirements have been before attempting to install VPNM:

· A Voicemail Pro server with VPNM installed connected to each IP Office system. Each system will need a license for
both Voicemail Pro and VPNM.

· All systems in the VPNM network need to be tested to ensure that they can communicate across the IP network. It
is suggested that you test the following:

· Ping the IP Addresses.

· Ping the computer names. If in a domain, ping the fully qualified domain name.

· The VMPro Servers must have an SMTP server installed. This can be done using the SMTP component of Internet
Information Service (IIS).

· To test type "Telnet <the name of the SMTP server> 25".

· Server names, where entered, must be fully qualified domain names.

· Voicemail Pro should not be installed on the same server as Exchange and/or the domain controller.
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10.6.2 Installing VoiceMail Pro with VPNM Support
This section describes how to install the Voicemail Pro software with its VPNM component onto the Voicemail Pro server
PC.

Before you begin:

1. Using IP Office Manager, check that the correct licenses for Voicemail Pro are installed and show a status of Valid.
The licenses required are:

· Voicemail Pro (4 ports) plus Additional Voicemail Pro (X ports) licenses up to the total number of port required
or supported by the IP Office control unit.

· Networked Messaging - Enables operation of VPNM with Voicemail Pro.

To install Voicemail Pro Software with VPNM support:

1. Insert the IP Office Applications DVD. Click on the link for Voicemail Pro and then double-click on setup.exe.
The Choose Setup Language window opens.

2. Select the installation language. This language is used for the installation and for the default language prompts.

3. Click OK. Installation preparation begins.

4. If the following window is displayed, Voicemail Pro is already installed. You need to upgrade rather than install a
new version. See Upgrading a Voicemail Pro System . 

5. If the Modify, repair or remove the program window appears you need to follow the upgrade process . 

6. In the Welcome window, click Next. The Customer Information window opens.

7. In the Customer Information window, type a user name and the company name or use the default names that are
proposed. These settings do not affect Voicemail Pro when it is installed.

8. In the same window choose the option that determines who should be able to use Voicemail Pro when it has been
installed. The recommended option is Anyone who uses this computer (all users).

9. In the Customer Information window, click Next. The Choose Destination Location window opens.

10. In the Choose Destination Location window, click Browse and choose the folder where the Voicemail Pro files are
to be installed. Otherwise, click Next to use the proposed folder. The Messaging Components window opens so
that you can choose the components that you want to install.

11. Unless there are specific reasons for changing the location, the default setting is recommended.

12. In the Messaging Components window, highlight Voicemail Pro (Full).

13. Click Next. The Setup Type window opens.

14. In the Setup Type window, select Custom.

15. Click Next. The Select Features window opens so that you can select which additional Voicemail Pro features to
install.

16. Scroll down and check VPNM.

34
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17. Ensure that the following are selected:

· The Voicemail Pro Campaign Web Component is not required for VPNM but is installed as part of a typical
VoicemailPro Server installation. If a web server has already been installed but the Voicemail Pro Campaign
Web Component is not required, uncheck it to remove it. If Voicemail Pro Campaign Web Component is
required for other use, make sure that it is checked so that it is not removed.

· Voicemail Pro and Voicemail Pro Server Service should be already selected.

· Ensure that Voicemail Pro Client and Voicemail Pro Service are also checked.

· Check the boxes for any additional required languages. It is recommended that either English or English US
is always selected in addition to any languages that are required by the customer.

· Important
Do not uncheck any other boxes as this will remove the corresponding software features.

· Scroll down and check VPNM.

18. Click Next. If you have chosen not to install the Web Campaign Component, the Service Account Name window
opens. The Select the Web Server root directory window opens so that you can specify the folder where the web
campaign web pages are to be stored.

19. The default folder is C:\inetpub\wwwroot. To use the default folder, click Next. To specify a different folder,
type the path to the preferred folder location. Alternatively, click Browse and locate the folder to use.

20. Click Next. The Destination of the Web Script Directory window opens so that you can specify the folder where the
web campaign components are to be stored.

21. The default folder is C:\inetpub\scripts. To use the default folder, click Next. To specify a different folder, type
the path to the preferred folder location. Alternatively, click Browse and locate the folder to use.

22. The Service Account Name window opens. Details of the default administrator account might already be filled in.

23. In the Service Account Name window, type the User Name and Password for the user account under which the
Voicemail Pro service should log on and run. This should be the IMS account created previously on the domain and
Exchange server. Alternatively, click Browse and select from the list of available PC or network accounts.

24. Click Next. The Select Program Folder window opens.

25. By default, the program folders are created in a folder called IP Office. You can specify a different folder or select
one from the list of existing folders. To specify a different folder, type the folder name in the Program Folders box.
Alternatively, to use an existing folder, highlight a name in the list of existing folders.

26. Click Next. The Start Copying Files window opens. Before any copying starts you are presented with a summary of
the settings that you have chosen so far.

27. Review the settings to make sure that they are what you expect. In particular, check that the required languages
are listed. Scroll down if necessary. When you are satisfied that the details are correct, click Next to start copying
the files. The Setup Status window opens to keep you informed while the installation takes place.

· If for any reason the details are not what you expect, click Back and make the necessary changes.

28. When the installation is complete you are prompted to restart your computer. Choose Yes I want to restart my
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computer now.

29. Click Finish to restart now.

30. When the server PC has restarted, the IP Office Voicemail Pro - Email Settings window is displayed so that you can
specify the name of the email account to use for outgoing SMTP e-mails from the Voicemail Pro server.

31. In the Account Details box, type the name of the email account to use. Alternatively, click Browse and select an
account to use.

32. Click Next. IP Office Voicemail Pro - SMTP Email Settings window opens so that you can specify details of the
SMTP server to which the Voicemail Pro server should send messages. A proposed server name might already be
filled in.

· In the Mail Server box, leave the proposed name unchanged or type the name of the server to use. This
should be the fully qualified domain name.

· In the Port Number box, type the number of the receiving port on the SMTP mail server. The default is 25.

· To enforce server authentication, check the Server Requires Authentication box. This is optional. If you
check it you also need to provide the Account Name and Password that need to be entered. You can also
choose whether or not to set the Use Challenge Response Authentication option.

33. Click Finish. An attempt is made to validate the email settings. An error message is displayed when the attempt to
connect with an SMTP server fails.

34. Click OK to acknowledge the message. You have now finished installing the Voicemail Pro Server and VPNM
software. The next step is to configure the VPNM accounts.
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10.6.3 Configuring VPNM Preferences

This set of preferences are only available if VPNM was selected during installation and is licensed within the IP Office
configuration. It is used to add a list of the remote VPNM servers and mailbox users on those servers. 

To open the VPN window:

1. Start the Voicemail Pro Client.

2. From the Administration menu, select Preferences > VPNM. The VPNM window opens. 

To add a VPNM server:

1. In the VPNM Server(s) section, click Add.

2. Enter the fully qualified domain name of the remote VPNM destination (the remote Voicemail Pro server PC or
Avaya Interchange).

3. Enter the two digit access prefix, if these are being used.

4. Click OK.

To delete a VPNM server:

1. In the VPNM Server(s) section, select the server that you need to delete.

2. Click Delete. When a server is deleted, all of the users associated with that server are also deleted.
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To add a user to VPNM server:

1. In the Users for VPNM Server(s) section, click Add. The Adding a new user window opens.

2. Enter details for the user. All of these details MUST be completed before the user can be added.

· Select the VPIM server from the listing.

· Enter the user's full name. The user's full name is used by the local Voicemail Pro's dial by name feature.

· Enter the user's extension. The local extension number is used as the local mailbox number and so should not
conflict with any existing local number.

· Enter the user's remote extension. The remote extension number should be the user's real extension number.
Typically this and the 'local extension number' are kept the same using a unique extension number dial plan
for the linked systems.

· Enter the user's full telephone number. The full telephone number should be a dialable number that is routed
to the user's extension or mailbox.

3. Click OK to save the details and return to the VPNM configuration window.
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To add a group of users:

1. (Optional) Check the option Enable WildCard. When this option is selected you can use the question mark symbol
(?) to represent any number.

2. In the Users for VPNM Server(s) section, click Add Range. The Adding a range of users window opens.

3. Enter details for the users. All of these details MUST be completed before the users can be added.

· Select the VPNM server to which you want to add the users.

· Enter the start number of the extension range.

· Enter the local prefix.

· Enter remote prefix.

4. Click OK to save the details and return to the VPNM configuration window.

To change details of a VPNM user:

1. In the Users for VPNM Server(s) section, select the name of the user whose details need to be changed.

2. Click Modify. You can change the user's full name, the local extension number and the full telephone number.
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10.6.4 Testing a VPNM Setup
It is advisable to test the VPNM setup.

To test the VPNM setup:

1. Dial into voicemail from one of the systems and record a message.

2. When selecting the target extension, enter an extension from the other system as specified in the VPNM
Preferences screen.

3. The message should be delivered to the other systems Voicemail Pro server into C:\\Inetpub\mailroot\Drop.

4. The VPNMreceiver Service checks the Drop directory approximately every 30 seconds. When it finds a message
in the Drop directory, it will send the message to the relevant extension's voicemail box on the remote system.
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10.7 IP Office to Avaya Interchange
10.7.1 Configuring the Avaya Intuity Audix
This section is based upon the S8100/G600 Intuity Audix. It is assumed that the IP address of the S8100 processor is
known. A browser should be available and the Avaya Terminal Emulator or the equivalent to do the necessary
configuration.

To configure the Avaya Intuity Audix:

1. Issue a telnet command to the S8100/G600, log in and enter "audix" to reach the audix command prompt.

2. Enter list configuration and verify that the TCP/IP value is set to at least 1. If not, these ports must be activated
through the license process before proceeding.

3. From a PC browser, access the S8100 processor IP address and login.

· At the S8100 main page, select Administer System > Audix Networking > Administrative Menu >
Network Channel Administration.

· Enable each channel in the Channel Configuration Column.

· Select Save when finished.

4. Return to the Audix command prompt screen. Inspect the system for the list of mailboxes that will be eligible to
receive messages.

· Type change machine. Note the range of local extensions. List subscribers will provide a more specific list.
It is best to distinguish mailboxes that are eligible to receive messages for example, call answer mailboxes.

· On page 2 of the change machine form, ensure that all the update settings are set to y.

· Make sure that Network Turnaround is set to y. Select Enter.

5. To administer the password for message exchange:

· From the S8100 home page select Administer System > Audix Networking > Administrative Menu >
Local Machine Administration.

· Enter the password to be used for transfer of messages between this system and the Avaya interchange.
Select Change.

6. To enter the information for connecting to the Interchange:

· From the S8100 home page select Administer System > Audix Networking > Administrative Menu >
Remote Machine Administration > Digital Machine Administration.

· Select Add New Machine.

· Enter the Avaya interchange name, IP address and networking password.

· Define the schedule for exchanging messages.

· Select Add to complete.

7. To administer the parameters associated with the Interchange:

· Type change machine <machine name> from the AUDIX command prompt.

· If all extensions that are not on the Intuity Audix are configured to be on the Interchange and "Send to non-
Administered Recipients" is set to yes, errant messages may be sent. This will waste bandwidth and
processing time.

· The extension Length setting is the dial plan length that has been configured in the Avaya Interchange.

· Set all the parameters of page 2 to y. (Send to non-administered recipients, Updates In, Updates Out and
Network Turnaround).

· Select F3 to Add the remote machine.
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10.7.2 Configuring the Avaya Interchange
For more information about the options that are mentioned in this section, refer to the Interchange documentation which
is available from www.support.avaya.com.

To configure the Interchange Intuity interface:

· Log in to the Intuity interchange.

· To verify that the system is optioned for TCP/IP digital ports, select Customer/Service Administration from
the Interchange Main Menu.

· The VPNM ports will also be required for interfacing to the Voicemail Pro.

· Ensure that the TCP/IP networking is set up so that the machine can communicate to and from the Intuity Audix.

· From the Main Menu, select Networking Administration > TCP/IP Administration.

· Make a note of the IP Address, Subnet Mask and default Gateway IP Address. The information will be required
later in the setup.

· Make sure that an entry exists with the data that corresponds to the information entered for connecting to the
Interchange.

· From the Main Menu, select Networking Administration > Local Machine Administration.

· To verify that there are equipped TCP/IP ports for the networking to Intuity Audix and to Voicemail Pro:

· From the Main Menu, select Networking Administration > Networking Channel Administration. The
status should be Idle.

· Information corresponding to the Intuity Audix information entered in Step 4 when configuring the Audix needs to
be entered under Digital Networking Machine Administration.

· From the Main Menu, select Networking Administration > Remote Machine Administration > Audix
Digital networking Machine Administration.

· Enter the transmission schedule for sending messages to the Audix System. Select Chg-Keys and then the
Add key to enter the form.

· Administer The Intuity Audix parameters in the Interchange.

· Select Interchange Administration > Remote Machine Administration > Remote Machine
Parameters.

· Select Choices, then the system to be updated.

· Ensure that the address range corresponds to the mailboxes on the Intuity Audix system that are eligible to
receive messages. Set the parameters as shown.

· Avaya Interchange? = n.

· Mailbox ID Length = 5.

· Default Language = us-eng.

· Failed Msg. Notification Priority = n.

· Msg ID? = y.

· Send Message for Warning? = n.

· Default NameNet type = u.

· Select the Details key to enter the following details:

· Subscriber Updates Type = dynamic.

· Updates In? = y.

· Updates Out? = y.

· Voiced Names for Dynamic? = y.

· Network Turnaround? = y.

· Provide Local Mapped Addresses = n.

· Dynamic Sub Expiration Days = 90.

· Select Save, Continue and then Save again.

7. If both systems are set for 5 digit dialing this step can be omitted. If both systems are not then Dial Plan Mapping
needs to be used to map the mailbox identification from the Interchange Dial Plan to the Intuity Audix Dial Plan.

· Select Interchange Administration > Remote Machine > Administration > Dial Plan Mapping. Update
the form as required.

 

Configure the Interchange VPIM Interface to Voicemail Pro

These steps follow the instructions in Avaya Interchange Release 5.4 Adding a VPIM System to Your Network which
should be referenced for greater detail on Interchange configuration steps and options.
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1. Check that Interchange has available VPNM ports.

· From the Interchange Main Menu, select Customer/Service Administration > Feature Options. Check that
there are sufficient current entries for the Maximum Number of Digital Nodes and VPNM ports.

2. Set the Interchange General Parameters.

· From the Interchange Main Menu, select System Parameters > General Parameters. Ensure that the VPNM
Port Field is set to 25.

3. Identify the Avaya Voicemail Pro to the interchange system.

· From the Interchange Main Menu, select Networking Administration > Remote Machine Administration
> VPIM Machine Administration.

· Select the name of the machine by telnet to the SMTP port of the Voicemail Pro to see how it identifies itself.

4. Set the IP Office parameters.

· From the Interchange Main Menu, select Interchange Administration > Remote Machine Administration
> Remote Machine Parameters.

· Select Choices. Select the Voicemail Pro name as the Remote Machine Name then enter the values as shown.

· Machine Type = VPIM.

· Avaya Interchange? = n.

· Mailbox ID Length = 5.

· Failed Msg. Notification Priority = n.

· Msg ID? = y.

· Send Message for Warning? = n.

· Select the Details key to enter the following details:

· Subscriber Updates Type = dynamic.

· Voiced Names for Dynamic? = y.

· Use DNS? = n.

· Domain Name = Enter the domain name.

5. If the Voicemail Pro Dial Plan length is shorter than the Interchange Dial Plan, select Interchange
Administration > Remote Machine Administration > Dial Plan Mapping. Follow the instructions in Avaya
Interchange Release 5.4 Adding a VPIM System to Your Network to map from the shorter length to the longer
length dial plan.

6. Add the subscribers for Voicemail Pro. The following is one of several ways that this can be done.

· Select Interchange Administration > Remote Machine Administration > Dial Plan Mapping.

· Select the Voicemail Pro as the Remote Machine and then select Options.

· Select Add Subscribers from range. Only mailboxes that are eligible to receive messages should be
included.

· Subscriber entries can be checked from interchange Administration > Subscriber Administration >
Subscriber Lists > By Remote Machine Name. From Choices select the Voicemail Pro PC name to see the
list of known subscribers.
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Directory View in Interchange for Intuity Audix and Voicemail Pro

Setting the directory view specifies which other messaging machines can provide subscriber updates to a particular
messaging machine. Each machine listed is associated with a range of mailboxes from which updates can be accepted
and whether a voiced name can be accepted.

1. Select Interchange Administration > Remote Machine Administration > Directory Views.

2. At the Machine Name prompt, select the Voicemail Pro.

3. Select the Options key and then Add all entries.

4. Select Save.

5. Repeat these steps for the Avaya Intuity Audix.

 

Avaya Interchange Enterprise List Administration

This section describes how to configure a list of endpoints in the Interchange. Interchange-based lists are an efficient way
to send messages to stable lists of mailboxes. Only one copy of the message is sent from the originating system to the
interchange, which takes care of distributing that message to the destination machines and mailboxes.

1. From the Interchange Main Menu, select Interchange Administration > Enterprise List Administration >
System Parameters. Set or check the address range of the interchange Dial Plan that can be used for lists.

2. From the Interchange Main Menu, select Interchange Administration > Enterprise List Administration > List
Definition.

· Choose a unique list id from the list range and assign an owner.

· In the 'Network Address' grid, enter the list of destination addresses from the Interchange Dial Plan.

· The 'Remote Address' grid should contain the systems where those destinations reside.

· The range of mailboxes that have permissions to send through the list is set in the 'permissions' grid.
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10.7.3 Configuring a DNS Server
A Domain Name Service Server is not required for the messaging systems, but may be a highly desirable way to
centralize the mapping of names to IP addresses. This section briefly describes the setup of DNS server used in this type
of configuration.

To configure a DNS Server:

1. From the Start menu of the PC running Microsoft Exchange Server, select Programs > Administrative Tools >
DNS. If DNS is not available, DNS needs to be installed from the Operating System CD.

2. Check that there is an entry within the domain for each messaging hosts involved.

3. Configure each PC to use the DNS server to resolve names. This is done in the Internet protocol (TCP/IP Properties
form of each LAN interface).

 

10.7.4 Verification and Troubleshooting
The configuration can be tested by creating a message and forwarding it to the far end of the system. Check that the
message is received at the correct destination. If the test fails, one of the following procedures may isolate the problem.

 

Ping Test 
Make sure that you can ping all end points. If DNS is used, ping using the machine name.

SMTP Service Test and Name Determination 
Test that the SMTP service of a messaging system is working by using telnet command as follows.

1. From a DOS or UNIX prompt, type telnet ip-address 25.

2. At the response, type Helo.

3. At the response, type Quit.

4. If the response is not as shown below, then the SMTP service is not running on the machine and incoming VPNM
messages will not be processed. Check that the required PC services are running.

telnet 172.16.254.197 25
220 avaya-8ccy2i4d3 Microsoft ESMTP MAIL Service, Version 5.0.2195.6713
ready a
t, Wed, 22 Oct 2003 08:45:03 -0400
Helo
250 avaya-8ccy2i4d3 Hello [172.16.254.197]
Quit
221 2.0.0 avaya-8ccy2i4d3 Service closing transmission channel
Connection t

 

Check That the Required PC Services are Running 
From the Control Panel, select Administrative Tools > Services. Check that the following services are Started with a
Startup type of Automatic.

· SMTP.

· Voicemail Pro Service.

· VPNM Database Service.

· VPNM Server.

· VPNM Receiver.
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Check the Voicemail Pro SMTP Settings 
From the PC Control Panel, select the Avaya Voicemail Pro icon.

1. Select the SMTP name.

2. Ensure that the Mail Server name is exactly the name of the Voicemail Pro server PC.

3. Select Check to make sure that a successful connection to the SMTP service can be made.

 

Interchange Basic Tests 
From the Interchange Main Menu, select Customer/Services Administration > Diagnostics. Perform the following
basic checks.

· TCP/IP Diagnostics.

· Send and receive Test Packets - ping the IP address.

· View Packet Statistics - look for any interface issues for example. collisions.

· Display Message Queue - monitors the contents of the outgoing message queue. If messages cannot be sent e.g.
due to administrative errors, then this queue is likely to contain the unsent messages.

· Remote Connection Test - test the basic connection to a remote Audix system.

 

Audix Browser Status Test 

· From the Browser interface to the S8100, select System Administration > AUDIX Networking >
Maintenance Menu > Network Snapshot. See the status of connectivity to the Interchange.

 

S8100 Ping Test

· From the Avaya Terminal Emulator interface to the S8100, select cmd at the Enter Command prompt.

· At the DOS prompt, enter ipconfig to verify the IP address and gateway.

· Ping to test the connection.

 

Check the Status Through the Intuity Audix Command Line Interface

· To update the Audix with reachable subscribers through the interchange, from the audix command line prompt
type get remote-updates machine and Enter where the machine is the name of the interchange system.

· Repeat the command periodically (and cancel out) until the 'Status of Last Update' entry is completed.

· From the command line prompt type display administrator's-log where message delivery failures and reasons
can be found.

 

Message Exchange Test 
In general the following capabilities are supported and can be verified.

· Sending Messages to lists or individuals, preserving any combination of Priority and Privacy.

· Replying to the sender.

· Forwarding.

 

Couldn't Send Message! Warning 
The following warning is normally associated with not having specified a fully qualified domain name for the local SMTP
server address.

" <CVPIM::bSendMessage>Couldn't send message!Response:550 5.7.1 Unable to relay for 210@avaya2k.test.
avaya.com "
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SMTP Email Settings  88
Configuring     103
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TCP/IP Administration  401

TCP/IP Diagnostics  404

TCP/IP networking  22, 401
TCP/IP Properties  404

telephone number including  112

Telephony Actions  130, 154

Assisted Transfer     343

Dial     343
Telephony Actions icon  195, 197, 198, 199, 201, 203,
204, 206, 207, 209, 282

Telephony Handset  161

Telephony Operation Mode  297

Teletype  274, 275
telnet  404

Issue     400

SMTP     401
telnet 172.16.254.197 25  404

telnet ip-address 25  404

temp/backup.mdb  34

Test Condition  143, 146, 147, 154, 270

add     220
Test Condition Action  143, 146, 147, 154, 220, 270

Test Connection button  227

Test Connection Succeeded  227
Test Packets  404

Test User Variable  154

add     222

use     138, 221

Test User Variable Action  138, 154, 221, 222
test”  327

Testing  

VPNM     399
VPNM Setup     399

text As String  332

text matching  345

text This  75, 332

Text To Speech  73, 74, 75, 78, 92, 178, 338
Textphone  274, 275

TIME  327

Time Check  239
TimeAndTrace  83

TimeCheck  238, 239

timeout As Long  319

TimeQueued  140, 256

TimeSystem  140, 256
Title  119, 334, 338, 340

Title Bar  119

TOC  95, 288
Token Name  158, 282

Touch  154, 162, 180, 241, 356, 361

Touch Tones  154, 241, 356, 361

Entering     180

Menu     162
tracing  

MAPI     83

Transfer  135, 180, 207, 236, 254, 265, 286
Transfer Action  135, 154, 199, 201, 241, 271

Transfer action transfers  

caller     199

Transmit Wave Files  

check     102
Troubleshooting  404

Trusted Location  243

Creating     246
Trusted Source  112, 240, 285

TTS  74, 75, 140, 178, 327, 332

choose     73

employing     74

includes     73
license     78

start     74

TTS Usages  73
TTY  15, 274, 278

default     275

see     273

set     275

setting     274
use     274

TTY Device  273, 274, 275

TTY Maintenance Patch  275
turn outcalling  369

turn outcalling off  369

turn outcalling on  369

Turn voicemail  237, 297



Voicemail Pro Page 420
15-601063 Issue 21c (16 July 2009)IP Office 5.0

Turn voicemail ringback  297

txt file  137

type matching  369
Typical  346

U
UK English  383

UMSEventTracing  83

Unable  404
Un-check Voicemail On  272

unchecking  

Voicemail On     109
un-checking  

Voicemail On     113

undelete  369

Under  Specific Start Points  285

Under Log  85
Unit Name/IP Address  118

United States  297

UNIX  404
UnPark Call  

use     351

Up Callback  

Setting     285

Up Text To Speech  
Setting     78

Updates In  113, 400, 401

Updates Out  400, 401
Upgrade  34, 78, 131

IP Office VoiceMail Pro window     35

Voicemail Pro     34, 36

US  73, 280, 369

Voicemail Pro     383
US English  280

Voicemail Pro     369

US English Intuity Prompts  369
Use Challenge Response Authentication  

set     103

Use DNS  401

user attempting  240

User Defined Fax Number  360
User Defined Variable menu  221

User Defined Variables  130, 138

User Locale  274, 275, 277, 279, 297
Changing     274

User Name Recordings  342

user presses  261

User Source Numbers  

Configuring     112
User Start Points  240

user’s DTMF  319

userconfiguration.htm  109
UserID  82

Users Access  244, 246, 285

Giving     245

Users Button Access  

Giving     244
users including users  248

Users Owners  274

Users Voicemail Access  
Giving     246

Using DSS Keys  261

Using IP Office Manager  74, 78

Using Short Codes  261

Access Voicemail     238
Using Start Points  136

Using VB Script  218, 310

Using Visual Voice  243

Using VM  239

Using Voicemail  112, 252, 255, 272, 287
Give Error Messages     292

Using Windows Explorer  36

utilisation  
view     115

V
VAR  140, 161, 317, 324, 327, 331

VAR voicemail  317

variable As String  331
variable matches  195, 222

Variable Property  317

Variable Routing  195

Variable Routing Action  154, 195

VB Action  316
VB Script Action  154, 218, 310

VB Scripting  

add     218, 310
VBS  313

VBScript  315

enter     218, 310

Use     218, 310

VB-Script  316
verb">record</partofsp  75

Verification  404

Version 3.2  34, 35
Version 5.0.2195.6713  404

View Packet Statistics  404

Visual Voice  

access     244

Visual Voice Button  244
VM Pro  73, 74, 218, 310, 333

VM Pro Database Interface  333

VM Pro Generic TTS  73
VM Pro ScanSoft TTS  73

VM Pro TTS  74

VM Pro VBScript  218, 310

VM Server Specific  83

VMCol  244
Vmdata.mdb  120

VMLite.exe  36

vmp file  120, 132, 219
VMPro Database Interface  154

VMPro TTS  74

VMPro User Log  82

VMS API  83

VmsNotifyTracing  83
Voice Mail  163, 201, 383

Voice Mailboxes  315

Voice Question  154, 201, 212, 256
add     188

preceding     165

Voice Question Action  154, 188, 201, 212

Voice Recording  

Select     263, 266
Voice Recording Administrators  260

Voice Recording Library  23, 186, 258, 260, 263, 266

Voiced Names  
Dynamic     401

Voicemail  

Email settings     69

Voicemail Callback  284

Voicemail Channel Reservations  107, 115
Voicemail Code  109, 112, 113, 158, 243, 244, 245, 246,
248, 250, 285, 342, 344



Voicemail Pro Page 421
15-601063 Issue 21c (16 July 2009)IP Office 5.0

Index

Voicemail Code  109, 112, 113, 158, 243, 244, 245, 246,
248, 250, 285, 342, 344

Add     292
voicemail code  For  243

Voicemail Collect  142, 236, 237, 238, 241, 243, 244, 245,
250, 282, 292, 343, 344

Voicemail Collect Button  243, 244

Voicemail Console  85
Voicemail Destination  

Leave     107

Voicemail Domain Account  

Creating     58

Voicemail Email  73, 78, 109, 113, 383
MAPI     92

Voicemail Email Mode  

Select     109, 113
Voicemail Email Reading  78, 109

voicemail functions  

call     133

Voicemail Help  109, 113

Voicemail IP Address  107
Voicemail Lite  109, 112, 113, 240, 292, 296, 297, 383

close     36

Voicemail     36
Voicemail Pro     34, 36

Voicemail Lite Folders  

Move     36

Voicemail Lite Installation Manual  113, 292

Voicemail Lite Manual  109
Voicemail Lite/Pro  107

Voicemail Mailbox  78, 89, 353, 356, 358

Voicemail Message  109, 113, 284
Voicemail Node  133, 136, 238, 240

Voicemail On  

unchecking     109

un-checking     113

Voicemail Outcalling  284
Voicemail Password  

match     89

voicemail PIN  
prompted     240

VoiceMail Pro  

Features     14

System Overview     9

Voicemail Pro 1.2.6  193, 223
Voicemail Pro 1.4  273

VoiceMail Pro 4.0.  35

Voicemail Pro Actions  218, 310
Voicemail Pro Administrators  119, 121, 133

Voicemail Pro below version 3.2  34

VoiceMail Pro Call Flow  

Start     32, 80

Voicemail Pro CD  
contains     34

Insert     34

Voicemail Pro Client  119, 121, 259, 290, 361
change     88

Close     34, 120, 131

run     118, 121

Start     34, 36, 260

use     89
Voicemail Pro Client Server  121

Voicemail Pro Client window  118

parts     119
Voicemail Pro Database Operation  333

Voicemail Pro detects  356

Voicemail Pro Dial  191, 204, 401

Voicemail Pro Dial Plan  401

Voicemail Pro file  132
Voicemail Pro GUI  

Start     34

Voicemail Pro housekeeping  93
Voicemail Pro Installation  74, 346

Voicemail Pro installation includes  74

Voicemail Pro involves  357

Voicemail Pro Login window  118, 121

Voicemail Pro Module  236, 239, 241, 282
Access     238

Voicemail Pro Networked Messaging  103, 290

Voicemail Pro PC  401
Voicemail Pro SelfSelect  241

Voicemail Pro Server  51, 73, 94, 101, 119, 120, 121, 159,
161, 185, 186, 219, 259, 264, 270, 274, 297, 363, 399, 404

change     88

connect     118
Voicemail Pro server during  274

Voicemail Pro Server PC  159, 161, 404

Voicemail Pro Service  35, 92, 404

Locate     85

set     85
Voicemail Pro SMTP Settings  

Check     404

Voicemail Pro Software  36, 73
Voicemail Pro Start Points  236, 239, 240

Voicemail Pro System Fax Number  362

Setting     358

Voicemail Pro System Variables  74, 207

Voicemail Pro TTS  73, 75
Voicemail Pro TTY  

Installing     274

Voicemail Pro User Log  82
Voicemail Pro Wave Editor  

starts     159, 161

Voicemail Pro window  89, 91, 92, 93, 94, 95, 136, 288

Voicemail Professional Server  85

Voicemail provides  
number     247, 251

Voicemail Reception  135, 185, 186, 383

voicemail ringback  112, 237, 248, 284, 296
Check     109

Voicemail Ringback Number  112

voicemail ringback on/off  296

voicemail rings  

user     133
Voicemail Server Directory  91

Voicemail Server PC  190, 192, 216

Identifying     107
Voicemail Server Speech Directory  91

voicemail service  32, 80

Voicemail System  91, 254

Voicemail System Files  91

Voicemail Telephone Numbers  240
Voicemail Transfer  369

Voicemail Trusted Source Access  112

Voicemail Type  107
Line     51

Set     51

Voicemail User Account  78

Create     62

voicemail works  247
VoicemailCollect  240

VoIP  51



Voicemail Pro Page 422
15-601063 Issue 21c (16 July 2009)IP Office 5.0

Volume - Change  75

VPIM  401

VPIM Machine Administration  401
VPIM System  

Avaya Interchange Release 5.4 Adding     401

VPNM  88, 103, 290, 391, 401
add     96, 396

delete     96, 396

incoming     404

Select     96, 396

test     399
VPNM Database Service  404

VPNM Port Field  401

VPNM Preferences  399
VPNM Receiver  404

VPNM Requirements  392

VPNM Server  404

VPNM Setup  

Testing     399
VPNM Support  393

VPNMreceiver Service  399

VRL  89, 186, 258, 260, 263, 266
VRL application  260, 263, 266

VRL Record Length  89, 260

W
Waiting Indication  112, 247, 248

WAN  118, 123
Warning  

Send Message     401

wav As String  326, 327

Wav Editor  140

Web Browser  351, 353
Web Campaign Component  346, 353

Web Campaigns  346

Using     353
Web Server  353

Web Sites  357

websites  75

Wed  404

Week Planner  143, 144, 148
add     147

Week Planner icon  147

Week Planner window  147
Whisper  135, 154, 201

Whisper Action  135, 154, 201

wildcard  195

Windows 2000  85

Windows Explorer  36
Windows TTS  75

Within Voicemail Pro  140, 281, 333

Wizard  34, 36, 228, 347
Wordpad  83

Work  95, 120, 288, 357

Work Group Member  

Email     62

Workstation  118
www.microsoft.com/speech/download/sdk51  73

www.support.avaya.com  401

X
XML  74

closing     75
opening     75

XML Tags  

Entering     75
XP  85

Y
YEAR/MONTH/DAY HOUR  325

Yes - Select  118
Your call  237, 369, 383

Your estimated  256

Your Network  401

Your Password  369



Voicemail Pro Page 423
15-601063 Issue 21c (16 July 2009)IP Office 5.0



Voicemail Pro Page 424
15-601063 Issue 21c (16 July 2009)IP Office 5.0

Performance figures and data quoted in this document are typical, and must be
specifically confirmed in writing by Avaya before they become applicable to any
particular order or contract. The company reserves the right to make alterations
or amendments to the detailed specifications at its discretion. The publication of

information in this document does not imply freedom from patent or other
protective rights of Avaya or others.

Intellectual property related to this product (including trademarks) and registered
to Lucent Technologies have been transferred or licensed to Avaya.

All trademarks identified by the ® or ™ are registered trademarks or trademarks,
respectively, of Avaya Inc. All other trademarks are the property of their

respective owners.

This document contains proprietary information of Avaya and is not to be
disclosed or used except in accordance with applicable agreements.

 
Any comments or suggestions regarding this document should be sent to

"wgctechpubs@avaya.com".

© 2009 Avaya Inc. All rights reserved.
Avaya

Unit 1, Sterling Court
15 - 21 Mundells

Welwyn Garden City
Hertfordshire 

AL7 1LZ
England.

Tel: +44 (0) 1707 392200
Fax: +44 (0) 1707 376933

Web: http://www.avaya.com/ipoffice/knowledgebase


	Voicemail Pro
	What is New in 5.0
	Features of Voicemail Pro
	Supported Languages
	Number of Simultaneous Users

	Installing Voicemail Pro
	General Installation Requirements
	PC Specification
	Network Requirements
	Disk Space Requirements
	Web Server Operation
	ContactStore Operation
	Voicemail Pro Licenses
	User and Group Mailboxes

	Server/Client Installation
	Modifying the Installed Components
	Web Campaigns Installation
	The Voicemail Pro Services

	Upgrading Voicemail Pro
	Upgrade from below version 3.2
	Upgrade from Version 3.2+
	Upgrade to Voicemail Pro

	UMS Web Services
	IMAP Installation
	Web Voicemail Installation
	Exchange 2007 Installation

	Centralized Voicemail Pro
	Voicemail Email
	SMTP Setup
	Selecting SMTP Operation
	Changing the Server SMTP Settings
	Setting the Server Email Address
	SMTP Errors

	MAPI Setup
	Domain Member
	Creating a Voicemail Domain Account
	Configuring Outlook for VoiceMail Email
	Installing the VoiceMail Pro Software
	Switching VoiceMail Pro to MAPI

	Work Group Member
	Installing VoiceMail Pro for MAPI VoiceMail Email as a Work Group Member
	Creating a Voicemail User Account
	Configuring Outlook Express for Internet Mail
	Configuring Outlook for Internet Mail
	Configuring Outlook for Exchange Server
	Installing the VoiceMail Pro Software
	Switching VoiceMail Pro to MAPI
	Changing SMTP Email Account Settings


	Voicemail Email Operation
	User and Group Configuration
	How Voicemail Email Messages Look
	The Voicemail Pro Email Action


	Text to Speech (TTS) Installation
	Installing Generic Text to Speech
	Installing Avaya Text to Speech
	Using the Speak Text Action
	Text to Speech SAPI Controls
	Setting Up Text To Speech to Read Email

	Troubleshooting
	About
	Checking the Voicemail Pro Service
	Voicemail Pro User Log
	Tracing in Debug
	The Voicemail Console


	Voicemail Pro Preferences
	System Preferences
	General
	Directories
	MAPI
	Housekeeping
	SNMP Alarm
	Outcalling
	VPNM

	Control Panel Options
	System Settings
	Path Settings
	Email Settings
	SMTP Email Settings


	IP Office Configuration
	System Settings
	User Voicemail Settings
	User Source Numbers
	Hunt Group Settings
	Voicemail Channel Reservations

	Using the Voicemail Pro Client
	Logging in to the Voicemail Pro Server
	Continue Offline Message Window
	The Main Voicemail Pro Window
	Saving Changes and Making them Live
	Logging Out
	Closing Down
	Changing Between Offline and Online Mode
	Administrator Accounts 
	Confirm Call Flow Download Window
	Using the Details Pane
	Users / Groups
	Voicemail Pro Administrators
	Server Queues
	User Variables
	Alarms
	Outcalls


	Toolbar Icons
	Importing and Exporting
	Including Other Files
	Start Points
	Default Start Points
	Using Start Points
	Viewing Call Flows as Text

	User Variables
	Call Variables
	Creating Modules
	Running a Module

	The Conditions Editor
	Using the Condition Editor
	Calendar
	Week Planner
	Condition
	Compare


	Voicemail Pro Actions
	Connections
	Available Actions
	Standard Action Tabs
	General
	Entry Prompts
	Using the Wave Editor

	Specific
	Reporting
	Results

	Basic Actions
	Generic
	Arithmetic Evaluation
	Change Callers Priority
	Change User or Group Configuration
	Clear Counter
	Counter Decrement
	Counter Increment
	Generic Free Format Command
	Set Counter
	Set CPxx Value
	String Manipulation

	Speak Text
	Menu
	Goto
	Disconnect
	Home
	Module Return

	Mailbox Actions
	Get Mail
	Leave Mail
	Listen
	Voice Question
	Campaign

	Configuration Actions
	Edit Play List
	Record Name
	Play Configuration Menu
	Select System Prompt Language

	Telephony Actions
	Variable Routing
	Route Incoming Call
	Route by Call Status
	Transfer
	Whisper
	Call List
	Dial by Name
	Conferencing Center
	Assisted Transfer
	Alphanumeric

	Miscellaneous Actions
	eMail
	Open Door
	Alarm Set
	Clock
	Post Dial
	VB Script
	Remote Call Flow

	Condition Actions
	Test Condition
	Set User Variable
	Test User Variable
	Test Variable
	Decrement and Test Counter
	Increment and Test Counter

	Database Actions
	Database Open
	Database Execute
	Database Get Data
	Database Close

	Queue Actions
	Queue ETA
	Queue Position


	Administration
	Routing Calls to Voicemail
	Routing Calls to Voicemail
	Forward Unconditional to Voicemail
	Transferring Calls to Voicemail
	Using Short Codes to Access Voicemail
	Using VM: to Access Voicemail
	Voicemail Telephone Numbers
	Example Call Flow

	User Voicemail Access
	Giving Users Button Access
	Giving Users Access from Any Extension
	Giving Users Access from an External Location
	Creating a Trusted Location

	Hunt Group Voicemail
	Configuring Message Waiting Indication
	Configuring Group Broadcast
	Using a Short Code to Collect Voicemail
	Out of Hours Operation
	Configuring Announcements
	Customizing Announcements
	Hunt Group Queuing
	Customizing a Hunt Group Call Flow

	Recording Calls
	Call Recording Warning
	Changing the Recording Time
	Voice Recording Library (VRL)
	Manual Call Recording
	Setting Manual Recording Options
	Customizing Manual Recording

	Automatic Call Recording
	Setting Automatic Recording Options
	Customizing Auto Recording


	Announcements
	Mandatory Announcement Example
	Personal Announcements

	Support for Callers with Impaired Hearing
	Installing Voicemail Pro TTY Prompts
	Changing User Locale
	Advice for Mailbox Owners Using a TTY Device
	Changing the Language Setting for a TTY Device

	Changing Language
	Supported Languages
	Changing the Language of System Prompts
	Changing the Language of Custom Prompts

	Mobile Twinning
	Example Call Flow

	Remote Voicemail Notification
	Callback
	Using a Play Configuration Menu Action

	Outcalling
	Setting the Outcalling Preferences
	Phone Manager Outcalling


	Personal Distribution Lists
	Automatic Message Deletion
	Using Voicemail to Give Error Messages
	Disabling a Mailbox

	Mailbox Access Controls
	General Controls
	Intuity Mode
	IP Office Mode
	Phone Manager
	Visual Voice
	UMS Web Voicemail
	UMS IMAP
	UMS Exchange 2007

	Voicemail Pro Examples
	Using VB Script
	VBScript Properties
	CallingParty Property
	EstimatedAnswer Property
	LastAccessedMsg Property
	Locale Property
	Name Property
	NewMsgs Property
	OldMsgs Property
	PositionInQueue Property
	Result Property
	SavedMsgs Property
	SavedResult Property
	Variable Property

	VBScript Methods
	ForwardMsg Method
	ForwardMsgToMailbox Method
	FullFilename Method
	GetCallingParty Method
	GetDTMF Method
	GetEstimatedAnswer Method
	GetExtension Method
	GetLastAccessed Msg Method
	GetLocale Method
	GetMailbox Method
	GetMailboxMessage Method
	GetMailboxMessages Method
	GetMessagePriority Method
	GetMessagePrivate Method
	GetMessageStatus Method
	GetName Method
	GetNewMsgs Method
	GetOldMsgs Method
	GetPositionInQueue Method
	GetRegister Method
	GetResult Method
	GetSavedMsgs Method
	GetSavedResult Method
	GetUserExtension Method
	GetUserMailboxFromExtn Method
	GetUserVariable Method
	GetVariable Method
	MessageCLI Method
	MessageDisplay Method
	MessageLength Method
	MessageTime Method
	PlayDigits Method
	PlayLocaleWav Method
	PlayWav Method
	RecordMsg Method
	RecordRegister Method
	Register Method
	SetLocale Method
	SetMailboxMessage Method
	SetRegister Method
	SetResult Method
	SetSavedResult Method
	SetUserVariable Method
	SetVariable Method
	Speak Method
	Stop Method


	Database Connection
	Example Database Scenario
	Retrieving Data from the Database
	Returning Data from the Database
	Entering Details into the Database


	Dial by Name
	Example Call Flow
	Adding a Record Name Module
	Using the Name Table
	Changing Full Names

	Campaigns
	Managing Campaigns
	Customer Prompts
	Customer Menu
	Campaign Identification

	Accessing Campaign Results
	Campaign Park Slots
	Using the Web Campaign


	Fax Server Configuration
	Fax Server Configuration
	Setting the VoiceMail Pro System Fax Number
	Setting up Fax Forwarding
	Setting Up a User Defined Fax Number
	Routing Fax Calls Using a Menu Action
	Configuring an Analog Extension Number for Fax Use
	Castelle Fax Server


	Appendix
	What Was New in 4.2
	What Was New in 4.1
	What Was New in 4.0
	Prompts
	US English Intuity Prompts
	English Non-Intuity Prompts

	Installing VoiceMail Pro as an ACM Gateway
	Installing Networked Messaging (VPNM)
	Requirements for VPNM
	Installing VoiceMail Pro with VPNM Support
	Configuring VPNM Preferences
	Testing a VPNM Setup

	IP Office to Avaya Interchange
	Configuring the Avaya Intuity Audix
	Configuring the Avaya Interchange
	Configuring a DNS Server
	Verification and Troubleshooting



